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Preface

PASW Statistics 18

PASW Statistics 18 is a comprehensive system for analyzing data. PASW Statistics can take
data from almost any type of file and use them to generate tabul ated reports, charts and plots of
distributions and trends, descriptive statistics, and complex statistical analyses.

This manual, the PASM® Satistics 18 Core System User’s Guide, documents the graphical
user interface of PASW Statistics. Examples using the statistical procedures found in PASW
Statistics Base 18 are provided in the Help system, installed with the software.

In addition, beneath the menus and dialog boxes, PASW Statistics uses a command language.
Some extended features of the system can be accessed only via command syntax. (Those features
are not available in the Student Version.) Detailed command syntax reference information is
available in two forms: integrated into the overall Help system and as a separate document in PDF
form in the Command Syntax Reference, also available from the Help menu.

PASW Statistics Options

The following options are available as add-on enhancements to the full (not Student Version)
PASW Statistics Base system:

Statistics Base gives you awide range of statistical procedures for basic analyses and reports,
including counts, crosstabs and descriptive statistics, OLAP Cubes and codebook reports. It also
provides awide variety of dimension reduction, classification and segmentation techniques such
as factor analysis, cluster analysis, nearest neighbor analysis and discriminant function analysis.
Additionally, PASW Statistics Base offers a broad range of algorithms for comparing means and
predictive techniques such ast-test, analysis of variance, linear regression and ordinal regression.

Advanced Statistics focuses on techniques often used in sophisticated experimental and biomedical
research. It includes procedures for general linear models (GLM), linear mixed models, variance
components analysis, loglinear analysis, ordinal regression, actuarial life tables, Kaplan-Meier
survival analysis, and basic and extended Cox regression.

Bootstrapping is a method for deriving robust estimates of standard errors and confidence
intervals for estimates such as the mean, median, proportion, odds ratio, correlation coefficient or
regression coefficient.

Categories performs optimal scaling procedures, including correspondence analysis.

Complex Samples alows survey, market, health, and public opinion researchers, as well as social
scientists who use sample survey methodology, to incorporate their complex sample designs
into data analysis.



Conjoint provides arealistic way to measure how individual product attributes affect consumer and
citizen preferences. With Conjoint, you can easily measure the trade-off effect of each product
attribute in the context of a set of product attributes—as consumers do when making purchasing
decisions.

Custom Tables creates a variety of presentation-quality tabular reports, including complex
stub-and-banner tables and displays of multiple response data.

Data Preparation provides a quick visual snapshot of your data. It provides the ability to apply
validation rules that identify invalid data values. You can create rules that flag out-of-range
values, missing values, or blank values. You can also save variables that record individual rule
violations and the total number of rule violations per case. A limited set of predefined rules that
you can copy or modify is provided.

Decision Trees creates a tree-based classification model. It classifies cases into groups or predicts
values of a dependent (target) variable based on values of independent (predictor) variables. The
procedure provides validation tools for exploratory and confirmatory classification analysis.

Direct Marketing allows organizations to ensure their marketing programs are as effective as
possible, through techniques specifically designed for direct marketing.

Exact Tests calculates exact p values for statistical tests when small or very unevenly distributed
samples could make the usual tests inaccurate. This option is available only on Windows
operating systems.

Forecasting performs comprehensive forecasting and time series analyses with multiple
curve-fitting models, smoothing models, and methods for estimating autoregressive functions.

Missing Values describes patterns of missing data, estimates means and other statistics, and
imputes values for missing observations.

Neural Networks can be used to make business decisions by forecasting demand for a product as a
function of price and other variables, or by categorizing customers based on buying habits and
demographic characteristics. Neura networks are non-linear data modeling tools. They can be
used to model complex relationships between inputs and outputs or to find patternsin data.

Regression provides techniques for analyzing data that do not fit traditional linear statistical
models. It includes procedures for probit analysis, logistic regression, weight estimation,
two-stage least-squares regression, and general nonlinear regression.

Amos™ (analysis of moment structures) uses structural equation modeling to confirm and explain
conceptual models that involve attitudes, perceptions, and other factors that drive behavior.

Installation

To install the Base system, run the License Authorization Wizard using the authorization code
that you received from SPSS Inc. For more information, see the installation instructions supplied
with the Base system.

Compatibility

PASW Statisticsis designed to run on many computer systems. See the installation instructions
that came with your system for specific information on minimum and recommended requirements.
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Serial Numbers

Your serial number is your identification number with SPSS Inc. You will need this serial number
when you contact SPSS Inc. for information regarding support, payment, or an upgraded system.
The serial number was provided with your Core system.

Customer Service

If you have any questions concerning your shipment or account, contact your local office, listed
on the Web site at http://www.spss.com/worldwide. Please have your serial number ready for
identification.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature hands-on
workshops. Seminars will be offered in major cities on aregular basis. For more information on
these seminars, contact your local office, listed on the Web site at http: //www.spss.com/worldwide.

Technical Support

Technical Support services are available to maintenance customers. Customers may
contact Technical Support for assistance in using PASW Statistics or for installation help
for one of the supported hardware environments. To reach Technical Support, see the

Web site at http://mwww.spss.com, or contact your local office, listed on the Web site at

http: //imww.spss.com/worldwide. Be prepared to identify yourself, your organization, and the
serial number of your system.

Additional Publications

The SPSS Satistics Satistical Procedures Companion, by Marija Norusis, has been published
by Prentice Hall. A new version of this book, updated for PASW Statistics 18, is planned. The
SPSS Satistics Advanced Satistical Procedures Companion, also based on PASW Statistics 18,
is forthcoming. The SPSS Satistics Guide to Data Analysis for PASW Statistics 18 isalso in
development. Announcements of publications available exclusively through Prentice Hall will
be available on the Web site at http: //mww.spss.conmvestore (select your home country, and then
click Books).
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Chapter

Overview

What's New in Version 18?

Automated data preparation. Automated Data Preparation (ADP) handles the task of preparing data
for analysis, analyzing your data and identifying fixes, screening out fields (variables) that are
problematic or not likely to be useful, deriving new attributes when appropriate, and improving
performance through intelligent screening techniques. You can use the algorithm in fully
automatic fashion, allowing it to choose and apply fixes, or you can useit in interactive fashion,
previewing the changes before they are made and accept or reject them as desired. Automated
Data Preparation is available in the Data Preparation add-on option.

Bootstrapping. Bootstrapping is a robust method for determining the properties of population
estimators (like the mean, median, percentiles, and correlation and regression coefficients) when
parametric assumptions do not hold, or when inferences based on parametric assumptions are
difficult to compute. Bootstrapping is available in the new Bootstrapping add-on option.

New nonparametric tests. Nonparametric tests make minimal assumptions about the underlying
distribution of the data. The new nonparametric tests provide a new user interface and Model
Viewer output, and include all of the tests available in the legacy nonparametric tests, including:
one-sample Wilcoxon signed-rank test, one-sample confidence intervals for the binomial
distribution, the related-samples marginal homogeneity test, and the Hodges-L ehman confidence
interval for the median of the difference in paired-samples and the difference in medians of two
independent samples. Pairwise and stepwise step-down multiple comparisons are also available
for all kindependent samples and k related samples tests. The Jonckheere-Terpstratest is available
without requiring the Exact Tests add-on option. The new nonparametric tests are available in
the Statistics Base add-on option.

Programmability enhancements. The R Integration Plug-in now supports R debugging features.
Additionally, you can create pivot tables from R with multiple row and column dimensions and
you can nest multiple pivot tables under a common outline heading. R extension commands
can be implemented directly from R source code files, bypassing the need to distribute them as
R packages. Also, you can bundle together all components of a custom R or Python procedure,
allowing end users to easily install the procedure without manually copying files. Complete
documentation for the Python and R Integration Plug-insis now integrated with the Help system.

Direct marketing tools. The new Direct Marketing add-on option provides a set of tools designed
to improve the results of direct marketing campaigns by identifying demographic, purchasing,
and other characteristics that define various groups of consumers and targeting specific groups to
maximize positive response rates.
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Custom Tables enhancements. The Custom Tables add-on option now offers computed categories
and significance results integrated into the same table as the values being tested.

Improved SAS data file support. You can now write data filesin SAS 9 format. For more
information, see the topic Saving Data: Data File Typesin Chapter 3 on p. 40.

Improved Custom Dialog Builder. The Custom Dialog Builder now has a list box control that
supports single or multiple selection. Also, list items for combo box and list box controls can now
be dynamically populated with values associated with the variables in a specified target list. In
addition, radio buttons can now contain a set of nested controls. For more information, see the
topic Creating and Managing Custom Dialogs in Chapter 18 on p. 319.

Improved display of large pivot tables. New display options are now available that make it easier
to view and navigate large pivot tables (tables with hundreds or thousands of rows). For more
information, see the topic Set Rows to Display in Chapter 11 on p. 238.

Improved Twostep Cluster output. The Twostep Cluster procedure now provides interactive model
viewer output. Twostep Cluster is available in the Statitics Base option.

Additional rule-checking on quality control charts. Rule-checking is now performed on several
additional control charts. When rule-checking is requested for an X-bar chart, it will also be
performed on the accompanying R (range) or s (standard deviation) chart. Similarly, when
rule-checking is requested for an Individuals (Runs) chart, it will also be performed on the
accompanying Moving Range chart. Quality control charts are available in the Statistics Base
option.

Windows

There are a number of different types of windowsin PASW Statistics:

Data Editor. The Data Editor displays the contents of the datafile. You can create new datafiles or
modify existing data files with the Data Editor. If you have more than one datafile open, thereisa
separate Data Editor window for each datafile.

Viewer. All statistical results, tables, and charts are displayed in the Viewer. You can edit the
output and save it for later use. A Viewer window opens automatically the first time you run
a procedure that generates output.

Pivot Table Editor. Output that is displayed in pivot tables can be modified in many ways with
the Pivot Table Editor. You can edit text, swap data in rows and columns, add color, create
multidimensional tables, and selectively hide and show results.

Chart Editor. You can modify high-resolution charts and plots in chart windows. You can change
the colors, select different type fonts or sizes, switch the horizontal and vertical axes, rotate 3-D
scatterplots, and even change the chart type.

Text Output Editor. Text output that is not displayed in pivot tables can be modified with the Text
Output Editor. You can edit the output and change font characteristics (type, style, color, size).
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Syntax Editor. You can paste your dialog box choices into a syntax window, where your selections
appear in the form of command syntax. You can then edit the command syntax to use specia
features that are not available through dialog boxes. You can save these commandsin afile for
use in subsequent sessions.

Figure 1-1
Data Editor and Viewer
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Business Products 88,707,150 §425152
Total 5145,038,250 §371,8493 "
< < >

Designated Window versus Active Window

If you have more than one open Viewer window, output is routed to the designated Viewer
window. If you have more than one open Syntax Editor window, command syntax is pasted into
the designated Syntax Editor window. The designated windows are indicated by aplussign in the
icon in thetitle bar. You can change the designated windows at any time.

The designated window should not be confused with the active window, which is the currently
selected window. If you have overlapping windows, the active window appears in the foreground.
If you open awindow, that window automatically becomes the active window and the designated
window.

Changing the Designated Window

>
>

Make the window that you want to designate the active window (click anywhere in the window).
Click the Designate Window button on the toolbar (the plus sign icon).

or

From the menus choose:

Utilities
Designate Window
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Note: For Data Editor windows, the active Data Editor window determines the dataset that is used
in subsequent calculations or analyses. Thereis no “designated” Data Editor window. For more
information, see the topic Basic Handling of Multiple Data Sources in Chapter 6 on p. 92.

Status Bar

The status bar at the bottom of each PASW Statistics window provides the following information:

Command status. For each procedure or command that you run, a case counter indicates the
number of cases processed so far. For statistical procedures that require iterative processing, the
number of iterations is displayed.

Filter status. If you have selected a random sample or a subset of casesfor analysis, the message
Filter on indicates that some type of case filtering is currently in effect and not all casesin the
data file are included in the analysis.

Weight status. The message Weight on indicates that a weight variable is being used to weight
cases for analysis.

Split File status. The message Split File on indicates that the data file has been split into separate
groups for analysis, based on the values of one or more grouping variables.

Dialog Boxes

Most menu selections open dialog boxes. You use dialog boxes to select variables and options
for analysis.

Dialog boxes for statistical procedures and charts typically have two basic components:

Source variable list. A list of variablesin the active dataset. Only variable types that are allowed
by the selected procedure are displayed in the source list. Use of short string and long string
variables is restricted in many procedures.

Target variable list(s). One or more lists indicating the variables that you have chosen for the
analysis, such as dependent and independent variable lists.

Variable Names and Variable Labels in Dialog Box Lists

You can display either variable names or variable labelsin dialog box lists, and you can control the
sort order of variablesin source variable lists. To control the default display attributes of variables
in source lists, choose Options on the Edit menu. For more information, see the topic General
Options in Chapter 16 on p. 291.

You can also change the variable list display attributes within dialogs. The method for changing
the display attributes depends on the dialog:

m If the diaog provides sorting and display controls above the source variable list, use those
controls to change the display attributes.

m If the dialog does not contain sorting controls above the source variable list, right-click on any
variable in the source list and select the display attributes from the context menu.
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You can display either variable names or variable labels (names are displayed for any variables
without defined labels), and you can sort the source list by file order, alphabetical order, or
measurement level. (In dialogs with sorting controls above the source variable list, the default
selection of None sortsthelist in file order.)

Resizing Dialog Boxes

You can resize dialog boxes just like windows, by clicking and dragging the outside borders or
corners. For example, if you make the dialog box wider, the variable lists will also be wider.

Figure 1-2
Resized dialog box
E Frequencies
Variable(=): -
= Statistics..
& ngein years [age] = —
f Marital status [marital]
f Years at current address [address]
‘g& Household income in thousands [income] =
Il Income categary in thousands [inceat] =

f Price of primary vehicle [car]

d:l Primary vehicle price category [carcat]
‘g& Level of education [ed]

&) Years with current employer [employ]

-

@ Digplay frequency takles

(o) (e ) ) () il

Dialog Box Controls

There are five standard controls in most dialog boxes:

0K. Runs the procedure. After you select your variables and choose any additional specifications,
click OK to run the procedure and close the dialog box. Some dial ogs have a Run button instead of
the OK button.

Paste. Generates command syntax from the dialog box selections and pastes the syntax into a
syntax window. You can then customize the commands with additional features that are not
available from dialog boxes.

Reset. Deselects any variablesin the selected variable list(s) and resets all specifications in the
dialog box and any subdialog boxes to the default state.

Cancel. Cancels any changes that were made in the dialog box settings since the last time it was
opened and closes the dialog box. Within a session, dialog box settings are persistent. A dialog
box retains your last set of specifications until you override them.

Help. Provides context-sensitive Help. This control takes you to a Help window that contains
information about the current dialog box.
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Selecting Variables

To select asingle variable, simply select it in the source variable list and drag and drop it into the
target variable list. You can also use arrow button to move variables from the source list to the

target lists. If thereis only one target variable list, you can double-click individual variables to
move them from the source list to the target list.

You can aso select multiple variables:

m  To select multiple variables that are grouped together in the variablelist, click thefirst variable
and then Shift-click the last variable in the group.

m To select multiple variables that are not grouped together in the variable list, click the first
variable, then Ctrl-click the next variable, and so on (Macintosh: Command-click).

Data Type, Measurement Level, and Variable List Icons

The icons that are displayed next to variables in dialog box lists provide information about the
variable type and measurement level.

M easurement Data Type
Level Numeric String

Scale (Continuous) & na
Ordi r-lal d:i d:g d%
Nominal 5}_‘ é)a %

m  For more information on measurement level, see Variable Measurement Level on p. 71.
m  For moreinformation on numeric, string, date, and time data types, see Variable Typeon p. 72.

Getting Information about Variables in Dialog Boxes

Many dialogs provide the ability to find out more about the variables displayed in the variablelists.
» Right-click avariable in the source or target variable list.

» Choose Variable Information.
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Figure 1-3
Variable information
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Basic Steps in Data Analysis

Analyzing data with PASW Statisticsis easy. All you haveto dois:

Get your data into PASW Statistics. You can open a previously saved PASW Statistics datafile,
you can read a spreadsheet, database, or text data file, or you can enter your data directly in
the Data Editor.

Select a procedure. Select a procedure from the menus to calculate statistics or to create a chart.

Select the variables for the analysis. The variables in the datafile are displayed in a dialog box for
the procedure.

Run the procedure and look at the results. Results are displayed in the Viewer.

Statistics Coach

If you are unfamiliar with PASW Statistics or with the available statistical procedures, the
Statistics Coach can help you get started by prompting you with simple questions, nontechnical
language, and visual examples that help you select the basic statistical and charting features that
are best suited for your data.

To use the Statistics Coach, from the menusin any PASW Statistics window choose:

Help
Statistics Coach

The Statistics Coach covers only a selected subset of procedures. It is designed to provide general
assistance for many of the basic, commonly used statistical techniques.
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Finding Out More

For a comprehensive overview of the basics, see the online tutorial. From any PASW Statistics
menu choose:

Help
Tutorial
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Getting Help

Help is provided in many different forms:

Help menu. The Help menu in most windows provides access to the main Help system, plus
tutorials and technical reference material.

Topics. Provides access to the Contents, Index, and Search tabs, which you can use to find
specific Help topics.

Tutorial. Illustrated, step-by-step instructions on how to use many of the basic features. You
don't have to view the whole tutorial from start to finish. You can choose the topics you want
to view, skip around and view topics in any order, and use the index or table of contentsto
find specific topics.

Case Studies. Hands-on examples of how to create various types of statistical analyses and
how to interpret the results. The sample data files used in the examples are also provided so
that you can work through the examples to see exactly how the results were produced. You
can choose the specific procedure(s) that you want to learn about from the table of contents
or search for relevant topics in the index.

Statistics Coach. A wizard-like approach to guide you through the process of finding the
procedure that you want to use. After you make a series of selections, the Statistics Coach
opens the dialog box for the statistical, reporting, or charting procedure that meets your
selected criteria.

Command Syntax Reference. Detailed command syntax reference information is available in
two forms: integrated into the overall Help system and as a separate document in PDF formin
the Command Syntax Reference, available from the Help menu.

Statistical Algorithms. The algorithms used for most statistical procedures are available in two
forms; integrated into the overall Help system and as a separate document in PDF form
available on the manuals CD. For links to specific algorithms in the Help system, choose
Algorithms from the Help menu.

Context-sensitive Help. In many placesin the user interface, you can get context-sensitive Help.

Dialog box Help buttons. Most dialog boxes have a Help button that takes you directly to a
Help topic for that dialog box. The Help topic provides general information and links to
related topics.
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m  Pivot table context menu Help. Right-click on termsin an activated pivot table in the Viewer
and choose What's This? from the context menu to display definitions of the terms.

®  Command syntax. In a command syntax window, position the cursor anywhere within a syntax
block for a command and press F1 on the keyboard. A complete command syntax chart for
that command will be displayed. Complete command syntax documentation is available from
the links in the list of related topics and from the Help Contents tab.

Other Resources

Technical Support Web site. Answers to many common problems can be found at
http: //support.spss.com. (The Technical Support Web site requires alogin ID and password.
Information on how to obtain an ID and password is provided at the URL listed above.)

Developer Central. Developer Central has resources for all levels of users and application
developers. Download utilities, graphics examples, new statistical modules, and articles. Visit
Developer Central at http://www.spss.convdevcentral .

Getting Help on Output Terms

To see a definition for aterm in pivot table output in the Viewer:
Double-click the pivot table to activate it.
Right-click on the term that you want explained.

Choose What's This? from the context menu.

A definition of the term is displayed in a pop-up window.

Figure 2-1

Activated pivot table glossary Help with right mouse button

-~
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Data Files

Data files come in awide variety of formats, and this software is designed to handle many of
them, including:

m  Spreadsheets created with Excel and Lotus

m Database tables from many database sources, including Oracle, SQL Server, Access, dBASE,
and others

Tab-delimited and other types of simple text files

Datafilesin PASW Statistics format created on other operating systems
SYSTAT datafiles

SAS data files

Stata data files

Opening Data Files

In addition to files saved in PASW Statistics format, you can open Excel, SAS, Stata,
tab-delimited, and other files without converting the files to an intermediate format or entering
data definition information.

m  Opening adata file makes it the active dataset. If you aready have one or more open data
files, they remain open and available for subsequent use in the session. Clicking anywhere
in the Data Editor window for an open data file will make it the active dataset. For more
information, see the topic Working with Multiple Data Sources in Chapter 6 on p. 92.

m Indistributed analysis mode using a remote server to process commands and run procedures,
the available data files, folders, and drives are dependent on what is available on or from the
remote server. The current server name is indicated at the top of the dialog box. You will
not have access to datafiles on your local computer unless you specify the drive as a shared
device and the folders containing your data files as shared folders. For more information, see
the topic Distributed Analysis Mode in Chapter 4 on p. 62.

To Open Data Files
» From the menus choose;
File

Open
Data...

» Inthe Open Datadialog box, select the file that you want to open.

1
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» Click Open.

Optionally, you can:

m  Automatically set the width of each string variable to the longest observed value for that
variable using Minimize string widths based on observed values. Thisis particularly useful
when reading code page data files in Unicode mode. For more information, see the topic
General Optionsin Chapter 16 on p. 291.

m Read variable names from the first row of spreadsheet files.
m  Specify arange of cellsto read from spreadsheet files.
m  Specify aworksheet within an Excel file to read (Excel 95 or later).

For information on reading data from databases, see Reading Database Files on p. 14. For
information on reading data from text data files, see Text Wizard on p. 28.

Data File Types
PASW Statistics. Opens data files saved in PASW Statistics format and also the DOS product
SPSS/PC+.
SPSS/PC+. Opens SPSS/PC+ datafiles. Thisis available only on Windows operating systems.
SYSTAT. Opens SY STAT data files.

PASW Statistics Portable. Opens data files saved in portable format. Saving afile in portable
format takes considerably longer than saving the file in PASW Statistics format.

Excel. Opens Excel files.
Lotus 1-2-3. Opens data files saved in 1-2-3 format for release 3.0, 2.0, or 1A of Lotus.

SYLK. Opens datafiles saved in SYLK (symbolic link) format, a format used by some spreadsheet
applications.

dBASE. Opens dBASE-format files for either dBASE 1V, dBASE 11 or |1l PLUS, or dBASE II.
Each caseis arecord. Variable and value labels and missing-value specifications are lost when
you save afile in this format.

SAS. SASversions 6-9 and SAS transport files. Using command syntax, you can also read value
labels from a SAS format catalog file.

Stata. Stata versions 4-8.

Opening File Options

Read variable names. For spreadsheets, you can read variable names from the first row of the file
or thefirst row of the defined range. The values are converted as necessary to create valid variable
names, including converting spaces to underscores.

Worksheet. Excel 95 or later files can contain multiple worksheets. By default, the Data Editor
reads the first worksheet. To read a different worksheet, select the worksheet from the drop-down
list.
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Range. For spreadsheet data files, you can also read a range of cells. Use the same method for
specifying cell ranges as you would with the spreadsheet application.

Reading Excel 95 or Later Files

The following rules apply to reading Excel 95 or later files:

Data type and width. Each column is avariable. The data type and width for each variable are
determined by the data type and width in the Excel file. If the column contains more than one
data type (for example, date and numeric), the datatype is set to string, and all values are read
as valid string values.

Blank cells. For numeric variables, blank cells are converted to the system-missing value,
indicated by a period. For string variables, ablank is avalid string value, and blank cells are
treated as valid string values.

Variable names. If you read the first row of the Excel file (or the first row of the specified range) as
variable names, values that don’t conform to variable naming rules are converted to valid variable
names, and the original names are used as variable labels. If you do not read variable names from
the Excel file, default variable names are assigned.

Reading Older Excel Files and Other Spreadsheets

The following rules apply to reading Excel files prior to Excel 95 and other spreadsheet data:

Data type and width. The data type and width for each variable are determined by the column
width and data type of the first data cell in the column. Values of other types are converted to the
system-missing value. If the first data cell in the column is blank, the global default data type
for the spreadsheet (usually numeric) is used.

Blank cells. For numeric variables, blank cells are converted to the system-missing value,
indicated by a period. For string variables, ablank is avalid string value, and blank cells are
treated as valid string values.

Variable names. |f you do not read variable names from the spreadsheet, the column letters (A,
B, C, ...) are used for variable names for Excel and Lotusfiles. For SYLK files and Excel files
saved in R1C1 display format, the software uses the column number preceded by the letter C
for variable names (C1, C2, C3, ..).

Reading dBASE Files

Database files are logically very similar to PASW Statistics datafiles. The following general
rules apply to dBASE files:

m  Field names are converted to valid variable names.
m  Colons used in dBASE field names are trand ated to underscores.

m  Records marked for deletion but not actually purged are included. The software creates a new
string variable, D_R, which contains an asterisk for cases marked for deletion.
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The following general rules apply to Stata data files:

m Variable names. Stata variable names are converted to PASW Statistics variable namesin
case-sensitive form. Stata variable names that are identical except for case are converted to
valid variable names by appending an underscore and a sequential letter ( A, B, C, ...,
_Z, AA, AB, ..., and so forth).

m Variable labels. Stata variable |abels are converted to PASW Statistics variable |abels.

m Value labels. Stata value labels are converted to PASW Statistics value labels, except for Stata
value labels assigned to “extended” missing values.

Missing values. Stata“extended” missing values are converted to system-missing values.

Date conversion. Stata date format values are converted to PASW Statistics pAaTE format
(d-m-y) values. Stata “time-series’ date format values (weeks, months, quarters, and so on)
are converted to simple numeric (F) format, preserving the original, internal integer value,
which is the number of weeks, months, quarters, and so on, since the start of 1960.

Reading Database Files

You can read data from any database format for which you have adatabase driver. Inloca analysis
mode, the necessary drivers must be installed on your local computer. In distributed analysis mode
(available with PASW Statistics Server), the drivers must be installed on the remote server.For
more information, see the topic Distributed Analysis Mode in Chapter 4 on p. 62.

To Read Database Files

» From the menus choose:
File
Open Database
New Query...

» Sedlect the data source.

» If necessary (depending on the data source), select the database file and/or enter alogin name,
password, and other information.

» Select the table(s) and fields. For OLE DB data sources (available only on Windows operating
systems), you can only select one table.

» Specify any relationships between your tables.

» Optionally:
m  Specify any selection criteria for your data.
®  Add aprompt for user input to create a parameter query.
m  Save your constructed query before running it.
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To Edit Saved Database Queries

» From the menus choose:
File
Open Database
Edit Query...

» Select the query file (*.spq) that you want to edit.

» Follow the instructions for creating a new query.

To Read Database Files with Saved Queries

» From the menus choose:
File
Open Database
Run Query...

» Select the query file (*.spq) that you want to run.
» If necessary (depending on the database file), enter alogin name and password.

» |f the query has an embedded prompt, enter other information if necessary (for example, the
quarter for which you want to retrieve sales figures).

Selecting a Data Source

Use the first screen of the Database Wizard to select the type of data source to read.

ODBC Data Sources

If you do not have any ODBC data sources configured, or if you want to add a new data source,
click Add ODBC Data Source.

m  On Linux operating systems, this button is not available. ODBC data sources are specified in
odbc.ini, and the ODBCINI environment variables must be set to the location of that file. For
more information, see the documentation for your database drivers.

m |ndistributed analysis mode (available with PASW Statistics Server), this button is not
available. To add data sources in distributed analysis mode, see your system administrator.

An ODBC data source consists of two essential pieces of information: the driver that will be
used to access the data and the location of the database you want to access. To specify data
sources, you must have the appropriate driversinstalled. Drivers for avariety of database formats
are available at http://mwww.spss.convdrivers.


http://www.spss.com/drivers
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Figure 3-1
Database Wizard

ﬁ Database Wizard

Welcome to the Database Wizard!

This wizard will help you get data from a non-PASW Statistics data source.

“ou can choose the data source, specify which cases are retrieved, aggregate and =ort the data before retrieval, and specify variable
names and properies here. Some festures are avaiable only vwhen connected to PASVY Statistics Server.

Fram wwhich data source would yvou like to retrieve data?

ODBC Data Sources

B dBASE Files
@3 Excel Files
% MZ Access Database

tatisti

[&dd ODEC Data Source. . ]

OLE DB Data Sources

To access OLE DB data sources (available only on Microsoft Windows operating systems),
you must have the following items installed:
m .NET framework. To obtain the most recent version of the .NET framework, go to
http: //Amww.mi crosoft.com/net.
m  PASW Reports for Surveys Components. A version that is compatible with this release can

be installed from the installation media. If you are using PASW Statistics Devel oper, you
can download a compatible version from the Downloads tab at www.spss.com/statistics

(http: /ww.spss.convstatistics/).


http://www.microsoft.com/net
http://www.spss.com/statistics/
http://www.spss.com/statistics/
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The following limitations apply to OLE DB data sources:
m Tablejoinsare not available for OLE DB data sources. You can read only onetable at atime.

®  You can add OLE DB data sources only in local analysis mode. To add OLE DB data sources
in distributed analysis mode on a Windows server, consult your system administrator.

m Indistributed analysis mode (available with PASW Statistics Server), OLE DB data sources
are available only on Windows servers, and both .NET and PASW Reports for Surveys
Components must be installed on the server.

Figure 3-2
Database Wizard with access to OLE DB data sources

ﬁ Databhase Wizard

Welcome to the Database Wizard!

Thiz wizard will help you get data from a non-PASW Statistics data source.

You can choose the data source, specify which cases are retrieved, aggregste and sort the data before retrieval, and specify variable
names and propetties here. Some festures are available only vwhen connected to PASVY Statistics Server.

From which data source would vou like to retrieve data?

OLE DE Data Sources CQDEC Data Sources
&3 OLAP Services & dBASE Files
% SGL survey data % Excel Files

%ﬁ M3 Access Database

[Agd OLE DE Data Source. . ] [&dd ODEC Data Source. . ]

To add an OLE DB data source:
» Click Add OLE DB Data Source.

» InDatalink Properties, click the Provider tab and select the OLE DB provider.
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Click Next or click the Connection tab.

Select the database by entering the directory location and database name or by clicking the button
to browse to a database. (A user name and password may also be required.)

Click OK after entering all necessary information. (You can make sure the specified database is
available by clicking the Test Connection button.)

Enter a name for the database connection information. (This name will be displayed in the list
of available OLE DB data sources.)

Figure 3-3
Save OLE DB Connection Information As dialog box

@ Save OLE DB Connection Information As

Mame:  [SEL survey data ‘

| | Cancel

Click OK.

This takes you back to the first screen of the Database Wizard, where you can select the saved
name from the list of OLE DB data sources and continue to the next step of the wizard.

Deleting OLE DB Data Sources

To delete data source names from the list of OLE DB data sources, delete the UDL file with the
name of the data source in:

[drive] :\Documents and Settings\[ user login]\Local Settings\Application Data\SPSS\UDL

Selecting Data Fields

The Select Data step controls which tables and fields are read. Database fields (columns) are
read as variables.

If atable has any field(s) selected, all of itsfields will be visible in the following Database
Wizard windows, but only fields that are selected in this step will be imported as variables. This
enables you to create table joins and to specify criteria by using fields that you are not importing.
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Figure 3-4
Database Wizard, selecting data
ﬁ Datahase Wizard

Select Data

Select the fields you want to retrieve. Then click the arrowy button or drag the fields to the Retrieve Fields list.

Tig: Selecting a takle selects all of s fields.

Available Tahles: Retrieve Fields in this Order:
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Displaying field names. To list thefieldsin atable, click the plus sign (+) to the left of atable name.
To hide the fields, click the minus sign (-) to the left of atable name.

To add afield. Double-click any field in the Available Tables list, or drag it to the Retrieve Fields In
This Order list. Fields can be reordered by dragging and dropping them within the fields list.

To remove a field. Double-click any field in the Retrieve Fields In This Order list, or drag it to the
Available Tables list.

Sort field names. If this check box is selected, the Database Wizard will display your available
fields in aphabetica order.

By default, the list of available tables displays only standard database tables. You can control
the type of items that are displayed in the list:

m Tables. Standard database tables.
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m Views. Viewsare virtual or dynamic “tables’ defined by queries. These can include joins of
multiple tables and/or fields derived from cal cul ations based on the values of other fields.

Synonyms. A synonym is an aliasfor atable or view, typically defined in a query.

System tables. System tables define database properties. In some cases, standard database
tables may be classified as system tables and will only be displayed if you select this option.
Access to real system tablesis often restricted to database administrators.

Note: For OLE DB data sources (available only on Windows operating systems), you can select
fields only from a single table. Multiple table joins are not supported for OLE DB data sources.

Creating a Relationship between Tables

The Specify Relationships step allows you to define the relationships between the tablesfor ODBC
data sources. If fields from more than one table are selected, you must define at least one join.

Figure 3-5
Database Wizard, specifying relationships

ﬁ Database Wizard

Specify Relationships

In arder to retrieve data from muttiple tables, you must specify howy to join them. To indicate a join, first select the type of join that youw weant. Then
drag a field from one table over the corresponding field in the other table, Aternatively, you can select the two fields and press the Join button.

s

| ‘= Demographicinformstion ‘= SurveyResponzes

Age DOUEBLE Call'Waiting DOUBLE
Car DOUEBLE CallerlD DOUBLE
Car Category DOUEBLE I COUNTER
Education DOUEBLE Internet IMTEGER
Empoat DOUEBLE uttline IMTEGER
Employ DOUELE Mews DaUELE
Fender YARCHAR v GO Player DOUBLE
I COUNTER Orovn Fax DOUBLE
Income DOUELE ey PC DaUBLE
Income Category  DOUBLE Oraem PO DOUBLE
Marital Status DOUEBLE O T DOUBLE
Reside DOUEBLE O WCR DOUBLE
Retire DOUEBLE Pacger INTEGER

Response DOUBLE

Yoice INTEGER
1 P Wireless INTEGER

1 »

=]
X [M]

Join Type: Inner A4 T [¥ Auto Join Tables

(= Back | [ext = ][ Finish | [ cancel || el |
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Establishing relationships. To create a relationship, drag afield from any table onto the field to
which you want to join it. The Database Wizard will draw ajoin line between the two fields,
indicating their relationship. These fields must be of the same data type.

Auto Join Tables. Attempts to automatically join tables based on primary/foreign keys or matching
field names and data type.

Join Type. If outer joins are supported by your driver, you can specify inner joins, left outer
joins, or right outer joins.

m Inner joins. Aninner join includes only rows where the related fields are equal. In this
example, al rows with matching ID valuesin the two tables will be included.

m  Outer joins. In addition to one-to-one matching with inner joins, you can also use outer joinsto
merge tables with a one-to-many matching scheme. For example, you could match atable
in which there are only afew records representing data values and associated descriptive
labels with values in atable containing hundreds or thousands of records representing survey
respondents. A left outer join includes all records from the table on the left and, from the table
on the right, includes only those records in which the related fields are equal. 1n aright outer
join, the join imports al records from the table on the right and, from the table on the left,
imports only those records in which the related fields are equal.

Limiting Retrieved Cases

The Limit Retrieved Cases step allows you to specify the criteriato select subsets of cases (rows).
Limiting cases generally consists of filling the criteria grid with criteria. Criteria consist of two
expressions and some relation between them. The expressions return a value of true, false, or
missing for each case.

m |If theresult istrue, the case is selected.

m If theresult is false or missing, the case is not selected.

m  Most criteria use one or more of the six relational operators (<, >, <=, >=, =, and <>).
[ |

Expressions can include field names, constants, arithmetic operators, numeric and other
functions, and logical variables. You can use fields that you do not plan to import as variables.
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Figure 3-6
Database Wizard, limiting retrieved cases

ﬁ Datahase Wizard

Limit Retrieved Cases

Limit the cases that are retrieved by specifying selection criteria.

Tip: Fields and Functions can be added to an expression by dragging and dropping into 2 cell.

See help for howy to express date and time values.

Fields: Criteria:
Connectar |Expression 1 |Relaﬂon Expression 2
1 I |
2
3
4
S
g
1
Functions m Randomly Sample Cazes
AZCI strexpr) ) -
Sampling Method Sample Size

CHAR asciicode)
COMCAT(strexpr strexpr)
INSERT strexpr pos len new)
LEFT(strexpr court)

LTRIM strexpr)

LEMGTH  strexpr)

LOCATE haystack needle)
LCASE strexpr)

REPEATI strexpr, count))
REPLACE(target old new)

RIGHT(strexpr count)
14 3

Prompt For Value. ..

@ Retrieve cases and randomly select

in PASW Statistics

Tige If ywou retrieve the cases and select them
in PASW Statistics, database aggregstion is

unavailable.

@ Approximate percentage of all cazes

Percentage: H
- <]

@ Exact number of cases

(= ook ) (i

[ Finizh ][ Cancel ][ Help ]

To build your criteria, you need at least two expressions and a relation to connect the expressions.

» To build an expression, choose one of the following methods:

In an Expression cell, type field names, constants, arithmetic operators, numeric and other

functions, or logical variables.
Double-click the field in the Fields list.

Drag the field from the Fields list to an Expression cell.

Choose afield from the drop-down menu in any active Expression cell.

» To choose the relational operator (such as = or >), put your cursor in the Relation cell and either

type the operator or choose it from the drop-down menu.
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If the SQL contains WHERE clauses with expressions for case selection, dates and timesin
expressions need to be specified in a special manner (including the curly braces shown in the
examples):

m Dateliterals should be specified using the general form {d 'yyyy-mm-dd' }.

m  Timeliterals should be specified using the genera form {t 'hh:mm:ss'}.

m Date/timeliterals (timestamps) should be specified using the general form {ts 'yyyy-mm-dd
hh:mm:ss'}.

m  The entire date and/or time value must be enclosed in single quotes. Years must be expressed
in four-digit form, and dates and times must contain two digits for each portion of the value.
For example January 1, 2005, 1:05 AM would be expressed as:

{ts '2005-01-01 01:05:00"'}

Functions. A selection of built-in arithmetic, logical, string, date, and time SQL functionsis
provided. You can drag afunction from the list into the expression, or you can enter any valid
SQL function. See your database documentation for valid SQL functions. A list of standard
functionsis available at:

http://msdn2.mi crosoft.com/en-us/library/ms711813.aspx

Use Random Sampling. This option selects arandom sample of cases from the data source. For
large data sources, you may want to limit the number of cases to a small, representative sample,
which can significantly reduce the time that it takes to run procedures. Native random sampling, if
available for the data source, is faster than PASW Statistics random sampling, because PASW
Statistics random sampling must still read the entire data source to extract a random sample.

m  Approximately. Generates arandom sample of approximately the specified percentage of cases.
Since this routine makes an independent pseudorandom decision for each case, the percentage
of cases selected can only approximate the specified percentage. The more cases there arein
the datafile, the closer the percentage of cases selected is to the specified percentage.

m  Exactly. Selects arandom sample of the specified number of cases from the specified total
number of cases. If the total number of cases specified exceeds the total number of casesin
the data file, the sample will contain proportionally fewer cases than the requested number.

Note: If you use random sampling, aggregation (available in distributed mode with PASW
Statistics Server) is not available.

Prompt For Value. You can embed a prompt in your query to create a parameter query. When
users run the query, they will be asked to enter information (based on what is specified here). You
might want to do thisif you need to see different views of the same data. For example, you may
want to run the same query to see sales figures for different fiscal quarters.

» Place your cursor in any Expression cell, and click Prompt For Value to create a prompt.

Creating a Parameter Query

Use the Prompt for Value step to create a dialog box that solicits information from users each
time someone runs your query. Thisfeature is useful if you want to query the same data source
by using different criteria.


http://msdn2.microsoft.com/en-us/library/ms711813.aspx
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Figure 3-7
Prompt for Value

ﬁpmmpt for Value

Prompt String: |Income categary (1=low, 2=madium, S=high) |

Information about data to be entered

Cefault value: |1 |

[ Allow user to select value from list

1
2
3

Datatype: |Number x|

[Corltinue][ Cancel ][ Help ]

To build a prompt, enter a prompt string and a default value. The prompt string is displayed each
time a user runs your query. The string should specify the kind of information to enter. If the user
is not selecting from alist, the string should give hints about how the input should be formatted.
An exampleis as follows. Enter a Quarter (Q1, Q2, Q3, ...).

Allow user to select value from list. If this check box is selected, you can limit the user to the values
that you place here. Ensure that your values are separated by returns.

Data type. Choose the data type here (Number, String, or Date).

The final result looks like this:

Figure 3-8
Userdefined prompt

ﬁ Select Value for Query

Income category (1=low, 2=medium, 3=high)

i 5

Aggregating Data

If you are in distributed mode, connected to a remote server (available with PASW Statistics
Server), you can aggregate the data before reading it into PASW Statistics.
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Figure 3-9
Database Wizard, aggregating data

Data Files

Database Wizard - Distributed Mode

Aggregate Data

& demn: ID 2
% demo: AGE

2 dema: MARITAL

& dema: ADDRESS

& demo: INCOME

& dema: INCCAT

& demo: CAR

& dema: ED

& dema: EMPLOY
& dema: RETIRE

& demo: EMPCAT
& demo: GENDER
& dema: RESIDE

B .

(T Mot

< b4

V

Y'ou cat aggregate vour data before retrieving it according to groups defined by break variables or press MNest to
retrieve the original cazez. The autput varisbles can be renamed on the nest panel.

Break Vaniable(s)

<

& demo: CARCAT Aggregated Yariables

Summaries of VWariable(z)

Hame | Function

<

[ Mumber of cases

Aggregation iz available only when connected bo SPSS Server

< Back | Mest > |

Firizh | Cancel | Help

You can also aggregate data after reading it into PASW Statistics, but preaggregating may save

time for large data sources.

» To create aggregated data, select one or more break variables that define how cases are grouped.

» Select one or more aggregated variables.

» Select an aggregate function for each aggregate variable.

» Optionally, create a variable that contains the number of cases in each break group.

Note: If you use PASW Statistics random sampling, aggregation is not available.

Defining Variables

Variable names and labels. The complete database field (column) name is used as the variable
label. Unless you modify the variable name, the Database Wizard assigns variable names to each

column from the database in one of two ways:

m If the name of the database field forms a valid, unique variable name, the name is used as

the variable name.

m |f the name of the database field does not form avalid, unique variable name, a new, unique

name is automatically generated.

Click any cell to edit the variable name.
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Converting strings to numeric values. Select the Recode to Numeric box for a string variable if you

want to automatically convert it to anumeric variable. String values are converted to consecutive
integer values based on alphabetical order of the original values. The original values are retained
as value labels for the new variables.

Width for variable-width string fields. This option controls the width of variable-width string
values. By default, the width is 255 bytes, and only the first 255 bytes (typically 255 charactersin
single-byte languages) will be read. The width can be up to 32,767 bytes. Although you probably
don’t want to truncate string values, you a so don’'t want to specify an unnecessarily large value,
which will cause processing to be inefficient.

Minimize string widths based on observed values. Automatically set the width of each string
variable to the longest observed value.

Figure 3-10
Database Wizard, defining variables

ﬁ Database Wizard

Define Variables

Ediit variable names and properties.
Mames will be automatically generated if left blank,

To convert a string variable to numeric using the ariginal values as value labels, check Recode to Mumeric.

Result Variable Name Data Type Recudt_! to
Numeric

no: ID 1n] Mumeric —
no: AGE AGE Mumeric

mo: MARITAL MARITAL Mumeric

no: ADDRESS ADDRE=S Mumeric

To: INCOME INCOME Mumeric

no: INCCAT INCCAT Mumeric

no: CAR CAR Mumeric

no: CARCAT CARCAT Mumeric

no: ED ED Mumeric

no: EMPLOY EMPLOY Mumeric

no: RETIRE RETIRE Mumeric

no: EMPCAT EMPCAT Mumeric

mo: GENDER GEMDER String ¥
no: RESIDE RESIDE Mumeric

no: WIRELESS WIRELESS Mumeric

no: MULTLINE MULTLINE Mumeric

no: VOICE WOICE Mumeric

no: PAGER PAGER Mumeric

no: INTERNET INTERMET Mumeric

no: CALLID CaLLID Mumeric

no: CALLWAIT CALLYAIT Mumeric

no: OWNTV O Mumatic p—

ittt for variable-width string fields: 255 [T Minimize string widths based on ohserved values

(< Back | fHext =]  Finish || cancet ][ Help |
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If you are in distributed mode, connected to a remote server (available with PASW Statistics
Server), you can sort the data before reading it into PASW Statistics.

Figure 3-11
Database Wizard, sorting cases

Database Wizard - Distributed Mode

Sort Cases

B MaRITAL

You can sort the data before it is read into SPSS or press Mest to get the data without sorting.

% AGE . Sort before retrieval by:

%ADDHESS Yariable

Direction

B INCOME i)

Azcending

EminCCaT

BmraR 2
EmCaRCaT
EmeD

Em EMPLOY
EmRETIRE
B EMPCAT
Er GEMDER
EmRESIDE
B wWIRELESS
Flew Lot T

< 3

e

appear in thiz vaniable ligt but will have names generated automatically.

< Back | Hest > |

Sorting iz available only when connected to SPSS Server. Any vanables not given names on the previous panel do not

Finizh | Cancel | Help

You can also sort data after reading it into PASW Statistics, but presorting may save time for

large data sources.

Results

The Results step displays the SQL Select statement for your query.

®  You can edit the SQL Select statement before you run the query, but if you click the Back
button to make changes in previous steps, the changes to the Select statement will be lost.

m  To savethe query for future use, use the Save query to file section.

m To paste complete GET DATA syntax into a syntax window, select Paste it into the syntax editor
for further modification. Copying and pasting the Select statement from the Results window
will not paste the necessary command syntax.

Note: The pasted syntax contains a blank space before the closing quote on each line of SQL that

is generated by the wizard. These blanks are not superfluous. When the command is processed, all
lines of the SQL statement are merged together in avery literal fashion. Without the space, there

would be no space between the last character on one line and first character on the next line.
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Figure 3-12
Database Wizard, results panel

ﬁ Datahase Wizard

Results

Your selection has resufted in the following SGL guery:

SELECT ID, AGE, MARITAL, ADDRESS, INCOME, INCCAT, CAR, CARCAT, ED, EMPLOY, RETIRE, EMPCAT, GEMDER, REZIDE, WWRELESS,

MULTLIME, %OICE, PAGER, INTERNET, CALLID, CALLWAIT CMTY | O CR, OWINCD, CWMPDA  OWINPC, OWINF &3, NEWS RESPONSE
FROM dema

—vhat sweould you like to do with this gquery?

® Retrieve the data | have selected.

Pazte it into the syntax editor far further maodification

—Save query to file

| EEES

(o]

” Cancel” Help ]

Text Wizard

The Text Wizard can read text data files formatted in a variety of ways:
B Tab-delimited files

m  Space-delimited files

m  Comma-delimited files

m  Fixed-field format files

For delimited files, you can also specify other characters as delimiters between values, and you
can specify multiple delimiters.
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To Read Text Data Files
» From the menus choose;
File
Read Text Data...
» Select the text file in the Open Data dia og box.

» Follow the stepsin the Text Wizard to define how to read the datafile.

Text Wizard: Step 1

Figure 3-13
Text Wizard: Step 1

B Text Import Wizard - Step 1 of 6

Wizlcome to the text import wizard!

Thiz wizard will help you read data from your text file and specify
information about the variables.

Does your text file match & predefined formst?

Wes

@i

L e | w|mis

Text file: I pubsispssidatajobsidelimit

a 10 20 30 40 a0 Bl

ID,Job_category,Region,Division,Travel ,Current sales,Prewvio ?J
1,2,3,2,2,570000,270000,3
2,1,3,2,2,402000,25300,3
3.1, ,1,2,257400,144000,1
4,1,3,1,2,262800,158400,1
5,1,3,2,2,1324,210000,3

6,1,3,2,2,321000,135000,2
7,1,3,2,2,360000,187500,3

v — [r

o -djmjin g Jia ko)

£l

Thetext file is displayed in a preview window. You can apply a predefined format (previously
saved from the Text Wizard) or follow the steps in the Text Wizard to specify how the data
should be read.
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Text Wizard: Step 2

Figure 3-14
Text Wizard: Step 2

B Text Import Wizard - Step 2 of 6

Horwye are your variables arranged?
@ Deiirited - “ariables are delimited by 5 specific character (i.e., comma, tab).

© Fized wridth - Yariables are aligned in fixed width columnz.

Are variable names included &t the top of your file?
@ ves
O na

Text file: 2 pubsispesidatajobsydelimit tad

0 10 20 30 4n a0 &0

1,2,3,2,2,570000,270000,3 <
z,1,3,2,2,402000,25300,3

3,1, ,1,2,257400,144000,1

4,1,3,1,2,262800,153400, 1

5,1,3,2,2,1324,210000, 3

1] G

1]

This step provides information about variables. A variableis similar to afield in a database. For
example, each item in a questionnaire is a variable.

How are your variables arranged? To read your data properly, the Text Wizard needs to know how
to determine where the data value for one variable ends and the data value for the next variable

begins. The arrangement of variables defines the method used to differentiate one variable
from the next.

m Delimited. Spaces, commas, tabs, or other characters are used to separate variables. The
variables are recorded in the same order for each case but not necessarily in the same column
locations.

m  Fixed width. Each variable is recorded in the same column location on the same record (line)
for each case in the datafile. No delimiter is required between variables. In fact, in many text
data files generated by computer programs, data values may appear to run together without
even spaces separating them. The column location determines which variable is being read.

Are variable names included at the top of your file? If the first row of the data file contains
descriptive labels for each variable, you can use these labels as variable names. Values that don’t
conform to variable naming rules are converted to valid variable names.
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Text Wizard: Step 3 (Delimited Files)

Figure 3-15
Text Wizard: Step 3 (for delimited files)
B Text Import Wizard - Delimited Step 3 of 6
The first caze of data beainz on which line number?

Howy are your cases represented?

® Each line represents & case

1

© A specific number of variahles represents a case:

Hiowee many cases do you want to import™?

@ All of the cazes

@ Tre first [
@ & random percentage of the cases (approximate) :' %
Data preview
10 20 30 4n a0 @D

1,2,3,2,2,570000,270000,3 -
z,1,3,2,2,402000,25300,5
3,1, ,1,2,257400,144000,1
4
1

|

,L1,3,1,2,262600,158400,1

This step provides information about cases. A caseis similar to arecord in a database. For
example, each respondent to a questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file that
contains data values. If the top line(s) of the data file contain descriptive labels or other text that
does not represent data values, this will not be line 1.

How are your cases represented? Controls how the Text Wizard determines where each case
ends and the next one begins.

m  Each line represents a case. Each line contains only one case. It isfairly common for each case
to be contained on a single line (row), even though this can be a very long line for datafiles
with alarge number of variables. If not al lines contain the same number of data values, the
number of variables for each case is determined by the line with the greatest number of data
values. Cases with fewer data values are assigned missing values for the additional variables.

m A specific number of variables represents a case. The specified number of variables for each
case tells the Text Wizard where to stop reading one case and start reading the next. Multiple
cases can be contained on the same line, and cases can start in the middle of one line and
be continued on the next line. The Text Wizard determines the end of each case based on
the number of values read, regardless of the number of lines. Each case must contain data
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values (or missing values indicated by delimiters) for al variables, or the data file will be
read incorrectly.

How many cases do you want to import? You can import al casesin the datafile, thefirst n cases
(nisanumber you specify), or arandom sample of a specified percentage. Since the random
sampling routine makes an independent pseudo-random decision for each case, the percentage of
cases selected can only approximate the specified percentage. The more cases there are in the data
file, the closer the percentage of cases selected is to the specified percentage.

Text Wizard: Step 3 (Fixed-Width Files)

Figure 3-16
Text Wizard: Step 3 (for fixed-width files)

B=| Text Import Wizard - Fixed Width Step 3 of 6

The first caze of data beains on which line number? I:E

Hovee many lines represent a case? I:E

Hiowy many cases do you want to import™?

@ All of the cazes

© The first ——
O a percertadge of the cases: 'S
Diata preview
o 10 20 30 40 a0 &0
L L 1 L [ L 1 L 1 L 1 L 1
1 1z 3.0022 §570,000 §270,000 3 ‘!
2 2l 3,002z §402,000 525,300 3
3 31 12 §257,400 £144,000 1
4 41 3.0012 §262,800 g§158,400 1
3 5l 3.002z 1,324 §210,000 3
g 6l 3.0022 §321,000 £135,000 2
7 71 3.0022 §360,000 g§187,500 3
[ gl 3.0012 §26Z,800 §117,000 1
] al 3.0012 £334,800 £153,000 2
10 101 3.0012 §288,000 glezZ,000 2 =1
AT I

|

This step provides information about cases. A caseis similar to arecord in a database. For
example, each respondent to questionnaire is a case.

The first case of data begins on which line number? Indicates the first line of the data file that
contains data values. If the top line(s) of the data file contain descriptive labels or other text that
does not represent data values, this will not be line 1.

How many lines represent a case? Controls how the Text Wizard determines where each case ends
and the next one begins. Each variable is defined by its line number within the case and its column
location. You need to specify the number of lines for each case to read the data correctly.
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How many cases do you want to import? You can import all casesin the datafile, thefirst n cases
(nisanumber you specify), or arandom sample of a specified percentage. Since the random
sampling routine makes an independent pseudo-random decision for each case, the percentage of
cases selected can only approximate the specified percentage. The more cases there are in the data
file, the closer the percentage of cases selected is to the specified percentage.

Text Wizard: Step 4 (Delimited Files)

Figure 3-17
Text Wizard: Step 4 (for delimited files)
B Text Import Wizard - Delimited Step 4 of 6

Which delimiters appear betvween varisbles? What iz the text qualifier?

[ Tab [+ Space @ Nane

ﬁz. Comma L. Semicolon @ Single guote

L. Cther: ()] Double guote

@ Other:

Diata presiew
I Job_category | Region Division Trawvel currert_sales |PrE
1 2 3 2 2 570000 270~
2 1 3 2 2 402000 253
3 1 1 2 257
4 1 3 1 2 262500 158
a 1 3 2 2 1324 210
5] 1 3 2 2 321000 135
7 1 3 2 2 360000 167
g 1 3 1 2 262500 117
9 1 3 1 2 334500 153+
W [*]

This step displays the Text Wizard’s best guess on how to read the data file and alows you to
modify how the Text Wizard will read variables from the datafile.

Which delimiters appear between variables? Indicates the characters or symbols that separate data
values. You can select any combination of spaces, commas, semicolons, tabs, or other characters.
Multiple, consecutive delimiters without intervening data values are treated as missing values.

What is the text qualifier? Characters used to enclose values that contain delimiter characters.

For example, if acommais the delimiter, values that contain commas will be read incorrectly
unless thereis atext quaifier enclosing the value, preventing the commas in the value from being
interpreted as delimiters between values. CSV-format data files exported from Excel use a double
guotation mark () as atext qualifier. The text qualifier appears at both the beginning and the
end of the value, enclosing the entire value.



34

Chapter 3

Text Wizard: Step 4 (Fixed-Width Files)

Figure 3-18
Text Wizard: Step 4 (for fixed-width files)

Text Import Wizard - Fixed Width Step 4 of 6

Specify where each variable begins. The first column is column 0.

To IMSERT & variable break line, click st the desired position in the ruler or data area. Aternatively,
move to the position using the arrow keys or by typing the column number; then press the Insert
Break button.

To MOWE & variahle break line, drag it ta the nevy position.

To DELETE & wariahle break line, select it or type ts position. Then press the Delete key or the Delete
Break button.

1z 3.0022 |$570,000 [£270,000|3
Z1 3.00z22 |£40Z&,000 §25,300|3

31 12 |$257,400 |$144,000|1
41 3.0012 |$262,800 |§155,400|1
1] I+
Column Number: 36 [Ingert Break ] [Qelete Ereak ]

Current YWariakle VWidth: =]

This step displays the Text Wizard’s best guess on how to read the data file and alows you to
modify how the Text Wizard will read variables from the datafile. Vertical linesin the preview
window indicate where the Text Wizard currently thinks each variable beginsin thefile.

Insert, move, and delete variable break lines as necessary to separate variables. If multiple lines
are used for each case, the data will be displayed as one line for each case, with subsequent
lines appended to the end of the line.

Notes:

For computer-generated data files that produce a continuous stream of data values with no
intervening spaces or other distinguishing characteristics, it may be difficult to determine where
each variable begins. Such datafiles usually rely on a data definition file or some other written
description that specifies the line and column location for each variable.



35

Data Files

Text Wizard: Step 5

Figure 3-19
Text Wizard: Step 5

B Text Import Wizard - Step 5 of 6

Specifications for variablels) selected in the data preview:

Wariahle nathe: Ovigiiral Matte:
:

Data format:

|Numeric -

Data preview

I Job_category | Region Division Trawel Currert_sales |Pre
1 3 2 2 570000 270
2 3 2 2 402000 25
3 1 1 2 25
4 1 3 1 2 262500 13
a 1 3 2 2 1324 M0+
S — [F]

This steps controls the variable name and the data format that the Text Wizard will use to read
each variable and which variables will be included in the final datafile.

Variable name. You can overwrite the default variable names with your own variable names. If
you read variable names from the data file, the Text Wizard will automatically modify variable
names that don’t conform to variable naming rules. Select avariable in the preview window and
then enter a variable name.

Data format. Select a variable in the preview window and then select a format from the

drop-down list. Shift-click to select multiple contiguous variables or Ctrl-click to select multiple
noncontiguous variables.

The default format is determined from the data valuesin thefirst 250 rows. |If more than one format
(e.g., numeric, date, string) is encountered in the first 250 rows, the default format is set to string.

Text Wizard Formatting Options

Formatting options for reading variables with the Text Wizard include:
Do not import. Omit the selected variable(s) from the imported datafile.

Numeric. Valid values include numbers, aleading plus or minus sign, and a decimal indicator.
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String. Valid valuesinclude virtually any keyboard characters and embedded blanks. For delimited
files, you can specify the number of charactersin the value, up to a maximum of 32,767. By
default, the Text Wizard sets the number of characters to the longest string value encountered for
the selected variable(s) in the first 250 rows of the file. For fixed-width files, the number of
charactersin string values is defined by the placement of variable break linesin step 4.

Date/Time. Valid values include dates of the general format dd-mm-yyyy, mm/dd/yyyy, dd.mm.yyyy,
yyyy/mm/dd, hh:mm:ss, and a variety of other date and time formats. Months can be represented
in digits, Roman numerals, or three-letter abbreviations, or they can be fully spelled out. Select a
date format from the list.

Dollar. Valid values are numbers with an optional leading dollar sign and optional commas as
thousands separators.

Comma. Valid values include numbers that use a period as a decimal indicator and commas as
thousands separators.

Dot. Valid vaues include numbers that use a comma as a decimal indicator and periods as
thousands separators.

Note: Valuesthat contain invalid characters for the selected format will be treated as missing.
Values that contain any of the specified delimiters will be treated as multiple values.

Text Wizard: Step 6

Figure 3-20
Text Wizard: Step 6

B Text Import Wizard - Step 6 of 6

Yo have successfully defined the format of your text file.

Wiould you like to save this file format for future use?

© ves

@ o

Wiould you like to paste the syntax?

@ ves [ cache data locally
@ o

Press the Finish button to complete the text impaort wizard.

Data preview
[} Job_categary | Region Division Trawel currert_sales | Pre
1 3 2 2 570000 270~
2 3 2 2 402000 253
3 1 1 2 257
4 1 3 1 2 262500 158
a3 1 3 2 2 1324 210
5] 1 3 2 2 321000 135
7 1 3 2 2 360000 167
g 1 3 1 2 262500 117 —
[n] 1 1 i A 2000 1= |
S — [}]

Cancel ] [ Help ]
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Thisisthefina step of the Text Wizard. You can save your specifications in afile for use when
importing similar text datafiles. You can also paste the syntax generated by the Text Wizard
into a syntax window. You can then customize and/or save the syntax for use in other sessions
or in production jobs.

Cache data locally. A data cache is a complete copy of the datafile, stored in temporary disk space.
Caching the data file can improve performance.

Reading PASW Data Collection Data

On Microsoft Windows operating systems, you can read data from PASW Data Collection
products. (Note: Thisfeature is only available with PASW Statistics installed on Microsoft
Windows operating systems.)

To read PASW Data Collection data sources, you must have the following items installed:

m .NET framework. To obtain the most recent version of the NET framework, go to
http: //mww.mi crosoft.conmv/net.

m  PASW Reports for Surveys Components. A version that is compatible with this release can
be installed from the installation media. If you are using PASW Statistics Developer, you
can download a compatible version from the Downloads tab at www.spss.com/statistics
(http: /www.spss.convstatistics/).

You can read PASW Data Collection data sources only in local analysis mode. Thisfeature is not
available in distributed analysis mode using PASW Statistics Server.

To read data from a PASW Data Collection data source:

In any open PASW Statistics window, from the menus choose:
File
Open PASW Data Collection Data

On the Connection tab of Data Link Properties, specify the metadata file, the case data type,
and the case data file.

» Click OK.

» Inthe PASW Data Collection Data lmport dialog box, select the variables that you want to include

>

and select any case selection criteria.

Click OK to read the data

Data Link Properties Connection Tab

To read a PASW Data Collection data source, you need to specify:

Metadata Location. The metadata document file (.mdd) that contains questionnaire definition
information.

Case Data Type. The format of the case datafile. Available formatsinclude:
m  Quancept Data File (DRS). Case datain a Quancept .drs, .drz, or .dru file.


http://www.microsoft.com/net
http://www.spss.com/statistics/
http://www.spss.com/statistics/
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Quanvert Database. Case datain a Quanvert database.

PASW Data Collection Database (MS SQL Server). Case datain arelational database in
SQL Server.

PASW Data Collection XML DataFile. Case datain an XML file.

Case Data Location. The file that contains the case data. The format of this file must be consistent
with the selected case data type.

Note: The extent to which other settings on the Connection tab or any settings on the other Data
Link Properties tabs may or may not affect reading PASW Data Collection data into PASW
Statistics is not known, so we recommend that you do not change any of them.

Select Variables Tab

You can select a subset of variablesto read. By default, all standard variables in the data source
are displayed and selected.

Show System variables. Displays any “system” variables, including variables that indicate
interview status (in progress, completed, finish date, and so on). You can then select any
system variables that you want to include. By default, al system variables are excluded.

Show Codes variables. Displays any variables that represent codes that are used for open-ended
“Other” responses for categorical variables. You can then select any Codes variables that you
want to include. By default, all Codes variables are excluded.

Show SourceFile variables. Displays any variables that contain filenames of images of scanned
responses. You can then select any SourceFile variables that you want to include. By defaullt,
al SourceFile variables are excluded.

Case Selection Tab

For PASW Data Collection data sources that contain system variables, you can select cases based
on anumber of system variable criteria. You do not need to include the corresponding system
variablesin thelist of variablesto read, but the necessary system variables must exist in the source
data to apply the selection criteria. If the necessary system variables do not exist in the source
data, the corresponding selection criteria are ignored.

Data collection status. You can select respondent data, test data, or both. You can also select cases
based on any combination of the following interview status parameters:

Completed successfully

Active/in progress

Timed out

Stopped by script

Stopped by respondent

Interview system shutdown

Signal (terminated by a signal statement in the script)
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Data collection finish date. You can select cases based on the data collection finish date.
m  Start Date. Cases for which data collection finished on or after the specified date are included.

m  End Date. Cases for which data collection finished before the specified date are included. This
does not include cases for which data collection finished on the end date.

m If you specify both a start date and end date, this defines a range of finish dates from the
start date to (but not including) the end date.

File Information

A datafile contains much more than raw data. It also contains any variable definition information,
including:

m Variable names

m Variable formats

m Descriptive variable and value labels

Thisinformation is stored in the dictionary portion of the data file. The Data Editor provides
one way to view the variable definition information. You can aso display complete dictionary
information for the active dataset or any other datafile.

To Display Data File Information

» From the menusin the Data Editor window choose:

File
Display Data File Information

» For the currently open data file, choose Working File.

» For other data files, choose External File, and then select the data file.

The data file information is displayed in the Viewer.

Saving Data Files

In addition to saving data files in PASW Statistics format, you can save datain awide variety of
external formats, including:

m  Excel and other spreadsheet formats
Tab-delimited and CSV text files
SAS

Stata

Database tables

To Save Modified Data Files

» Make the Data Editor the active window (click anywhere in the window to make it active).
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>

From the menus choose;
File
Save

The modified datafile is saved, overwriting the previous version of thefile.

Note: A datafile saved in Unicode mode cannot be read by versions of PASW Statistics prior to
16.0. To save a Unicode data filein aformat that can be read by earlier releases, open the file
in code page mode and re-save it. The file will be saved in the encoding based on the current
locale. Some dataloss may occur if the file contains characters not recognized by the current
locale. For information on switching between Unicode mode and code page mode, see General
Options on p. 291.

Saving Data Files in External Formats

>

>

Make the Data Editor the active window (click anywhere in the window to make it active).
From the menus choose:
File

Save As...

Select afile type from the drop-down list.

Enter a filename for the new datafile.

To write variable names to the first row of a spreadsheet or tab-delimited data file:

Click write variable names to spreadsheet in the Save Data As dialog box.

To save value labels instead of data values in Excel files:

Click Save value labels where defined instead of data values in the Save Data As dialog box.
To save value labels to a SAS syntax file (active only when a SAS file type is selected):

Click Save value labels into a .sas file in the Save Data As dialog box.

For information on exporting data to database tables, see Exporting to a Database on p. 46.

For information on exporting data for use in PASW Data Collection applications, see Exporting
to PASW Data Collection on p. 58.

Saving Data: Data File Types

You can save datain the following formats:

PASW Statistics (*.sav). PASW Statistics format.
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m Datafiles saved in PASW Statistics format cannot be read by versions of the software prior to
version 7.5. Datafiles saved in Unicode mode cannot be read by releases of PASW Statistics
prior to version 16.0 For more information, see the topic General Options in Chapter 16
onp. 291

®  When using data files with variable names longer than eight bytesin version 10.x or 11.x,
unique, eight-byte versions of variable names are used—nbut the original variable names are
preserved for usein release 12.0 or later. In releases prior to 10.0, the original long variable
names are lost if you save the datafile.

®  When using data files with string variables longer than 255 bytesin versions prior to release
13.0, those string variables are broken up into multiple 255-byte string variables.

Version 7.0 (*.sav). Version 7.0 format. Datafiles saved in version 7.0 format can be read by
version 7.0 and earlier versions but do not include defined multiple response sets or Data Entry
for Windows information.

SPSS/PC+ (*.sys). SPSS/PC+ format. If the data file contains more than 500 variables, only the
first 500 will be saved. For variables with more than one defined user-missing value, additional
user-missing values will be recoded into the first defined user-missing value. Thisformat is
available only on Windows operating systems.

PASW Statistics Portable (*.por). Portable format that can be read by other versions of PASW
Statistics and versions on other operating systems. Variable names are limited to eight bytes
and are automatically converted to unique eight-byte names if necessary. In most cases, saving
data in portable format is no longer necessary, since PASW Statistics data files should be
platform/operating system independent. You cannot save datafilesin portable file in Unicode
mode. For more information, see the topic General Optionsin Chapter 16 on p. 291.

Tab-delimited (*.dat). Text files with values separated by tabs. (Note: Tab characters embedded
in string values are preserved as tab characters in the tab-delimited file. No distinction is made
between tab characters embedded in values and tab characters that separate values.)

Comma-delimited (*.csv). Text files with values separated by commas or semicolons. If the current
PASW Statistics decimal indicator is a period, values are separated by commas. If the current
decimal indicator is a comma, values are separated by semicolons.

Fixed ASCII (*.dat). Text filein fixed format, using the default write formats for all variables. There
are no tabs or spaces between variable fields.

Excel 2007 (*.xIsx). Microsoft Excel 2007 XL SX-format workbook. The maximum number of
variablesis 16,000; any additional variables beyond the first 16,000 are dropped. If the dataset
contains more than one million cases, multiple sheets are created in the workbook.

Excel 97 through 2003 (*.xls). Microsoft Excel 97 workbook. The maximum number of variables
is 256; any additional variables beyond the first 256 are dropped. If the dataset contains more
than 65,356 cases, multiple sheets are created in the workbook.

Excel 2.1 (*.xIs). Microsoft Excel 2.1 spreadsheet file. The maximum number of variablesis 256,
and the maximum number of rowsis 16,384.

1-2-3 Release 3.0 (*.wk3). Lotus 1-2-3 spreadsheet file, release 3.0. The maximum number of
variables that you can save is 256.
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1-2-3 Release 2.0 (*.wk1). Lotus 1-2-3 spreadsheet file, release 2.0. The maximum number of
variables that you can save is 256.

1-2-3 Release 1.0 (*.wks). Lotus 1-2-3 spreadsheet file, release 1A. The maximum number of
variables that you can save is 256.

SYLK (*.slk). Symbolic link format for Microsoft Excel and Multiplan spreadsheet files. The
maximum number of variables that you can save is 256.

dBASE IV (*.dbf). dBASE IV format.

dBASE Il (*.dbf). dBASE Il format.

dBASE Il (*.dbf). dBASE Il format.

SAS v9+ Windows (*.sas7bdat). SAS versions 9 for Windows.

SAS v9+ UNIX (*.sas7hdat). SAS versions 9 for UNIX.

SAS v7-8 Windows short extension (*.sd7). SAS versions 7-8 for Windows short filename format.

SAS v7-8 Windows long extension (*.sas7bdat). SAS versions 7-8 for Windows long filename
format.

SAS v7-8 for UNIX (*.sas7bdat). SAS v8 for UNIX.

SAS v6 for Windows (*.sd2). SAS v6 file format for Windows/OS2.

SAS v6 for UNIX (*.ssd01). SAS V6 file format for UNIX (Sun, HBE, IBM).
SAS v6 for Alpha/OSF (*.ssd04). SAS v6 file format for Alpha/OSF (DEC UNIX).
SAS Transport (*.xpt). SAS transport file.

Stata Version 8 Intercooled (*.dta).

Stata Version 8 SE (*.dta).

Stata Version 7 Intercooled (*.dta).

Stata Version 7 SE (*.dta).

Stata Version 6 (*.dta).

Stata Versions 4-5 (*.dta).

Saving File Options

For spreadsheet, tab-delimited files, and comma-delimited files, you can write variable names
to the first row of thefile.

Saving Data Files in Excel Format

You can save your datain one of three Microsoft Excdl file formats. Excel 2.1, Excel 97, and
Excel 2007.

m  Excel 2.1 and Excel 97 arelimited to 256 columns; so only the first 256 variables are included.
m  Excel 2007 islimited to 16,000 columns; so only the first 16,000 variables are included.
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Excel 2.1 islimited to 16,384 rows; so only the first 16,384 cases are included.

Excel 97 and Excel 2007 aso have limits on the number of rows per sheet, but workbooks can
have multiple sheets, and multiple sheets are created if the single-sheet maximum is exceeded.

Variable Types

The following table shows the variable type matching between the original datain PASW
Statistics and the exported data in Excel.

PASW Statistics Variable Type Excel Data Format
Numeric 0.00; ###0.00; ...
Comma 0.00; #,##0.00; ...
Dollar $##40 ); ...

Date d-mmm-yyyy

Time hh:mm:ss

String Generd

Saving Data Files in SAS Format

Specia handling is given to various aspects of your data when saved as a SASfile. These cases
include:

Certain characters that are allowed in PASW Statistics variable names are not valid in SAS,
suchas @, #, and $. Theseillegal characters are replaced with an underscore when the data
are exported.

PASW Statistics variable names that contain multibyte characters (for example, Japanese or
Chinese characters) are converted to variables names of the general form Vnnn, where nnn
is an integer value.

PASW Statistics variable labels containing more than 40 characters are truncated when
exported to a SAS v6 file.

Where they exist, PASW Statistics variable labels are mapped to the SAS variable labels. If
no variable label exists in the PASW Statistics data, the variable name is mapped to the
SAS variable label.

SAS alows only one value for system-missing, whereas PASW Statistics allows numerous
user-missing values in addition to system-missing. Asaresult, al user-missing valuesin
PASW Statistics are mapped to asingle system-missing value in the SASfile.

SAS 6-8 datafiles are saved in the current PASW Statistics locale encoding, regardless of
current mode (Unicode or code page). In Unicode mode, SAS 9 files are saved in UTF-8
format. In code page mode, SAS 9 files are saved in the current locale encoding.

A maximum of 32,767 variables can be saved to SAS 6-8.

Save Value Labels

You have the option of saving the values and value |abels associated with your datafileto a SAS
syntax file. This syntax file containsproc format andproc datasets commands that can be
run in SASto create a SAS format catalog file.
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This feature is not supported for the SAS transport file.

Variable Types

The following table shows the variable type matching between the original datain PASW
Statistics and the exported datain SAS.

PASW Statistics Variable Type SAS Variable Type SAS Data Format

Numeric Numeric 12

Comma Numeric 12

Dot Numeric 12

Scientific Notation Numeric 12

Date Numeric (Date) for example,
MMDDYY10, ...

Date (Time) Numeric Timel8

Dollar Numeric 12

Custom Currency Numeric 12

String Character $8

Saving Data Files in Stata Format

Data can be written in Stata 5-8 format and in both Intercooled and SE format (versions
7 and 8 only).

Datafiles that are saved in Stata 5 format can be read by Stata 4.
The first 80 bytes of variable |abels are saved as Stata variable labels.

For numeric variables, the first 80 bytes of value labels are saved as Stata value labels. Value
labels are dropped for string variables, non-integer numeric values, and numeric values
greater than an absolute value of 2,147,483,647.

For versions 7 and 8, the first 32 bytes of variable names in case-sensitive form are saved as
Stata variable names. For earlier versions, the first eight bytes of variable names are saved
as Stata variable names. Any characters other than letters, numbers, and underscores are
converted to underscores.

PASW Statistics variable names that contain multibyte characters (for example, Japanese or
Chinese characters) are converted to variable names of the general form Vnnn, where nnn
is an integer value.

For versions 5-6 and Intercooled versions 7-8, the first 80 bytes of string values are saved.
For Stata SE 7-8, the first 244 bytes of string values are saved.

For versions 5-6 and Intercooled versions 7-8, only the first 2,047 variables are saved. For
Stata SE 7-8, only the first 32,767 variables are saved.

PASW Statistics Stata Variable Type Stata Data For mat
Variable Type

Numeric Numeric
Comma Numeric
Dot Numeric
Scientific Notation Numeric

Q Q Q «Q
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PASW Statistics
Variable Type

Date*, Datetime
Time, DTime
Wkday

Month

Dollar

Custom Currency
String

Data Files

Stata Variable Type Stata Data For mat

Numeric
Numeric
Numeric
Numeric
Numeric
Numeric
String

D myY

g (number of seconds)
9 (1-7)

9(1-12)

g

g
s

*Date, Adate, Edate, SDate, Jdate, Qyr, Moyr, Wkyr

Saving Subsets of Variables

Figure 3-21

Save Data As Variables dialog box

ﬁ Save Data As: Yariables

Only selected variables will be saved to specifisd data file.

Heep | Hame

Lakel Circler

age
marital
address
incame
inccat
car
carcat
ed
employ
retire

LAy

Agein years 1
Iarital status 2
Yearsatc.. 3]
Houzehald ... 4
Income cat... 5
Price of pri... 51
Primary we... 7
Level of ed... g
Years with... 9
Retired 10

.

4]

Selected: 29 of 29 variables.

[Continue][ Cancel ][ Help ]

The Save Data As Variables dialog box allows you to select the variables that you want saved in
the new datafile. By default, all variables will be saved. Deselect the variables that you don't
want to save, or click Drop All and then select the variables that you want to save.

Visible Only. Selects only variablesin variable sets currently in use. For more information, see the
topic Using Variable Sets to Show and Hide Variablesin Chapter 15 on p. 282.

To Save a Subset of Variables

» Make the Data Editor the active window (click anywhere in the window to make it active).

» From the menus choose;

File
Save As...

» Click Variables.
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>

Select the variables that you want to save.

Exporting to a Database

You can use the Export to Database Wizard to:

m  Replace valuesin existing database table fields (columns) or add new fieldsto atable.
m  Append new records (rows) to a database table.

m  Completely replace a database table or create a new table.

To export data to a database:

From the menus in the Data Editor window for the dataset that contains the data you want to
export, choose:
File

Export to Database

Select the database source.

Follow the instructions in the export wizard to export the data.

Creating Database Fields from PASW Statistics Variables

When creating new fields (adding fields to an existing database table, creating a new table,
replacing atable), you can specify field names, datatype, and width (where applicable).

Field name. The default field names are the same as the PASW Statistics variable names. You
can change the field names to any names allowed by the database format. For example, many
databases alow charactersin field names that aren’t allowed in variable names, including spaces.
Therefore, avariable name like CallWaiting could be changed to the field name Call Waiting.

Type. The export wizard makes initial data type assignments based on the standard ODBC data
types or data types allowed by the selected database format that most closely matches the defined
PASW Statistics data format—but databases can make type distinctions that have no direct
equivaent in PASW Statistics, and vice versa. For example, most numeric valuesin PASW
Statistics are stored as double-precision floating-point values, whereas database numeric data
types include float (double), integer, real, and so on. In addition, many databases don’t have
equivalents to PASW Statistics time formats. You can change the data type to any type available
in the drop-down list.

Asagenerd rule, the basic data type (string or numeric) for the variable should match the basic
data type of the database field. If there is a data type mismatch that cannot be resolved by the
database, an error results and no data are exported to the database. For example, if you export a
string variable to a database field with a numeric datatype, an error will result if any values of the
string variable contain non-numeric characters.

Width. You can change the defined width for string (char, varchar) field types. Numeric field
widths are defined by the data type.
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By default, PASW Statistics variable formats are mapped to database field types based on the
following general scheme. Actual database field types may vary, depending on the database.

PASW Statistics Variable Format
Numeric

Comma

Dot

Scientific Notation
Date

Datetime

Time, DTime
Wkday

Month

Dollar

Custom Currency
String

User-Missing Values

Database Field Type

Float or Double

Float or Double

Float or Double

Float or Double

Date or Datetime or Timestamp
Datetime or Timestamp

Float or Double (number of seconds)
Integer (1-7)

Integer (1-12)

Float or Double

Float or Double

Char or Varchar

There are two options for the treatment of user-missing values when data from variables are

exported to database fields:

m  Export as valid values. User-missing values are treated as regular, valid, nonmissing values.

®  Export numeric user-missing as nulls and export string user-missing values as blank spaces.
Numeric user-missing values are treated the same as system-missing values. String
user-missing values are converted to blank spaces (strings cannot be system-missing).

Selecting a Data Source

In the first panel of the Export to Database Wizard, you select the data source to which you

want to export data.
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Figure 3-22
Export to Database Wizard, selecting a data source

E Export to Database Wizard

Welcome to the Export to Database Wizard!

The Export to Database Wizard helps you export data from the active PASW Statistics dataset to a database. To start, select
a dats source.

CDEC Data Sources

28 CBASE Files

Qﬁ Excel Files

% MS Access Database

Add ODEC Data Source..

|Ne>d = I Cancel Help

You can export data to any database source for which you have the appropriate ODBC driver.
(Note: Exporting datato OLE DB data sources is not supported.)

If you do not have any ODBC data sources configured, or if you want to add a new data source,
click Add ODBC Data Source.

m  OnLinux operating systems, this button is not available. ODBC data sources are specified in
odbc.ini, and the ODBCINI environment variables must be set to the location of that file. For
more information, see the documentation for your database drivers.

m Indistributed analysis mode (available with PASW Statistics Server), this button is not
available. To add data sources in distributed analysis mode, see your system administrator.

An ODBC data source consists of two essential pieces of information: the driver that will be
used to access the data and the location of the database you want to access. To specify data
sources, you must have the appropriate driversinstalled. Drivers for avariety of database formats
are available at http://www.spss.convdrivers.

Some data sources may require alogin ID and password before you can proceed to the next step.

Choosing How to Export the Data

After you select the data source, you indicate the manner in which you want to export the data.


http://www.spss.com/drivers
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Figure 3-23
Export to Database Wizard, choosing how to export

ﬁ Export to Database Wizard

Choose how to export the data
Connected to Database: Zpubsispesidatajobsidm_demo.mdb

Export Methods

+ ® Replace values in existing fields

ﬂ To uze this option, you may need to know which variables are the primary keys

[&] Add new fields to an existing table

-% To use this option, you may need to know which varishles are the primary keys.

(o] Append new records to an existing table

_’E @ Drop an existing table and creste a new table of the same name
@ Creste a new table
===l

[< Eack“fNe)d =i [Cancal][ Help ]

The following choices are available for exporting data to a database:

m  Replace values in existing fields. Replaces values of selected fields in an existing table with
values from the selected variables in the active dataset. For more information, see the topic
Replacing Values in Existing Fields on p. 52.

m  Add new fields to an existing table. Creates new fields in an existing table that contain the
values of selected variables in the active dataset. For more information, see the topic Adding
New Fieldson p. 53. Thisoption is not available for Excel files.

m  Append new records to an existing table. Adds new records (rows) to an existing table
containing the values from cases in the active dataset. For more information, see the topic
Appending New Records (Cases) on p. 54.

m  Drop an existing table and create a new table of the same name. Deletes the specified table
and creates a new table of the same name that contains selected variables from the active
dataset. All information from the original table, including definitions of field properties (for
example, primary keys, data types) islost. For more information, see the topic Creating a
New Table or Replacing a Table on p. 56.

m Create a new table. Creates anew table in the database containing data from selected variables
in the active dataset. The name can be any value that is alowed as a table name by the data
source. The name cannot duplicate the name of an existing table or view in the database. For
more information, see the topic Creating a New Table or Replacing a Table on p. 56.
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Selecting a Table

When modifying or replacing atable in the database, you need to select the table to modify or

replace. This panel in the Export to Database Wizard displays alist of tables and viewsin the
selected database.

Figure 3-24
Export to Database Wizard, selecting a table or view

ﬁ Export to Database Wizard

Select a table or view %"
Connected to Database: Zpubsispesidatajobsidm_demo.mdb

Table= and Yiews:

ComhinedZubset
ComhinedTakle
Demographicinformation
SurveyResponses
SurveySubset

walug Labels

Show: I_oz Tahles I__ Views I:[ Synonyms I__ System tables

[< Eack“fNe)d =i [Cancal][ Help ]

By default, the list displays only standard database tables. You can control the type of items
that are displayed in the list:

m Tables. Standard database tables.

m Views. Views are virtua or dynamic “tables’ defined by queries. These can include joins of
multiple tables and/or fields derived from cal culations based on the values of other fields. You
can append records or replace values of existing fieldsin views, but the fields that you can
modify may be restricted, depending on how the view is structured. For example, you cannot
modify aderived field, add fields to aview, or replace a view.

m  Synonyms. A synonym isan alias for atable or view, typically defined in a query.

m  System tables. System tables define database properties. In some cases, standard database
tables may be classified as system tables and will be displayed only if you select this option.
Access to real system tablesis often restricted to database administrators.

Selecting Cases to Export

Case selection in the Export to Database Wizard is limited either to all cases or to cases selected
using a previously defined filter condition. If no casefiltering isin effect, this panel will not
appear, and all cases in the active dataset will be exported.
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Figure 3-25
Export to Database Wizard, selecting cases to export
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For information on defining afilter condition for case selection, see Select Cases on p. 182.

Matching Cases to Records

When adding fields (columns) to an existing table or replacing the values of existing fields,
you need to make sure that each case (row) in the active dataset is correctly matched to the
corresponding record in the database.

m Inthedatabase, the field or set of fields that uniquely identifies each record is often designated
asthe primary key.

m  You need to identify which variable(s) correspond to the primary key field(s) or other fields
that uniquely identify each record.

m Thefields don't have to be the primary key in the database, but the field value or combination
of field values must be unique for each case.
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To match variables with fields in the database that uniquely identify each record:

» Drag and drop the variable(s) onto the corresponding database fields.

or

» Select avariable from the list of variables, select the corresponding field in the database table, and
click Connect.

To delete a connection line:

» Select the connection line and press the Delete key.

Figure 3-26
Export to Database Wizard, matching cases to records

B Export to Database Wizard

Match cases to records ¥

eSS4

which variables and figlds should be used to match cases inthe dataset with records in the table or view? Only the records
that match will be changed.

To indicste that & variable in the dataset corresponds to a field in the table or view, select the variable and the field and then
click the Connect button. & ling will ke drawn to connect the variable to the fisld. Aternatively, you may drag the variable to the
Tl ancl drogp it

To remove a line, select it and press the Delste key.
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g@ SurveyDate (Cotments warchar [
&4 Comments
e& Wireless Recoded [Recod...
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Note: The variable names and database field names may not be identical (since database field
names may contain characters not alowed in PASW Statistics variable names), but if the active
dataset was created from the database table you are modifying, either the variable names or the
variable labels will usually be at least similar to the database field names.

Replacing Values in Existing Fields

To replace values of existing fields in a database:

» Inthe Choose how to export the data panel of the Export to Database Wizard, select Replace
values in existing fields.

» Inthe Select a table or view panel, select the database table.
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» Inthe Match cases to records panel, match the variables that uniquely identify each case to the
corresponding database field names.

» For each field for which you want to replace values, drag and drop the variable that contains the
new values into the Source of values column, next to the corresponding database field name.
Figure 3-27
Export to Database Wizard, replacing values of existing fields
H Export to Database Wizard

Select variables to store in existing fields %"
To replace the valuss in table fisld with the values of a dataset variable, place the variable inthe cell next to the figld name. Use
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m  Asagenera rule, the basic data type (string or numeric) for the variable should match the
basic data type of the database field. If there is a data type mismatch that cannot be resolved
by the database, an error results and no data is exported to the database. For example, if you
export a string variable to a database field with a numeric data type (for example, double,
real, integer), an error will result if any values of the string variable contain non-numeric
characters. The letter a in the icon next to a variable denotes a string variable.

® You cannot modify the field name, type, or width. The original database field attributes are
preserved; only the values are replaced.

Adding New Fields

To add new fields to an existing database table:

» Inthe Choose how to export the data panel of the Export to Database Wizard, select Add new
fields to an existing table.

» In the Select a table or view panel, select the database table.

» Inthe Match cases to records panel, match the variables that uniquely identify each case to the
corresponding database field names.
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» Drag and drop the variables that you want to add as new fields to the Source of values column.

Figure 3-28
Export to Database Wizard, adding new fields to an existing table
B Export to Database Wizard
Select variables to store in new fields v
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For information on field names and data types, see the section on creating database fields from
PASW Statistics variables in Exporting to a Database on p. 46.

Show existing fields. Select this option to display alist of existing fields. You cannot use this panel
in the Export to Database Wizard to replace existing fields, but it may be helpful to know what
fields are already present in the table. If you want to replace the values of existing fields, see
Replacing Values in Existing Fields on p. 52.

Appending New Records (Cases)

To append new records (cases) to a database table:

In the Choose how to export the data panel of the Export to Database Wizard, select Append new
records to an existing table.

In the Select a table or view panel, select the database table.

Match variables in the active dataset to table fields by dragging and dropping variables to the
Source of values column.
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Figure 3-29
Export to Database Wizard, adding records (cases) to a table
ﬁ Export to Database Wizard
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The Export to Database Wizard will automatically select al variables that match existing fields,
based on information about the original database table stored in the active dataset (if available)
and/or variable names that are the same as field names. Thisinitial automatic matching isintended
only as a guide and does not prevent you from changing the way in which variables are matched

with database fields.

When adding new records to an existing table, the following basic rules/limitations apply:

m  All cases (or all selected cases) in the active dataset are added to the table. If any of these
cases duplicate existing records in the database, an error may result if a duplicate key value
is encountered. For information on exporting only selected cases, see Selecting Cases to

Export on p. 50.

m  You can usethe values of new variables created in the session as the values for existing fields,
but you cannot add new fields or change the names of existing fields. To add new fieldsto a
database table, see Adding New Fields on p. 53.

m  Any excluded database fields or fields not matched to a variable will have no values for the
added records in the database table. (If the Source of values cell is empty, thereis no variable
matched to the field.)
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Creating a New Table or Replacing a Table

To create a new database table or replace an existing database table:

In the Choose how to export the data panel of the export wizard, select Drop an existing table and
create a new table of the same name or select Create a new table and enter a name for the new table.

If you are replacing an existing table, in the Select a table or view panel, select the database table.
Drag and drop variables into the Variables to save column.

Optionally, you can designate variables/fields that define the primary key, change field names,
and change the data type.

Figure 3-30
Export to Database Wizard, selecting variables for a new table
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Primary key. To designate variables as the primary key in the database table, select the box in the
column identified with the key icon.

m  All values of the primary key must be unique or an error will result.

m If you select asingle variable as the primary key, every record (case) must have a unique
value for that variable.

m If you select multiple variables as the primary key, this defines a composite primary key, and
the combination of values for the selected variables must be unique for each case.

For information on field names and data types, see the section on creating database fields from
PASW Statistics variables in Exporting to a Database on p. 46.
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Completing the Database Export Wizard

The last panel of the Export to Database Wizard provides a summary that indicates what data will
be exported and how it will be exported. It also gives you the option of either exporting the data or
pasting the underlying command syntax to a syntax window.

Figure 3-31
Export to Database Wizard, finish panel

Export to Database Wizard
Finish ~EEEE
‘our specifications are summarized below, You are ready ko export the data or paste the syntax,
Surnmary
Dataset: [SurveyResponses]
Table: UpdateTable
Cases o Export: Filtered
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‘what would you like to do?
(&) Export the data
() Paste the syntax
[ Finish |[ Cancel ][ Help
Summary Information
|

Dataset. The PASW Statistics session name for the dataset that will be used to export

data. Thisinformation is primarily useful if you have multiple open data sources. Data
sources opened using the graphical user interface (for example, the Database Wizard) are
automatically assigned names such as DataSet1, DataSet2, etc. A data source opened using
command syntax will have a dataset name only if oneis explicitly assigned.

Table. The name of the table to be modified or created.

Cases to Export. Either al cases are exported or cases selected by a previously defined filter
condition are exported. For moreinformation, seethetopic Selecting Casesto Export on p. 50.

Action. Indicates how the database will be modified (for example, create a new table, add
fields or records to an existing table).

User-Missing Values. User-missing values can be exported as valid values or treated the same
as system-missing for numeric variables and converted to blank spaces for string variables.
This setting is controlled in the panel in which you select the variables to export.
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Exporting to PASW Data Collection

The Export to PASW Data Collection dialog box creates PASW Statistics data files and PASW
Data Collection metadata files that you can use to read the data into PASW Data Collection
applications. Thisis particularly useful when “roundtripping” data between PASW Statistics and
PASW Data Collection applications.

To export data for use in PASW Data Collection applications:

» From the menusin the Data Editor window that contains the data you want to export, choose:
File
Export to PASW Data Collection

» Click Data File to specify the name and location of the PASW Statistics datafile.

» Click Metadata File to specify the name and location of the PASW Data Collection metadata file.

For new variables and datasets not created from PASW Data Collection data sources, PASW
Statistics variable attributes are mapped to PASW Data Collection metadata attributes in the
metadata file according to the methods described in the SAV DSC documentation in the Data
Collection Developer Library.

If the active dataset was created from a PASW Data Collection data source;

m  The new metadatafile is created by merging the origina metadata attributes with metadata
attributes for any new variables, plus any changesto original variables that might affect their
metadata attributes (for example, addition of, or changes to, value labels).

m  For origina variables read from the PASW Data Collection data source, any metadata
attributes not recognized by PASW Statistics are preserved in their origina state. For
example, PASW Statistics converts grid variablesto regular PASW Statistics variables, but the
metadata that defines these grid variables is preserved when you save the new metadatafile.

m If any PASW Data Collection variables were automatically renamed to conform to PASW
Statistics variable naming rules, the metadata file maps the converted names back to the
original PASW Data Collection variable names.

The presence or absence of value labels can affect the metadata attributes of variables and
consequently the way those variables are read by PASW Data Collection applications. If value
labels have been defined for any nonmissing values of avariable, they should be defined for all
nonmissing values of that variable; otherwise, the unlabeled values will be dropped when the
datafileis read by PASW Data Collection.

Protecting Original Data

To prevent the accidental modification or deletion of your original data, you can mark the file as
read-only.

» From the Data Editor menus choose:
File
Mark File Read Only
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If you make subsequent modifications to the data and then try to save the datafile, you can save
the data only with a different filename, so the original data are not affected.

You can change the file permissions back to read-write by choosing Mark File Read Write

from the File menu.

Virtual Active File

The virtual active file enables you to work with large data files without requiring equally large (or
larger) amounts of temporary disk space. For most analysis and charting procedures, the origina
data source is reread each time you run a different procedure. Procedures that modify the data
require a certain amount of temporary disk space to keep track of the changes, and some actions
always require enough disk space for at least one entire copy of the datafile.

Figure 3-32
Temporary disk space requirements
COMPUTE v6 = ...
RECODE v4... SORT CASES BY...
Action GET FILE = 'vi-5.sav". REGRESSION... or
FREQUENCIES... /SAVE ZPRED. CACHE
vi|v2 | v3 ] vd|vs vi | v2 | v3 ]| vd | v5 ] v6 |zpre vi | v2 | v3 | vd | v5 ] v6 |zpre
11]12]13) 14 15 111213 14]15)16] 1 11 ) 1213141516 1
Virtual 21 22| 23]24] 25 21 )22 23] 24| 25]26] 2 2122|2324 25]26] 2
Active 31 [32|33]34]35 31 [32|33]34]35]36] 3 31[32|33[34]35]36] 3
File 41| 42| 43| 44 | 45 41| 42| 43| 44| 45 46| 4 41 | 42| 43| 44| 45] 46| 4
51| 52| 53] 54|55 51| 52|53]54]|55]56]5 51 |52|53[54]55]56]5
61|62 63| 64|65 61|62 |63]|64]|65]|66] 6 61|62 |63[64]65]|66] 6
Data v4  v6 |zpre vi | v2 | v3 | v4 | v5 | v6 |zpre
Stored 14| 16 | 1 111213 | 14| 15| 16| 1
in 24 | 26 | 2 21 22| 23|24 |25]| 26| 2
Temporary None 34| 36| 3 31 (32|33[34|35]|36]| 3
Disk 44 | 46 | 4 41 |42 | 43 [ 44 | 45| 46| 4
Space 54 | 56| 5 51 |52|53[54|55]|56]|5
64 | 66 | 6 61|62 |63[64/65)|66| 6

A

A
|
|

ctions that don’t require any temporary disk space include:
Reading PASW Statistics data files
Merging two or more PASW Statistics data files
Reading database tables with the Database Wizard
Merging PASW Statistics data files with database tables
Running procedures that read data (for example, Frequencies, Crosstabs, Explore)

ctions that create one or more columns of data in temporary disk space include:
Computing new variables
Recoding existing variables

Running procedures that create or modify variables (for example, saving predicted valuesin
Linear Regression)
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Actions that create an entire copy of the data file in temporary disk space include:
m  Reading Excel files

Running procedures that sort data (for example, Sort Cases, Split File)
Reading data with GET TRANSLATE Or DATA LIST commands

Using the Cache Data facility or the cacHE command

Launching other applications from PASW Statistics that read the datafile (for example,
AnswerTree, DecisionTime)

Note: The GET paTa command provides functionality comparable to baTa LIsT without
creating an entire copy of the datafile in temporary disk space. The spLIT FILE command in
command syntax does not sort the data file and therefore does not create a copy of the datafile.
This command, however, requires sorted data for proper operation, and the dialog box interface
for this procedure will automatically sort the datafile, resulting in a complete copy of the datafile.
(Command syntax is not available with the Student Version.)

Actions that create an entire copy of the data file by default:

m  Reading databases with the Database Wizard

m  Reading text files with the Text Wizard

The Text Wizard provides an optional setting to automatically cache the data. By default, this

option is selected. You can turn it off by deselecting Cache data locally. For the Database Wizard,
you can paste the generated command syntax and del ete the cacHE command.

Creating a Data Cache

Although the virtual active file can vastly reduce the amount of temporary disk space required, the
absence of atemporary copy of the“active” file meansthat the origina data source hasto be reread
for each procedure. For large datafiles read from an external source, creating atemporary copy of
the data may improve performance. For example, for data tables read from a database source, the
SQL query that reads the information from the database must be reexecuted for any command or
procedure that needsto read the data. Sincevirtualy all statistical analysis procedures and charting
procedures need to read the data, the SQL query is reexecuted for each procedure you run, which
can result in asignificant increase in processing time if you run alarge number of procedures.

If you have sufficient disk space on the computer performing the analysis (either your local
computer or a remote server), you can eiminate multiple SQL queries and improve processing
time by creating a data cache of the active file. The data cache is atemporary copy of the
complete data.

Note: By default, the Database Wizard automatically creates a data cache, but if you use the GET
paTa command in command syntax to read a database, a data cache is not automatically created.
(Command syntax is not available with the Student Version.)
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To Create a Data Cache

» From the menus choose;
File
Cache Data...

» Click OK or Cache Now.

OK creates a data cache the next time the program reads the data (for example, the next time you
run a statistical procedure), which is usually what you want because it doesn’t require an extra
data pass. Cache Now creates a data cache immediately, which shouldn’t be necessary under most
circumstances. Cache Now is useful primarily for two reasons:

m A datasourceis“locked” and can’t be updated by anyone until you end your session, open
adifferent data source, or cache the data.

m  For large data sources, scrolling through the contents of the Data View tab in the Data Editor
will be much faster if you cache the data.

To Cache Data Automatically

You can use the seT command to automatically create a data cache after a specified number of
changes in the active data file. By default, the active datafile is automatically cached after 20
changes in the active data file.

» From the menus choose;
File
New
Syntax

» In the syntax window, type SET CACHE n (where n represents the number of changesin the
active datafile before the datafile is cached).

» From the menus in the syntax window choose;

Run
All

Note: The cache setting is not persistent across sessions. Each time you start a new session, the
value is reset to the default of 20.
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Distributed analysis mode allows you to use a computer other than your local (or desktop)
computer for memory-intensive work. Because remote servers that are used for distributed
analysis are typically more powerful and faster than your local computer, distributed analysis
mode can significantly reduce computer processing time. Distributed analysis with aremote
server can be useful if your work involves:

m Large datafiles, particularly data read from database sources.

®  Memory-intensive tasks. Any task that takes along timein local anaysis mode may be
a good candidate for distributed analysis.

Distributed analysis affects only data-related tasks, such as reading data, transforming data,
computing new variables, and calculating statistics. Distributed analysis has no effect on tasks
related to editing output, such as manipulating pivot tables or modifying charts.

Note: Distributed analysisis available only if you have both a local version and access to a
licensed server version of the software that isinstalled on a remote server.

Server Login

The Server Login dialog box allows you to select the computer that processes commands and runs
procedures. You can select your local computer or a remote server.

Figure 4-1
Server Login dialog box
Bl server Login: Local Computer
Detautt |Server Mame |Descripti0n Part |
J' Local Computer Add...
T MetworkServer Metwark Server 3018

Search...

Checkmark indicates start-up connection

(conca)  (oee)
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You can add, modify, or delete remote serversin the list. Remote servers usualy require a user
ID and password, and a domain name may also be necessary. Contact your system administrator
for information about available servers, a user ID and password, domain names, and other
connection information.

You can select a default server and save the user ID, domain name, and password that are
associated with any server. You are automatically connected to the default server when you
start a new session.

If you are licensed to use the Statistics Adapter and your site is running PASW Collaboration
and Deployment Services 3.5 or later, you can click Search... to view alist of serversthat are
available on your network. If you are not logged on to arepository, you will be prompted to enter
connection information before you can view the list of servers.

Adding and Editing Server Login Settings

Use the Server Login Settings dialog box to add or edit connection information for remote servers
for use in distributed analysis mode.

Figure 4-2
Server Login Settings dialog box

Bl Server Login Settings

Server Marme: |Netw0rkServer |

Port Number: (3018 |

Description: |Network Server |

Advanced Connection Settings

(concet]  (n)

Contact your system administrator for alist of available servers, port numbers for the servers, and
additional connection information. Do not use the Secure Socket Layer unless instructed to do
so by your administrator.

Server Name. A server “name” can be an aphanumeric name that is assigned to a computer (for
example, NetworkServer) or a unique | P address that is assigned to a computer (for example,
202.123.456.78).

Port Number. The port number is the port that the server software uses for communications.
Description. You can enter an optional description to display in the serverslist.

Connect with Secure Socket Layer. Secure Socket Layer (SSL) encrypts requests for distributed
analysis when they are sent to the remote server. Before you use SSL, check with your
administrator. For this option to be enabled, SSL must be configured on your desktop computer
and the server.
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To Select, Switch, or Add Servers

>

From the menus choose;

File
Switch Server...

To select a default server:

In the server list, select the box next to the server that you want to use.

Enter the user 1D, domain name, and password that were provided by your administrator.
Note: You are automatically connected to the default server when you start a new session.
To switch to another server:

Select the server from the list.

Enter your user ID, domain name, and password (if necessary).

Note: When you switch servers during a session, al open windows are closed. You will be
prompted to save changes before the windows are closed.

To add a server:
Get the server connection information from your administrator.
Click Add to open the Server Login Settings dialog box.

Enter the connection information and optional settings, and then click OK.

To edit a server:

Get the revised connection information from your administrator.
Click Edit to open the Server Login Settings dialog box.

Enter the changes and click OK.

To search for available servers:

Note: The ability to search for available serversis available only if you are licensed to use the
Statistics Adapter and your site is running PASW Collaboration and Deployment Services 3.5 or
later.

Click Search... to open the Search for Servers dialog box. If you are not logged on to arepository,
you will be prompted for connection information.

Select one or more available servers and click OK. The servers will now appear in the Server
Login dialog box.

To connect to one of the servers, follow the instructions “ To switch to another server.”
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Searching for Available Servers

Use the Search for Servers dialog box to select one or more servers that are available on your
network. This dialog box appears when you click Search... on the Server Login dialog box.

Figure 4-3
Search for Servers dialog box

< Search for Servers
Server Name | Description Port
10.11 .40.216 Server on Linux 3333
10.11.10.201 Server on Solaris 3353
10.10.72.68 Server on windows 32 bit 3016
10.11.10.42 Server an HP-LX 3333

| Cancel | | Help |

Select one or more servers and click OK to add them to the Server Login dialog box. Although
you can manually add serversin the Server Login dialog box, searching for available servers
lets you connect to servers without requiring that you know the correct server name and port
number. Thisinformation is automatically provided. However, you still need the correct logon
information, such as user name, domain, and password.

Opening Data Files from a Remote Server

In distributed analysis mode, the Open Remote File dialog box replaces the standard Open File
dialog box.

m  The contents of the list of available files, folders, and drives depends on what is available on
or from the remote server. The current server nameisindicated at the top of the dialog box.

m Indistributed analysis mode, you will not have access to files on your local computer unless
you specify the drive as a shared device or specify the folders containing your datafiles as
shared folders. Consult the documentation for your operating system for information on how
to “share” folders on your local computer with the server network.

m If the server isrunning a different operating system (for example, you are running Windows
and the server is running UNIX), you probably won’'t have access to local datafilesin
distributed analysis mode even if they are in shared folders.

File Access in Local and Distributed Analysis Mode

The view of data folders (directories) and drives for both your local computer and the
network is based on the computer that you are currently using to process commands and run
procedures—which is not necessarily the computer in front of you.

Local analysis mode. \When you use your local computer as your “server,” the view of datafiles,
folders, and drivesin the file access dialog box (for opening datafiles) is similar to what you see
in other applications or in Windows Explorer. You can see al of the data files and folders on your
computer and any files and folders on mounted network drives.
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Distributed analysis mode. \WWhen you use another computer as a “remote server” to run commands
and procedures, the view of datafiles, folders, and drives represents the view from the remote
server computer. Although you may see familiar folder names (such as Program Files) and drives
(such as C), these items are not the folders and drives on your computer; they are the folders and
drives on the remote server.
Figure 4-4
Local and remote views
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In distributed analysis mode, you will not have access to data files on your local computer unless
you specify the drive as a shared device or specify the folders containing your datafiles as shared
folders. If the server is running a different operating system (for example, you are running
Windows and the server is running UNIX), you probably won't have access to local datafiles

in distributed analysis mode even if they are in shared folders.

Distributed analysis mode is not the same as accessing data files that reside on another
computer on your network. You can access data files on other network devicesin local analysis
mode or in distributed analysis mode. In local mode, you access other devices from your local
computer. In distributed mode, you access other network devices from the remote server.

If you're not sure if you're using local analysis mode or distributed analysis mode, ook at the
title bar in the dialog box for accessing datafiles. If the title of the dialog box contains the word
Remote (as in Open Remote File), or if the text Remote Server: [server name] appears at the top of
the dialog box, you' re using distributed analysis mode.

Note: This situation affects only dialog boxes for accessing data files (for example, Open Data,
Save Data, Open Database, and Apply Data Dictionary). For all other file types (for example,
Viewer files, syntax files, and script files), the local view is aways used.

Availability of Procedures in Distributed Analysis Mode

In distributed analysis mode, procedures are available for use only if they are installed on both
your local version and the version on the remote server.
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If you have optional components installed locally that are not available on the remote server
and you switch from your local computer to a remote server, the affected procedures will be
removed from the menus and the corresponding command syntax will result in errors. Switching
back to local mode will restore all affected procedures.

Absolute versus Relative Path Specifications

In distributed analysis mode, relative path specifications for data files and command syntax files
arerelative to the current server, not relative to your local computer. A relative path specification
such as /mydocs/mydata.sav does not point to a directory and file on your local drive; it pointsto a
directory and file on the remote server’s hard drive.

Windows UNC Path Specifications

If you are using a Windows server version, you can use universal naming convention (UNC)
specifications when accessing data and syntax files with command syntax. The genera form
of a UNC specification is:

\\servername\sharename\path\filename

m  Servername is the name of the computer that contains the datafile.

m  Sharenameis the folder (directory) on that computer that is designated as a shared folder.
m Pathisany additiona folder (subdirectory) path below the shared folder.

m  Filename is the name of the datafile.

An example is as follows:

GET FILE='\\hgdev00l\public\july\sales.sav'.

If the computer does not have a name assigned to it, you can useits IP address, asiin:
GET FILE='\\204.125.125.53\public\july\sales.sav"'.

Even with UNC path specifications, you can access data and syntax files only from devices and
folders that are designated as shared. When you use distributed analysis mode, this situation
includes data and syntax files on your local computer.

UNIX Absolute Path Specifications

For UNIX server versions, there is no equivalent to the UNC path, and all directory paths
must be absolute paths that start at the root of the server; relative paths are not allowed. For
example, if the datafileis located in /bin/data and the current directory is also /bin/data, GET
FILE='sales.sav' isnotvalid; you must specify the entire path, asin:

GET FILE='/bin/sales.sav'.
INSERT FILE='/bin/salesjob.sps'.
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The Data Editor provides a convenient, spreadsheet-like method for creating and editing datafiles.

The Data Editor window opens automatically when you start a session.

The Data Editor provides two views of your data:

m Data View. Thisview displays the actual data values or defined value labels.

m Variable View. Thisview displays variable definition information, including defined variable
and value labels, data type (for example, string, date, or numeric), measurement level

(nominal, ordinal, or scale), and user-defined missing values.

In both views, you can add, change, and delete information that is contained in the datafile.

Data View
Figure 5-1
Data View
demo.sav - Data Editor =]
Flle Edit Yiew Data Transform Analyze Graphs  Utiliies Add-ons  wWindow  Help
20 : age 40
age | marital | address | income | inccat | car a
1 55 Married 12 7200| %50 - §74 36.
2 56| Unmarried 28 153.00 55+ 76.
3 28 Married 9 28.00] $25 - §49 13.
4 24 Married 4 26.00] $25 - §49 12.
a 25| Unmarried 2 23.00| Under §25 11.
3 45 Married 9 76.00 55+ 37.
7 42 Unmarried 19 40.00| §25 - §49 19.
g 35| Unmarried 15 57.00 %50 - §74 28.
9 46| Unmarried 2B 24.00| Under §25 12.
10 34 Married 0 §9.00 55+ 46.
11 5 Married 17 72000 %50 - §74 35 ¥
4/ v \Data View /?\Jariame view /| ]< >

Many of the features of Data View are similar to the features that are found in spreadsheset
applications. There are, however, several important distinctions:

m  Rows are cases. Each row represents a case or an observation. For example, each individual
respondent to a questionnaire is a case.

m  Columns are variables. Each column represents a variable or characteristic that is being

measured. For example, each item on a questionnaire is avariable.

68
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Cells contain values. Each cell contains a single value of avariable for acase. The cell is
where the case and the variable intersect. Cells contain only data values. Unlike spreadsheet
programs, cellsin the Data Editor cannot contain formulas.

The datafile is rectangular. The dimensions of the data file are determined by the number
of cases and variables. You can enter datain any cell. If you enter datain a cell outside
the boundaries of the defined data file, the data rectangle is extended to include any rows
and/or columns between that cell and the file boundaries. There are no “empty” cells within
the boundaries of the data file. For numeric variables, blank cells are converted to the
system-missing value. For string variables, ablank is considered avalid value.

Variable View

Figure 5-2
Variable View

demo.sav - Data Editor =&
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Variable View contains descriptions of the attributes of each variable in the datafile. In Variable
View:

Rows are variables.
Columns are variable attributes.

You can add or delete variables and modify attributes of variables, including the following
attributes:

Variable name

Data type

Number of digits or characters
Number of decimal places
Descriptive variable and vaue labels
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User-defined missing values

m  Column width

Measurement level

All of these attributes are saved when you save the datafile.

In addition to defining variable properties in Variable View, there are two other methods for
defining variable properties:

m  The Copy Data Properties Wizard provides the ability to use an external PASW Statistics data

file or another dataset that is available in the current session as a template for defining file
and variable properties in the active dataset. You can also use variables in the active dataset
as templates for other variables in the active dataset. Copy Data Propertiesis available on
the Data menu in the Data Editor window.

Define Variable Properties (also available on the Data menu in the Data Editor window) scans
your data and lists al unique data values for any selected variables, identifies unlabeled
values, and provides an auto-label feature. This method is particularly useful for categorical
variables that use numeric codes to represent categories—for example, 0 = Male, 1 = Female.

To Display or Define Variable Attributes

>

>

>

>

Make the Data Editor the active window.

Double-click avariable name at the top of the column in Data View, or click the Variable View tab.

To define new variables, enter avariable name in any blank row.

Select the attribute(s) that you want to define or modify.

Variable Names

The following rules apply to variable names:

Each variable name must be unique; duplication is not allowed.

m Variable names can be up to 64 bytes long, and the first character must be a letter or one of

the characters @, #, or $. Subsequent characters can be any combination of letters, numbers,
nonpunctuation characters, and a period (.). In code page mode, sixty-four bytes typically
means 64 characters in single-byte languages (for example, English, French, German,
Spanish, Italian, Hebrew, Russian, Greek, Arabic, and Thai) and 32 characters in double-byte
languages (for example, Japanese, Chinese, and Korean). Many string characters that only
take one byte in code page mode take two or more bytes in Unicode mode. For example, éis
one byte in code page format but is two bytesin Unicode format; so résuméissix bytesin a
code page file and eight bytes in Unicode mode.

Note: Lettersinclude any nonpunctuation characters used in writing ordinary words in the
languages supported in the platform’s character set.

m Variable names cannot contain spaces.
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A # character in the first position of a variable name defines a scratch variable. You can only
create scratch variables with command syntax. You cannot specify a# asthe first character of
avariable in dialog boxes that create new variables.

A $signinthefirst position indicates that the variable is a system variable. The $ signis not
allowed asthe initial character of a user-defined variable.

The period, the underscore, and the characters $, #, and @ can be used within variable names.
For example, A._$@#1 is avalid variable name.

Variable names ending with a period should be avoided, since the period may be interpreted
as acommand terminator. You can only create variables that end with a period in command
syntax. You cannot create variables that end with a period in dialog boxes that create new
variables.

Variable names ending in underscores should be avoided, since such names may conflict with
names of variables automatically created by commands and procedures.

Reserved keywords cannot be used as variable names. Reserved keywords are ALL, AND,
BY, EQ, GE, GT, LE, LT, NE, NOT, OR, TO, and WITH.

Variable names can be defined with any mixture of uppercase and lowercase characters,
and case is preserved for display purposes.

When long variable names need to wrap onto multiple lines in output, lines are broken at
underscores, periods, and points where content changes from lower case to upper case.

Variable Measurement Level

You can specify the level of measurement as scale (numeric data on an interval or ratio scale),
ordinal, or nominal. Nominal and ordinal data can be either string (a phanumeric) or numeric.

Nominal. A variable can be treated as nominal when its values represent categories with no
intrinsic ranking (for example, the department of the company in which an employee works).
Examples of nominal variables include region, zip code, and religious affiliation.

Ordinal. A variable can be treated as ordinal when its values represent categories with some
intrinsic ranking (for example, levels of service satisfaction from highly dissatisfied to
highly satisfied). Examples of ordinal variables include attitude scores representing degree
of satisfaction or confidence and preference rating scores.

Scale. A variable can be treated as scale (continuous) when its values represent ordered
categories with a meaningful metric, so that distance comparisons between values are
appropriate. Examples of scale variables include age in years and income in thousands of
dollars.

Note: For ordinal string variables, the alphabetic order of string valuesis assumed to reflect the
true order of the categories. For example, for a string variable with the values of low, medium,
high, the order of the categoriesis interpreted as high, low, medium, which is not the correct order.
In generd, it ismore reliable to use numeric codes to represent ordinal data.
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New numeric variables created during a session are assigned the scale measurement level. For
data read from externa file formats and PASW Statistics data files that were created prior to
version 8.0, default assignment of measurement level is based on the following rules:

m  Numeric variables with fewer than 24 unique values and string variables are set to nominal.
m  Numeric variables with 24 or more unique values are set to scale.

You can change the scale/nominal cutoff value for numeric variables in the Options dialog box.
For more information, see the topic Data Options in Chapter 16 on p. 295.

The Define Variable Properties dialog box, available from the Data menu, can help you assign
the correct measurement level. For more information, see the topic Assigning the Measurement
Level in Chapter 7 on p. 100.

Variable Type

Variable Type specifies the data type for each variable. By default, al new variables are assumed
to be numeric. You can use Variable Type to change the data type. The contents of the Variable
Type dialog box depend on the selected data type. For some data types, there are text boxes

for width and number of decimals; for other data types, you can simply select a format from a
scrollable list of examples.

Figure 5-3
Variable Type dialog box
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'D Mumeric T -
@ Comma i
© Dot T gan
- itk R
© sciertific natation | Tt
= T A R
© pate S A R
@ Dallar Ttk HRR AR p
(0 Custom currency | THEE B 8 B
© String YWicth;
Deciial Places: D

[ §|[Cance|][ Help ]

The available data types are as follows:

Numeric. A variable whose values are numbers. Values are displayed in standard numeric format.
The Data Editor accepts numeric values in standard format or in scientific notation.

Comma. A numeric variable whose values are displayed with commas delimiting every three
places and displayed with the period as a decimal delimiter. The Data Editor accepts numeric
values for comma variables with or without commas or in scientific notation. Values cannot
contain commas to the right of the decimal indicator.
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Dot. A numeric variable whose values are displayed with periods delimiting every three places
and with the comma as a decimal delimiter. The Data Editor accepts numeric values for dot
variables with or without periods or in scientific notation. Values cannot contain periods to the
right of the decimal indicator.

Scientific notation. A numeric variable whose values are displayed with an embedded E and a
signed power-of-10 exponent. The Data Editor accepts numeric values for such variables with or
without an exponent. The exponent can be preceded by E or D with an optional sign or by the sign
alone—for example, 123, 1.23E2, 1.23D2, 1.23E+2, and 1.23+2.

Date. A numeric variable whose values are displayed in one of severa calendar-date or clock-time
formats. Select aformat from thelist. You can enter dates with slashes, hyphens, periods,
commas, or blank spaces as delimiters. The century range for two-digit year valuesis determined
by your Options settings (from the Edit menu, choose Options, and then click the Data tab).

Dollar. A numeric variable displayed with aleading dollar sign ($), commas delimiting every three
places, and a period as the decimal delimiter. You can enter data values with or without the
leading dollar sign.

Custom currency. A numeric variable whose values are displayed in one of the custom currency
formats that you have defined on the Currency tab of the Options dialog box. Defined custom
currency characters cannot be used in data entry but are displayed in the Data Editor.

String. A variable whose values are not numeric and therefore are not used in calculations. The
values can contain any characters up to the defined length. Uppercase and lowercase |etters are
considered distinct. Thistypeisaso known as an aphanumeric variable.

To Define Variable Type
» Click the button in the Type cell for the variable that you want to define.
» Select the data type in the Variable Type dialog box.
» Click OK.

Input versus Display Formats

Depending on the format, the display of valuesin Data View may differ from the actua value as
entered and stored internally. Following are some general guidelines:

m  For numeric, comma, and dot formats, you can enter values with any number of decimal
positions (up to 16), and the entire value is stored internaly. The Data View displays only
the defined number of decimal places and rounds values with more decimals. However, the
complete value is used in al computations.

m For string variables, all values are right-padded to the maximum width. For astring variable
with a maximum width of three, avalue of No is stored internally as 'No ' and is not
equivalentto ' No'.

m For date formats, you can use slashes, dashes, spaces, commas, or periods as delimiters
between day, month, and year values, and you can enter numbers, three-letter abbreviations,
or complete names for month values. Dates of the general format dd-mmm-yy are displayed
with dashes as delimiters and three-letter abbreviations for the month. Dates of the general
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format dd/mm/yy and mnmvdd/yy are displayed with slashes for delimiters and numbers for the
month. Internally, dates are stored as the number of seconds from October 14, 1582. The
century range for dates with two-digit years is determined by your Options settings (from
the Edit menu, choose Options, and then click the Data tab).

m  For time formats, you can use colons, periods, or spaces as delimiters between hours, minutes,
and seconds. Times are displayed with colons as delimiters. Internally, times are stored as a
number of seconds that represents atime interval. For example, 10:00:00 is stored internally
as 36000, which is 60 (seconds per minute) x 60 (minutes per hour) x 10 (hours).

Variable Labels

You can assign descriptive variable labels up to 256 characters (128 characters in double-byte

languages). Variable labels can contain spaces and reserved characters that are not allowed in
variable names.

To Specify Variable Labels
» Make the Data Editor the active window.
» Double-click avariable name at the top of the column in Data View, or click the Variable View tab.

» Inthe Label cell for the variable, enter the descriptive variable label.

Value Labels

You can assign descriptive value labels for each value of avariable. This processis particularly

useful if your data file uses numeric codes to represent non-numeric categories (for example,
codes of 1 and 2 for male and female).

m  Value labels can be up to 120 bytes.

Figure 5-4

Value Labels dialog box
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To Specify Value Labels

>
>
>
>

Click the button in the Values cell for the variable that you want to define.
For each value, enter the value and a label.
Click Add to enter the value label.

Click OK.

Inserting Line Breaks in Labels

Variable labels and value labels automatically wrap to multiple lines in pivot tables and charts if
the cell or areaisn’'t wide enough to display the entire label on one line, and you can edit results to
insert manua line breaks if you want the label to wrap at a different point. You can aso create
variable labels and value labels that will always wrap at specified points and be displayed on
multiple lines.

For variable labels, select the Label cell for the variable in Variable View in the Data Editor.

For value labels, select the Values cell for the variable in Variable View in the Data Editor, click
the button in the cell, and select the label that you want to modify in the Value Labels dialog box.

» At theplacein the label where you want the label to wrap, type \n.

The\n isnot displayed in pivot tables or charts; it isinterpreted as aline break character.

Missing Values

Missing Values defines specified data values as user-missing. For example, you might want to
distinguish between data that are missing because a respondent refused to answer and data that are
missing because the question didn't apply to that respondent. Data values that are specified as
user-missing are flagged for special treatment and are excluded from most calculations.

Figure 5-5
Missing Values dialog box

ﬁ Missing Values

2 Mo mizzing values

® Digcrete missing values

999

@ Range plus ane optional dizcrete missing value

Cance|][ Help ]

® You can enter up to three discrete (individual) missing values, arange of missing values,
or arange plus one discrete value.

m  Ranges can be specified only for numeric variables.
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m  All string values, including null or blank values, are considered to be valid unless you
explicitly define them as missing.

m  Missing valuesfor string variables cannot exceed eight bytes. (Thereis no limit on the defined
width of the string variable, but defined missing values cannot exceed eight bytes.)

m  To define null or blank values as missing for a string variable, enter a single space in one of
the fields under the Discrete missing values selection.

To Define Missing Values
» Click the button in the Missing cell for the variable that you want to define.

» Enter the values or range of values that represent missing data.

Roles

Some dialogs support predefined roles that can be used to pre-select variables for analysis. When
you open one of these dialogs, variables that meet the role requirements will be automatically
displayed in the destination list(s). Available roles are:

Input. The variable will be used as an input (e.g., predictor, independent variable).
Target. The variable will be used as an output or target (e.g., dependent variable).
Both. The variable will be used as both input and output.

None. The variable has no role assignment.

Partition. The variable will be used to partition the data into separate samples for training, testing,
and validation.

Split. Included for round-trip compatibility with PASW Modeler. Variables with thisrole are not
used as split-file variables in PASW Statistics.

m By default, al variables are assigned the Input role. This includes data from external file
formats and data files from versions of PASW Statistics prior to version 18.

m  Role assignment only affects dialogs that support role assignment. It has no effect on
command syntax.

To Assign Roles

» Select therole from the list in the Role cell for the variable.

Column Width

You can specify a number of characters for the column width. Column widths can also be changed
in Data View by clicking and dragging the column borders.

m  Column width for proportional fonts is based on average character width. Depending on the
characters used in the value, more or fewer characters may be displayed in the specified width.

m  Column width affect only the display of valuesin the Data Editor. Changing the column width
does not change the defined width of avariable.
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Variable Alignment

Alignment controls the display of data values and/or value labels in Data View. The default
alignment is right for numeric variables and left for string variables. This setting affects only
the display in Data View.

Applying Variable Definition Attributes to Multiple Variables

After you have defined variable definition attributes for a variable, you can copy one or more
attributes and apply them to one or more variables.

Basic copy and paste operations are used to apply variable definition attributes. You can:

m  Copy asingle attribute (for example, value labels) and paste it to the same attribute cell(s)
for one or more variables.

Copy all attributes from one variable and paste them to one or more other variables.
Create multiple new variables with dl the attributes of a copied variable.

Applying Variable Definition Attributes to Other Variables

To Apply Individual Attributes from a Defined Variable
» InVariable View, select the attribute cell that you want to apply to other variables.

» From the menus choose;
Edit
Copy

» Select the attribute cell(s) to which you want to apply the attribute. (You can select multiple
target variables.)

» From the menus choose;
Edit
Paste

If you paste the attribute to blank rows, new variables are created with default attributes for all
attributes except the selected attribute.

To Apply All Attributes from a Defined Variable

» In Variable View, select the row number for the variable with the attributes that you want to
use. (The entire row is highlighted.)

» From the menus choose;
Edit
Copy

» Select the row number(s) for the variable(s) to which you want to apply the attributes. (You
can select multiple target variables.)
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>

From the menus choose;

Edit
Paste

Generating Multiple New Variables with the Same Attributes

>

In Variable View, click the row number for the variable that has the attributes that you want to use
for the new variable. (The entire row is highlighted.)

From the menus choose;
Edit
Copy

Click the empty row number beneath the last defined variable in the datafile.

From the menus choose;
Edit

Paste Variables...
In the Paste Variables dialog box, enter the number of variables that you want to create.

Enter a prefix and starting number for the new variables.

Click OK.

The new variable names will consist of the specified prefix plus a sequential number starting
with the specified number.

Custom Variable Attributes

In addition to the standard variable attributes (for example, value labels, missing values,
measurement level), you can create your own custom variable attributes. Like standard variable
attributes, these custom attributes are saved with PASW Statistics data files. Therefore, you could
create a variable attribute that identifies the type of response for survey questions (for example,
single selection, multiple selection, fill-in-the-blank) or the formulas used for computed variables.

Creating Custom Variable Attributes

>

>

>

To create new custom attributes:

In Variable View, from the menus choose:

Data
New Custom Attribute...

Drag and drop the variables to which you want to assign the new attribute to the Selected
Variables list.

Enter aname for the attribute. Attribute names must follow the same rules as variable names.
For more information, see the topic Variable Names on p. 70.
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» Enter an optional value for the attribute. If you select multiple variables, the value is assigned
to all selected variables. You can leave this blank and then enter values for each variable in
Variable View.

Figure 5-6
New Custom Attribute dialog box

E Hew Custom Attribute

Select vatiable(s) for the new custom attribute.
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G

Cancel][ Help ]

Display attribute in the Data Editor. Displays the attribute in Variable View of the Data Editor. For
information on controlling the display of custom attributes, see Displaying and Editing Custom
Variable Attributes below.

Display Defined List of Attributes. Displaysalist of custom attributes already defined for the dataset.
Attribute names that begin with a dollar sign ($) are reserved attributes that cannot be modified.

Displaying and Editing Custom Variable Attributes

Custom variable attributes can be displayed and edited in the Data Editor in Variable View.
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Figure 5-7
Custom variable attributes displayed in Variable View
B *Untitled3 [] - Data Editor =)
File Edit “iew Data Transform Analyze Graphs  Utliies Add-ons  Window  Help
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3[Fill-in Empty
4[Fill-in Empty
a[Fill-in Empty
G[Single select Empty
7|Single select Empty
g|Computed value | Aray.. mean(lncomel, Income2, Incomed) | Empty
Q| Computed value | Aray.. max(lncomel, IncomeZ, Incomed) | Empty
10
11
12 |
<+ |\, Data View ) Variable View f |<] >

m  Custom variable attribute names are enclosed in square brackets.
m  Attribute names that begin with adollar sign are reserved and cannot be modified.

m A blank cell indicates that the attribute does not exist for that variable; the text Empty
displayed in a cell indicates that the attribute exists for that variable but no value has been
assigned to the attribute for that variable. Once you enter text in the cell, the attribute exists
for that variable with the value you enter.

m  Thetext Array... displayed in acell indicates that thisis an attribute array—an attribute that
contains multiple values. Click the button in the cell to display the list of values.

To Display and Edit Custom Variable Attributes

» |n Variable View, from the menus choose:
View
Customize Variable View...

» Select (check) the custom variable attributes you want to display. (The custom variable attributes
are the ones enclosed in square brackets.)
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Figure 5-8
Customize Variable View
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Once the attributes are displayed in Variable View, you can edit them directly in the Data Editor.

Variable Attribute Arrays

Thetext Array... (displayed in acell for a custom variable attribute in Variable View or in the
Custom Variable Properties dialog box in Define Variable Properties) indicates that thisis an
attribute array, an attribute that contains multiple values. For example, you could have an
attribute array that identifies all of the source variables used to compute a derived variable. Click
the button in the cell to display and edit the list of values.

Figure 5-9
Custom Attribute Array dialog box
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Customizing Variable View

You can use Customize Variable View to control which attributes are displayed in Variable View
(for example, name, type, label) and the order in which they are displayed.

m  Any custom variable attributes associated with the dataset are enclosed in square brackets. For
more information, see the topic Creating Custom Variable Attributes on p. 78.

Customized display settings are saved with PASW Statistics datafiles.
You can aso control the default display and order of attributes in Variable View. For more
information, see the topic Changing the Default Variable View in Chapter 16 on p. 297.
To Customize Variable View
» |In Variable View, from the menus choose:
View
Customize Variable View...

» Select (check) the variable attributes you want to display.

» Use the up and down arrow buttons to change the display order of the attributes.

Figure 5-10
Customize Variable View dialog box
ﬁ Customize Variable View
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Restore Defaults. Apply the default display and order settings.

Spell Checking

Variable and Value Labels

To check the spelling of variable labels and value labels:
» Select the Variable View tab in the Data Editor window.
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» Right-click on the Labels or Values column and from the context menu choose:
Spelling

or

» |n Variable View, from the menus choose:
Utilities
Spelling

or

» Inthe Value Labels dialog box, click Spelling. (This limits the spell checking to the value labels
for a particular variable.)

Spell checking islimited to variable labels and value labelsin Variable View of the Data Editor.

String Data Values

To check the spelling of string data values:
» Select the Data View tab of the Data Editor.

» Optionally, select one or more variables (columns) to check. To select avariable, click the variable
name at the top of the column.

» From the menus choose:
Utilities
Spelling
m |f there are no selected variables in Data View, al string variables will be checked.

m If there are no string variables in the dataset or the none of the selected variablesis a string
variable, the Spelling option on the Utilities menu is disabled.

Entering Data

In Data View, you can enter data directly in the Data Editor. You can enter datain any order. You
can enter data by case or by variable, for selected areas or for individua cells.

m  The active cell is highlighted.

m  The variable name and row number of the active cell are displayed in the top left corner
of the Data Editor.

m  When you select a cell and enter a data value, the value is displayed in the cell editor at
the top of the Data Editor.

m Datavalues are not recorded until you press Enter or select another cell.
m  To enter anything other than simple numeric data, you must define the variable type first.

If you enter avalue in an empty column, the Data Editor automatically creates a new variable
and assigns a variable name.
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To Enter Numeric Data
» Select acell in Data View.
» Enter the datavaue. (The valueisdisplayed in the cell editor at the top of the Data Editor.)

» To record the value, press Enter or select another cell.

To Enter Non-Numeric Data
» Double-click avariable name at the top of the column in Data View or click the Variable View tab.
Click the button in the Type cell for the variable.
Select the data type in the Variable Type diaog box.
Click OK.

Double-click the row number or click the Data View tab.

vV v v Vv VY

Enter the data in the column for the newly defined variable.

To Use Value Labels for Data Entry

» |If value labels aren’t currently displayed in Data View, from the menus choose:
View
Value Labels

» Click the cell in which you want to enter the value.

» Choose avaue label from the drop-down list.
The value is entered, and the value label is displayed in the cell.

Note: This process works only if you have defined value labels for the variable.

Data Value Restrictions in the Data Editor

The defined variable type and width determine the type of value that can be entered in the cell in
Data View.

m If you type a character that is not allowed by the defined variable type, the character is not
entered.

m  For string variables, characters beyond the defined width are not allowed.

m  For numeric variables, integer values that exceed the defined width can be entered, but the
Data Editor displays either scientific notation or a portion of the value followed by an ellipsis
(...) toindicate that the value is wider than the defined width. To display the value in the
cell, change the defined width of the variable.

Note: Changing the column width does not affect the variable width.
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Editing Data

With the Data Editor, you can modify data valuesin Data View in many ways. You can:
m Change data values

Cut, copy, and paste data values

Add and delete cases

Add and delete variables

Change the order of variables

Replacing or Modifying Data Values

To Delete the Old Value and Enter a New Value
» In Data View, double-click the cell. (The cell value isdisplayed in the cell editor.)
» Edit the value directly in the cell or in the cell editor.

» Press Enter or select another cell to record the new value.

Cutting, Copying, and Pasting Data Values

You can cut, copy, and paste individual cell values or groups of values in the Data Editor. You can:
m  Move or copy asingle cell value to another cell

Move or copy asingle cell value to a group of cells

Move or copy the values for asingle case (row) to multiple cases

Move or copy the values for a single variable (column) to multiple variables

Move or copy agroup of cell values to another group of cells

Data Conversion for Pasted Values in the Data Editor

If the defined variable types of the source and target cells are not the same, the Data Editor
attempts to convert the value. If no conversion is possible, the system-missing valueisinserted in
the target cell.

Converting numeric or date into string. Numeric (for example, numeric, dollar, dot, or comma) and
date formats are converted to strings if they are pasted into a string variable cell. The string
valueis the numeric value as displayed in the cell. For example, for adollar format variable, the
displayed dollar sign becomes part of the string value. Values that exceed the defined string
variable width are truncated.

Converting string into numeric or date. String values that contain acceptable characters for the
numeric or date format of the target cell are converted to the equivalent numeric or date value. For
example, astring value of 25/12/91 is converted to avalid date if the format type of the target cell
is one of the day-month-year formats, but the value is converted to system-missing if the format
type of the target cell is one of the month-day-year formats.
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Converting date into numeric. Date and time values are converted to a number of secondsif the
target cell is one of the numeric formats (for example, numeric, dollar, dot, or comma). Because
dates are stored internally as the number of seconds since October 14, 1582, converting dates to
numeric values can yield some extremely large numbers. For example, the date 10/29/91 is
converted to a numeric value of 12,908,073,600.

Converting numeric into date or time. Numeric values are converted to dates or timesif the value
represents a number of seconds that can produce a valid date or time. For dates, numeric values
that are less than 86,400 are converted to the system-missing value.

Inserting New Cases

Entering datain acell in ablank row automatically creates anew case. The Data Editor inserts the
system-missing value for all other variables for that case. If there are any blank rows between the
new case and the existing cases, the blank rows become new cases with the system-missing value
for all variables. You can aso insert new cases between existing cases.

To Insert New Cases between Existing Cases

» In Data View, select any cell in the case (row) below the position where you want to insert the

new case.

» From the menus choose;

Edit
Insert Cases

A new row isinserted for the case, and all variables receive the system-missing value.

Inserting New Variables

Entering datain an empty column in Data View or in an empty row in Variable View automatically
creates a new variable with a default variable name (the prefix var and a sequential number)

and a default data format type (numeric). The Data Editor inserts the system-missing value for

all casesfor the new variable. If there are any empty columns in Data View or empty rowsin
Variable View between the new variable and the existing variables, these rows or columns aso
become new variables with the system-missing value for all cases. You can also insert new
variables between existing variables.

To Insert New Variables between Existing Variables

» Select any cell in the variable to the right of (Data View) or below (Variable View) the position

where you want to insert the new variable.

» From the menus choose;

Edit
Insert Variable

A new variable is inserted with the system-missing value for al cases.
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To Move Variables

» To select the variable, click the variable name in Data View or the row number for the variablein
Variable View.

» Drag and drop the variable to the new location.

» If you want to place the variable between two existing variables: In Data View, drop the variable
on the variable column to the right of where you want to place the variable, or in Variable View,
drop the variable on the variable row below where you want to place the variable.

To Change Data Type

You can change the data type for a variable at any time by using the Variable Type dialog box

in Variable View. The Data Editor will attempt to convert existing values to the new type. If no
conversion is possible, the system-missing value is assigned. The conversion rules are the same as
the rules for pasting data values to a variable with a different format type. If the change in data
format may result in the loss of missing-value specifications or value labels, the Data Editor
displays an alert box and asks whether you want to proceed with the change or cancdl it.

Finding Cases, Variables, or Imputations

The Go To dialog box finds the specified case (row) number or variable name in the Data Editor.

Cases
» For cases, from the menus choose:
Edit
Go to Case...

» Enter an integer value that represents the current row number in Data View.

Note: The current row number for a particular case can change due to sorting and other actions.

Variables
» For variables, from the menus choose:;
Edit
Go to Variable...

» Enter the variable name or select the variable from the drop-down list.
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Figure 5-11
Go To dialog box
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Imputations

» From the menus choose:
Edit
Go to Imputation...

» Select the imputation (or Original data) from the drop-down list.

Figure 5-12
Go To dialog box

E Go To
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Alternatively, you can select the imputation from the drop-down list in the edit bar in Data View
of the Data Editor.
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Figure 5-13
Data Editor with imputation markings ON
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Relative case position is preserved when selecting imputations. For example, if there are 1000
casesin the original dataset, case 1034, the 34th case in the first imputation, displays at the top of
the grid. If you select imputation 2 in the dropdown, case 2034, the 34th case in imputation 2,
would display at the top of the grid. If you select Original data in the dropdown, case 34 would
display at the top of the grid. Column position is also preserved when navigating between
imputations, so that it is easy to compare values between imputations.

Finding and Replacing Data and Attribute Values

To find and/or replace data values in Data View or attribute valuesin Variable View:

» Click acell in the column you want to search. (Finding and replacing values is restricted to a
single column.)

» From the menus choose:
Edit
Find
or

Edit
Replace

Data View
® You cannot search up in Data View. The search direction is always down.

m For dates and times, the formatted values as displayed in Data View are searched. For example,
adate displayed as 10/28/2007 will not be found by a search for a date of 10-28-2007.

m  For other numeric variables, Contains, Begins with, and Ends with search formatted values. For
example, with the Begins with option, a search value of $123 for a Dollar format variable will
find both $123.00 and $123.40 but not $1,234. With the Entire cell option, the search value
can be formatted or unformatted (simple F numeric format), but only exact numeric values
(to the precision displayed in the Data Editor) are matched.
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m If valuelabels are displayed for the selected variable column, the label text is searched, not the

underlying data value, and you cannot replace the label text.

Variable View

m  Findisonly available for the Name, Label, Values, Missing, and custom variable attribute
columns.

m Replaceisonly available for the Label, Values, and custom attribute columns.

m Inthe Values (value labels) column, the search string can match either the data value or a
value labdl.

Note: Replacing the data value will delete any previous value label associated with that value.

Case Selection Status in the Data Editor

If you have selected a subset of cases but have not discarded unselected cases, unselected cases
are marked in the Data Editor with a diagonal line (slash) through the row number.

Figure 5-14
Filtered cases in the Data Editor
EH *demo.sav [DataSet2] - Data Editor =)=
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Data Editor Display Options

The View menu provides severa display options for the Data Editor:
Fonts. This option controls the font characteristics of the data display.
Grid Lines. This option toggles the display of grid lines.

Value Labels. This option toggles between the display of actual data values and user-defined
descriptive value labels. Thisoption is available only in Data View.
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Using Multiple Views

In Data View, you can create multiple views (panes) by using the splitters that are located below
the horizontal scroll bar and to the right of the vertical scroll bar.

You can also use the Window menu to insert and remove pane splitters. To insert splitters:

» |n Data View, from the menus choose:

Window
Split

Splitters are inserted above and to the left of the selected cell.

m |f thetop left cell is selected, splitters are inserted to divide the current view approximately in
half, both horizontally and vertically.

m If any cell other than the top cell in the first column is selected, a horizontal pane splitter is
inserted above the selected cell.

m If any cell other than the first cell in the top row is selected, a vertical pane splitter is inserted
to the left of the selected cell.

Data Editor Printing

A datafileis printed as it appears on the screen.

m  Theinformation in the currently displayed view is printed. In Data View, the data are printed.
In Variable View, data definition information is printed.

Grid lines are printed if they are currently displayed in the selected view.

Value labels are printed in Data View if they are currently displayed. Otherwise, the actual
data values are printed.

Use the View menu in the Data Editor window to display or hide grid lines and toggle between
the display of data values and value labels.

To Print Data Editor Contents
» Make the Data Editor the active window.
» Click the tab for the view that you want to print.
» From the menus choose:

File
Print...
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Starting with version 14.0, multiple data sources can be open at the same time, making it easier to:

m  Switch back and forth between data sources.
Compare the contents of different data sources.
Copy and paste data between data sources.

text data) without saving each data source first.

Basic Handling of Multiple Data Sources

Figure 6-1
Two data sources open at same time

Create multiple subsets of cases and/or variables for analysis.

Merge multiple data sources from various data formats (for example, spreadsheet, database,
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By default, each data source that you open is displayed in a new Data Editor window. (See
Genera Options for information on changing the default behavior to only display one dataset at a

time, in a single Data Editor window.)

®  Any previously open data sources remain open and available for further use.

m  When you first open a data source, it automatically becomes the active dataset.
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®  You can change the active dataset simply by clicking anywhere in the Data Editor window
of the data source that you want to use or by selecting the Data Editor window for that data

source from the Window menu.

®  Only the variablesin the active dataset are available for anaysis.

Figure 6-2
Variable list containing variables in the active dataset
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@ Displary frequency tables

m You cannot change the active dataset when any dialog box that accesses the data is open
(including all dialog boxes that display variable lists).

m At least one Data Editor window must be open during a session. When you close the
last open Data Editor window, PASW Statistics automatically shuts down, prompting you

to save changes first.

Working with Multiple Datasets in Command Syntax

If you use command syntax to open data sources (for example, GET FILE, GET DATA), you
need to use the bATASET NAME command to name each dataset explicitly in order to have more

than one data source open at the same time.
When working with command syntax, the active dataset name is displayed on the toolbar of the
syntax window. All of the following actions can change the active dataset:

m Usethe DATASET ACTIVATE command.
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m  Click anywhere in the Data Editor window of a dataset.
m  Select adataset name from the toolbar in the syntax window.

Figure 6-3
Open datasets displayed on syntax window toolbar
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Copying and Pasting Information between Datasets

You can copy both data and variable definition attributes from one dataset to another dataset in
basically the same way that you copy and paste information within a single datafile.

| |
no variable definition attributes.

Copying and pasting selected data cells in Data View pastes only the data values, with

Copying and pasting an entire variable in Data View by selecting the variable name at the top

of the column pastes all of the data and all of the variable definition attributes for that variable.

Copying and pasting variable definition attributes or entire variables in Variable View pastes

the selected attributes (or the entire variable definition) but does not paste any data values.

Renaming Datasets

When you open a data source through the menus and dialog boxes, each data source is
automatically assigned a dataset name of DataSetn, where n is a sequential integer value, and
when you open a data source using command syntax, no dataset name is assigned unless you
explicitly specify one with DATASET NaME. To provide more descriptive dataset names:

File
Rename Dataset...

topic Variable Names in Chapter 5 on p. 70.

From the menus in the Data Editor window for the dataset whose name you want to change choose:

Enter a new dataset name that conforms to variable naming rules. For more information, see the
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Suppressing Multiple Datasets

If you prefer to have only one dataset available at a time and want to suppress the multiple
dataset feature:

» From the menus choose;
Edit
Options...

» Click the General tab.
Select (check) Open only one dataset at a time.

For more information, see the topic General Options in Chapter 16 on p. 291.
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Data Preparation

Once you' ve opened a data file or entered data in the Data Editor, you can start creating reports,
charts, and analyses without any additional preliminary work. However, there are some additional
data preparation features that you may find useful, including the ability to:

m  Assign variable properties that describe the data and determine how certain values should
be treated.

m |dentify casesthat may contain duplicate information and exclude those cases from analyses
or delete them from the data file.

m Create new variables with afew distinct categories that represent ranges of values from
variables with a large number of possible values.

Variable Properties

Data entered in the Data Editor in Data View or read from an external file format (such as an
Excel spreadsheet or atext data file) lack certain variable properties that you may find very
useful, including:

m  Definition of descriptive value labels for numeric codes (for example, 0 = Maleand 1 =
Female).

m |dentification of missing values codes (for example, 99 = Not applicable).
m  Assignment of measurement level (nominal, ordinal, or scale).

All of these variable properties (and others) can be assigned in Variable View in the Data Editor.
There are also severa utilities that can assist you in this process:

m Define Variable Properties can help you define descriptive value labels and missing val ues.
Thisis particularly useful for categorical data with numeric codes used for category values.

m  Copy Data Properties provides the ability to use an existing PASW Statistics datafile asa
template for file and variable properties in the current datafile. Thisis particularly useful if
you frequently use external-format data files that contain similar content (such as monthly
reports in Excel format).

Defining Variable Properties

Define Variable Properties is designed to assist you in the process of assigning attributes to
variables, including creating descriptive value labels for categorical (nominal, ordinal) variables.
Define Variable Properties:

m  Scansthe actual data values and lists al unique data values for each selected variable.
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m Identifies unlabeled values and provides an “auto-label” feature.

m  Provides the ability to copy defined value labels and other attributes from another variable to
the selected variable or from the selected variable to multiple additional variables.

Note: To use Define Variable Properties without first scanning cases, enter 0 for the number
of cases to scan.

To Define Variable Properties

» From the menus choose:
Data
Define Variable Properties...

Figure 7-1
Initial dialog box for selecting variables to define
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» Select the numeric or string variables for which you want to create value labels or define or change
other variable properties, such as missing values or descriptive variable labels.

» Specify the number of cases to scan to generate the list of unique values. Thisis particularly
useful for datafiles with alarge number of cases for which a scan of the complete data file might
take a significant amount of time.

» Specify an upper limit for the number of unique valuesto display. Thisis primarily useful to
prevent listing hundreds, thousands, or even millions of values for scale (continuous interval,
ratio) variables.

» Click Continue to open the main Define Variable Properties dial og box.
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>

Select a variable for which you want to create value labels or define or change other variable
properties.

Enter the label text for any unlabeled values that are displayed in the Value Label grid.

If there are values for which you want to create value labels but those values are not displayed,
you can enter values in the Value column below the last scanned value.

Repeat this process for each listed variable for which you want to create value labels.

Click OK to apply the value labels and other variable properties.

Defining Value Labels and Other Variable Properties

Figure 7-2
Define Variable Properties, main dialog box
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The Define Variable Properties main dialog box provides the following information for the
scanned variables:

Scanned Variable List. For each scanned variable, a check mark in the Unlabeled (U.) column
indicates that the variable contains values without assigned value labels.

To sort the variable list to display al variables with unlabeled values at the top of the list:

» Click the Unlabeled column heading under Scanned Variable List.
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You can also sort by variable name or measurement level by clicking the corresponding column
heading under Scanned Variable List.

Value Label Grid

m Label. Displays any value labels that have already been defined. You can add or change
labels in this column.

m Value. Unique values for each selected variable. Thislist of unique valuesis based on the
number of scanned cases. For example, if you scanned only the first 100 cases in the datafile,
then the list reflects only the unique values present in those cases. If the datafile has already
been sorted by the variable for which you want to assign value labels, the list may display
far fewer unique values than are actually present in the data.

m  Count. The number of times each value occurs in the scanned cases.

m  Missing. Values defined as representing missing data. You can change the missing values
designation of the category by clicking the check box. A check indicates that the category
is defined as a user-missing category. If avariable already has a range of values defined as
user-missing (for example, 90-99), you cannot add or delete missing values categories for
that variable with Define Variable Properties. You can use Variable View in the Data Editor
to modify the missing values categories for variables with missing values ranges. For more
information, see the topic Missing Valuesin Chapter 5 on p. 75.

m Changed. Indicates that you have added or changed a value label.
Note: If you specified O for the number of casesto scan in the initial dialog box, the Value Label
grid will initialy be blank, except for any preexisting value labels and/or defined missing values

categories for the selected variable. In addition, the Suggest button for the measurement level
will be disabled.

Measurement Level. Value labels are primarily useful for categorical (nominal and ordinal)
variables, and some procedures treat categorical and scale variables differently; so it is sometimes
important to assign the correct measurement level. However, by default, all new numeric variables
are assigned the scale measurement level. Thus, many variables that are in fact categorical may
initially be displayed as scale.

If you are unsure of what measurement level to assign to a variable, click Suggest.

Role. Some dialogs support the ability to pre-select variables for analysis based on defined roles.
For more information, see the topic Roles in Chapter 5 on p. 76.

Copy Properties. You can copy value labels and other variable properties from ancther variable
to the currently selected variable or from the currently selected variable to one or more other
variables.

Unlabeled Values. To create labels for unlabeled values automatically, click Automatic Labels.

Variable Label and Display Format

You can change the descriptive variable label and the display format.
® You cannot change the variable's fundamental type (string or numeric).
m  For string variables, you can change only the variable label, not the display format.
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m  For numeric variables, you can change the numeric type (such as numeric, date, dollar, or
custom currency), width (maximum number of digits, including any decimal and/or grouping
indicators), and number of decimal positions.

m  For numeric date format, you can select a specific date format (such as dd-mm-yyyy,
mm/dd/yy, and yyyyddd)

m  For numeric custom format, you can select one of five custom currency formats (CCA through
CCE). For more information, see the topic Currency Options in Chapter 16 on p. 297.

m  Anasterisk is displayed in the Value column if the specified width is less than the width of
the scanned values or the displayed values for preexisting defined value labels or missing
values categories.

m A period (.) isdisplayed if the scanned values or the displayed values for preexisting defined
value labels or missing values categories are invalid for the selected display format type. For
example, an internal numeric value of less than 86,400 isinvalid for a date format variable.

Assigning the Measurement Level

When you click Suggest for the measurement level in the Define Variable Properties main dialog
box, the current variable is evaluated based on the scanned cases and defined value labels, and
ameasurement level is suggested in the Suggest Measurement Level dialog box that opens.
The Explanation area provides a brief description of the criteria used to provide the suggested
measurement level.
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Figure 7-3
Suggest Measurement Level dialog box

& Define Variable Properties: Suggest Measurement Level

“ariakle: |ownpc: |

Current Measurement Level |Scale

Suggested Level: Crdinal o Mominal

® Crdinal @ Mominal

Explanation:  ownpe has only small, nonnedgative, integer values and does not have
a large number of differert values.

=2 & nominal level is one where the variable values do not have a natural
wt  ranking, for example names of countries.

An ordingl level is one where the variable valuss have a natural arder but
ditferences between values are not meaningful, for example, importance of a
political position coded "low"”, "medium", and "high".

& zcale level is one where the differences between variable values are
comparable, for example, age in years,

The suggested measurement level is based on empirical rules and is nat &
substitute for user judgment.

PASYY Statistics uses the measurement level in some cases to determine
whether the wariable defines categories in & table or graph or is to be
summarized.

Cancel ][ Help ]

Note: Values defined as representing missing values are not included in the evaluation for
measurement level. For example, the explanation for the suggested measurement level may
indicate that the suggestion isin part based on the fact that the variable contains no negative
values, whereas it may in fact contain negative values—but those values are already defined as
missing values.

» Click Continue to accept the suggested level of measurement or Cancel to leave the measurement
level unchanged.

Custom Variable Attributes

The Attributes button in Define Variable Properties opens the Custom Variable Attributes dialog
box. In addition to the standard variable attributes, such as value labels, missing values, and
measurement level, you can create your own custom variable attributes. Like standard variable
attributes, these custom attributes are saved with PASW Statistics data files.
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Figure 7-4
Custom Variable Attributes
@ Custom Variable Attributes
Custom Attributes for Avgincome
Mame |Value | Al
AnsvweerFormst Computed value
-

DerivedFrom Array... =
Formula meaniincome] | INcomez, Incames)

Maotes

|§C0ntinue§|[ Cancel ][ Help ]

Name. Attribute names must follow the same rules as variable names. For more information, see
the topic Variable Names in Chapter 5 on p. 70.

Value. The value assigned to the attribute for the selected variable.

m  Attribute names that begin with a dollar sign are reserved and cannot be modified. You can
view the contents of areserved attribute by clicking on the button in the desired cell.

m  Thetext Array..., displayed in a Value cell, indicates that thisis an attribute array, an
attribute that contains multiple values. Click the button in the cell to display the list of values.

Copying Variable Properties

The Apply Labelsand Level dialog box is displayed when you click From Another Variable or To
Other Variables in the Define Variable Properties main dialog box. It displays all of the scanned

variables that match the current variable's type (numeric or string). For string variables, the
defined width must also match.
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Figure 7-5
Apply Labels and Level dialog box

ok Apply Labels and Level to

ai 4 Select the variables that the current variable's

w2 value labelz, measurement level, role, missing
value defintion, and formst will be copied to.
(Walue labels and mizsing values are merged.)

Wariahles:
Orvns TV [oseenty]
Oyyns VR [owenvor]
Oywng stereciCh playver [owncd]
Oyyns PDA [ownpca]
wns fax machine [ovweniax]

|: Copwy él[Cancel][ Help ]

» Select asingle variable from which to copy value labels and other variable properties (except
variable label).

or
» Select one or more variables to which to copy value labels and other variable properties.

» Click Copy to copy the value labels and the measurement level.
m  Existing value labels and missing value categories for target variable(s) are not replaced.

m Value labels and missing value categories for values not already defined for the target
variable(s) are added to the set of value labels and missing value categories for the target
variable(s).

m  The measurement level for the target variable is always replaced.

The role for the target variable is always replaced.

If either the source or target variable has a defined range of missing values, missing values
definitions are not copied.

Multiple Response Sets

Custom Tables and the Chart Builder support a special kind of “variable” called amultiple
response set. Multiple response sets aren’t really “variables’ in the normal sense. You can't see
them in the Data Editor, and other procedures don’t recognize them. Multiple response sets use
multiple variables to record responses to questions where the respondent can give more than one
answer. Multiple response sets are treated like categorical variables, and most of the things you
can do with categorical variables, you can aso do with multiple response sets.

Multiple response sets are constructed from multiple variables in the datafile. A multiple
response set is a special construct within adatafile. You can define and save multiple response
setsin PASW Statistics datafiles, but you cannot import or export multiple response sets from/to
other file formats. You can copy multiple response sets from other PASW Statistics datafilesusing
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Copy Data Properties, which is accessed from the Data menu in the Data Editor window. For
more information, see the topic Copying Data Properties on p. 106.

Defining Multiple Response Sets

To define multiple response sets:

» From the menus, choose:
Data
Define Multiple Response Sets...

Figure 7-6
Define Multiple Response Sets dialog box

Ef Define Multiple Response Sets

et Definition Sets defined here are not available in

the Muttiple Response Freguencies and

atiables in Set:
atiables in Crosstabs procedurs

ol Confience in major .. [ @ Get neves from interne...

H:I Confidence in educ &) Get newes from radio[... 3 REEnD B
,{I Confidence in pres... &) Get newes from televisi... Fethmutt

,{l Confidence in medi... &) Get newvs from news Fmitcars

,{I Confidence in televi... - @b Gt newes from neswsp... Fmitnews

l{l Age category [sgec...
H:I Mumber of children

& Car maker, most re...
% Car maker, second ...
9) Car maker, third car ... |+

Yariakle Coding

[#] Categories

Remave

Category Labels Source
@ Wariable labels
© Labels of counted valus

Set Mame: |mnnews ‘

Set Lakel: |Naws FOUFCES |

=

» Select two or more variables. If your variables are coded as dichotomies, indicate which value
you want to have counted.

» Enter aunique name for each multiple response set. The name can be up to 63 byteslong. A dollar
sign is automatically added to the beginning of the set name.

» Enter adescriptive label for the set. (Thisisoptional.)

» Click Add to add the multiple response set to the list of defined sets.
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Dichotomies

A multiple dichotomy set typically consists of multiple dichotomous variables. variables with
only two possible values of ayes/no, present/absent, checked/not checked nature. Although the
variables may not be strictly dichotomous, all of the variablesin the set are coded the same way,
and the Counted Value represents the positive/present/checked condition.

For example, a survey asks the question, “Which of the following sources do you rely on
for news?’ and provides five possible responses. The respondent can indicate multiple choices
by checking a box next to each choice. The five responses become five variables in the data
file, coded O for No (not checked) and 1 for Yes (checked). In the multiple dichotomy set, the
Counted Value is 1.

The sample data file survey_sample.sav already has three defined multiple response sets.
$mitnews is a multiple dichotomy set.

Select (click) $mltnews in the Mult. Response Sets list.

This displays the variables and settings used to define this multiple response set.

m The Variablesin Set list displays the five variables used to construct the multiple response set.
m The Variable Coding group indicates that the variables are dichotomous.

m  The Counted Vaueis 1.

Select (click) one of the variables in the Variables in Set list.

Right-click the variable and select Variable Information from the pop-up context menu.

» Inthe Variable Information window, click the arrow on the Value Labels drop-down list to display

the entire list of defined value |abels.

Figure 7-7
Variable information for multiple dichotomy source variable
E Variable Information
Mame: newwss
Label: k:‘et nevys from internet |
Walue Labels: 0 Mo b4

0 Mo
1 Yes

=

The value labels indicate that the variable is a dichotomy with values of 0 and 1, representing No
and Yes, respectively. All five variablesin the list are coded the same way, and the value of 1 (the
code for Yes) is the counted value for the multiple dichotomy set.

Categories

A multiple category set consists of multiple variables, all coded the same way, often with many
possible response categories. For example, a survey item states, “Name up to three nationalities
that best describe your ethnic heritage.” There may be hundreds of possible responses, but for
coding purposes the list is limited to the 40 most common nationalities, with everything else
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relegated to an “other” category. In the datafile, the three choices become three variables, each
with 41 categories (40 coded nationalities and one “ other” category).

In the sample data file, $ethmult and $mitcars are multiple category sets.

Category Label Source

For multiple dichotomies, you can control how sets are labeled.

Variable labels. Uses the defined variable labels (or variable names for variables without
defined variable labels) as the set category labels. For example, if all of the variablesin the set
have the same value label (or no defined value labels) for the counted value (for example,
Yes), then you should use the variable labels as the set category labels.

Labels of counted values. Uses the defined value labels of the counted values as set category
labels. Select this option only if all variables have a defined value label for the counted value
and the value label for the counted value is different for each variable.

Use variable label as set label. If you select Label of counted values, you can also use the
variable label for the first variable in the set with a defined variable label as the set |abel. If
none of the variables in the set have defined variable labels, the name of the first variable
in the set is used as the set |abel.

Copying Data Properties

The Copy Data Properties Wizard provides the ability to use an external PASW Statistics data
file as atemplate for defining file and variable properties in the active dataset. You can also use
variables in the active dataset as templates for other variablesin the active dataset. You can:

Copy selected file properties from an external datafile or open dataset to the active dataset. File
properties include documents, file labels, multiple response sets, variable sets, and weighting.

Copy selected variable properties from an external datafile or open dataset to matching
variablesin the active dataset. Variable properties include value labels, missing values, level
of measurement, variable labels, print and write formats, alignment, and column width (in
the Data Editor).

Copy selected variable properties from one variable in either an external datafile, open
dataset, or the active dataset to many variables in the active dataset.

Create new variables in the active dataset based on selected variables in an external data
file or open dataset.

When copying data properties, the following general rules apply:

If you use an external data file as the source datafile, it must be adatafilein PASW Statistics
format.

If you use the active dataset as the source datafile, it must contain at least one variable. You
cannot use a completely blank active dataset as the source datafile.

Undefined (empty) properties in the source dataset do not overwrite defined propertiesin the
active dataset.

Variable properties are copied from the source variable only to target variables of a matching
type—string (a phanumeric) or numeric (including numeric, date, and currency).
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Note: Copy Data Properties replaces Apply Data Dictionary, formerly available on the File menu.

To Copy Data Properties

» From the menusin the Data Editor window choose:
Data
Copy Data Properties...

Figure 7-8
Copy Data Properties Wizard: Step 1

A Copy Data Properties - Step 1 of 5

Welcome to the Copy Data Properties Wizard.

Copy Data Properties can copy selected variahble and dataset properties from an open dataset or
external PASW Statistics data file to the active dataset.

-
.j_ You can also copy properies from one variable to ancther within the active dataset.

Data properies are copied but not data values.

Chooze the source of the properties

@ An external PASYY Statistics data file

|C:1Program FilesSPEEIincP ASW St atistice1 S Samples Englishidemo. say |

© The active datazet [ smaldemo.zav [DataSetd] )

(e

Finizt ][ Cancel ][ Helg ]

» Select the data file with the file and/or variable properties that you want to copy. This can be a
currently open dataset, an external PASW Statistics datafile, or the active dataset.

» Follow the step-by-step instructions in the Copy Data Properties Wizard.

Selecting Source and Target Variables

In this step, you can specify the source variables containing the variable properties that you want
to copy and the target variables that will receive those variable properties.
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Figure 7-9
Copy Data Properties Wizard: Step 2

£ Copy Data Properties - Step 2 of 5

Copry data properties - Choose source and target variables
@ Apply properties from selected source dataszet variables to matching active dataset variables.
I:Z Create atching variables in the active dataset if they do not already exist.
@ Apply properties from a single source variakle to selected active dataset variables of the same type.
@ Apply datazet properies only - no variable selection

o A varishle matches if the name and basic type (nUmetic or string and string length) are the zame. The
'l 4 particular properties to apply will be specified on the following panels. Right click on a variable to see
its properties.

Select the variables inthe source list whose properties will be copied to the matching variables or that should
be created in the active dstaset if they do not already exist.

Source Dataszet Watiables: hatching Active Dataset
& Age in years [age]  |© é?
@& Marital status [marital] 659
& Years at current ad... é?

‘g& Household income ...
di Income category in ..
& Price of primary ve...
di Frimary wehicle pric...
f Level of education [...
.9& Years with e rrert

Selected variables: 29 Matching variahbles: 3

“ariables to be created: 26

(< Baok ] [

Finizh ][ Cancel ][ Help ]

Apply properties from selected source dataset variables to matching active dataset variables.
Variable properties are copied from one or more sel ected source variables to matching variablesin
the active dataset. Variables“match” if both the variable name and type (string or numeric) are the
same. For string variables, the defined length must also be the same. By default, only matching
variables are displayed in the two variable lists.

m  Create matching variables in the active dataset if they do not already exist. This updates the
source list to display all variables in the source datafile. If you select source variables that do
not exist in the active dataset (based on variable name), new variables will be created in the
active dataset with the variable names and properties from the source datafile.

If the active dataset contains no variables (a blank, new dataset), al variables in the source data
file are displayed and new variables based on the selected source variables are automatically
created in the active dataset.

Apply properties from a single source variable to selected active dataset variables of the same type.
Variable properties from a single selected variable in the source list can be applied to one or more
selected variables in the active dataset list. Only variables of the same type (numeric or string) as
the selected variable in the source list are displayed in the active dataset list. For string variables,
only strings of the same defined length as the source variable are displayed. This option is not
available if the active dataset contains no variables.

Note: You cannot create new variablesin the active dataset with this option.
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Apply dataset properties only—no variable selection. Only file properties (for example, documents,
file label, weight) will be applied to the active dataset. No variable properties will be applied. This
option is not available if the active dataset is a so the source datafile.

Choosing Variable Properties to Copy

You can copy selected variable properties from the source variables to the target variables.
Undefined (empty) properties in the source variables do not overwrite defined propertiesin the
target variables.

Figure 7-10
Copy Data Properties Wizard: Step 3

£ Copy Data Properties - Step 3 of 5

Copy Data Properties - Choose Yarishle Properties to Copy
Select the variable properties to be copied to the active datazet.

& For value labelz, you can choose to replace the existing walues or to merge them with active dataset
M propetties az far as possible. When merging, the active datazet has priorty.

Empty properties in source variables will never replace target variable propeties.

For any variables being created, all properties will he copied.

“Yariable Properties to Copy for Existing Selected Variables

I;& Yalue Labels @ Replace (@] hleroe
[T custom Attributes @

[ Mizsing values

[l variable Iakel

[ Meazuremert Level

I:& Role

[ Formats

I;& Alignmert

[ Data Editor Column wicth

o [

Finizh ][ Cancel ][ Help ]

Value Labels. Value labels are descriptive labels associated with data values. Value labels are often
used when numeric data values are used to represent non-numeric categories (for example, codes
of 1 and 2 for Male and Female). You can replace or merge value labels in the target variables.

B Replace deletes any defined value labels for the target variable and replaces them with the
defined value labels from the source variable.

B Merge merges the defined value labels from the source variable with any existing defined value
label for the target variable. If the same value has a defined value label in both the source and
target variables, the value label in the target variable is unchanged.

Custom Attributes. User-defined custom variable attributes. For more information, see the topic
Custom Variable Attributes in Chapter 5 on p. 78.
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B Replace deletes any custom attributes for the target variable and replaces them with the
defined attributes from the source variable.

®  Merge merges the defined attributes from the source variable with any existing defined
attributes for the target variable.

Missing Values. Missing values are values identified as representing missing data (for example, 98
for Do not know and 99 for Not applicable). Typically, these values also have defined value labels
that describe what the missing value codes stand for. Any existing defined missing values for the
target variable are deleted and replaced with the defined missing values from the source variable.

Variable Label. Descriptive variable labels can contain spaces and reserved characters not allowed
in variable names. If you're copying variable properties from a single source variable to multiple
target variables, you might want to think twice before selecting this option.

Measurement Level. The measurement level can be nominal, ordinal, or scale.

Role. Some diaogs support the ability to pre-select variables for analysis based on defined roles.
For more information, see the topic Roles in Chapter 5 on p. 76.

Formats. For numeric variables, this controls numeric type (such as numeric, date, or currency),
width (total number of displayed characters, including leading and trailing characters and decimal
indicator), and number of decimal places displayed. This option isignored for string variables.

Alignment. This affects only alignment (Ieft, right, center) in Data View in the Data Editor.
Data Editor Column Width. This affects only column width in Data View in the Data Editor.

Copying Dataset (File) Properties

You can apply selected, global dataset properties from the source data file to the active dataset.
(Thisis not available if the active dataset is the source datafile.)
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Figure 7-1
Copy Data Properties Wizard: Step 4

£ Copy Data Properties - Step 4 of 5

Copy Data Properties - Choose Dataset Properties to Copy
Select the dataset properties to be copied to the active dataset.

& For some properties, you can choose to replace the existing values or to merge them with source
J_ properties as far as possible. When merging, the active dataset has priovity.

Muttiple Response Setz and Variable Sets that would be invalid in the active dataset will be ignored.

Datazet Properties to Copy
a
@
[ Documerts @ Replace © Merge
@
[< Eac:k][[}l“ Finish ][ Cancel][ Help ]

Data Preparation

Multiple Response Sets. Applies multiple response set definitions from the source datafile to the

active dataset.

m  Multiple response sets that contain no variables in the active dataset are ignored unless those
variables will be created based on specifications in step 2 (Selecting Source and Target

Variables) in the Copy Data Properties Wizard.

m Replace deletes all multiple response sets in the active dataset and replaces them with the

multiple response sets from the source datafile.

m  Merge adds multiple response sets from the source data file to the collection of multiple
response setsin the active dataset. If a set with the same name exists in both files, the existing

set in the active dataset is unchanged.

Variable Sets. Variable sets are used to control the list of variables that are displayed in dialog
boxes. Variable sets are defined by selecting Define Variable Sets from the Utilities menu.

m  Setsin the source datafile that contain variables that do not exist in the active dataset are
ignored unless those variables will be created based on specifications in step 2 (Selecting

Source and Target Variables) in the Copy Data Properties Wizard.
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Replace deletes any existing variable sets in the active dataset, replacing them with variable
sets from the source data file.

Merge adds variable sets from the source data file to the collection of variable setsin the
active dataset. If a set with the same name exists in both files, the existing set in the active
dataset is unchanged.

Documents. Notes appended to the data file via the bocUMENT command.

Replace deletes any existing documents in the active dataset, replacing them with the
documents from the source data file.

Merge combines documents from the source and active dataset. Unique documentsin the
source file that do not exist in the active dataset are added to the active dataset. All documents
are then sorted by date.

Custom Attributes. Custom data file attributes, typically created with the DATAFILE ATTRIBUTE
command in command syntax.

Replace deletes any existing custom data file attributes in the active dataset, replacing them
with the data file attributes from the source data file.

Merge combines data file attributes from the source and active dataset. Unique attribute names
in the source file that do not exist in the active dataset are added to the active dataset. |If

the same attribute name exists in both data files, the named attribute in the active dataset

is unchanged.

Weight Specification. Weights cases by the current weight variable in the source datafile if there
is amatching variable in the active dataset. This overrides any weighting currently in effect
in the active dataset.

File Label. Descriptive label applied to adatafile with the FTLE LABEL command.
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Results

Figure 7-12
Copy Data Properties Wizard: Step 5

B Copy Data Properties - Step 5 of 5

Finizh
.i o Wariables to which properties will he applied: 3
—
Yariables to be copied: 26

Datazet properties to be copied; 1

C)] Execute the command

@ Paste the command into & syntax window:

[Cance|][ Help ]

The last step in the Copy Data Properties Wizard provides information on the number of variables
for which variable properties will be copied from the source data file, the number of new variables
that will be created, and the number of dataset (file) properties that will be copied.

You can aso choose to paste the generated command syntax into a syntax window and save the
syntax for later use.

Identifying Duplicate Cases

“Duplicate” cases may occur in your datafor many reasons, including:
Data entry errors in which the same case is accidentally entered more than once.

Muultiple cases share acommon primary ID value but have different secondary ID values, such
as family members who all live in the same house.

m  Multiple cases represent the same case but with different values for variables other than those
that identify the case, such as multiple purchases made by the same person or company
for different products or at different times.

Identify Duplicate Cases alows you to define duplicate almost any way that you want and
provides some control over the automatic determination of primary versus duplicate cases.
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To Identify and Flag Duplicate Cases

From the menus choose;

Data
Identify Duplicate Cases...

Select one or more variables that identify matching cases.

Select one or more of the options in the Variables to Create group.

Optionally, you can:

Select one or more variables to sort cases within groups defined by the selected matching cases
variables. The sort order defined by these variables determines the “first” and “last” casein each

group. Otherwise, the original file order is used.

Automatically filter duplicate cases so that they won't beincluded in reports, charts, or calculations

of statistics.

Figure 7-13
Identify Duplicate Cases dialog box

B Identify Duplicate Cases

Define matching cases by:

f gender & Househaold 1D [ID_house]
+ f Perzon ID [ID_person]

Sort within matching groups by:

aé Irterview date [int_date] -- Ascending

Saort
@ ascending
@ Cescending

Mumber of matching and soring variables: 3
“ariables to Create

Ef. Inclicator of primary cases (1=unigue ar primary, D=cduplicate)

@) Last case in each group is primary
- Matre: |PrimaryLa31

©) First case in each group is primary

|| Fiter by indicatar valugs

EZ. Sequential count of matching case in each Name:

MatchSeguence
group (O=nonmstching case) | il

[ paste | [ Reset | cancel || Hep |

Define matching cases by. Cases are considered duplicatesif their values match for all selected
variables. If you want to identify only cases that are a 100% match in all respects, select all

of the variables.
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Sort within matching groups by. Cases are automatically sorted by the variables that define
matching cases. You can select additional sorting variables that will determine the sequential
order of cases in each matching group.

m  For each sort variable, you can sort in ascending or descending order.

m If you select multiple sort variables, cases are sorted by each variable within categories of the
preceding variable in the list. For example, if you select date as the first sorting variable and
amount as the second sorting variable, cases will be sorted by amount within each date.

m  Usethe up and down arrow buttons to the right of the list to change the sort order of the
variables.

m The sort order determines the “first” and “last” case within each matching group, which
determines the value of the optional primary indicator variable. For example, if you want
to filter out all but the most recent case in each matching group, you could sort cases within
the group in ascending order of a date variable, which would make the most recent date
the last date in the group.

Indicator of primary cases. Creates a variable with avalue of 1 for all unique cases and the case
identified as the primary case in each group of matching cases and avalue of 0 for the nonprimary
duplicates in each group.

m  The primary case can be either the last or first case in each matching group, as determined by

the sort order within the matching group. If you don’'t specify any sort variables, the original
file order determines the order of cases within each group.

®  You can usetheindicator variable as afilter variable to exclude nonprimary duplicates from
reports and analyses without deleting those cases from the datafile.

Sequential count of matching cases in each group. Creates a variable with a sequential value from 1
to nfor cases in each matching group. The sequence is based on the current order of casesin each
group, which is either the original file order or the order determined by any specified sort variables.

Move matching cases to the top. Sorts the datafile so that all groups of matching cases are at the
top of the datafile, making it easy to visually inspect the matching cases in the Data Editor.

Display frequencies for created variables. Frequency tables containing counts for each value of
the created variables. For example, for the primary indicator variable, the table would show the
number of cases with avalue O for that variable, which indicates the number of duplicates, and the
number of cases with avalue of 1 for that variable, which indicates the number of unique and
primary cases.

Missing Values. For numeric variables, the system-missing value is treated like any other
value—cases with the system-missing value for an identifier variable are treated as having
matching values for that variable. For string variables, cases with no value for an identifier
variable are treated as having matching values for that variable.
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Visual Binning

>

Visual Binning is designed to assist you in the process of creating new variables based on
grouping contiguous values of existing variablesinto a limited number of distinct categories. You
can use Visual Binning to:

m Create categorical variables from continuous scale variables. For example, you could use a
scale income variable to create a new categorica variable that contains income ranges.

m  Collapse alarge number of ordinal categoriesinto a smaller set of categories. For example,
you could collapse arating scale of nine down to three categories representing low, medium,
and high.

In the first step, you:

Select the numeric scale and/or ordinal variables for which you want to create new categorical
(binned) variables.

Figure 7-14
Initial dialog box for selecting variables to bin

ﬁ Visual Binning

ri W Select the variables whose values will be grouped into bins. Data il
we  be scanned when you click Continue.

The Variahles list belovw contains all numeric ordinal and scale

variahles.
WVariahles: “ariahles to Bin:
& Age in years [age] - & Househald incame inth...

f Iarital status [marital]

f Years at current ad...

d:l Income category in ..

y Price of primary ve...

d:l Primary vehicle pric...

& Level of education [...

y “ears with current ..

& Retired [retire]

d:l Years with current
Job satistaction Jiok.. |7

|| Limit number of cases acanned to:

[Continue][ Cancel ][ Help ]

Optionally, you can limit the number of casesto scan. For data files with alarge number of cases,
limiting the number of cases scanned can save time, but you should avoid thisif possible because
it will affect the distribution of values used in subsequent calculationsin Visual Binning.

Note: String variables and nominal numeric variables are not displayed in the source variable
list. Visual Binning requires numeric variables, measured on either a scale or ordinal level, since
it assumes that the data values represent some logical order that can be used to group valuesin
ameaningful fashion. You can change the defined measurement level of avariablein Variable
View in the Data Editor. For more information, see the topic Variable Measurement Level in
Chapter 50on p. 71.
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From the menus in the Data Editor window choose:

Transform
Visual Binning...

Select the numeric scale and/or ordinal variables for which you want to create new categorical

(binned) variables.

Select avariable in the Scanned Variable List.

Enter a name for the new binned variable. Variable names must be unique and must follow
variable naming rules. For more information, see the topic Variable Namesin Chapter 5 on p. 70.

Define the binning criteria for the new variable. For more information, see the topic Binning

Variableson p. 117.

Click OK.

Binning Variables

Figure 7-15

Visual Binning, main dialog box
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The Visua Binning main dialog box provides the following information for the scanned variables:

Scanned Variable List. Displays the variables you selected in the initial dialog box. You can
sort the list by measurement level (scale or ordinal) or by variable label or name by clicking on

the column headings.
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Cases Scanned. Indicates the number of cases scanned. All scanned cases without user-missing
or system-missing values for the selected variable are used to generate the distribution of values
used in calculations in Visual Binning, including the histogram displayed in the main dialog box
and cutpoints based on percentiles or standard deviation units.

Missing Values. Indicates the number of scanned cases with user-missing or system-missing
values. Missing values are not included in any of the binned categories. For more information,
see the topic User-Missing Valuesin Visua Binning on p. 122.

Current Variable. The name and variable label (if any) for the currently selected variable that will
be used as the basis for the new, binned variable.

Binned Variable. Name and optional variable label for the new, binned variable.

m  Name. You must enter a name for the new variable. Variable names must be unique and
must follow variable naming rules. For more information, see the topic Variable Namesin
Chapter 5 on p. 70.

m Label. You can enter a descriptive variable label up to 255 characters long. The default
variable labd is the variable label (if any) or variable name of the source variable with
(Binned) appended to the end of the label.

Minimum and Maximum. Minimum and maximum values for the currently selected variable, based
on the scanned cases and not including values defined as user-missing.

Nonmissing Values. The histogram displays the distribution of honmissing values for the currently
selected variable, based on the scanned cases.

m After you define bins for the new variable, vertical lines on the histogram are displayed to
indicate the cutpoints that define bins.

® You can click and drag the cutpoint lines to different locations on the histogram, changing
the bin ranges.

® You can remove bins by dragging cutpoint lines off the histogram.

Note: The histogram (displaying nonmissing vaues), the minimum, and the maximum are based
on the scanned values. If you do not include all casesin the scan, the true distribution may not be
accurately reflected, particularly if the data file has been sorted by the selected variable. If you
scan zero cases, no information about the distribution of valuesis available.

Grid. Displays the values that define the upper endpoints of each bin and optional value labels for
each bin.

m Value. The vauesthat define the upper endpoints of each bin. You can enter values or use
Make Cutpoints to automatically create bins based on selected criteria. By default, a cutpoint
with avalue of HIGH is automatically included. This bin will contain any nonmissing values
above the other cutpoints. The bin defined by the lowest cutpoint will include all honmissing
values lower than or equal to that value (or simply lower than that value, depending on how
you define upper endpoints).

m Label. Optional, descriptive labels for the values of the new, binned variable. Since the
values of the new variable will simply be sequential integers from 1 to n, labels that describe
what the values represent can be very useful. You can enter labels or use Make Labels to
automatically create value labels.
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To Delete a Bin from the Grid
» Right-click on the either the Value or Label cell for the bin.
» From the pop-up context menu, select Delete Row.

Note: If you delete the HIGH bin, any cases with values higher than the last specified cutpoint
value will be assigned the system-missing value for the new variable.

To Delete All Labels or Delete All Defined Bins
» Right-click anywhere in the grid.

» From the pop-up context menu select either Delete All Labels or Delete All Cutpoints.

Upper Endpoints. Controls treatment of upper endpoint values entered in the Value column of the
grid.
m Included (<=). Cases with the value specified in the Value cell are included in the binned

category. For example, if you specify values of 25, 50, and 75, cases with a value of exactly
25 will go in thefirst bin, since thiswill include all cases with values less than or equal to 25.

m  Excluded (<). Cases with the value specified in the Value cell are not included in the binned
category. Instead, they are included in the next bin. For example, if you specify values of 25,
50, and 75, cases with avalue of exactly 25 will go in the second bin rather than the first,
since the first bin will contain only cases with values less than 25.

Make Cutpoints. Generates binned categories automatically for equal width intervals, intervals
with the same number of cases, or intervals based on standard deviations. Thisis not available if
you scanned zero cases. For more information, see the topic Automatically Generating Binned
Categories on p. 119.

Make Labels. Generates descriptive labels for the sequentia integer values of the new, binned
variable, based on the values in the grid and the specified treatment of upper endpoints (included
or excluded).

Reverse scale. By default, values of the new, binned variable are ascending sequential integers
from 1 to n. Reversing the scale makes the values descending sequentia integers from nto 1.

Copy Bins. You can copy the binning specifications from another variable to the currently selected
variable or from the selected variable to multiple other variables. For more information, see the
topic Copying Binned Categories on p. 121.

Automatically Generating Binned Categories

The Make Cutpoints dialog box alows you to auto-generate binned categories based on selected
criteria.
To Use the Make Cutpoints Dialog Box

» Select (click) avariable in the Scanned Variable List.

» Click Make Cutpoints.
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» Select the criteriafor generating cutpoints that will define the binned categories.

» Click Apply.

Figure 7-16
Make Cutpoints dialog box
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Note: The Make Cutpoints dialog box is not available if you scanned zero cases.

Equal Width Intervals. Generates binned categories of equal width (for example, 1-10, 11-20, and
21-30) based on any two of the following three criteria:

m  First Cutpoint Location. The value that defines the upper end of the lowest binned category (for
example, avalue of 10 indicates a range that includes all values up to 10).

®  Number of Cutpoints. The number of binned categories is the number of cutpoints plus one. For
example, 9 cutpoints generate 10 binned categories.

m  Width. The width of each interval. For example, avalue of 10 would bin age in yearsinto
10-year intervals.
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Equal Percentiles Based on Scanned Cases. Generates binned categories with an equal number
of casesin each bin (using the aempirical algorithm for percentiles), based on either of the
following criteria:

®  Number of Cutpoints. The number of binned categories is the number of cutpoints plus one. For
example, three cutpoints generate four percentile bins (quartiles), each containing 25% of
the cases.

®  Width (%). Width of each interval, expressed as a percentage of the total number of cases.
For example, avalue of 33.3 would produce three binned categories (two cutpoints), each
containing 33.3% of the cases.

If the source variable contains arelatively small number of distinct values or alarge number
of cases with the same value, you may get fewer bins than requested. If there are multiple
identical values at a cutpoint, they will al go into the same interval; so the actual percentages
may not always be exactly equal.

Cutpoints at Mean and Selected Standard Deviations Based on Scanned Cases. Generates binned
categories based on the values of the mean and standard deviation of the distribution of the
variable.

m If you don't select any of the standard deviation intervals, two binned categories will be
created, with the mean as the cutpoint dividing the bins.

® You can select any combination of standard deviation intervals based on one, two, and/or
three standard deviations. For example, selecting all three would result in eight binned
categories—six binsin one standard deviation intervals and two bins for cases more than three
standard deviations above and below the mean.

In anormal distribution, 68% of the cases fall within one standard deviation of the mean; 95%,
within two standard deviations; and 99%, within three standard deviations. Creating binned
categories based on standard deviations may result in some defined bins outside of the actual data
range and even outside of the range of possible data values (for example, a negative salary range).

Note: Calculations of percentiles and standard deviations are based on the scanned cases. If you
limit the number of cases scanned, the resulting bins may not contain the proportion of cases that
you wanted in those bins, particularly if the datafile is sorted by the source variable. For example,
if you limit the scan to the first 100 cases of a data file with 1000 cases and the datafileis sorted in
ascending order of age of respondent, instead of four percentile age bins each containing 25% of
the cases, you may find that the first three bins each contain only about 3.3% of the cases, and the
last bin contains 90% of the cases.

Copying Binned Categories

When creating binned categories for one or more variables, you can copy the binning
specifications from ancther variable to the currently selected variable or from the selected variable
to multiple other variables.
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Figure 7-17
Copying bins to or from the current variable
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To Copy Binning Specifications

Define binned categories for at least one variable—but do not click OK or Paste.

Select (click) avariable in the Scanned Variable List for which you have defined binned categories.
Click To Other Variables.

Select the variables for which you want to create new variables with the same binned categories.

vV vV v v Vv

Click Copy.
or

» Select (click) avariable in the Scanned Variable List to which you want to copy defined binned
categories.

» Click From Another Variable.
» Select the variable with the defined binned categories that you want to copy.
» Click Copy.

If you have specified value labels for the variable from which you are copying the binning
specifications, those are also copied.

Note: Once you click OK in the Visual Binning main dialog box to create new binned variables
(or close the dialog box in any other way), you cannot use Visual Binning to copy those binned
categories to other variables.

User-Missing Values in Visual Binning

Values defined as user-missing (values identified as codes for missing data) for the source variable
are not included in the binned categories for the new variable. User-missing values for the source
variables are copied as user-missing values for the new variable, and any defined value labels for
missing value codes are also copied.
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If amissing value code conflicts with one of the binned category values for the new variable,
the missing value code for the new variable is recoded to a nonconflicting value by adding 100 to
the highest binned category value. For example, if avalue of 1 is defined as user-missing for the
source variable and the new variable will have six binned categories, any cases with avaue of 1
for the source variable will have a value of 106 for the new variable, and 106 will be defined as
user-missing. If the user-missing value for the source variable had a defined value |abel, that 1abel
will be retained as the value label for the recoded value of the new variable.

Note: If the source variable has a defined range of user-missing values of the form LO-n, where n

is a positive number, the corresponding user-missing values for the new variable will be negative
numbers.
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In anideal situation, your raw data are perfectly suitable for the type of analysis you want
to perform, and any relationships between variables are either conveniently linear or neatly
orthogonal. Unfortunately, thisisrarely the case. Preliminary analysis may reveal inconvenient
coding schemes or coding errors, or data transformations may be required in order to expose the
true relationship between variables.

You can perform data transformations ranging from simple tasks, such as collapsing categories
for analysis, to more advanced tasks, such as creating new variables based on complex equations
and conditional statements.

Computing Variables

Use the Compute dialog box to compute values for a variable based on numeric transformations of
other variables.

® You can compute values for numeric or string (al phanumeric) variables.

m You can create new variables or replace the values of existing variables. For new variables,
you can also specify the variable type and label.

m You can compute values selectively for subsets of data based on logical conditions.

m  You can use alarge variety of built-in functions, including arithmetic functions, statistical
functions, distribution functions, and string functions.

124
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Figure 8-1
Compute Variable dialog box
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To Compute Variables

» From the menus choose:

Transform
Compute Variable...

» Typethe name of asingle target variable. It can be an existing variable or a new variable to be
added to the active dataset.

» To build an expression, either paste components into the Expression field or type directly in
the Expression field.

®m You can paste functions or commonly used system variables by selecting a group from the
Function group list and double-clicking the function or variable in the Functions and Special
Variableslist (or select the function or variable and click the arrow adjacent to the Function
group list). Fill in any parameters indicated by question marks (only applies to functions).
The function group labeled All provides a listing of al available functions and system
variables. A brief description of the currently selected function or variable is displayed in
areserved areain the dialog box.

m  String constants must be enclosed in quotation marks or apostrophes.
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m If values contain decimals, aperiod (.) must be used as the decimal indicator.
m  For new string variables, you must also select Type & Label to specify the data type.

Compute Variable: If Cases

The If Cases dialog box allows you to apply data transformations to selected subsets of cases,
using conditional expressions. A conditional expression returns avalue of true, false, or missing
for each case.

Figure 8-2
Compute Variable If Cases dialog box
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If the result of a conditional expression istrue, the case isincluded in the selected subset.

If the result of a conditional expression isfalse or missing, the case is not included in the
selected subset.

m  Most conditional expressions use one or more of the six relational operators (<, >, <=, >=,
=, and ~=) on the calculator pad.

m  Conditiona expressions can include variable names, constants, arithmetic operators, numeric
(and other) functions, logical variables, and relational operators.

Compute Variable: Type and Label

By default, new computed variables are numeric. To compute a new string variable, you must
specify the data type and width.
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Label. Optional, descriptive variable label up to 255 byteslong. You can enter alabel or use the
first 110 characters of the compute expression as the label.

Type. Computed variables can be numeric or string (alphanumeric). String variables cannot be
used in calculations.

Figure 8-3
Type and Label dialog box

k| Compute Variable: Type and Label

Lakel

@ Lahel: |.£werage manthly expense |

@ Uze expression as label
Type
@ riumeric

@ String

[ Cancel ][ Help ]

Functions

Many types of functions are supported, including:
Arithmetic functions

Statistical functions

String functions

Date and time functions

Distribution functions

Random variable functions

Missing value functions

Scoring functions (PASW Statistics Server only)

For more information and a detailed description of each function, type functions on the Index tab
of the Help system.

Missing Values in Functions
Functions and simple arithmetic expressions treat missing values in different ways. In the
expression:
(varl+var2+var3) /3

the result ismissing if a case has amissing value for any of the three variables.
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In the expression:
MEAN (varl, var2, var3)

the result ismissing only if the case has missing values for all three variables.

For statistical functions, you can specify the minimum number of arguments that must have
nonmissing values. To do so, type a period and the minimum number after the function name, asin:

MEAN.2 (varl, var2, var3)

Random Number Generators

The Random Number Generators dialog box alows you to select the random number generator
and set the starting sequence value so you can reproduce a sequence of random numbers.

Active Generator. Two different random number generators are available:

m Version 12 Compatible. The random number generator used in version 12 and previous rel eases.
If you need to reproduce randomized results generated in previous releases based on a
specified seed value, use this random number generator.

m  Mersenne Twister. A newer random number generator that is more reliable for simulation
purposes. If reproducing randomized results from version 12 or earlier is not an issue, use this
random number generator.

Active Generator Initialization. The random number seed changes each time a random number is
generated for use in transformations (such as random distribution functions), random sampling, or
case weighting. To replicate a sequence of random numbers, set the initialization starting point
value prior to each analysis that uses the random numbers. The value must be a positive integer.
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Figure 8-4
Random Number Generators dialog box
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To select the random number generator and/or set the initialization value:

» From the menus choose:

Transform
Random Number Generators

Count Occurrences of Values within Cases

This dialog box creates a variable that counts the occurrences of the same value(s) in alist of
variables for each case. For example, a survey might contain alist of magazines with yes/no
check boxes to indicate which magazines each respondent reads. You could count the number

of yes responses for each respondent to create a new variable that contains the total number of
magazines read.
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Figure 8-5
Count Occurrences of Values within Cases dialog box
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To Count Occurrences of Values within Cases

» From the menus choose;

Transform
Count Values within Cases...

» Enter atarget variable name.
» Select two or more variables of the same type (numeric or string).

» Click Define Values and specify which value or values should be counted.

Optionally, you can define a subset of cases for which to count occurrences of values.

Count Values within Cases: Values to Count

The value of the target variable (on the main dialog box) isincremented by 1 each time one of the
selected variables matches a specification in the Values to Count list here. If acase matches severa
specifications for any variable, the target variable is incremented severa times for that variable.
Value specifications can include individual values, missing or system-missing values, and
ranges. Ranges include their endpoints and any user-missing values that fall within the range.
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Figure 8-6
Values to Count dialog box
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Count Occurrences: If Cases

The If Cases dialog box allows you to count occurrences of values for a selected subset of
cases, using conditional expressions. A conditional expression returns a value of true, false, or
missing for each case.
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Figure 8-7
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For general considerations on using the If Cases dialog box, see Compute Variable: If Cases

onp. 126.

Shift Values

Shift Values creates new variables that contain the values of existing variables from preceding

or subsequent cases.

Name. Name for the new variable. This must be a name that does not aready exist in the active

dataset.

Get value from earlier case (lag). Get the value from a previous case in the active dataset. For
example, with the default number of cases value of 1, each case for the new variable has the value

of the original variable from the case that immediately precedesit.

Get value from following case (lead). Get the value from a subsequent case in the active dataset.
For example, with the default number of cases value of 1, each case for the new variable has the

value of the original variable from the next case.
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Number of cases to shift. Get the value from the nth preceding or subsequent case, where nisthe
value specified. The value must be a non-negative integer.

m If split file processing is on, the scope of the shift islimited to each split group. A shift value
cannot be obtained from a case in a preceding or subsequent split group.

m Filter statusisignored.

m  The value of the result variable is set to system-missing for the first or last n casesin the
dataset or split group, where nisthe value specified for Number of cases to shift. For example,
using the Lag method with a value of 1 would set the result variable to system-missing for
the first case in the dataset (or first case in each split group).

m  User-missing values are preserved.

m Dictionary information from the original variable, including defined value labels and
user-missing value assignments, is applied to the new variable. (Note: Custom variable
attributes are not included.)

m A variable label is automatically generated for the new variable that describes the shift
operation that created the variable.

To Create a New Variable with Shifted Values
» From the menus, choose:

Transform

Shift Values

» Select the variable to use as the source of values for the new variable.
» Enter aname for the new variable.
» Select the shift method (lag or lead) and the number of cases to shift.
» Click Change.

» Repeat for each new variable you want to create.

Recoding Values

You can modify data values by recoding them. Thisis particularly useful for collapsing or
combining categories. You can recode the values within existing variables, or you can create new
variables based on the recoded va ues of existing variables.

Recode into Same Variables

The Recode into Same Variables dialog box allows you to reassign the values of existing variables
or collapse ranges of existing values into new values. For example, you could collapse salaries
into salary range categories.

You can recode numeric and string variables. If you select multiple variables, they must all be
the same type. You cannot recode numeric and string variables together.
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Figure 8-8
Recode into Same Variables dialog box
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To Recode Values of a Variable

» From the menus choose;

Transform
Recode into Same Variables...

» Select the variables you want to recode. If you select multiple variables, they must be the same
type (numeric or string).

» Click OId and New Values and specify how to recode values.

Optionally, you can define a subset of casesto recode. The If Cases dialog box for doing thisisthe
same as the one described for Count Occurrences.

Recode into Same Variables: 0ld and New Values

You can define values to recode in this dialog box. All value specifications must be the same data
type (numeric or string) as the variables selected in the main dialog box.

0ld Value. The value(s) to be recoded. You can recode single values, ranges of values, and missing
values. System-missing values and ranges cannot be selected for string variables because neither
concept applies to string variables. Ranges include their endpoints and any user-missing values
that fall within the range.

m Value. Individual old value to be recoded into a new value. The value must be the same data
type (numeric or string) as the variable(s) being recoded.

m  System-missing. VValues assigned by the program when values in your data are undefined
according to the format type you have specified, when a numeric field is blank, or when
avalue resulting from a transformation command is undefined. Numeric system-missing
values are displayed as periods. String variables cannot have system-missing values, since
any character islegal in a string variable.
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System- or user-missing. Observations with valuesthat either have been defined as user-missing
values or are unknown and have been assigned the system-missing value, which is indicated
with a period (.).

Range. Inclusive range of values. Not available for string variables. Any user-missing values
within the range are included.

All other values. Any remaining values not included in one of the specifications on the
Old-New list. This appears as EL SE on the Old-New list.

New Value. The single value into which each old value or range of valuesis recoded. You can
enter avalue or assign the system-missing value.

Value. Value into which one or more old values will be recoded. The value must be the same
data type (numeric or string) as the old value.

System-missing. Recodes specified old values into the system-missing value. The
system-missing value is not used in calculations, and cases with the system-missing value are
excluded from many procedures. Not available for string variables.

0ld—>New. The list of specifications that will be used to recode the variable(s). You can add,
change, and remove specifications from the list. The list is automatically sorted, based on the
old value specification, using the following order: single values, missing values, ranges, and all
other values. If you change a recode specification on the list, the procedure automatically re-sorts
the list, if necessary, to maintain this order.

Figure 8-9

Old and New Values dialog box

E Recode into Same Variables: Old and New Values
ol Yalue Mewy Walue
() *alue: @ Yalue: | |

@' System-mizsing

@ system-missing il --= Mew:

@ system- or user-missing Loweest thru 24999 = 1
25000 thru 49999 = 2
50000 thru 74999 = 3
7000 thru Highest --= 4

() Range:

© Range, LOWWEST through value:

@ Range, value through HGHEST:

[ ]

@ a ather values

[ Cancel ][ Help ]
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Recode into Different Variables

The Recode into Different Variables dialog box allows you to reassign the values of existing
variables or collapse ranges of existing values into new values for a new variable. For example,
you could collapse salaries into a new variable containing salary-range categories.

® You can recode numeric and string variables.
m  You can recode numeric variables into string variables and vice versa

m If you select multiple variables, they must al be the same type. You cannot recode numeric
and string variables together.

Figure 8-10
Recode into Different Variables dialog box

E Recode into Different Variables

Mumeric Yariable -= Output Yariable: Enfin it

‘gﬁ Emploves Code [id] salary --= salcat

G%l Gender [gender] Mame:

Date of Birth [beate]
d:l Educational Level (vea...

ol Empioyment Category [... Lahel

@@ Beginning Salary [zalb...
f Maonths since Hire [jobiti...

f Previous Experience (...

ol Minarity Classification [...

Old and Mew Values...
(optional caze election condition)

(psste ) (goset ) (conca) ek

]

To Recode Values of a Variable into a New Variable

» From the menus choose;

Transform
Recode into Different Variables...

» Select the variables you want to recode. If you select multiple variables, they must be the same
type (numeric or string).

» Enter an output (new) variable name for each new variable and click Change.

» Click Old and New Values and specify how to recode values.

Optionally, you can define a subset of casesto recode. The If Cases dialog box for doing thisisthe
same as the one described for Count Occurrences.

Recode into Different Variables: 0ld and New Values

You can define values to recode in this dialog box.
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0ld Value. The value(s) to be recoded. You can recode single values, ranges of values, and
missing values. System-missing values and ranges cannot be selected for string variables because
neither concept applies to string variables. Old values must be the same data type (numeric or
string) as the original variable. Ranges include their endpoints and any user-missing values

that fall within the range.

m Value. Individua old value to be recoded into a new value. The value must be the same data
type (numeric or string) as the variable(s) being recoded.

m  System-missing. Values assigned by the program when values in your data are undefined
according to the format type you have specified, when a numeric field is blank, or when
avalue resulting from a transformation command is undefined. Numeric system-missing
values are displayed as periods. String variables cannot have system-missing values, since
any character islegal in a string variable.

m System- or user-missing. Observations with values that either have been defined as user-missing
values or are unknown and have been assigned the system-missing value, which is indicated
with a period (.).

m  Range. Inclusive range of values. Not available for string variables. Any user-missing values
within the range are included.

m  All other values. Any remaining values not included in one of the specifications on the
Old-New list. This appears as EL SE on the Old-New list.

New Value. The single value into which each old value or range of valuesisrecoded. New values
can be numeric or string.

m Value. Value into which one or more old values will be recoded. The value must be the same
data type (numeric or string) as the old value.

m  System-missing. Recodes specified old values into the system-missing value. The
system-missing value is not used in calculations, and cases with the system-missing value are
excluded from many procedures. Not available for string variables.

m  Copy old values. Retainsthe old value. If some valuesdon't require recoding, use thisto include
the old values. Any old values that are not specified are not included in the new variable, and
cases with those values will be assigned the system-missing value for the new variable.

Output variables are strings. Defines the new, recoded variable as a string (al phanumeric) variable.
The old variable can be numeric or string.

Convert numeric strings to numbers. Converts string values containing numbers to numeric values.
Strings containing anything other than numbers and an optional sign (+ or -) are assigned the
system-missing value.

0ld—>New. Thelist of specifications that will be used to recode the variable(s). You can add,
change, and remove specifications from the list. The list is automatically sorted, based on the
old value specification, using the following order: single values, missing values, ranges, and all
other values. If you change a recode specification on the list, the procedure automatically re-sorts
the list, if necessary, to maintain this order.
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Figure 8-11
Old and New Values dialog box
ﬁ Recode into Different Variables: Old and New Values
el Yalue ey Walue
@ wvalue: @ walue: | |

© System-mizzing

@ System-mizsing (@] Copy ald value(=s)
© System- ar uzer-missing 0l = Mew:
© Range: Lowwest thru 24999 --= 1

23000 thru 499588 --= 2
30000 thru 74889 = 3
75000 thru Highest --= 4

© Range, LOWEST through value:

@ Range, value through HIGHEST:

I:I [7] output wariables are strings

@ al cther values IE

[Continue][ Cancel ][ Help ]

Automatic Recode

The Automatic Recode dialog box allows you to convert string and numeric values into
consecutive integers. When category codes are not sequential, the resulting empty cells reduce
performance and increase memory requirements for many procedures. Additionally, some

procedures cannot use string variables, and some require consecutive integer values for factor
levels.
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Figure 8-12
Automatic Recode dialog box

ﬁ Automatic Recode

Wariahle-= Mew Mame

‘gﬁ Emploves Code [id] q‘la Qencer--=gender2
Dete of Birth [bdate]
d:l Educational Level (yea...

d:l Employment Category [
f Current Salary [salary]

5& Beginning Salary [zalb...
&’ Marnths since Hire [jokti...

f Previous Experience (.. ey Mame:
ol Minarity Classification [...
Add Mewy hlame

Recode Starting from

® Lowwest value © Highest value

[7] uze the same recoding scheme for all variables
[] Treat blank string values &= user-missing

Template

|| Save template as:

[ |[ Paste ][Eeset ][Cancel][ Help ]

m  The new variable(s) created by Automatic Recode retain any defined variable and value labels

from the old variable. For any values without a defined value label, the original value is used
asthelabel for the recoded value. A table displays the old and new values and value labels.

String values are recoded in aphabetical order, with uppercase |etters preceding their
lowercase counterparts.

Missing values are recoded into missing values higher than any nonmissing values, with their
order preserved. For example, if the origina variable has 10 nonmissing values, the lowest

missing value would be recoded to 11, and the value 11 would be a missing value for the
new variable.

Use the same recoding scheme for all variables. This option allows you to apply a single

autorecoding scheme to all the selected variables, yielding a consistent coding scheme for al the
new variables.

If you select this option, the following rules and limitations apply:

All variables must be of the same type (numeric or string).

All observed values for all selected variables are used to create a sorted order of values to
recode into sequential integers.

User-missing values for the new variables are based on the first variable in the list with
defined user-missing values. All other values from other original variables, except for
system-missing, are treated as valid.
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Treat blank string values as user-missing. For string variables, blank or null values are not treated
as system-missing. This option will autorecode blank strings into a user-missing value higher
than the highest nonmissing value.

Templates

You can save the autorecoding scheme in a template file and then apply it to other variables
and other datafiles.

For example, you may have alarge number of alphanumeric product codes that you autorecode
into integers every month, but some months new product codes are added that change the original
autorecoding scheme. If you save the original scheme in atemplate and then apply it to the new
data that contain the new set of codes, any new codes encountered in the data are autorecoded into
values higher than the last value in the template, preserving the original autorecode scheme of
the original product codes.

Save template as. Saves the autorecode scheme for the selected variablesin an externa template
file.

m  The template contains information that maps the original nonmissing values to the recoded
values.

®  Only information for nonmissing values is saved in the template. User-missing value
information is not retained.

m |f you have selected multiple variables for recoding but you have not selected to use the same
autorecoding scheme for all variables or you are not applying an existing template as part of
the autorecoding, the template will be based on thefirst variable in the list.

m |f you have selected multiple variables for recoding and you have also selected Use the same
recoding scheme for all variables and/or you have selected Apply template, then the template
will contain the combined autorecoding scheme for al variables.

Apply template from. Applies a previously saved autorecode template to variables selected for
recoding, appending any additional values found in the variables to the end of the scheme and
preserving the relationship between the original and autorecoded values stored in the saved
scheme.

m All variables selected for recoding must be the same type (numeric or string), and that type
must match the type defined in the template.

m  Templates do not contain any information on user-missing values. User-missing values for
the target variables are based on the first variable in the original variable list with defined
user-missing values. All other values from other original variables, except for system-missing,
are treated as valid.

m Value mappings from the template are applied first. All remaining values are recoded into
values higher than the last value in the template, with user-missing values (based on the
first variable in the list with defined user-missing values) recoded into values higher than
the last vaid value.

m If you have selected multiple variables for autorecoding, the template is applied first, followed
by a common, combined autorecoding for all additional values found in the selected variables,
resulting in a single, common autorecoding scheme for all selected variables.
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To Recode String or Numeric Values into Consecutive Integers

Transform

Automatic Recode...

Rank Cases

From the menus choose;

Select one or more variables to recode.

For each selected variable, enter a name for the new variable and click New Name.

The Rank Cases dialog box allows you to create new variables containing ranks, normal and
Savage scores, and percentile values for numeric variables.

New variable names and descriptive variable labels are automatically generated, based on the
origina variable name and the selected measure(s). A summary table lists the original variables,

the new variables, and the variable labels. (Note: The automatically generated new variable names
are limited to a maximum length of 8 bytes.)

Optionally, you can:

Rank cases in ascending or descending order.

Organize rankings into subgroups by selecting one or more grouping variables for the By list.
Ranks are computed within each group. Groups are defined by the combination of values of
the grouping variables. For example, if you select gender and minority as grouping variables,
ranks are computed for each combination of gender and minority.

Figure 8-13
Rank Cases dialog box

@ Rank Cases

5& Employes Code [id]

Date of Birth [beate]

d:l Educational Level (yea...
d:l Employment Categary [...
\g& Beginning Salary [zalb...
.g& honths since Hire [jokti...
‘g@ Previous Experience (...
ol Minarity Classification [...

Aszign Rank 1 to
@ smallest value

() Largest value

“ariahle(s)

f Current Salary [salary]

[+ Display summary tables

(o) (esste ) (goset.) (cance)) (e

Rank Types...

To Rank Cases

» From the menus choose;

Transform
Rank Cases...
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» Select one or more variables to rank. You can rank only numeric variables.

Optionally, you can rank casesin ascending or descending order and organize ranks into subgroups.

Rank Cases: Types

You can select multiple ranking methods. A separate ranking variable is created for each method.
Ranking methods include simple ranks, Savage scores, fractional ranks, and percentiles. You can
also create rankings based on proportion estimates and normal scores.

Rank. Simple rank. The value of the new variable equalsiits rank.
Savage score. The new variable contains Savage scores based on an exponentia distribution.

Fractional rank. The value of the new variable equals rank divided by the sum of the weights of
the nonmissing cases.

Fractional rank as percent. Each rank is divided by the number of cases with valid values and
multiplied by 100.

Sum of case weights. The value of the new variable equals the sum of case weights. The new
variable is a constant for all cases in the same group.

Ntiles. Ranks are based on percentile groups, with each group containing approximately the
same number of cases. For example, 4 Ntiles would assign arank of 1 to cases below the 25th
percentile, 2 to cases between the 25th and 50th percentile, 3 to cases between the 50th and 75th
percentile, and 4 to cases above the 75th percentile.

Proportion estimates. Estimates of the cumulative proportion of the distribution corresponding
to a particular rank.

Normal scores. The z scores corresponding to the estimated cumulative proportion.
Proportion Estimation Formula. For proportion estimates and normal scores, you can select the
proportion estimation formula: Blom, Tukey, Rankit, Or Van der Waerden.

m  Blom. Creates new ranking variable based on proportion estimates that uses the formula (r-3/8)
/ (w+1/4), where w is the sum of the case weights and r is the rank.

m  Tukey. Usesthe formula (r-1/3) / (w+1/3), wherer is the rank and w is the sum of the case
weights.

m  Rankit. Usesthe formula (r-1/2) / w, where w is the number of observations and r is the rank,
ranging from 1 to w.

m  Van der Waerden. VVan der Waerden's transformation, defined by the formula r/(w+1), where w
is the sum of the case weights and r is the rank, ranging from 1 to w.
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Figure 8-14
Rank Cases Types dialog box
B Rank Cases: Types
[+ Rank [ Fractional rank as %
Ei Savage score [I Sum of case weights
[ Fractiorel rark [ rtiess:

Ei Proportion estimates Ei Mormal scores

Propartion Estimation Fortmula

IEContinueél[ Cancel ][ Helpp ]

Rank Cases: Ties

This dialog box controls the method for assigning rankings to cases with the same value on
the original variable.

Figure 8-15
Rank Cases Ties dialog box
ﬁ Rank Cases: Ties

Rank Aszigned to Ties
® Mean © Low © High

(@] Sequertial ranks ta unigue values

IEContinueél[ Cancel ][ Help ]

The following table shows how the different methods assign ranksto tied values:

Value Mean Low High Sequential
10 1 1 1 1
15 3 2 4 2
15 3 2 4 2
15 3 2 4 2
16 5 5 5 3
20 6 6 6 4

Date and Time Wizard

The Date and Time Wizard simplifies a number of common tasks associated with date and time
variables.
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To Use the Date and Time Wizard

» From the menus choose;

Transform
Date and Time Wizard...

» Select the task you wish to accomplish and follow the steps to define the task.

Figure 8-16
Date and Time Wizard introduction screen

ﬁ Date and Time Wizard

Wielcome to the date and time wizard

‘Wyhat wwould yvou like to do?

@) Learn how dates and times are represented in PASYY Statistics

© Create a datetime variable from variables halding parts of dates or times
@ Calculate with dates and times

© Extract part of a date or time variable
@ Assign periodicity to a dataset (for time series data). This ends the wizard and opens the
Define Dates dialog box

Learn how dates and times are represented. This choice |eads to a screen that provides a brief
overview of date/time variables in PASW Statistics. By clicking on the Help button, it also
provides alink to more detailed information.

Create a date/time variable from a string containing a date or time. Use this option to create a
date/time variable from a string variable. For example, you have a string variable representing
dates in the form mm/dd/yyyy and want to create a date/time variable from this.

Create a date/time variable from variables holding parts of dates or times. This choice alows
you to construct a date/time variable from a set of existing variables. For example, you have
avariable that represents the month (as an integer), a second that represents the day of the
month, and a third that represents the year. You can combine these three variablesinto a
single date/time variable.

Calculate with dates and times. Use this option to add or subtract values from date/time
variables. For example, you can calculate the duration of a process by subtracting a variable
representing the start time of the process from another variable representing the end time

of the process.
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m Extract a part of a date or time variable. This option allows you to extract part of a date/time
variable, such as the day of the month from a date/time variable, which has the form
mm/dd/yyyy.

®m  Assign periodicity to a dataset. This choice takes you to the Define Dates dialog box, used to
create date/time variables that consist of a set of sequential dates. This feature istypicaly
used to associate dates with time series data.

Note: Tasks are disabled when the dataset lacks the types of variables required to accomplish the
task. For instance, if the dataset contains no string variables, then the task to create a date/time
variable from a string does not apply and is disabled.

Dates and Times in PASW Statistics

Variables that represent dates and times in PASW Statistics have a variable type of numeric,
with display formats that correspond to the specific date/time formats. These variables are
generally referred to as date/time variables. Date/time variables that actually represent dates are
distinguished from those that represent a time duration that is independent of any date, such as 20
hours, 10 minutes, and 15 seconds. The latter are referred to as duration variables and the former
as date or date/time variables. For a completelist of display formats, see “Date and Time” in the
“Universals’ section of the Command Syntax Reference.

Date and date/time variables. Date variables have aformat representing adate, such asmm/dd/yyyy.
Date/time variables have a format representing a date and time, such as dd-mmm-yyyy hh:mm:ss.
Internally, date and date/time variables are stored as the number of seconds from October 14,
1582. Date and date/time variables are sometimes referred to as date-format variables.

m Both two- and four-digit year specifications are recognized. By default, two-digit years
represent a range beginning 69 years prior to the current date and ending 30 years after the
current date. Thisrangeis determined by your Options settings and is configurable (from the
Edit menu, choose Options and click the Data tab).

m  Dashes, periods, commas, slashes, or blanks can be used as delimiters in day-month-year
formats.

m  Months can be represented in digits, Roman numerals, or three-character abbreviations, and
they can be fully spelled out. Three-letter abbreviations and fully spelled-out month names
must be in English; month names in other languages are not recognized.

Duration variables. Duration variables have aformat representing atime duration, such as hh:mm.
They are stored internally as seconds without reference to a particular date.

m |Intime specifications (applies to date/time and duration variables), colons can be used as
delimiters between hours, minutes, and seconds. Hours and minutes are required, but seconds
areoptional. A period is required to separate seconds from fractional seconds. Hours can be
of unlimited magnitude, but the maximum value for minutesis 59 and for seconds is 59.999....

Current date and time. The system variable $TIME holds the current date and time. It represents
the number of seconds from October 14, 1582, to the date and time when the transformation
command that uses it is executed.
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Create a Date/Time Variable from a String

To create a date/time variable from a string variable:

» Select Create a date/time variable from a string containing a date or time on the introduction screen of
the Date and Time Wizard.

Select String Variable to Convert to Date/Time Variable

Figure 8-17
Create date/time variable from string variable, step 1

Ef Date and Time Wizard - Step 1 of 2

Cregte a DatedTime Yariable from a String Variable
Select the string variable holding the date or time to convert.

Select the appropriste pattern and press Mext. If no pattern fits the string, the wizard cannot convert this variakle.

“ariables: Sample Walues:

&4 StartDateStr 104282002 s
=

& EnciDateStr 102892002
0101 #1996

Patterns:
dd-mmm-yyyy -
clol-mimim-yy
do-mm-yyyy
do-mim-yy
mmfdd ey
ey
el mim ey
el iy
yyedcid
Wyl

» Select the string variable to convert in the Variables list. Note that the list displays only string
variables.

» Select the pattern from the Patterns list that matches how dates are represented by the string
variable. The Sample Values list displays actual values of the selected variable in the datafile.
Values of the string variable that do not fit the selected pattern result in a value of system-missing
for the new variable.
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Figure 8-18
Create date/time variable from string variable, step 2

Data Transformations

ﬁ Date and Time Wizard - Step 2 of 2

Create a DateTime Yariable from a String Yariable

Complete or edit the specifications for new variakle

InpLt Watiakle:

InfaLt Format:
[StartDatestr | [rmicinyyy |
Result Yariahle: OQutput Format:
[startpate | [emmmorryy <
cel-thimm-yy
mitricc iy -
Yariahle Label:

|F‘rc-c:ess Start Date

Execution

@ Creste the vatiable now ()] Paste the syntac into the syrtax window

= Back |; Finizh | [ Cancel ][ Help ]

» Enter aname for the Result Variable. This cannot be the name of an existing variable.

Optionally, you can:

m  Select adate/time format for the new variable from the Output Format list.

m  Assign adescriptive variable label to the new variable.

Create a Date/Time Variable from a Set of Variables

To merge a set of existing variables into a single date/time variable:

» Select Create a date/time variable from variables holding parts of dates or times on the introduction

screen of the Date and Time Wizard.
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Select Variables to Merge into Single Date/Time Variable

Figure 8-19
Create date/time variable from variable set, step 1

ﬁ Date and Time Wizard - Step 1 of 2

“ou can create a datetime or duration variable from numeric variables cortaining parts of the information such as years morths, and hours.
The parts (other than seconds) should not already be datedime or durstion variables,

Select the appropriste variables below and press Mext

Wariahbles: Year:

,.é Process Start Date [Star... d | f Eirth'ear | Days:

j,; Process End Date [EndD... = | |

45 Time1 Month:

&8 Time2 - rsg? BirthMonth | - Hours:

f BirthHour Day of Marth: | |

Birthihdinut T

& Srtinuie [ ertrpay | Minutes:

ef& BirthCrateTime -y | |
Day of year:
| | Seconds:

Result Yariable Type: Date

» Select the variables that represent the different parts of the date/time.

Some combinations of selections are not alowed. For instance, creating a date/time variable
from Year and Day of Month isinvalid because once Year is chosen, afull date isrequired.

You cannot use an existing date/time variable as one of the parts of the final date/time variable
you're creating. Variables that make up the parts of the new date/time variable must be
integers. The exception is the allowed use of an existing date/time variable as the Seconds
part of the new variable. Since fractional seconds are allowed, the variable used for Seconds
is not required to be an integer.

Values, for any part of the new variable, that are not within the allowed range result in avalue
of system-missing for the new variable. For instance, if you inadvertently use a variable
representing day of month for Month, any cases with day of month valuesin the range 14-31
will be assigned the system-missing value for the new variable since the valid range for
months in PASW Statistics is 1-13.
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Specify Date/Time Variable Created by Merging Variables

Figure 8-20
Create date/time variable from variable set, step 2

ﬁ Date and Time Wizard - Step 2 of 2

“ou can name and label the result variable and assign an appropriste format

Result Yariakhle: Output Formiat:

BirthCrate dd-mmm-yyyy -~
clel-thimi-yy
it ey
mimidcl by
ol mim ey
el mm.yy
yyclced
¥y yrclcled bt

Wariahle Label.

[Birth Date

Execution

@ Create the variable now @ Paste the syntax into the syntax window

= Back |; Finizh | [ Cancel ][ Help ]

» Enter aname for the Result Variable. This cannot be the name of an existing variable.

» Select adate/time format from the Output Format list.

Optionally, you can:
m  Assign adescriptive variable label to the new variable.

Add or Subtract Values from Date/Time Variables

To add or subtract values from date/time variables:

» Select Calculate with dates and times on the introduction screen of the Date and Time Wizard.



150

Chapter 8

Select Type of Calculation to Perform with Date/Time Variables

Figure 8-21
Add or subtract values from date/time variables, step 1

Ef pate and Time Wizard - Step 1 of 3

Do Calculstions on Dates:

Choose one of the following tazks and press MNext

® Ade or subtract & durstion from & date (e.g., add & month to an age or add & time variable
to a datedime variable)

(@] Calculste the number of time units between tvwo dates (e.g., calculate an age in years from
a hirthdate and another date)

®m  Add or subtract a duration from a date. Use this option to add to or subtract from a date-format
variable. You can add or subtract durationsthat are fixed values, such as 10 days, or the values
from a numeric variable, such as a variable that represents years.

m Calculate the number of time units between two dates. Use this option to obtain the difference
between two dates as measured in a chosen unit. For example, you can obtain the number of
years or the number of days separating two dates.

m  Subtract two durations. Use this option to obtain the difference between two variables that
have formats of durations, such as hh:mm or hh:mm:ss.

Note: Tasks are disabled when the dataset lacks the types of variables required to accomplish the
task. For instance, if the dataset lacks two variables with formats of durations, then the task to
subtract two durations does not apply and is disabled.

Add or Subtract a Duration from a Date

To add or subtract a duration from a date-format variable;

» Select Add or subtract a duration from a date on the screen of the Date and Time Wizard labeled
Do Calculations on Dates.
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Select Date/Time Variable and Duration to Add or Subtract

Figure 8-22
Add or subtract duration, step 2

ﬁ Date and Time Wizard - Step 2 of 3

Add to or subtract from a date or datefime variable

Choose a date or datetime variable. Then choose either a durstion variable or an ordinary variable or enter & constant; Set the duration units
and operation choice appropristely, and press Mext.

Wariahles: Date:
& Customer ID [custid] | 42 Date of intisl praduct license [P... |

A "
5 Current date and time [FTIME] Duration Variable:

Date of last uparade [LastU)| .
Pd { Kl | @& Years of tech support [Support] | Unit:
45 Date of next release [MextRel]
Duration Constant: \‘r‘ears—'/

Operation
@ Adsition
@ Subtraction

FTIME i= the current date and time.

» Select adate (or time) variable.

» Select aduration variable or enter a value for Duration Constant. Variables used for durations
cannot be date or date/time variables. They can be duration variables or simple numeric variables.

» Select the unit that the duration represents from the drop-down list. Select Duration if using a
variable and the variable is in the form of a duration, such as hh:mm or hh:mm:ss.
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Specify Result of Adding or Subtracting a Duration from a Date/Time Variable

Figure 8-23
Add or subtract duration, step 3

ﬁ Date and Time Wizard - Step 3 of 3

Enter a name for the result variahle and optionally, a lahel. The format for the input datedime variable wil be applied to the result variable.

Calculstion:
PurDate + Support (ears)

Result Yariable:
ISupEndDate

Wariable Label.
|End date for support

Execution

@® Create the variable now @] Pazte the syntax into the syntax window

= Back |: Finizh | [ Cancel ][ Help ]

» Enter aname for Result Variable. This cannot be the name of an existing variable.

Optionally, you can:
m Assign adescriptive variable label to the new variable.
Subtract Date-Format Variables

To subtract two date-format variables:

» Select Calculate the number of time units between two dates on the screen of the Date and Time
Wizard labeled Do Calculations on Dates.
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Select Date-Format Variables to Subtract

Figure 8-24
Subtract dates, step 2

ﬁ Date and Time Wizard - Step 2 of 3

Calculate the number of time units between two date or datetime variables.

The result will be an integer variable. Any fractional part of a unit will be discarded. The result will be & duration wariable. Only duration
variables are shown in the varisbles list below.

Wariahles: Datel:
&2 Current dete and time .. 49 Date of next release [NextRel] |

45 Date of initial product 1i... inus Date2:
« ,4?,; Date of last upgrade [LastUp] |

Unit:

Years e

Result Treatment

@ Truncate to integer
@ Found to integer
©) Retain fractional part

For month and year units, the result is based on
average unit length unless truncation is used.

FTIME i= the current date and time.

» Select the variables to subtract.
» Select the unit for the result from the drop-down list.

» Select how the result should be calculated (Result Treatment).

Result Treatment

The following options are available for how the result is calcul ated:

m  Truncate to integer. Any fractional portion of the result isignored. For example, subtracting
10/28/2006 from 10/21/2007 returns aresult of O for years and 11 for months.

®  Round to integer. The result is rounded to the closest integer. For example, subtracting
10/28/2006 from 10/21/2007 returns aresult of 1 for years and 12 for months.

m Retain fractional part. The complete value is retained; no rounding or truncation is applied.
For example, subtracting 10/28/2006 from 10/21/2007 returns a result of 0.98 for years and
11.76 for months.

For rounding and fractional retention, the result for yearsis based on average number of days

in ayear (365.25), and the result for months is based on the average number of daysin a month
(30.4375). For example, subtracting 2/1/2007 from 3/1/2007 (m/d/y format) returns a fractional
result of 0.92 months, whereas subtracting 3/1/2007 from 2/1/2007 returns a fractional difference
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of 1.02 months. This also affects values calculated on time spans that include leap years. For
example, subtracting 2/1/2008 from 3/1/2008 returns a fractional difference of 0.95 months,
compared to 0.92 for the same time span in a non-leap year.

Datel Date 2 Years Months
Truncate | Round Fraction | Truncate | Round Fraction
10/21/2006 10/28/2007 1 1 1.02 12 12 12.22
10/28/2006 10/21/2007 0 1 .98 1 12 11.76
2/1/2007 3/1/2007 0 0 .08 1 1 .92
2/1/2008 3/1/2008 0 0 .08 1 1 .95
3/1/2007 4/1/2007 0 0 .08 1 1 1.02
4/1/2007 5/1/2007 0 0 .08 1 1 .99
Specify Result of Subtracting Two Date-Format Variables
Figure 8-25
Subtract dates, step 3
Ef Date and Time Wizard - Step 3of 3

Calculation: MextRel - Lastip

Result Yariahle:

Unit=:

|YearsLastUp

Years

Wariahle Lakbel:

|Years since last upgrade

"Execu‘tion

® Creste the vatiable now Paste the syntac into the syrtax window

[< Eack] |F|n|3h] [ Cancel ][ Helg ]

» Enter aname for Result Variable. This cannot be the name of an existing variable.

Optionally, you can:

m Assign adescriptive variable label to the new variable.
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Subtract Duration Variables

To subtract two duration variables:

» Select Subtract two durations on the screen of the Date and Time Wizard |abeled Do Calculations
on Dates.

Select Duration Variables to Subtract

Figure 8-26
Subtract two durations, step 2

EA Date and Time Wizard - Step 2 of 3

Calculste the difference between two durstion varisbles.

The result will be a duration variable. Only durstion variables are shoven in the variables list below,

Wariakles: Duration:

¥ [ B Timez |
minus Durationz:
(5 Time |

» Sedlect the variables to subtract.
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Specify Result of Subtracting Two Duration Variables

Figure 8-27
Subtract two durations, step 3

ﬁ Date and Time Wizard - Step 3 of 3

Calculation: Time2 - Time1

Result Variable: Output Formiat:

TDift hh:mm

hh:mnss
hh:mimiss.s
dddd hh:mm

ddd hh:mmess
deled hhemim:ss.s

“ariable Label:

|Time Difference

|'Execution

@ Create the variable now Pazte the syntax inta the syntac window

= Back |: Finizh | [ Cancel ][ Help ]

» Enter aname for Result Variable. This cannot be the name of an existing variable.

» Select aduration format from the Output Format list.
Optionally, you can:

m  Assign adescriptive variable label to the new variable.

Extract Part of a Date/Time Variable

To extract a component—such as the year—from a date/time variable:

» Select Extract a part of a date or time variable on the introduction screen of the Date and Time
Wizard.
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Select Component to Extract from Date/Time Variable
Figure 8-28
Get part of a date/time variable, step 1

ﬁ Date and Time Wizard - Step 1 of 2

[ |
et part of a date or time as an ordinary numeric variable.

Choose a varishle and the component of the date or time to extract.

Wariahles: Diate or Time:
42 Current date and time [$TIME] | ef@ BirthDateTime |
Ef Process Start Date [StartDate] Format  dd-mmm-yyyy bk imim

4% Process End Date [EndDate]

e‘@ Timed Unit to Extract:

&5 Timez

|Time portion

FTIME i the current dete and time.

» Select the variable containing the date or time part to extract.

» Select the part of the variable to extract, from the drop-down list. You can extract information
from dates that is not explicitly part of the display date, such as day of the week.
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Specify Result of Extracting Component from Date/Time Variable

Figure 8-29
Get part of a date/time variable, step 2

ﬁ Date and Time Wizard - Step 2 of 2
It wariable: EirthDateTime
Unit Extractec: Time partion
Result YWariahle: Cutput Format:
[BirthTime hh:mm
hh:mm: ss
hh:mm:ss .=
deld hh:mm
ddd hh:mmiss
ddd hhimmizz.s

Watiahle Label:
[Birth Hour and Minute

Execution

@ Create the vatiable now @ Paste the syntax inta the syntac windaw

= Back |: Finizh | [ Cancel ][ Help ]

» Enter aname for Result Variable. This cannot be the name of an existing variable.

» If you're extracting the date or time part of a date/time variable, then you must select a format

from the Output Format list. In cases where the output format is not required, the Output Format
list will be disabled.

Optionally, you can:
m  Assign adescriptive variable label to the new variable.

Time Series Data Transformations

Several datatransformations that are useful in time series analysis are provided:

m  Generate date variables to establish periodicity and to distinguish between historical,
validation, and forecasting periods.

m Create new time series variables as functions of existing time series variables.
m  Replace system- and user-missing values with estimates based on one of several methods.

A time seriesis obtained by measuring a variable (or set of variables) regularly over a period
of time. Time series data transformations assume a data file structure in which each case (row)
represents a set of observations at a different time, and the length of time between casesisuniform.
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Define Dates

The Define Dates dialog box allows you to generate date variables that can be used to establish the
periodicity of atime series and to label output from time series analysis.

Figure 8-30
Define Dates dialog box

E Define Dates

Cazes Are:

Firat Caze |s:

Days, hours -
Days, wark hour(8) Periodicity st higher
iWeeks, days, hours leve

Weeks, work days, hours Wask: EI
Minutes

Hours, minutes Day: T

Days, haurs, minutes Hour: EI 24
Seconds

Minutes, seconds
Hours, minutes, seconds

Current Dates:
Mone

(Lo (ot (conce) Cer)

Cases Are. Defines the time interval used to generate dates.

®  Not dated removes any previously defined date variables. Any variables with the following
names are deleted: year , quarter_, month_, week , day , hour_, minute , second_, and
date .

B Custom indicates the presence of custom date variables created with command syntax (for
example, afour-day workweek). This item merely reflects the current state of the active
dataset. Selecting it from the list has no effect.

First Case Is. Defines the starting date value, which is assigned to the first case. Sequential values,
based on the time interval, are assigned to subsequent cases.

Periodicity at higher level. Indicates the repetitive cyclica variation, such as the number of months
in ayear or the number of daysin aweek. The value displayed indicates the maximum value you
can enter. For hours, minutes, and seconds the maximum is the displayed value minus one.

A new numeric variable is created for each component that is used to define the date. The new
variable names end with an underscore. A descriptive string variable, date , is also created
from the components. For example, if you selected Weeks, days, hours, four new variables are
created: week , day , hour_, and date .

If date variables have aready been defined, they are replaced when you define new date
variables that will have the same names as the existing date variables.

To Define Dates for Time Series Data

» From the menus choose;

Data
Define Dates...
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» Select atimeinterval from the Cases Arelist.

» Enter the value(s) that define the starting date for First Case I's, which determines the date assigned
to the first case.

Date Variables versus Date Format Variables

Date variables created with Define Dates should not be confused with date format variables
defined in the Variable View of the Data Editor. Date variables are used to establish periodicity for
time series data. Date format variables represent dates and/or times displayed in various date/time
formats. Date variables are simple integers representing the number of days, weeks, hours, and so
on, from a user-specified starting point. Internally, most date format variables are stored as the
number of seconds from October 14, 1582.

Create Time Series

The Create Time Series dialog box allows you to create new variables based on functions of
existing numeric time series variables. These transformed values are useful in many time series
analysis procedures.

Default new variable names are the first six characters of the existing variable used to create
it, followed by an underscore and a sequential number. For example, for the variable price, the
new variable name would be price_1. The new variables retain any defined value labels from
the original variables.

Available functions for creating time series variables include differences, moving averages,
running medians, lag, and lead functions.
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Figure 8-31
Create Time Series dialog box

@ Create Time Series

“ariahle-= Mew name

f demand price_1=DIFF(price 1]
f income

& morth_
f price

& year_

Mame and Function

Name: |price 1 |

Function:

|Difference ' |

Orcler:

Current Periodicity: Mone

(o (poste ) (oset ) (cancer) (e

To Create New Time Series Variables

» From the menus choose;

Transform
Create Time Series...

» Select the time series function that you want to use to transform the original variable(s).

» Select the variable(s) from which you want to create new time series variables. Only numeric
variables can be used.
Optionally, you can:
m  Enter variable names to override the default new variable names.
m  Change the function for a selected variable.

Time Series Transformation Functions

Difference. Nonseasonal difference between successive values in the series. The order is the
number of previous values used to calculate the difference. Because one observation is lost
for each order of difference, system-missing values appear at the beginning of the series. For
example, if the difference order is 2, the first two cases will have the system-missing value for
the new variable.
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Seasonal difference. Difference between series values a constant span apart. The span is based on
the currently defined periodicity. To compute seasonal differences, you must have defined date
variables (Data menu, Define Dates) that include a periodic component (such as months of the
year). The order is the number of seasona periods used to compute the difference. The number
of cases with the system-missing value at the beginning of the seriesis equal to the periodicity
multiplied by the order. For example, if the current periodicity is 12 and the order is 2, thefirst 24
cases will have the system-missing value for the new variable.

Centered moving average. Average of a span of series values surrounding and including the current
value. The span isthe number of seriesvalues used to compute the average. If the span iseven, the
moving average is computed by averaging each pair of uncentered means. The number of cases
with the system-missing value at the beginning and at the end of the series for a span of nisequal
to n/2 for even span values and (n—1)/2 for odd span values. For example, if the spanis 5, the
number of cases with the system-missing value at the beginning and at the end of the seriesis 2.

Prior moving average. Average of the span of series values preceding the current value. The spanis
the number of preceding series values used to compute the average. The number of cases with the
system-missing value at the beginning of the seriesis equal to the span value.

Running medians. Median of a span of series values surrounding and including the current value.
The span is the number of series values used to compute the median. If the span is even, the
median is computed by averaging each pair of uncentered medians. The number of cases with the
system-missing value at the beginning and at the end of the series for a span of nisequal to n/2 for
even span values and (n—1)/2 for odd span values. For example, if the span is 5, the number of
cases with the system-missing value at the beginning and at the end of the seriesis 2.

Cumulative sum. Cumulative sum of series values up to and including the current value.

Lag. Value of a previous case, based on the specified lag order. The order is the number of
cases prior to the current case from which the value is obtained. The number of cases with the
system-missing value at the beginning of the seriesis equal to the order value.

Lead. Value of a subsequent case, based on the specified lead order. The order is the number of
cases after the current case from which the value is obtained. The number of cases with the
system-missing value at the end of the seriesis equal to the order value.

Smoothing. New series values based on a compound data smoother. The smoother starts with
arunning median of 4, which is centered by a running median of 2. It then resmoothes these
values by applying a running median of 5, arunning median of 3, and hanning (running weighted
averages). Residuals are computed by subtracting the smoothed series from the original series.
Thiswhole processis then repeated on the computed residuas. Finally, the smoothed residuals are
computed by subtracting the smoothed values obtained the first time through the process. Thisis
sometimes referred to as T4253H smoothing.

Replace Missing Values

Missing observations can be problematic in analysis, and some time series measures cannot
be computed if there are missing values in the series. Sometimes the value for a particular
observation is simply not known. In addition, missing data can result from any of the following:

m  Each degree of differencing reduces the length of a series by 1.
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m  Each degree of seasonal differencing reduces the length of a series by one season.

m If you create new series that contain forecasts beyond the end of the existing series (by
clicking a Save button and making suitable choices), the original series and the generated
residual series will have missing data for the new observations.

m  Some transformations (for example, the log transformation) produce missing data for certain
values of the original series.

Missing data at the beginning or end of a series pose no particular problem; they simply shorten
the useful length of the series. Gaps in the middle of a series (embedded missing data) can be
a much more serious problem. The extent of the problem depends on the analytical procedure
you are using.

The Replace Missing Values dialog box allows you to create new time series variables from
existing ones, replacing missing values with estimates computed with one of several methods.
Default new variable names are the first six characters of the existing variable used to create it,
followed by an underscore and a sequential number. For example, for the variable price, the
new variable name would be price_1. The new variables retain any defined value labels from
the original variables.

Figure 8-32
Replace Missing Values dialog box
B Replace Missing Values
Mewy Wariable(s):
f demand demand_1 = SMEAN{demancd)
f income
‘gﬁ month_
f price
& yest_
Mame and hethod
MName: |demand_1 | Change
Method |Mean of nearby poirts =
Span of nearbry points:
@ rumber: O

| ok |[ Paste ][geset ][Cance|][ Help ]

To Replace Missing Values for Time Series Variables

» From the menus choose;

Transform
Replace Missing Values...

» Select the estimation method you want to use to replace missing values.

» Select the variable(s) for which you want to replace missing values.
Optionally, you can:
m  Enter variable names to override the default new variable names.
m Change the estimation method for a selected variable.
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Estimation Methods for Replacing Missing Values

Series mean. Replaces missing values with the mean for the entire series.

Mean of nearby points. Replaces missing values with the mean of valid surrounding values. The
span of nearby points is the number of valid values above and below the missing value used
to compute the mean.

Median of nearby points. Replaces missing values with the median of valid surrounding values.
The span of nearby points is the number of valid values above and below the missing value
used to compute the median.

Linear interpolation. Replaces missing values using a linear interpolation. The last valid value
before the missing value and the first valid value after the missing value are used for the
interpolation. If thefirst or last case in the series has a missing value, the missing value is not
replaced.

Linear trend at point. Replaces missing values with the linear trend for that point. The existing
seriesis regressed on an index variable scaled 1 to n. Missing values are replaced with their
predicted values.

Scoring Data with Predictive Models

The process of applying a predictive model to a set of datais referred to as scoring the data.
PASW Statistics, PASW Modeler, and AnswerTree have procedures for building predictive
models such as regression, clustering, tree, and neural network models. Once a model has been
built, the model specifications can be saved as an XML file containing all of the information
necessary to reconstruct the model. The PASW Statistics Server product then provides the means
to read an XML model file and apply the model to a dataset.

Example. A credit application is rated for risk based on various aspects of the applicant and
the loan in question. The credit score obtained from the risk model is used to accept or reject
the loan application.

Scoring is treated as a transformation of the data. The model is expressed internally as a set

of numeric transformations to be applied to a given set of variables—the predictor variables
specified in the model—in order to obtain a predicted result. In this sense, the process of scoring
data with a given model is inherently the same as applying any function, such as a square root
function, to a set of data.

Scoring is only available with PASW Statistics Server and can be done interactively by users
working in distributed analysis mode. For scoring large datafiles, you'll probably want to make
use of the Batch Facility, a separate executable provided with PASW Statistics Server. For
information about using the Batch Facility, see the Batch Facility User’s Guide, provided as a
PDF file on the PASW Statistics Server product CD.

The scoring process consists of the following:
Loading a modd from afilein XML (PMML) format.

Computing your scores as a new variable, using the ApplyModel or StrApplyModel function
available in the Compute Variable dialog box.
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For details concerning the ApplyModel Of StrapplyModel function, see Scoring Expressions
in the Transformation Expressions section of the Command Syntax Reference.

The following table lists the procedures that support the export of model specificationsto XML.
The exported models can be used with PASW Statistics Server to score new data as described
above. Thefull list of model types that can be scored with PASW Statistics Server is provided in
the description of the applyModel function.

Procedure name Command name Option
Discriminant DISCRIMINANT Base

Linear Regression REGRESSION Base

TwoStep Cluster TWOSTEP CLUSTER Base

Generalized Linear Models GENLIN Advanced Statistics
Complex Samples General Linear Model | CSGLM Complex Samples
Complex Samples Logistic Regression CSLOGISTIC Complex Samples
Complex Samples Ordinal Regression CSORDINAL Complex Samples
Logistic Regression LOGISTIC REGRESSION Regression
Multinomial Logistic Regression NOMREG Regression
Decision Tree TREE Decision Tree

Loading a Saved Model

The Load Model dialog box allows you to load predictive models saved in XML (PMML) format
and is only available when working in distributed analysis mode. Loading modelsis a necessary

first step to scoring data with them.

Figure 8-33
Load Model output
hodel Yariables
SPSS Variables Mame Label Type Wiclth Role Meazurement
Aoe_Graup Age_Group Age group Mumeric g | Factor MarmiraEl
Freguenc:

& ¥ Frecguency Mumber of purchases | Mumeric T | Covariste | Continuous
Gender Gender Gender String 6 | Factar Matminal
Has_Broacdband

- Has_Broadband Has h"”?'e brozdband Mumeric 10 | Factor Mormiral

connection

Ha=s_Chiled Ha=_Chiled Has children Mumeric 10 | Factar Marminal

Incame_Graup Income_Group Income group Mumeric 10 | Factor Mormiral

Log_Amourt K

£ Amou Log_Amaourit Log-transformed Mumeric g | Covariste | Cortinuous
amaurit

Recency Recency Days since last Mumeric 10 | Covarigte | Continuous
purchasze

Response Response Response Mumeric 10 | Target Mormiral

To Load a Model

» From the menus choose;

Transform
Prepare Model
Load Model...
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>

>

Figure 8-34
Prepare Model Load Model dialog box
Prepare Model: Load Model
MNarne: mregression
Cihymultinomial_logistic_merged, xml
Missing Yalues
(#) Use value Substitution
O Use System-Missing n
To apply this model, use the Server Only
functions: ApplyModel or StrApplyModel located in
Compute TransForm,

Enter a name to associate with this model. Each loaded model must have a unique name.

Click File and select amodel file. The resulting Open File dialog box displays the files that are
availablein distributed analysis mode. Thisincludes files on the machine where PASW Statistics
Server isinstalled and files on your local computer that reside in shared folders or on shared drives.

Note: When you score data, the model will be applied to variables in the active dataset with the
same names as the variables from the model file. You can map variables in the original model
to different variables in the active dataset with the use of command syntax (see the MODEL
HANDLE command).

Name. A name used to identify thismodel. The rules for valid model names are the same as for
variable names (see Variable Names in Chapter 5 on p. 70), with the addition of the $ character as
an allowed first character. You will use this name to specify the model when scoring data with
the ApplyModel or StrApplyModel functions.

File. The XML (PMML) file containing the model specifications.

Missing Values

This group of options controls the treatment of missing values, encountered during the scoring
process, for the predictor variables defined in the model. A missing value in the context of scoring
refers to one of the following:

m A predictor variable contains no value. For numeric variables, this means the system-missing
value. For string variables, this means a null string.

m  The value has been defined as user-missing, in the model, for the given predictor. Values
defined as user-missing in the active dataset, but not in the model, are not treated as missing
values in the scoring process.

m The predictor variable is categorical and the value is not one of the categories defined in
the model.

Use Value Substitution. Attempt to use value substitution when scoring cases with missing values.
The method for determining a value to substitute for a missing value depends on the type of
predictive model.
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m  PASW Statistics Models. For independent variablesin linear regression and discriminant
models, if mean value substitution for missing values was specified when building and
saving the model, then this mean value is used in place of the missing value in the scoring
computation, and scoring proceeds. If the mean valueis not available, then the system-missing
value is returned.

®  AnswerTree models & TREE command models. For the CHAID and Exhaustive CHAID models,
the biggest child node is selected for a missing split variable. The biggest child nodeis the
one with the largest population among the child nodes using learning sample cases. For
C&RT and QUEST models, surrogate split variables (if any) are used first. (Surrogate
splits are splits that attempt to match the original split as closely as possible using aternate
predictors.) If no surrogate splits are specified or al surrogate split variables are missing, the
biggest child node is used.

m  PASW Modeler models. Linear regression models are handled as described under PASW
Statistics models. Logistic regression models are handled as described under Logistic
Regression models. C&RT Tree models are handled as described for C& RT models under
AnswerTree models.

m Logistic Regression models. For covariatesin logistic regression models, if a mean value of the
predictor was included as part of the saved model, then this mean vaue is used in place of the
missing value in the scoring computation, and scoring proceeds. If the predictor is categorical
(for example, afactor in alogistic regression model), or if the mean value is not available,
then the system-missing value is returned.

Use System-Missing. Return the system-missing value when scoring a case with a missing value.

Displaying a List of Loaded Models

You can obtain alist of the currently loaded models. From the menus (only available in distributed
analysis mode) choose:

Transform
Prepare Model
List Model(s)

Thiswill generate aModel Handles table. The table contains alist of all currently loaded models
and includes the name (referred to as the model handle) assigned to the model, the type of model,
the path to the model file, and the method for handling missing values.
Figure 8-35
Listing of loaded models

Model Handles

Walidation
Mame Type Input File Mame handling Mizsing hancdling
mregression MNOMREG Crmodelzimregression . xml O SUBSTITUTE
tree TREE Crmodelstree xml On SUBSTITUTE
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Additional Features Available with Command Syntax

From the Load Model dialog box, you can paste your selections into a syntax window and edit the
resulting MODEL. HANDLE command syntax. This allows you to:

m  Map variablesin the original model to different variablesin the active dataset (with the map
subcommand). By default, the model is applied to variables in the active dataset with the
same names as the variables from the model file.

See the Command Syntax Reference for complete syntax information.
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Data files are not aways organized in the ideal form for your specific needs. You may want
to combine datafiles, sort the data in a different order, select a subset of cases, or change the
unit of analysis by grouping cases together. A wide range of file transformation capabilitiesis
available, including the ability to:

Sort data. You can sort cases based on the value of one or more variables.

Transpose cases and variables. The PASW Statistics data file format reads rows as cases and
columns as variables. For datafilesin which this order is reversed, you can switch the rows and
columns and read the data in the correct format.

Merge files. You can merge two or more datafiles. You can combine files with the same variables
but different cases or the same cases but different variables.

Select subsets of cases. You can restrict your analysis to a subset of cases or perform simultaneous
analyses on different subsets.

Aggregate data. You can change the unit of analysis by aggregating cases based on the value
of one or more grouping variables.

Weight data. You can weight cases for analysis based on the value of aweight variable.

Restructure data. You can restructure data to create a single case (record) from multiple cases
or create multiple cases from a single case.

Sort Cases

This dialog box sorts cases (rows) of the data file based on the values of one or more sorting
variables. You can sort cases in ascending or descending order.

m If you select multiple sort variables, cases are sorted by each variable within categories
of the preceding variable on the Sort list. For example, if you select gender as the first
sorting variable and minority as the second sorting variable, cases will be sorted by minority
classification within each gender category.

m  The sort sequence is based on the locale-defined order (and is not necessarily the same as the
numerical order of the character codes). The default locale is the operating system locale.
You can control the locale with the Language setting on the General tab of the Options dialog
box (Edit menu).

169
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Figure 9-1
Sort Cases dialog box

ﬁ Sort Cases

Sort byt

f Employes Code [id] 63 Fender [aender] - Azcending
Dste of Eirth [bdste] d:l Minority Classification [minority] -- 2scending
d:l Eclucational Level (years) [educ]

d:l Employment Category [jobost]
f Current Salary [salary] Sort Croer
gﬁ Eeginning Salary [salbegin] @ Ascending
f Maorths since Hire [joktime] -
gﬁ Frevious Experience (months) [preve:xp]

@' Descending

|0K][ Paste ][geset ][Cancel][ Help ]

To Sort Cases

» From the menus choose:

Data
Sort Cases...

» Select one or more sorting variables.

Sort Variables

You can sort the variables in the active dataset based on the values of any of the variable attributes
(e.q., variable name, data type, measurement level), including custom variable attributes.

m Values can be sorted in ascending or descending order.
m You can save the original (pre-sorted) variable order in a custom variable attribute.

m  Sorting by values of custom variable attributesis limited to custom variable attributes that are
currently visible in Variable View.

For more information on custom variable attributes, see Custom Variable Attributes.

To Sort Variables

In Variable View of the Data Editor:

» Right-click on the attribute column heading and from the context menu choose Sort Ascending
or Sort Descending.

or

» From the menusin Variable View or Data View, choose:

Data
Sort Variables

Select the attribute you want to use to sort variables.

» Select the sort order (ascending or descending).
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Figure 9-2
Sort Variables dialog
@ Sort Variables

Yariable View Columns

Mame -~
Type
Wickth
Decimals
Lakel
Walues
Missing
Calurmns:
Align
heasure hd

Sort Croer

@ Ascending
© Dezcending

I_qf: Save the current (pre-sorted) variable order in a nevr attribute

Attribute name: |origina|_order

[ |[ Paste ][Eeset ][Cance|][ Help ]

m  Thelist of variable attributes matches the attribute column names displayed in Variable View
of the Data Editor.

®  You can save the original (pre-sorted) variable order in a custom variable attribute. For each
variable, the value of the attribute is an integer value indicating its position prior to sorting; so
by sorting variables based on the value of that custom attribute you can restore the original
variable order.

Transpose

>

Transpose creates a new data file in which the rows and columns in the original datafile are
transposed so that cases (rows) become variables and variables (columns) become cases.
Transpose automatically creates new variable names and displays alist of the new variable names.

® A new string variable that contains the original variable name, case_lhl, is automatically
created.

m If the active dataset contains an ID or name variable with unique values, you can useit asthe
name variable, and its values will be used as variable names in the transposed datafile. If itis
anumeric variable, the variable names start with the letter V, followed by the numeric value.

m  User-missing values are converted to the system-missing value in the transposed data file.

To retain any of these values, change the definition of missing values in the Variable View
in the Data Editor.

To Transpose Variables and Cases

From the menus choose;

Data
Transpose...
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» Select one or more variables to transpose into cases.

Merging Data Files

You can merge data from two files in two different ways. You can:

m  Merge the active dataset with another open dataset or PASW Statistics data file containing the
same variables but different cases.

m  Merge the active dataset with another open dataset or PASW Statistics data file containing the
same cases but different variables.

To Merge Files

» From the menus choose;

Data
Merge Files

» Select Add Cases or Add Variables.

Figure 9-3
Selecting files to merge

EF] Add Cases to region1.sav[DataSet1]

Select a dataszet from the list of open datasets ar from a file ta merge with the active dataset
@ an open dataset

region? sav[DataSet2]

© An external PASWY Statistics data file

Mon-PASW Statistics data files must be opened in PASWYW Statistics before they can be uzed as part of & merge.

[Continue][ Cancel ][ Help ]

Add Cases

Add Cases merges the active dataset with a second dataset or external PASW Statistics datafile
that contains the same variables (columns) but different cases (rows). For example, you might
record the same information for customers in two different sales regions and maintain the data
for each region in separate files. The second dataset can be an external PASW Statistics datafile
or a dataset available in the current session.
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Figure 9-4
Add Cases dialog box
Ef Add Cases From region2.sav[DataSet2]

Unpaired Yariahles: wariahles in Mew Active Dataszef:
datebrth(*) name:s=
ownrent(*) age
2E%[*F) ecuyrs
brthidatel+) - famsize
sex=l+] inzome

jobcat
marital

|| Indicate case source as variable:

(M=Active dataset
(+)=region? sav[DataSet2]

(o

(psste ) (meset ) (canca] e |

Unpaired Variables. Variables to be excluded from the new, merged datafile. Variables from the

active dataset are identified with an asterisk (*). Variables from the other dataset are identified

with aplus sign (+). By default, thislist contains:

m Variables from either datafile that do not match a variable name in the other file. You can
create pairs from unpaired variables and include them in the new, merged file.

m Variables defined as numeric datain one file and string data in the other file. Numeric
variables cannot be merged with string variables.

m  String variables of unequal width. The defined width of a string variable must be the samein
both data files.

Variables in New Active Dataset. Variables to be included in the new, merged datafile. By default,
all of the variables that match both the name and the data type (numeric or string) are included
on the list.

®  You can remove variables from thelist if you do not want them to be included in the merged
file.

m  Any unpaired variables included in the merged file will contain missing data for cases from
the file that does not contain that variable.

Indicate case source as variable. |ndicates the source data file for each case. Thisvariable has a
value of O for cases from the active dataset and a value of 1 for cases from the external datafile.

To Merge Data Files with the Same Variables and Different Cases

Open at least one of the data files that you want to merge. If you have multiple datasets open,
make one of the datasets that you want to merge the active dataset. The cases from thisfile
will appear first in the new, merged datafile.
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From the menus choose;

Data
Merge Files
Add Cases...

Select the dataset or external PASW Statistics data file to merge with the active dataset.
Remove any variables that you do not want from the Variablesin New Active Dataset list.
Add any variable pairs from the Unpaired Variables list that represent the same information

recorded under different variable namesin the two files. For example, date of birth might have the
variable name brthdate in one file and datebrth in the other file.

To Select a Pair of Unpaired Variables
Click one of the variables on the Unpaired Variables list.

Ctrl-click the other variable on the list. (Press the Ctrl key and click the left mouse button at
the same time.)

Click Pair to move the variable pair to the Variables in New Active Dataset list. (The variable
name from the active dataset is used as the variable name in the merged file))

Figure 9-5
Selecting pairs of variables with Ctrl-click
£ Add Cases From region2.sav[DataSet 2]
Unpaired Yariables: Wariables in New Active Dataset:
datebirthi*) narmes=
owenrent(*) e
sex(*) eduyrs
brihclatel+) » famsize
sexal+]
E Add Cases From region2.sav[DataSet2]
Unpaired Yariables: “ariables in Mewr Active Dataset:
ovenrent(*) Names=
sex*) age
e sex+] eduyrs
famsize
income
(*=Active iobost
) marital
[+)=region
datebrth & brihdate
= l__. Inclicate case source as variahle:

(*)=Active dataset
(+)=region2 sav[DataSet2]

(Lo (paste ) (geset ) (cance) e |
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Add Cases: Rename

You can rename variables from either the active dataset or the other dataset before moving them

from the unpaired list to the list of variables to be included in the merged data file. Renaming
variables enables you to:

m  Usethe variable name from the other dataset rather than the name from the active dataset for
variable pairs.

®m  Include two variables with the same name but of unmatched types or different string widths.
For example, to include both the numeric variable sex from the active dataset and the string
variable sex from the other dataset, one of them must be renamed first.

Add Cases: Dictionary Information

Any existing dictionary information (variable and value labels, user-missing values, display
formats) in the active dataset is applied to the merged datafile.

m If any dictionary information for a variable is undefined in the active dataset, dictionary
information from the other dataset is used.

m |f the active dataset contains any defined value labels or user-missing values for avariable, any
additional value labels or user-missing values for that variable in the other dataset are ignored.

Merging More Than Two Data Sources

Using command syntax, you can merge up to 50 datasets and/or datafiles. For more information,
seetheapp FILES command in the Command Syntax Reference (available from the Help menu).

Add Variables

Add Variables merges the active dataset with another open dataset or external PASW Statistics
data file that contains the same cases (rows) but different variables (columns). For example, you
might want to merge a datafile that contains pre-test results with one that contains post-test results.

m  Cases must be sorted in the same order in both datasets.

m If one or more key variables are used to match cases, the two datasets must be sorted by
ascending order of the key variable(s).

m Variable namesin the second data file that duplicate variable names in the active dataset are

excluded by default because Add Variables assumes that these variables contain duplicate
information.

Indicate case source as variable. Indicates the source data file for each case. This variable has a
value of 0 for cases from the active dataset and avalue of 1 for cases from the external datafile.
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Figure 9-6
Add Variables dialog box
B Add Variables from addvar2.sav[DataSet2]
Excluded Yariahles: Mew: Active Dataset:
income+] name=(t) P

names=l+] age(™)

income;®)
datebrthi(*)

awvnrent(*)
eduyrs(+)
famsize(+)
johcat(+) b
I_oz. Match cases on key variables in sorted files Hey Yariables:
®) Beth files provide cases idnumber
© Mon-active detaset is keved table
© Active dataset is keyed table

|| Indicate casze source &3 variable:

(*1=Active dataset
(+)=addvar2 sav[DataSet2]

Paste ][ Reset ][Cance|][ Helps ]

Excluded Variables. Variables to be excluded from the new, merged datafile. By default, thislist
contains any variable names from the other dataset that duplicate variable names in the active
dataset. Variables from the active dataset are identified with an asterisk (*). Variables from the
other dataset are identified with a plus sign (+). If you want to include an excluded variable
with a duplicate name in the merged file, you can rename it and add it to the list of variables

to be included.

New Active Dataset. Variables to be included in the new, merged dataset. By default, all unique
variable names in both datasets are included on the list.

Key Variables. If some casesin one dataset do not have matching cases in the other dataset (that is,
some cases are missing in one dataset), use key variables to identify and correctly match cases
from the two datasets. You can also use key variables with table lookup files.

m  Thekey variables must have the same names in both datasets.

m Both datasets must be sorted by ascending order of the key variables, and the order of variables
on the Key Variables list must be the same as their sort sequence.

m Casesthat do not match on the key variables are included in the merged file but are not merged
with cases from the other file. Unmatched cases contain values for only the variables in the
file from which they are taken; variables from the other file contain the system-missing value.

Non-active or active dataset is keyed table. A keyed table, or table lookup file, isafilein which
data for each “case” can be applied to multiple cases in the other datafile. For example, if one
file contains information on individual family members (such as sex, age, education) and the
other file contains overall family information (such as total income, family size, location), you
can use the file of family data as a table lookup file and apply the common family data to each
individual family member in the merged datafile.
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To Merge Files with the Same Cases but Different Variables

» Open at least one of the data files that you want to merge. If you have multiple datasets open,
make one of the datasets that you want to merge the active dataset.

» From the menus choose:

Data
Merge Files
Add Variables...

» Select the dataset or external PASW Statistics data file to merge with the active dataset.

To Select Key Variables
» Select the variables from the external file variables (+) on the Excluded Variables list.
» Select Match cases on key variables in sorted files.

» Add the variables to the Key Variables list.

The key variables must exist in both the active dataset and the other dataset. Both datasets must be
sorted by ascending order of the key variables, and the order of variables on the Key Variables
list must be the same as their sort sequence.

Add Variables: Rename

You can rename variables from either the active dataset or the other dataset before moving them to
the list of variables to be included in the merged datafile. Thisis primarily useful if you want to
include two variables with the same name that contain different information in the two files.

Merging More Than Two Data Sources

Using command syntax, you can merge up to 50 datasets and/or datafiles. For more information,
seethemMaTcH FILES command in the Command Syntax Reference (available from the Help
menu).

Aggregate Data

Aggregate Data aggregates groups of cases in the active dataset into single cases and creates a
new, aggregated file or creates new variablesin the active dataset that contain aggregated data.
Cases are aggregated based on the value of zero or more break (grouping) variables. If no break
variables are specified, then the entire dataset is a single break group.

m |f you create a new, aggregated datafile, the new data file contains one case for each group
defined by the break variables. For example, if there is one break variable with two values,
the new datafile will contain only two cases. If no break variable is specified, the new data
file will contain one case.

m |f you add aggregate variables to the active dataset, the data file itself is not aggregated.
Each case with the same value(s) of the break variable(s) receives the same values for the
new aggregate variables. For example, if gender is the only break variable, all males would
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receive the same value for a new aggregate variable that represents average age. 1f no break
variable is specified, al cases would receive the same value for a new aggregate variable
that represents average age.

Figure 9-7
Aggregate Data dialog box

B Agoregate Data

Break Variable(=):
@f Age in years [age] ‘gﬁ Marital status [marital]
f Years at current ad... 93 Gender [gender]
f Household income ...

,{I Income category in ... Aggregated Variables
é) Price of primary ve...

Summaties of Variable(z):

d:l Primary wehicle pric...

f Lewel of educstion [...
@f Vears with currert . income_mean = MEARINCome)

& Retired [retire] income_median = MEDIAMN(InCome)

d:l Wears with current
& Jab satisfaction [ioh...
é) Mumber of people in...
@ﬁ Wireless service [...

& Muttiple lines [mutting]

gﬁ Yoice mall [voice] - [ rumber of cases Mame:
¥l

Save

age_mean = MEARN(age)

(@) Add agoregated variables to active dataset
@ Create a new dataset containing only the aooregated variables

Dataset name:  ([agaregate_data

(@) Wiite & nesne data file containing only the sgaregated variables

Options for Wery Large Datasets

|| Sort file before agoregating

(ot ) (esste) (geset) (cancel) (k)

Break Variable(s). Cases are grouped together based on the values of the break variables. Each
unique combination of break variable values defines a group. When creating a new, aggregated
datafile, all break variables are saved in the new file with their existing names and dictionary
information. The break variable, if specified, can be either numeric or string.

Aggregated Variables. Source variables are used with aggregate functions to create new aggregate
variables. The aggregate variable name is followed by an optional variable label, the name of the
aggregate function, and the source variable name in parentheses.

You can override the default aggregate variable names with new variable names, provide
descriptive variable labels, and change the functions used to compute the aggregated data val ues.
You can also create a variable that contains the number of cases in each break group.
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To Aggregate a Data File

From the menus choose;

Data
Aggregate...

Optionally select break variables that define how cases are grouped to create aggregated data. If
no break variables are specified, then the entire dataset is a single break group.

Select one or more aggregate variables.

Select an aggregate function for each aggregate variable.

Saving Aggregated Results

You can add aggregate variables to the active dataset or create a new, aggregated datafile.

m Add aggregated variables to active dataset. New variables based on aggregate functions are
added to the active dataset. The datafileitself is not aggregated. Each case with the same
value(s) of the break variable(s) receives the same values for the new aggregate variables.

m Create a new dataset containing only the aggregated variables. Saves aggregated datato a
new dataset in the current session. The dataset includes the break variables that define the
aggregated cases and all aggregate variables defined by aggregate functions. The active
dataset is unaffected.

m  Write a new data file containing only the aggregated variables. Saves aggregated data to an
external datafile. The fileincludes the break variables that define the aggregated cases and all
aggregate variables defined by aggregate functions. The active dataset is unaffected.

Sorting Options for Large Data Files

For very large datafiles, it may be more efficient to aggregate presorted data.

File is already sorted on break variable(s). |f the data have already been sorted by values of the
break variables, this option enables the procedure to run more quickly and use less memory.
Use this option with caution.

m Datamust by sorted by values of the break variables in the same order as the break variables
specified for the Aggregate Data procedure.

m If you are adding variables to the active dataset, select this option only if the data are sorted
by ascending values of the break variables.

Sort file before aggregating. In very rare instances with large data files, you may find it necessary
to sort the data file by values of the break variables prior to aggregating. This option is not
recommended unless you encounter memory or performance problems.
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Aggregate Data: Aggregate Function

This dialog box specifies the function to use to calculate aggregated data values for selected
variables on the Aggregate Variables list in the Aggregate Data dialog box. Aggregate functions

include;

m  Summary functions for numeric variables, including mean, median, standard deviation, and

sum

m  Number of cases, including unweighted, weighted, nonmissing, and missing

m  Percentage or fraction of values above or below a specified value

m  Percentage or fraction of valuesinside or outside of a specified range

Figure 9-8
Aggregate Function dialog box

B Ageregate Data: Aggregate Function

Summary Statistics Specific Values Mumber of cases

@ Mean

@ Median

© sum

(0 standard Deviation
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O Last
@) Minimum
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@ Unweeighted missing

© Above
© Below
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@ Outsicle
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Aggregate Data: Variable Name and Label

Aggregate Data assigns default variable names for the aggregated variables in the new data
file. This dialog box enables you to change the variable name for the selected variable on the
Aggregate Variables list and provide a descriptive variable label. For more information, see the

topic Variable Names in Chapter 5 on p. 70.
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Figure 9-9
Variable Name and Label dialog box

&M Aggregate Data: Variable Mame and Label

Mame:

Label:

MEANM(InCOMmE)

income_mean

Average income

|§Continue§|[ Cancel ][ Hel ]

Split File

File Handling and File Transformations

Split File splits the data file into separate groups for analysis based on the values of one or more
grouping variables. If you select multiple grouping variables, cases are grouped by each variable
within categories of the preceding variable on the Groups Based On list. For example, if you
select gender as the first grouping variable and minority as the second grouping variable, cases
will be grouped by minority classification within each gender category.

®  You can specify up to eight grouping variables.

m Each eight bytes of along string variable (string variables longer than eight bytes) counts as a

variable toward the limit of eight grouping variables.

m  Cases should be sorted by values of the grouping variables and in the same order that variables
are listed in the Groups Based On list. If the datafile isn’t already sorted, select Sort the
file by grouping variables.

Figure 9-10

Split File dialog box

A split File

f Employes Code [id]

Date of Birth [beiate]

,{I Educational Level (vea...
d:l Etnplayment Category [...
g& Currert Salary [salary]
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& Previous Experience (...
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@ Analyze all cazes, do not creste groups
@ Compare groups
@ Organize output by groups

Groups Bazed on;

93 Gender [gender]

@ Sort the file by grouping variables
@ File iz already sarted

Currert Status; Analyvsis by groups is off.

Paste ][ Reset ][Cance|][ Help ]

Compare groups. Split-file groups are presented together for comparison purposes. For pivot
tables, asingle pivot table is created and each split-file variable can be moved between table
dimensions. For charts, a separate chart is created for each split-file group and the charts are
displayed together in the Viewer.
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Organize output by groups. All results from each procedure are displayed separately for each
split-file group.

To Split a Data File for Analysis

» From the menus choose;

Data
Split File...

» Select Compare groups oOr Organize output by groups.

» Select one or more grouping variables.

Select Cases

Select Cases provides several methods for selecting a subgroup of cases based on criteria that
include variables and complex expressions. You can also select arandom sample of cases. The
criteria used to define a subgroup can include:

Variable values and ranges
Date and time ranges
Case (row) numbers
Arithmetic expressions
Logical expressions

Functions
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Figure 9-11
Select Cases dialog box
E Select Cases
Select
‘gﬁ Age in years [age] - @] All cazes

& Mertal stetus [martal] @) If condition is satisfied
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f Househald incomei...
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.gﬁ Level of education ...
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d:l Years with currert ... L |
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gﬁ Mumber of people in...
& wirdless service [... Output

f Muttiple lines [muttline] @ Fitter out unzelected cases
f Woice mail [voice]
f Paging service [pag...
& nternet [internet]

& Caller 1D [callic] -

D Bazed on time or case range

(@] Copy selected cases to a new dataset

D Delete unzelected cazes

Current Status: Do nat fiter cases

[ Paste ][ Reset ][Cancel][ Help ]

All cases. Turns case filtering off and uses all cases.

If condition is satisfied. Use a conditional expression to select cases. If the result of the conditional
expression istrue, the caseis selected. If the result isfalse or missing, the caseis not selected.

Random sample of cases. Selects a random sample based on an approximate percentage or an
exact number of cases.

Based on time or case range. Selects cases based on a range of case numbers or a range of
dates/times.

Use filter variable. Use the selected numeric variable from the data file as the filter variable. Cases
with any value other than 0 or missing for the filter variable are sel ected.

Output

This section controls the treatment of unselected cases. You can choose one of the following
alternatives for the treatment of unselected cases:

m  Filter out unselected cases. Unselected cases are not included in the analysis but remain in
the dataset. You can use the unselected cases later in the session if you turn filtering off. If
you select arandom sample or if you select cases based on a conditional expression, this
generates a variable named filter_$ with avalue of 1 for selected cases and avalue of 0
for unselected cases.
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m  Copy selected cases to a new dataset. Selected cases are copied to a new dataset, leaving the
origina dataset unaffected. Unselected cases are not included in the new dataset and are | eft
in their original state in the original dataset.

Delete unselected cases. Unselected cases are deleted from the dataset. Deleted cases can be
recovered only by exiting from the file without saving any changes and then reopening the
file. The deletion of casesis permanent if you save the changes to the datafile.

Note: If you delete unselected cases and save the file, the cases cannot be recovered.

To Select a Subset of Cases

» From the menus choose;
Data

Select Cases...

» Select one of the methods for selecting cases.

» Specify the criteria for selecting cases.

Select Cases: If

This dialog box alows you to select subsets of cases using conditional expressions. A conditional
expression returns a value of true, false, or missing for each case.

Figure 9-12
Select Cases If dialog box

ﬁ Select Cases: If
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If the result of a conditional expression istrue, the caseisincluded in the selected subset.
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m If the result of a conditional expression isfalse or missing, the case is not included in the
selected subset.

m  Most conditional expressions use one or more of the six relational operators (<, >, <=, >=,
=, and ~=) on the calculator pad.

m  Conditional expressions can include variable names, constants, arithmetic operators, numeric
(and other) functions, logical variables, and relational operators.

Select Cases: Random Sample

This dialog box allows you to select a random sample based on an approximate percentage or an
exact number of cases. Sampling is performed without replacement; so, the same case cannot
be selected more than once.

Figure 9-13
Select Cases Random Sample dialog box

ﬁ Select Cases: Random Sample

Sample Size

®ia

; D % of all cases

cazes from the first Cazes

(o) (ceneer) (e

© Exactly

Approximately. Generates a random sample of approximately the specified percentage of cases.
Since this routine makes an independent pseudo-random decision for each case, the percentage of
cases selected can only approximate the specified percentage. The more cases there are in the data
file, the closer the percentage of cases selected is to the specified percentage.

Exactly. A user-specified number of cases. You must also specify the number of cases from which
to generate the sample. This second number should be less than or equal to the total number of
casesin the datafile. If the number exceeds the total number of casesin the datafile, the sample
will contain proportionally fewer cases than the requested number.

Select Cases: Range

This dialog box selects cases based on arange of case numbers or arange of dates or times.
m Caseranges are based on row number as displayed in the Data Editor.

m Date and time ranges are available only for time series data with defined date variables
(Data menu, Define Dates).
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Figure 9-14
Select Cases Range dialog box for range of cases (no defined date variables)

ﬁ Select Cases: Range

First Caze Last Case
Ohzervation:

(Coriinie] | cancest || Hew |

Figure 9-15
Select Cases Range dialog box for time series data with defined date variables

A Select Cases: Range
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Weight Cases

Weight Cases gives cases different weights (by simulated replication) for statistical analysis.

m  Thevalues of the weighting variable should indicate the number of observations represented
by single cases in your data file.

m  Cases with zero, negative, or missing values for the weighting variable are excluded from
analysis.

m Fractional values are valid and some procedures, such as Freguencies, Crosstabs, and Custom
Tables, will use fractional weight values. However, most procedures treat the weighting
variable as areplication weight and will simply round fractional weights to the nearest integer.

Some procedures ignore the weighting variable completely, and this limitation is noted in the
procedure-specific documentation.

Figure 9-16
Weight Cases dialog box

ﬁ Weight Cases

@ Do not weight cazes
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Once you apply aweight variable, it remainsin effect until you select another weight variable or
turn off weighting. If you save a weighted data file, weighting information is saved with the data
file. You can turn off weighting at any time, even after the file has been saved in weighted form.

Weights in Crosstabs. The Crosstabs procedure has several options for handling case weights.

Weights in scatterplots and histograms. Scatterplots and histograms have an option for turning
case weights on and off, but this does not affect cases with a zero, negative, or missing value for
the weight variable. These cases remain excluded from the chart even if you turn weighting

off from within the chart.

To Weight Cases

From the menus choose;

Data
Weight Cases...

Select Weight cases by.

Select a frequency variable.

The values of the frequency variable are used as case weights. For example, a case with avalue of
3 for the frequency variable will represent three cases in the weighted datafile.

Restructuring Data

Use the Restructure Data Wizard to restructure your data for the procedure that you want to use.
The wizard replaces the current file with a new, restructured file. The wizard can:

m  Restructure selected variables into cases
m  Restructure selected cases into variables
m  Transpose al data

To Restructure Data

>

From the menus choose;

Data
Restructure...

Select the type of restructuring that you want to do.

Select the data to restructure.

Optionally, you can:

m Create identification variables, which allow you to trace a value in the new file back to a
value in the original file

m  Sort the data prior to restructuring
m  Define options for the new file
m Paste the command syntax into a syntax window
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Restructure Data Wizard: Select Type

Use the Restructure Data Wizard to restructure your data. In the first dialog box, select the type of

restructuring that you want to do.

Figure 9-17
Restructure Data Wizard
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Welcome to the Restructure Data Wizard!

Thiz wizard helps wou to restructure vour data from multiple wariables (columns) in a single casze to groups of
related cazes (rows) or vice versa, or you can choose to transpose your data.

The wizard replaces the current data set with the restructured data. hote that data restructuring

Wyhat do you wwant o da?
@ Restructure selected variables into cazes

Use thiz when each case in your current dsta has some
variables that you would like to rearrange into groups of
relsted cazes in the new data set.

0 Restructure selected cases irto variables

Use thiz when you have groups of related cases that you
weant to rearrange so that data from each group are
represented as a single case inthe new data set.

(& Tranzpose all data

All cases will become variables and selected variables wyill
became cazes inthe new data zet. (Chooszing this option
will end the wizard, and the Transpose dialog will appear.)

m Restructure selected variables into cases. Choose this when you have groups of related
columns in your data and you want them to appear in groups of rows in the new datafile. If
you choose this, the wizard will display the steps for Variablesto Cases.

m Restructure selected cases into variables. Choose this when you have groups of related rows
in your data and you want them to appear in groups of columns in the new datafile. If you
choose this, the wizard will display the steps for Casesto Variables.

m Transpose all data. Choose this when you want to transpose your data. All rows will become
columns and all columnswill become rows in the new data. This choice closes the Restructure
Data Wizard and opens the Transpose Data dialog box.
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Deciding How to Restructure the Data

A variable contains information that you want to analyze—for example, a measurement or a
score. A caseis an observation—for example, an individual. In a simple data structure, each
variableisasingle columnin your data and each caseis asingle row. So, for example, if you were
measuring test scores for all studentsin aclass, al score values would appear in only one column,
and there would be arow for each student.

When you analyze data, you are often analyzing how a variable varies according to some
condition. The condition can be a specific experimental treatment, a demographic, a point in
time, or something else. In data analysis, conditions of interest are often referred to asfactors.
When you analyze factors, you have a complex data structure. You may have information about a
variablein more than one column in your data (for example, acolumn for each level of afactor), or
you may have information about a case in more than one row (for example, arow for each level of
afactor). The Restructure Data Wizard helps you to restructure files with a complex data structure.

The structure of the current file and the structure that you want in the new file determine the
choices that you make in the wizard.

How are the data arranged in the current file? The current data may be arranged so that factors are
recorded in a separate variable (in groups of cases) or with the variable (in groups of variables).

m  Groups of cases. Does the current file have variables and conditions recorded in separate
columns? For example:

var factor
8 1
9 1
3 2
1 2

In this example, the first two rows are a case group because they are related. They contain data
for the same factor level. In PASW Statistics data analysis, the factor is often referred to as a
grouping variable when the data are structured this way.

m  Groups of columns. Does the current file have variables and conditions recorded in the same
column? For example:

var_1 var_2
8 3
9 1

In this example, the two columns are avariable group because they are related. They contain
data for the same variable—var_1 for factor level 1 and var_2 for factor level 2. In PASW
Statistics data analysis, the factor is often referred to as arepeated measure when the data are
structured this way.

How should the data be arranged in the new file? Thisis usually determined by the procedure that
you want to use to analyze your data.
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®m  Procedures that require groups of cases. Your data must be structured in case groups to do
analyses that require a grouping variable. Examples are univariate, multivariate, and variance
components with General Linear Model, Mixed Models, and OLAP Cubes and independent
samples with T Test or Nonparametric Tests. If your current data structure is variable groups
and you want to do these analyses, select Restructure selected variables into cases.

m  Procedures that require groups of variables. Your data must be structured in variable groupsto
analyze repeated measures. Examples are repeated measures with General Linear Model,
time-dependent covariate analysis with Cox Regression Analysis, paired samples with T Test,
or related samples with Nonparametric Tests. |f your current data structure is case groups and
you want to do these analyses, select Restructure selected cases into variables.

Example of Variables to Cases

In this example, test scores are recorded in separate columns for each factor, A and B.

Figure 9-18

Current data for variables to cases

score_a score_b
1014.00 £R4.00
534.00 B536.00
810.00 B538.00

—

]

o

You want to do an independent-samples t test. You have a column group consisting of score_a
and score_b, but you don’t have the grouping variable that the procedure requires. Select
Restructure selected variables into cases in the Restructure Data Wizard, restructure one variable
group into a new variable named score, and create an index named group. The new datafileis
shown in the following figure.

Figure 9-19
New, restructured data for variables to cases
graup scare

SCORE_A 1014.00
SCORE_B 964.00
SCORE_A B34.00
SCORE_B B36.00
SCORE_A §10.00
SCORE_B E38.00

o =) k) —

When you run the independent-samples t test, you can now use group as the grouping variable.

Example of Cases to Variables

In this example, test scores are recorded twice for each subject—before and after a treatment.

Figure 9-20
Current data for cases to variables

id scaor time
1 1 1014.00 |bef
2 1 864.00 |aft
E 2 E84.00 [bef
4 2 B36.00 |aft
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You want to do a paired-samples t test. Your data structure is case groups, but you don’'t have
the repeated measures for the paired variables that the procedure requires. Select Restructure
selected cases into variables in the Restructure Data Wizard, use id to identify the row groupsin
the current data, and use time to create the variable group in the new file.

Figure 9-21
New, restructured data for cases to variables
id af bef |
1 1 BrR4 .00 1014.00
2 2 G36.00 534,00

When you run the paired-samplest test, you can now use bef and aft as the variable pair.

Restructure Data Wizard (Variables to Cases): Number of Variable Groups
Note: The wizard presents this step if you choose to restructure variable groups into rows.

In this step, decide how many variable groups in the current file that you want to restructure
in the new file.

How many variable groups are in the current file? Think about how many variable groups exist in
the current data. A group of related columns, called avariable group, records repeated measures
of the same variable in separate columns. For example, if you have three columnsin the current
data—w1, w2, and w3—that record width, you have one variable group. |f you have an additional
three columns—hl, h2, and h3—that record height, you have two variable groups.

How many variable groups should be in the new file? Consider how many variable groups you
want to have represented in the new datafile. You do not have to restructure all variable groups
into the new file.
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Figure 9-22
Restructure Data Wizard: Number of Variable Groups, Step 2

@Restructure Data Wizard - Step 2 of 7

Variables to Cases: Number of Variable Groups

You have chosen to restructure selected variables into groups of related cases in the new file.
A group of relsted varisbles, called a vatisble group, represents measurements on one wariable.

For example, the variable may be wicdth. If it is recorded in three separate measurements, each one
& representing a different point in time--w1 w2, and w3, then the data are arranged in a group of
\! variables.

If there is more than one variable in the file often it is also recorded in a variable group, for example
height, recarded in h1, h2, and b3

Howy mary variable groups do you weart to restructure?

;

[ [ofs ][]

® one rfor example, w1, w2, and w3)

@ More than one (for example, wi, w2, w3 and b1 h2, h3, ete.)

[« ek | [z =] [(cancal | [ rep |

m  One. Thewizard will create a single restructured variable in the new file from one variable
group in the current file.

m  More than one. The wizard will create multiple restructured variables in the new file. The
number that you specify affects the next step, in which the wizard automatically creates the
specified number of new variables.

Restructure Data Wizard (Variables to Cases): Select Variables
Note: The wizard presents this step if you choose to restructure variable groups into rows.

In this step, provide information about how the variables in the current file should be used in the
new file. You can aso create a variable that identifies the rowsin the new file.
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Figure 9-23
Restructure Data Wizard: Select Variables, Step 3

@Restructure Data Wizard - Step 3 of 7

Variables to Cases: Select Variables

For each variablz group you have inthe current data the restructured file will have one target variable.

Inthis step, choose how to identity case groups in the restructured data, and choose which variables belong with
each target variable.

Optionally, you can also choose variables to copy to the new file as Fixed Yarishles.

Wariables inthe Current File:

f scare_a Case Group Identification

f soare_b Use case number =

Warisbles to be Transposed

Fixed Variable(s):

How should the new rows be identified? You can create avariablein the new datafile that identifies
the row in the current data file that was used to create a group of new rows. The identifier can be a
sequential case number or it can be the values of the variable. Use the controls in Case Group

| dentification to define the identification variable in the new file. Click acell to change the default
variable name and provide a descriptive variable label for the identification variable.

What should be restructured in the new file? In the previous step, you told the wizard how many
variable groups you want to restructure. The wizard created one new variable for each group.
The values for the variable group will appear in that variable in the new file. Use the controlsin
Variable to be Transposed to define the restructured variable in the new file.

To Specify One Restructured Variable

Put the variables that make up the variable group that you want to transform into the Variable to be
Transposed list. All of the variablesin the group must be of the same type (numeric or string).

You can include the same variable more than once in the variable group (variables are copied
rather than moved from the source variable list); its values are repeated in the new file.

To Specify Multiple Restructured Variables
Select thefirst target variable that you want to define from the Target Variable drop-down list.

Put the variables that make up the variable group that you want to transform into the Variable to be
Transposed list. All of the variablesin the group must be of the same type (numeric or string).
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You can include the same variable more than once in the variable group. (A variable is copied
rather than moved from the source variable list, and its values are repeated in the new file.)

» Select the next target variable that you want to define, and repeat the variable selection process for
all available target variables.

m  Although you can include the same variable more than once in the same target variable group,
you cannot include the same variable in more than one target variable group.

m  Each target variable group list must contain the same number of variables. (Variables that are
listed more than once are included in the count.)

m  The number of target variable groups is determined by the number of variable groups that you
specified in the previous step. You can change the default variable names here, but you must
return to the previous step to change the number of variable groups to restructure.

m  You must define variable groups (by selecting variables in the source list) for al available
target variables before you can proceed to the next step.

What should be copied into the new file? Variables that aren’t restructured can be copied into the

new file. Their values will be propagated in the new rows. Move variables that you want to copy
into the new file into the Fixed Variable(s) list.

Restructure Data Wizard (Variables to Cases): Create Index Variables
Note: The wizard presents this step if you choose to restructure variable groups into rows.

In this step, decide whether to create index variables. Anindex isanew variable that sequentially
identifies arow group based on the original variable from which the new row was created.
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Restructure Data Wizard: Create Index Variables, Step 4

File Handling and File Transformations

@Restructure Data Wizard - Step 4 of 7

Variables to Cases: Create Index Variables
In the current deta, values for & variable group sppeat inoa single case in multiple varisbles. For example, a
single case contains the values for wl, w2 and w3,
In the new data, values for a variable group will sappear in multiple cases in a single variable. For example,
there will be three cases, one each for wil, w2, and w3,
An index is a nev variable that idertifies the group of new cases that was created from the origingl case. For
example, an index named "w" wolld have the values 1, 2 and 3

007 Howy many index vatiables do you wart to creste?
0.1
0.0 ® one
g'g Use this when a variable group records the effects of & single
oo factor, treatment or concition.
0.07
0.1
0.0
0.0 Use this when a variahle group records the effects of more than
g'g one factor, trestment or condtion.
=
1 0.08 007
0.1 0.1 ) Mane.
0.07 0.0
4 (i) [ile] Use this if index information is stored in one of the sets of
EAREET o varishles 1o be transposed.

[< Back ] it =)

[ Cancel ] [ Help ]

How many index variables should be in the new file? Index variables can be used as grouping
variablesin procedures. In most cases, asingle index variable is sufficient; however, if the variable
groups in your current file reflect multiple factor levels, multiple indices may be appropriate.

m  One. The wizard will create a single index variable.

m  More than one. The wizard will create multiple indices and enter the number of indices that
you want to create. The number that you specify affects the next step, in which the wizard

automatically creates the specified number of indices.

m None. Select thisif you do not want to create index variables in the new file.

Example of One Index for Variables to Cases

In the current data, there is one variable group, width, and one factor, time. Width was measured
three times and recorded in wl, w2, and w3.

Figure 9-25
Current data for one index
subject '] w2 w3
1 1 B.70 4.30 570
2 2 7.0 5480 5.60

WEe'll restructure the variable group into a single variable, width, and create a single numeric

index. The new data are shown in the following table.
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Figure 9-26
New, restructured data with one index
subject index width

1 1 1 B.70
2 1 2 4,30
3 1 3 570
4 2 1 70
5 2 2 580
o] 2 3 5.60

Index starts with 1 and increments for each variable in the group. It restarts each time a new row
is encountered in the original file. We can now use index in procedures that require a grouping
variable.

Example of Two Indices for Variables to Cases

When a variable group records more than one factor, you can create more than one index;
however, the current data must be arranged so that the levels of the first factor are a primary
index within which the levels of subsequent factors cycle. In the current data, there is one
variable group, width, and two factors, A and B. The data are arranged so that levels of factor B
cycle within levels of factor A.

Figure 9-27
Current data for two indices

subject w_alhl w_alh2 w_azhb w_a2h?
1 1 5.50 6.40 5.80 5.890
2 2 7.40 7.10 560 6.70

WEe'll restructure the variable group into a single variable, width, and create two indices. The new
data are shown in the following table.

Figure 9-28
New, restructured data with two indices

subject index_a index_b width

5.50
5.40
5.80
5.80
7.40
7.10
5.60
6.70

oo~ |m| e w|r|—
ral k| paf | = =) ==
ra|ra| = = raf | =| =
ra| =t = | = raf =

Restructure Data Wizard (Variables to Cases): Create One Index Variable

Note: The wizard presents this step if you choose to restructure variable groups into rows and
create one index variable.

In this step, decide what values you want for the index variable. The values can be sequential
numbers or the names of the variables in an original variable group. You can also specify a
name and a label for the new index variable.
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Figure 9-29
Restructure Data Wizard: Create One Index Variable, Step 5

File Handling and File Transformations

@Restructure Data Wizard - Step 5 of 7

Variables to Cases: Create One Index Variable

*ou have chosen to creste one index varishle. The vatisble's values can be sequentisl numbers or the names
of variables in & group

In the table you can specify the name and label for the index variable.

hat kind of index values?

® sequential numbers

Indlex Walues: 1,2,3
© Variable names
Edit the: Index Variable Name and Label:
Name Lakel Lewvels Index Values
1 irelext 3 1.2.3
[ e eim——l | ————————————— | |

(< Bk (2 =] [ Finish | [ cancet | [_rer |

For more information, see the topic Example of One Index for Variables to Cases on p. 195.

m  Sequential numbers. The wizard will automatically assign sequential numbers as index values.

m Variable names. The wizard will use the names of the selected variable group as index values.

Choose a variable group from the list.

m Names and labels. Click acell to change the default variable name and provide a descriptive

variable label for the index variable.

Restructure Data Wizard (Variables to Cases): Create Multiple Index Variables

Note: The wizard presents this step if you choose to restructure variable groups into rows and

create multiple index variables.

In this step, specify the number of levels for each index variable. You can also specify a name and

alabel for the new index variable.



198

Chapter 9

Figure 9-30
Restructure Data Wizard: Create Multiple Index Variables, Step 5

EH Restructure Data Wizard - Step 5 of 7

Variables to Cases: Create Multiple Index Variables

‘fou have chosen to have multiple index variables created in your nevw data file. The first variable in the table is the
primary index. All subsequent indexes cycle within each level of this index.

In the tahle below, enter the nurmber of levels for each index variable. You can also editthe Name and Label of
each indexvariahle.

Index Variable Mames, Labels, and Number of Levels:

Marne | Label Lewvels Index Values
1 index_a
2 indesx_h

4 [»
Total number of combined levels {product): 4

Mote that the product of the number of levels of all the index variables must equal the Total' number
displayed below the table. This nurnber equals the number of variables to be transposed

| =pack |[_mext> || Finish || cancel || Hep |

For more information, see the topic Example of Two Indices for Variablesto Cases on p. 196.

How many levels are recorded in the current file? Consider how many factor levels are recorded in
the current data. A level defines a group of cases that experienced identical conditions. If there
are multiple factors, the current data must be arranged so that the levels of the first factor are a
primary index within which the levels of subsequent factors cycle.

How many levels should be in the new file? Enter the number of levels for each index. The values
for multiple index variables are always sequential numbers. The values start at 1 and increment
for each level. The first index increments the slowest, and the last index increments the fastest.

Total combined levels. You cannot create more levels than exist in the current data. Because the

restructured data will contain one row for each combination of treatments, the wizard checks the
number of levelsthat you create. It will compare the product of the levels that you create to the
number of variables in your variable groups. They must match.

Names and labels. Click acell to change the default variable name and provide a descriptive
variable label for the index variables.

Restructure Data Wizard (Variables to Cases): Options
Note: The wizard presents this step if you choose to restructure variable groups into rows.

In this step, specify options for the new, restructured file.
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Figure 9-31
Restructure Data Wizard: Options, Step 6

@Restructure Data Wizard - Step 6 of 7

Variables to Cases: Options

In this step you can set options that will be applied to the restructured data file.

Handling of Variables not Selected

@ Drop variable(s) from the new data file

@ Keep and treat as ficed variable(s)

System Missing or Blank Yalues in al Transposed Yariables
@ Create a caze in the new file

© Digrard the data

Caze Count Yariable

|| Court the number of new cazes created by the caze in the current data

(< Bk (2 =] [ Finish | [ cancet | [_rer |

Drop unselected variables? In the Select Variables step (step 3), you selected variable groups to be
restructured, variables to be copied, and an identification variable from the current data. The data
from the selected variables will appear in the new file. If there are other variables in the current
data, you can choose to discard or keep them.

Keep missing data? The wizard checks each potential new row for null values. A null valueisa
system-missing or blank value. You can choose to keep or discard rows that contain only null
values.

Create a count variable? The wizard can create a count variablein the new file. It contains the
number of new rows generated by arow in the current data. A count variable may be useful if
you choose to discard null values from the new file because that makes it possible to generate a
different number of new rowsfor agiven row in the current data. Click acell to change the default
variable name and provide a descriptive variable label for the count variable.

Restructure Data Wizard (Cases to Variables): Select Variables
Note: The wizard presents this step if you choose to restructure case groups into columns.

In this step, provide information about how the variables in the current file should be used
in the new file.
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Figure 9-32
Restructure Data Wizard: Select Variables, Step 2

@Restructure Data Wizard - Step 2 of 5

Cases to Variables: Select Variables
Data from case groups inthe currert file will be restructured into single cases inthe new fils.

Chooze variables that identity case groups by moving those variables into the Idertifier Variable list. Optionally
you can also choose Index Variables.

& The variables that remain in the list of Yariables inthe Currert File ether contain data that vary within a
‘! case group or data that do not vary
A vatiable with data that vary will become a group of new variables in the restructured file. A varisble

weith data that do not vary will be copied into the nesw file.

“ariahles in the Current File: lclertifier Variabls(s)
g@ scor ga il

Index Yariahlels):

@q time

= Back || hext = Cancel Help

What identifies case groups in the current data? A case group isagroup of rowsthat are related
because they measure the same observational unit—for example, an individual or an institution.
The wizard needs to know which variables in the current file identify the case groups so that it can
consolidate each group into a single row in the new file. Move variables that identify case groups
in the current file into the Identifier Variable(s) list. Variables that are used to split the current data
file are automatically used to identify case groups. Each time a new combination of identification
values is encountered, the wizard will create a new row, so cases in the current file should be
sorted by values of the identification variables in the same order that variables are listed in the
Identifier Variable(s) list. If the current datafileisn’t already sorted, you can sort it in the next step.

How should the new variable groups be created in the new file? In the original data, a variable
appears in a single column. In the new datafile, that variable will appear in multiple new
columns. Index variables are variables in the current data that the wizard should use to create
the new columns. The restructured data will contain one new variable for each unique value in
these columns. Move the variables that should be used to form the new variable groups to the
Index Variable(s) list. When the wizard presents options, you can also choose to order the new
columns by index.

What happens to the other columns? The wizard automatically decides what to do with the
variables that remain in the Current Filelist. It checks each variable to seeif the data values vary
within acase group. If they do, the wizard restructures the values into a variable group in the new
file. If they don’t, the wizard copies the values into the new file.
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Restructure Data Wizard (Cases to Variables): Sort Data
Note: The wizard presents this step if you choose to restructure case groups into columns.

In this step, decide whether to sort the current file before restructuring it. Each time the wizard
encounters a new combination of identification values, anew row is created, so it isimportant that
the data are sorted by the variables that identify case groups.

Figure 9-33
Restructure Data Wizard: Sorting Data, Step 3

@Restructure Data Wizard - Step 3 of 5

Cases to Variables: Sorting Data

The warishles thet you used to identify case groups inthe currert file need to be sorted before the file can be
restructured. If you are not sure about your data, select "ves"

% Sort the current data?
005
010 oo
[ile] 004
002 00z
[iliy] oo ® wes - data wil be sorted by the Identifier and Inclex variables
004 007
002 006
010
W
010 [l
[ileE] 004
o0s)| o0z (] Mo - use the data as currently sorted
007 [iT
004 007
002 005
010

(< Bk (2 =] [ Finish | [ cancet | [_rer |

How are the rows ordered in the current file? Consider how the current data are sorted and which
variables you are using to identify case groups (specified in the previous step).

m Yes. Thewizard will automatically sort the current data by the identification variablesin
the same order that variables are listed in the Identifier Variable(s) list in the previous step.
Choose this when the data aren’t sorted by the identification variables or when you aren’'t
sure. This choice requires a separate pass of the data, but it guarantees that the rows are
correctly ordered for restructuring.

m  No. Thewizard will not sort the current data. Choose this when you are sure that the current
data are sorted by the variables that identify case groups.

Restructure Data Wizard (Cases to Variables): Options
Note: The wizard presents this step if you choose to restructure case groups into columns.

In this step, specify options for the new, restructured file.
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Figure 9-34
Restructure Data Wizard: Options, Step 4

@Restructure Data Wizard - Step 4 of 5

Cases to Variables: Options

In this step you can set options that will be applied to the restructured data file.

Order of Mew Yariable Groups

@ Group by ariginal variable (for example: wl w2 w3, bl h2 h3
(@] Group by index(for example: w bl w2 h2, w3 h3

Case Count Yariable

|| Court the numher of cases in the current data used to create a new case

Indicator Variables

|| Create indicator variables

(< Bk (2 =] [ Finish | [ cancet | [_rer |

How should the new variable groups be ordered in the new file?
m By variable. The wizard groups the new variables created from an original variable together.
m  Byindex. The wizard groups the variables according to the values of the index variables.

Example. The variablesto be restructured are w and h, and the index is month:

w h month

Grouping by variable resultsin:

w.jan w.feb h.jan

Grouping by index resultsin:

w.jan h.jan w.feb

Create a count variable? The wizard can create a count variable in the new file. It contains the
number of rows in the current data that were used to create arow in the new datafile.

Create indicator variables? The wizard can use the index variablesto createindicator variablesin
the new datafile. It creates one new variable for each unique value of the index variable. The
indicator variables signal the presence or absence of avaue for acase. Anindicator variable has
the value of 1 if the case has a value; otherwise, it isO.
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Example. Theindex variable is product. It records the products that a customer purchased. The
origina data are:

customer product
1 chick
1 €ggs
2 €ggs
3 chick

Creating an indicator variable results in one new variable for each unique value of product.
The restructured data are:

customer indchick indeggs
1 1 1
2 0 1
3 1 0

In this example, the restructured data could be used to get frequency counts of the products
that customers buy.

Restructure Data Wizard: Finish

Thisisthefinal step of the Restructure Data Wizard. Decide what to do with your specifications.
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Figure 9-35
Restructure Data Wizard: Finish

Q Restructure Data Wizard - Finish

Finish

What do you want to da?

@ Restructurs the data now

Use this when you weant to replace the current file immedistely.

RARER

(w] Paste the syntax generated by the wizard into & syntax window

Use thiz when you want to save or modify the syntse before you
restructure the data

Cancel Help

Finish ;

= Back

m  Restructure now. The wizard will create the new, restructured file. Choose thisif you want to
replace the current file immediately.

Note: If origina data are weighted, the new data will be weighted unless the variable that is used
as the weight is restructured or dropped from the new file.

m Paste syntax. The wizard will paste the syntax it generates into a syntax window. Choose this
when you are not ready to replace the current file, when you want to modify the syntax,
or when you want to save it for future use.
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Working with Output

When you run a procedure, the results are displayed in awindow called the Viewer. In this
window, you can easily navigate to the output that you want to see. You can also manipulate the
output and create a document that contains precisely the output that you want.

Viewer

Results are displayed in the Viewer. You can use the Viewer to:
m  Browse results

m  Show or hide selected tables and charts

m  Change the display order of results by moving selected items
m  Move items between the Viewer and other applications

Figure 10-1
Viewer

T viewertut.spv - Viewer B|E)]%]

Eile Edit Wiew Data Transform  Insert Format  Analyze  Graphs  Ubilities  add-ons  Window  Help

[E] cuteut 2
F- ] Frequencies e

[ Tie Statistics
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The Viewer is divided into two panes:
m  Theleft pane contains an outline view of the contents.
m  Theright pane contains statistical tables, charts, and text output.

You can click an item in the outline to go directly to the corresponding table or chart. You can
click and drag the right border of the outline pane to change the width of the outline pane.
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Showing and Hiding Results

In the Viewer, you can selectively show and hide individual tables or results from an entire
procedure. This processis useful when you want to shorten the amount of visible output in the
contents pane.

To Hide Tables and Charts

» Double-click the item’s book icon in the outline pane of the Viewer.

or
» Click the item to select it.
» From the menus choose;
View
Hide

or

» Click the closed book (Hide) icon on the Outlining toolbar.

The open book (Show) icon becomes the active icon, indicating that the item is now hidden.

To Hide Procedure Results

» Click the box to the left of the procedure name in the outline pane.

This hides al results from the procedure and collapses the outline view.

Moving, Deleting, and Copying Output

You can rearrange the results by copying, moving, or deleting an item or a group of items.

To Move Output in the Viewer
» Sdlect the itemsin the outline or contents pane.

» Drag and drop the selected items into a different location.

To Delete Output in the Viewer
» Select the items in the outline or contents pane.

» Pressthe Delete key.

or

» From the menus choose;
Edit
Delete
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Changing Initial Alignment

By default, all resultsareinitially left-aligned. To change theinitial alignment of new output items:

» From the menus choose;
Edit
Options

» Click the Viewer tab.
» Inthelnitial Output State group, select the item type (for example, pivot table, chart, text output).

» Select the alignment option you want.

Changing Alignment of Output Items
» Intheoutline or contents pane, select the items that you want to align.

» From the menus choose;

Format
Align Left

or

Format
Center

or

Format
Align Right

Viewer Outline

The outline pane provides atable of contents of the Viewer document. You can use the outline
pane to navigate through your results and control the display. Most actions in the outline pane
have a corresponding effect on the contents pane.

m  Selecting an item in the outline pane displays the corresponding item in the contents pane.
m  Moving an item in the outline pane moves the corresponding item in the contents pane.
m  Collapsing the outline view hides the results from al items in the collapsed levels.

Controlling the outline display. To control the outline display, you can:
m  Expand and collapse the outline view

m  Change the outline level for selected items

m  Change the size of items in the outline display

m  Change the font that is used in the outline display
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To Collapse and Expand the Outline View

>

>

>

Click the box to the l€eft of the outline item that you want to collapse or expand.

or
Click the item in the outline.

From the menus choose;
View
Collapse

or

View
Expand

To Change the Outline Level

>

>

Click the item in the outline pane.
Click the left arrow on the Outlining toolbar to promote the item (move the item to the left).

or

Click the right arrow on the Outlining toolbar to demote the item (move the item to the right).

or

From the menus choose;

Edit
Outline
Promote

or

Edit
Ouitline
Demote

Changing the outline level is particularly useful after you move itemsin the outline level. Moving
items can change the outline level of the items, and you can use the left- and right-arrow buttons
on the Outlining toolbar to restore the original outline level.

To Change the Size of Outline ltems

>

>

From the menus choose:
View
Outline Size

Select the outline size (Small, Medium, or Large).
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To Change the Font in the Outline
» From the menus choose:
View

Outline Font...

» Select afont.

Adding Items to the Viewer

In the Viewer, you can add items such astitles, new text, charts, or material from other applications.

To Add a Title or Text

Text items that are not connected to a table or chart can be added to the Viewer.
» Click the table, chart, or other object that will precede the title or text.
» From the menus choose;

Insert

New Title

or
Insert

New Text

» Double-click the new object.

» Enter the text.

To Add a Text File

» Inthe outline pane or contents pane of the Viewer, click the table, chart, or other object that
will precede the text.

» From the menus choose;

Insert
Text File...

» Select atext file.
To edit the text, double-click it.

Pasting Objects into the Viewer
Objects from other applications can be pasted into the Viewer. You can use either Paste After or

Paste Special. Either type of pasting puts the new object after the currently selected object in the
Viewer. Use Paste Special when you want to choose the format of the pasted object.
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Finding and Replacing Information in the Viewer

» To find or replace information in the Viewer, from the menus choose:

Edit
Find

or
Edit
Replace

Figure 10-2
Find and Replace dialog box
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You can use Find and Replace to:

m  Search the entire document or just the selected items.
Search down or up from the current location.

|
m  Search both panes or restrict the search to the contents or outline pane.
|

Search for hidden items. These include any items hidden in the contents pane (for example,
Notes tables, which are hidden by default) and hidden rows and columnsin pivot tables.

Restrict the search criteria to case-sensitive matches.

Restrict the search criteriain pivot tables to matches of the entire cell contents.

Hidden Items and Pivot Table Layers

m Layersbeneath the currently visible layer of a multidimensional pivot table are not considered
hidden and will be included in the search area even when hidden items are not included in

the search.
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® Hidden items include hidden itemsin the contents pane (items with closed book iconsin the
outline pane or included within collapsed blocks of the outline pane) and rows and columns
in pivot tables either hidden by default (for example, empty rows and columns are hidden
by default) or manually hidden by editing the table and selectively hiding specific rows or
columns. Hidden items are only included in the search if you explicitly select Include hidden
items.

m |n both cases, the hidden or nonvisible element that contains the search text or valueis
displayed when it is found, but the item is returned to its original state afterward.

Copying Output into Other Applications

Output objects can be copied and pasted into other applications, such as a word-processing
program or a spreadsheet. You can paste output in a variety of formats. Depending on the target
application, some or al of the following formats may be available:

Picture (metafile). Pivot tables and charts can be pasted as metafile pictures. The picture format
can be resized in the other application, and sometimes a limited amount of editing can be done
with the facilities of the other application. Pivot tables that are pasted as pictures retain all borders
and font characteristics. For pivot tables, select Files from the Paste Specia menu. Thisformat is
available only on Windows operating systems.

RTF (rich text format). Pivot tables can be pasted into other applications in RTF format. In most
applications, this means that the pivot table is pasted as a table that can then be edited in the
other application.

Note: Microsoft Word may not display extremely wide tables properly.
Bitmap. Charts and other graphics can be pasted into other applications as bitmaps.

BIFF. The contents of atable can be pasted into a spreadsheet and retain numeric precision. This
format is available only on Windows operating systems.

Text. The contents of atable can be copied and pasted as text. This process can be useful for
applications such as e-mail, where the application can accept or transmit only text.

If the target application supports multiple available formats, it may have a Paste Special menu item
that allows you to select the format, or it may automatically display alist of available formats.

To Copy and Paste Output Items into Another Application
» Select the objectsin either the outline or contents pane of the Viewer.

» From the Viewer menus choose;
Edit
Copy

» From the menusin the target application choose:

Edit
Paste
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or
Edit
Paste Special...

m Paste. Output is copied to the Clipboard in a number of formats. Each application determines
the “best” format to use for Paste.

m Paste Special. Results are copied to the Clipboard in multiple formats. Paste Special alows
you to select the format that you want from the list of formats that are available to the target
application.

Copying and pasting model views. All model views, including tables, are pasted as graphic images.

Copying and pasting pivot tables. \When pivot tables are pasted in Word/RTF format, tables that are
too wide for the document width will either be wrapped, scaled down to fit the document width, or
left unchanged, depending on the pivot table options settings. For more information, see the topic
Pivot Table Options in Chapter 16 on p. 303.

Export Output

>

>

>

Export Output saves Viewer output in HTML, text, Word/RTF, Excel, PowerPoint (requires
PowerPoint 97 or later), and PDF formats. Charts can also be exported in a number of different
graphics formats.

Note: Export to PowerPoint is available only on Windows operating systems and is not available
in the Student Version.

To Export Output
Make the Viewer the active window (click anywhere in the window).
From the menus choose:
File
Export...

Enter afilename (or prefix for charts) and select an export format.



213

Working with Output

Figure 10-3
Export Output dialog box
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Objects to Export. You can export al objectsin the Viewer, al visible abjects, or only selected
objects.

Document Type. The available options are:

m  Word/RTF (*.doc). Pivot tables are exported as Word tables with all formatting attributes
intact—for example, cell borders, font styles, and background colors. Text output is exported
as formatted RTF. Charts, tree diagrams, and model views are included in PNG format.

Note: Microsoft Word may not display extremely wide tables properly.

m  Excel (*.xls). Pivot table rows, columns, and cells are exported as Excel rows, columns,
and cdlls, with al formatting attributes intact—for example, cell borders, font styles, and
background colors. Text output is exported with all font attributes intact. Each line in the text
output isarow in the Excel file, with the entire contents of the line contained in asingle cell.
Charts, tree diagrams, and model views are included in PNG format.

m  HTML (*.htm). Pivot tables are exported as HTML tables. Text output is exported as
preformatted HTML. Charts, tree diagrams, and model views are embedded by reference,

and you should export charts in a suitable format for inclusion in HTML documents (for
example, PNG and JPEG).
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m  Portable Document Format (*.pdf). All output is exported as it appearsin Print Preview, with all
formatting attributes intact.

m  PowerPointfile (*.ppt). Pivot tables are exported as Word tables and are embedded on separate
dlidesin the PowerPoint file, with one slide for each pivot table. All formatting attributes of the
pivot table are retained—for example, cell borders, font styles, and background colors. Charts,
tree diagrams, and model views are exported in TIFF format. Text output is not included.

Export to PowerPoint is available only on Windows operating systems.

m  Text (*.txt). Text output formats include plain text, UTF-8, and UTF-16. Pivot tables can
be exported in tab-separated or space-separated format. All text output is exported in
space-separated format. For charts, tree diagrams, and model views, alineisinserted in the
text file for each graphic, indicating the image filename.

m  None (Graphics Only). Available export formats include: EPS, JPEG, TIFF, PNG, and BMP.
On Windows operating systems, EMF (enhanced metafile) format is also available.

Output Management System. You can also automatically export all output or user-specified types
of output as Word, Excel, PDF, HTML, text or PASW Statistics-format data files. For more
information, see the topic Output Management System in Chapter 20 on p. 353.

HTML Options

>

>

The following options are available for exporting output in HTML format:

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.

Include footnotes and captions. Controls the inclusion or exclusion of all pivot table footnotes and
captions.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude al but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

Note: For HTML, you can also control the image file format for exported charts. For more
information, see the topic Graphics Format Options on p. 222.

To Set HTML Export Options
Select HTML as the export format.

Click Change Options.
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Figure 10-4
HTML Export Output Options
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Word/RTF Options
The following options are available for exporting output in Word format:

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.

Wide Pivot Tables. Controls the treatment of tables that are too wide for the defined document
width. By default, the table is wrapped to fit. The table is divided into sections, and row labels
are repeated for each section of the table. Alternatively, you can shrink wide tables or make no
changes to wide tables and allow them to extend beyond the defined document width.

Include footnotes and captions. Controls the inclusion or exclusion of al pivot table footnotes and
captions.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

Page Setup for Export. This opens a dialog where you can define the page size and margins for the
exported document. The document width used to determine wrapping and shrinking behavior is
the page width minus the left and right margins.

To Set Word Export Options
» Select Word/RTF as the export format.

» Click Change Options.
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Figure 10-5
Word Export Output Options
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Excel Options
The following options are available for exporting output in Excel format:

Create a worksheet or workbook or modify an existing worksheet. By default, a new workbook is
created. If afile with the specified name aready exists, it will be overwritten. If you select the
option to create aworksheet, if aworksheet with the specified name aready exists in the specified
file, it will be overwritten. If you select the option to modify an existing worksheet, you must
also specify the worksheet name. (Thisis optional for creating a worksheet.) Worksheet names
cannot exceed 31 characters and cannot contain forward or back slashes, square brackets, question
marks, or asterisks.

If you modify an existing worksheet, charts, model views, and tree diagrams are not included in
the exported output.

Location in worksheet. Controls the location within the worksheet for the exported output. By
default, exported output will be added after the last column that has any content, starting in the
first row, without modifying any existing contents. Thisisagood choice for adding new columns
to an existing worksheet. Adding exported output after the last row is a good choice for adding
new rows to an existing worksheet. Adding exported output starting at a specific cell location will
overwrite any existing content in the area where the exported output is added.

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.
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Include footnotes and captions. Controls the inclusion or exclusion of al pivot table footnotes and
captions.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

To Set Excel Export Options
» Select Excel as the export format.

» Click Change Options.

Figure 10-6
Excel Export Output Options
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PowerPoint Options
The following options are avail able for PowerPoint:

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.
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Wide Pivot Tables. Controls the treatment of tables that are too wide for the defined document
width. By default, the table is wrapped to fit. The table is divided into sections, and row labels
are repeated for each section of the table. Alternatively, you can shrink wide tables or make no
changes to wide tables and allow them to extend beyond the defined document width.

Include footnotes and captions. Controls the inclusion or exclusion of all pivot table footnotes and
captions.

Use Viewer outline entries as slide titles. Includes atitle on each dlide that is created by the export.
Each slide contains a single item that is exported from the Viewer. Thetitle is formed from the
outline entry for the item in the outline pane of the Viewer.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

Page Setup for Export. This opens a dialog where you can define the page size and margins for the
exported document. The document width used to determine wrapping and shrinking behavior is
the page width minus the left and right margins.

To Set PowerPoint Export Options

» Select PowerPoint as the export format.

» Click Change Options.

Figure 10-7
Powerpoint Export Options dialog
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Note: Export to PowerPoint is available only on Windows operating systems.

PDF Options

The following options are available for PDF:

Embed bookmarks. This option includes bookmarks in the PDF document that correspond to
the Viewer outline entries. Like the Viewer outline pane, bookmarks can make it much easier
to navigate documents with a large number of output objects.

Embed fonts. Embedding fonts ensures that the PDF document will look the same on al computers.
Otherwise, if some fonts used in the document are not available on the computer being used to
view (or print) the PDF document, font substitution may yield suboptimal results.

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

To Set PDF Export Options
» Select Portable Document Format as the export format.

» Click Change Options.

Figure 10-8
PDF Options dialog box
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Other Settings That Affect PDF Output

Page Setup/Page Attributes. Page size, orientation, margins, content and display of page headers
and footers, and printed chart size in PDF documents are controlled by page setup and page
attribute options.

Table Properties/TableLooks. Scaling of wide and/or long tables and printing of table layers are
controlled by table properties for each table. These properties can also be saved in Tablel ooks.
For more information, see the topic Table Properties: Printing in Chapter 11 on p. 243.

Default/Current Printer. The resolution (DPI) of the PDF document is the current resolution setting
for the default or currently selected printer (which can be changed using Page Setup). The
maximum resolution is 1200 DPI. If the printer setting is higher, the PDF document resolution
will be 1200 DPI.

Note: High-resolution documents may yield poor results when printed on lower-resol ution printers.

Text Options

>

>

The following options are available for text export:

Pivot Table Format. Pivot tables can be exported in tab-separated or space-separated format. For
space-separated format, you can also control:

m  Column Width. Autofit does not wrap any column contents, and each column is as wide as the
widest label or value in that column. Custom sets a maximum column width that is applied
to al columnsin the table, and values that exceed that width wrap onto the next line in that
column.

m  Row/Column Border Character. Controls the characters used to create row and column borders.
To suppress display of row and column borders, enter blank spaces for the values.

Layers in pivot tables. By default, inclusion or exclusion of pivot table layersis controlled by
the table properties for each pivot table. You can override this setting and include all layers or
exclude al but the currently visible layer. For more information, see the topic Table Properties:
Printing in Chapter 11 on p. 243.

Include footnotes and captions. Controls the inclusion or exclusion of all pivot table footnotes and
captions.

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

To Set Text Export Options
Select Text as the export format.

Click Change Options.
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Figure 10-9
Text Options dialog box

ik Export Gutput: Text Options

Pivot Table Format

@ Use tabs to separate columnz
@ Uze spaces to separate columng

Column \Width
@ autofit
© custam

Rowy Barder Character: I:I

Column Barder Character: D

Layers in Pivat Tables

@ Honor Print Layer setting (=et in Table Properties on & per table bazis)
@) Export all layers
()] Export wisible layer only

@ Include foctnates and captions

“iewes of Models

@ Honar print 2etting (2et in Model Vieswer Propetties for each madel)
@ Export all views
(@] Export wisible wigw only

k

Reset ][ Cancel ][ Help ]

Graphics Only Options
The following options are available for exporting graphics only:

Views of Models. By default, inclusion or exclusion of model views is controlled by the model
properties for each model. You can override this setting and include all views or exclude all but
the currently visible view. For more information, see the topic Model Propertiesin Chapter 12 on
p. 254. (Note: al model views, including tables, are exported as graphics.)

Figure 10-10
Graphics Only Options
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Graphics Format Options
For HTML and text documents and for exporting charts only, you can select the graphic format,
and for each graphic format you can control various optional settings.

To select the graphic format and options for exported charts:
» Select HTML, Text, or None (Graphics only) as the document type.
» Select the graphic file format from the drop-down list.

» Click Change Options to change the options for the selected graphic file format.

JPEG Chart Export Options
m Image size. Percentage of original chart size, up to 200 percent.
m  Convert to grayscale. Converts colors to shades of gray.

BMP Chart Export Options
m Image size. Percentage of original chart size, up to 200 percent.

m  Compress image to reduce file size. A |ossless compression technique that creates smaller files
without affecting image quality.

PNG Chart Export Options

Image size. Percentage of original chart size, up to 200 percent.

Color Depth. Determines the number of colorsin the exported chart. A chart that is saved under
any depth will have a minimum of the number of colors that are actually used and a maximum
of the number of colorsthat are allowed by the depth. For example, if the chart contains three
colors—red, white, and black—and you save it as 16 colors, the chart will remain as three colors.

m |f the number of colorsin the chart exceeds the number of colors for that depth, the colors will
be dithered to replicate the colorsin the chart.

B Current screen depth isthe number of colors currently displayed on your computer monitor.

EMF and TIFF Chart Export Options

Image size. Percentage of original chart size, up to 200 percent.

Note: EMF (enhanced metafile) format is available only on Windows operating systems.

EPS Chart Export Options

Image size. You can specify the size as a percentage of the original image size (up to 200 percent),
or you can specify an image width in pixels (with height determined by the width value and the
aspect ratio). The exported image is always proportional to the original.

Include TIFF preview image. Saves a preview with the EPS image in TIFF format for display in
applications that cannot display EPS images on screen.
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Fonts. Controls the treatment of fonts in EPS images.

m Use font references. |f the fonts that are used in the chart are available on the output device,
the fonts are used. Otherwise, the output device uses alternate fonts.

m  Replace fonts with curves. Turns fonts into PostScript curve data. The text itself isno longer
editable as text in applications that can edit EPS graphics. This option is useful if the fonts
that are used in the chart are not available on the output device.

Viewer Printing

There are two options for printing the contents of the Viewer window:

All visible output. Prints only items that are currently displayed in the contents pane. Hidden
items (items with a closed book icon in the outline pane or hidden in collapsed outline layers)
are not printed.

Selection. Printsonly items that are currently selected in the outline and/or contents panes.

To Print Output and Charts
» Make the Viewer the active window (click anywhere in the window).

» From the menus choose:
File
Print...

» Select the print settings that you want.

» Click OK to print.

Print Preview

Print Preview shows you what will print on each page for Viewer documents. It isagood ideato
check Print Preview before actualy printing a Viewer document, because Print Preview shows
you items that may not be visible by looking at the contents pane of the Viewer, including:

m  Page breaks

m  Hidden layers of pivot tables

m  Breaksin wide tables

m Headers and footers that are printed on each page
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Figure 10-11
Print Preview
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If any output is currently selected in the Viewer, the preview displays only the selected output. To
view a preview for al output, make sure nothing is selected in the Viewer.

Page Attributes: Headers and Footers

Headers and footers are the information that is printed at the top and bottom of each page. You
can enter any text that you want to use as headers and footers. You can aso use the toolbar in the
middle of the dialog box to insert:

m Date and time

Page numbers

Viewer filename
Ouitline heading labels
Page titles and subtitles
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Figure 10-12
Page Attributes dialog box, Header/Footer tab
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B Make Default uses the settings specified here as the default settings for new Viewer documents.
(Note: this makes the current settings on both the Header/Footer tab and the Options tab
the default settings.)

m  Outline heading labels indicate the first-, second-, third-, and/or fourth-level outline heading
for the first item on each page.

m  Pagetitles and subtitles print the current page titles and subtitles. These can be created with
New Page Title on the Viewer Insert menu or with the TTTLE and SUBTITLE commands. If
you have not specified any page titles or subtitles, this setting is ignored.

Note: Font characteristics for new page titles and subtitles are controlled on the Viewer tab of
the Options dialog box (accessed by choosing Options on the Edit menu). Font characteristics
for existing page titles and subtitles can be changed by editing the titles in the Viewer.

To see how your headers and footers will look on the printed page, choose Print Preview from
the File menu.

To Insert Page Headers and Footers
» Make the Viewer the active window (click anywhere in the window).
» From the menus choose:
File
Page Attributes...

» Click the Header/Footer tab.
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» Enter the header and/or footer that you want to appear on each page.

Page Attributes: Options

This dialog box controls the printed chart size, the space between printed output items, and page
numbering.

m Printed Chart Size. Controls the size of the printed chart relative to the defined page size. The
chart’s aspect ratio (width-to-height ratio) is not affected by the printed chart size. The overall
printed size of achart is limited by both its height and width. When the outer borders of a
chart reach the left and right borders of the page, the chart size cannot increase further to
fill additional page height.

m  Space between items. Controls the space between printed items. Each pivot table, chart, and
text object is a separate item. This setting does not affect the display of itemsin the Viewer.

m  Number pages starting with. Numbers pages sequentidly, starting with the specified number.

m  Make Default. This option uses the settings specified here as the default settings for new
Viewer documents. (Note: this makes the current settings on both the Header/Footer tab and
the Options tab the default settings.)

Figure 10-13
Page Attributes dialog box, Options tab

= Page Attributes

HeaderFooter | Cptions
Printed Chart Size
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Mumber pages starting with: 1 &
oK I [ Cancel ] [ Help ] [Make DetaLit ]

To Change Printed Chart Size, Page Numbering, and Space hetween Printed Items

» Make the Viewer the active window (click anywhere in the window).
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» From the menus choose:
File
Page Attributes...

» Click the Options tab.

» Change the settings and click OK.

Saving Output

The contents of the Viewer can be saved to a Viewer document. The saved document includes
both panes of the Viewer window (the outline and the contents).

To Save a Viewer Document

» From the Viewer window menus choose:

File
Save

» Enter the name of the document, and then click Save.

Optionally, you can lock files to prevent editing in Smartreader (a separate product for working
with Viewer documents). If a Viewer document is locked, you can manipulate pivot tables (swap
rows and columns, change the displayed layer, etc.) but you cannot edit any output or save any
changes to the Viewer document in Smartreader. This setting has no effect on Viewer documents
opened in PASW Statistics.

To saveresultsin externa formats (for example, HTML or text), use Export on the File menu.
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Many results are presented in tables that can be pivoted interactively. That is, you can rearrange
the rows, columns, and layers.

Manipulating a Pivot Table

Options for manipulating a pivot table include:

Transposing rows and columns

Moving rows and columns

Creating multidimensional layers

Grouping and ungrouping rows and columns

Showing and hiding rows, columns, and other information
Rotating row and column labels

Finding definitions of terms

Activating a Pivot Table

Before you can manipulate or modify a pivot table, you need to activate the table. To activate a
table:

» Double-click the table.
or
» Right-click the table and from the context menu choose Edit Content.

» From the sub-menu choose either In Viewer or In Separate Window.

m By default, activating the table by double-clicking will activate all but very large tablesin
the Viewer window. For more information, see the topic Pivot Table Optionsin Chapter 16
on p. 303.

m |f you want to have more than one pivot table activated at the same time, you must activate the
tables in separate windows.

Pivoting a Table

» Activate the pivot table.

228
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» From the menus choose:
Pivot
Pivoting Trays

Figure 11-1
Pivoting trays

iz Pivoting Trays

f+] Gender

Statistics
2] ) Owns PDA

~| [ Internet

alr
ot

A table has three dimensions; rows, columns, and layers. A dimension can contain multiple
elements (or none at al). You can change the organization of the table by moving elements
between or within dimensions. To move an element, just drag and drop it where you want it.

Changing Display Order of Elements within a Dimension

To change the display order of elements within atable dimension (row, column, or layer):

» If pivoting trays are not aready on, from the Pivot Table menu choose:

Pivot
Pivoting Trays

» Drag and drop the elements within the dimension in the pivoting tray.

Moving Rows and Columns within a Dimension Element
» Inthetableitself (not the pivoting trays), click the label for the row or column you want to move.
» Drag the label to the new position.

» From the context menu choose Insert Before Or Swap.

Note: Make sure that Drag to Copy on the Edit menu is not enabled (checked). If Drag to Copy is
enabled, deselect it.
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Transposing Rows and Columns

If you just want to flip the rows and columns, there's a simple aternative to using the pivoting
trays:

» From the menus choose;

Pivot
Transpose Rows and Columns

This has the same effect as dragging all of the row elements into the column dimension and
dragging all of the column elements into the row dimension.

Grouping Rows or Columns

» Select the labels for the rows or columns that you want to group together (click and drag or
Shift+click to select multiple labels).

» From the menus choose:
Edit
Group
A group label isautomatically inserted. Double-click the group label to edit the label text.

Figure 11-2
Row and column groups and labels

Column Group Label
Female Male Total
Row Clerical 206 157 363
Group Custodial 27 27
Label Manager 10 74 84

Note: To add rows or columns to an existing group, you must first ungroup the items that are
currently in the group. Then you can create a new group that includes the additional items.

Ungrouping Rows or Columns
» Click anywhere in the group label for the rows or columns that you want to ungroup.

» From the menus choose;
Edit
Ungroup

Ungrouping automatically deletes the group label.

Rotating Row or Column Labels

You can rotate |abel s between horizontal and vertical display for the innermost column labels and
the outermost row labels in atable.

» From the menus choose;

Format
Rotate Inner Column Labels
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or
Format
Rotate Outer Row Labels
Figure 11-3
Rotated column labels
Cumulative
Frequency | Percent | “/alid Percent Percent
Cid not complete high school 1390 M7 iy 2T
High zchool degree 1936 303 303 520
Some college
College degree # 2
g deg| = k= o & £ =
Post-undergraduste dec El ] =8B = B
Total o 2| -2 | EX
. @ [T Q
Did not complete high school | 1390 MT M7 7
High =chool degree 1936 0.3 0.3 £2.0
Some college 1360 M3 213 732
College degres 1355 212 M2 944
Post-underaraduste dearee 358 56 56 | 1000
Total E400 | 1000 | 1000

Only the innermost column labels and the outermost row labels can be rotated.

Working with Layers

You can display a separate two-dimensional table for each category or combination of categories.
The table can be thought of as stacked in layers, with only the top layer visible.

Creating and Displaying Layers
To create layers:
» Activate the pivot table.
» If pivoting trays are not aready on, from the Pivot Table menu choose:
Pivot
Pivoting Trays

» Drag an element from the row or column dimension into the layer dimension.
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Figure 114
Moving categories into layers
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Moving elements to the layer dimension creates a multidimensional table, but only a single
two-dimensional “dlice” isdisplayed. The visible table is the table for the top layer. For example,
if ayes/no categorical variable isin the layer dimension, then the multidimensional table has two
layers: one for the yes category and one for the no category.

Figure 11-5
Categories in separate layers

Internet: ves
Gender
Female hlale Total
wng Mo Count 13 612 1025
FDA Expected Count 8126 | 8124 | 10250
Intarnet: Mo
Gender
Female hlale Total
| || Owns Mo Count 1897 1962 3859
Taotal | | DA Expected Count 10024 | 19556 | 38500
% within Crweng PDA 49.2% 50.8% | 100.0%
| Yes Count 327 323 G50
— Expected Count 3206 3294 g50.0
% within Cwens PDA a0.3% 49.7% | 100.0%
Tatal Count 2224 2285 45049
Expected Count 22240 | 22850 | 45090
% within Crweng PDA 49.3% 50.7% | 100.0%

Changing the Displayed Layer

» Choose acategory from the drop-down list of layers (in the pivot tableitself, not the pivoting tray).
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Figure 11-6
Selecting layers from drop-down lists
Internet o w
Gender
Yas Female Male Total
Owns Mo Count 1897 1962 38549
FDA Expected Count 1903.4 | 19556 | 3859.0
% within Cwns PDA | 4802% | ADA8% | 100.0%
Yasg Count 327 323 &0
Expected Count 3206 3294 650.0
% within Cwns PDA | 503% | 49.7% | 100.0%
Tatal Count 2224 2285 4509
Expected Count 22240 | 22850 | 4509.0
% within Owng PDA 49.3% a0.7% | 100.0%

Go to Layer Category

Go to Layer Category alows you to change layersin apivot table. This dialog box is particularly
useful when there are many layers or the selected layer has many categories.

» From the menus choose;
Pivot
Go to Layer...

Figure 11-7
Go to Layer Category dialog box

EH Go to Layer Category

Visible Category for Each Dimension in Layer: Categaries for Internet:

Irternet: Mo Mo

ok ) (canen) (amon) (k)

» IntheVisible Category list, select alayer dimension. The Categories|ist will display all categories
for the selected dimension.

» Inthe Categories list, select the category that you want, and then click OK or Apply.
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Showing and Hiding Items

Many types of cells can be hidden, including:

m  Dimension labels

m Categories, including the label cell and data cellsin arow or column
m Category labels (without hiding the data cells)

m Footnotes, titles, and captions

Hiding Rows and Columns in a Table
» Right-click the category label for the row or column you want to hide.

» From the context menu choose:

Select
Data and Label Cells

» Right-click the category label again and from the context menu choose Hide Category.
or

» From the View menu choose Hide.

Showing Hidden Rows and Columns in a Table
» Right-click another row or column label in the same dimension as the hidden row or column.

» From the context menu choose:

Select
Data and Label Cells

» From the menus choose:
View
Show All Categories in [dimension name]

or

» Todisplay al hidden rows and columns in an activated pivot table, from the menus choose:
View
Show All

Thisdisplays al hidden rows and columnsin the table. (If Hide empty rows and columns is selected
in Table Properties for this table, a completely empty row or column remains hidden.)
Hiding and Showing Dimension Labels
» Select the dimension label or any category label within the dimension.

» From the View menu or the context menu choose Hide Dimension Label or Show Dimension Label.
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Hiding and Showing Table Titles

To hide a title:
» Select the title.

» From the View menu choose Hide.

To show hidden titles:

» From the View menu choose Show All.

TableLooks

A TableL ook is a set of properties that define the appearance of atable. You can select a
previously defined TablelL ook or create your own Tablel ook.

m Before or after a TablelL ook is applied, you can change cell formats for individual cells or
groups of cells by using cell properties. The edited cell formats will remain intact, even when
you apply anew TableLook. For more information, see the topic Cell Properties on p. 245.

m  Optionally, you can reset all cellsto the cell formats that are defined by the current Tablel ook.
This resets any cells that have been edited. |f As Displayed is selected in the TableL ook Files
list, any edited cells are reset to the current table properties.

Note: Tablel ooks created in earlier versions of PASW Statistics cannot be used in version 16.0 or
|ater.

To Apply or Save a TableLook
» Activate a pivot table.
» From the menus choose:

Format
TableLooks...
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>

>

Figure 11-8

TableLooks dialog box

RH TableLooks
TableLook: =System Default=
TableLook Files: Sainple
=43 Displayed= - Table Title
=System Default= Layeriayer]
Acacdemic bbb
AvantGarde [TITH WhbbE
Elue*ellowContrast aaaa aaaa
BlugellowContrast Atternate dddd coog | daaal aaaai aaaal aaaal
Boxed dddd1 ceecl| O abed 212.4 abed
Compact cocc?| 286 abed 8365 abed
CompactAcademic group  dddd?  ceccl] 105 abed 5253 abed
CompacttcademicTimesRoman ceced) 1142 abed 05 abcd
CompactEoxed dddd?  cocccl| 20.45 abed 0.0 abed
Contrast Tahle Caption
ContrastAternate = a. Text for fostnote a.

b. Text for faotnote b

[ Reset all cell formats to the TableLook [ga"e ARl ] [SE"E i ] [5"“ oL ]

Select a Tablel ook from the list of files. To select afile from another directory, click Browse.

Click OK to apply the Tablel ook to the selected pivot table.

To Edit or Create a TableLook

>

>
»
»

In the TablelL ooks dialog box, select a Tablel ook from the list of files.
Click Edit Look.
Adjust the table properties for the attributes that you want, and then click OK.

Click Save Look to save the edited TableL ook, or click Save As to save it as anew TableLook.

Editing a TableL ook affects only the selected pivot table. An edited TablelL ook is not applied to
any other tables that uses that Tablel ook unless you select those tables and reapply the Tablel ook.

Table Properties

Table Properties allows you to set general properties of atable, set cell stylesfor various parts of a
table, and save a set of those properties as a TableL ook. You can:

m  Control genera properties, such as hiding empty rows or columns and adjusting printing
properties.

Control the format and position of footnote markers.

Determine specific formats for cellsin the data area, for row and column labels, and for
other areas of the table.

m  Control the width and color of the lines that form the borders of each area of the table.
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To Change Pivot Table Properties

>

>

Activate the pivot table.

From the menus choose;

Format
Table Properties...

Select atab (General, Footnotes, Cell Formats, Borders, Of Printing).
Select the options that you want.

Click OK or Apply.

The new properties are applied to the selected pivot table. To apply new table propertiesto a
TablelL ook instead of just the selected table, edit the Tablel ook (Format menu, Tablel ooks).

Table Properties: General

Several properties apply to the table as awhole. You can:

m  Show or hide empty rows and columns. (An empty row or column has nothing in any of
the data cells.)

m  Control the default number of rowsto display in long tables. To display all therowsin atable,
regardless of how long it is, deselect (uncheck) Display table by rows.

m  Control the placement of row labels, which can be in the upper left corner or nested.
m  Control maximum and minimum column width (expressed in points).
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Figure 11-9
Table Properties dialog box, General tab
i Table Properties
General | Footnotes | Cell Formats | Borders || Printing
General Sample
I-q?: Hide empty rovws and columns Table Title
[7] Display tables by rows
bbbk
Set Rows ta Display.. bbbbd bbbbZ
aaaa aaaa
Riow Dimension Labels dddd coo 3333l | az3aZ | asaal | 3a3aaz
® In Corner dddd1 ceoe 0 abed | 2124 | abed
) seee? | agg abed | B83.65 abed
© ested goup  dddd2  cceel | qos | abed | 5853 | abed
T T ceeed | 1442 abed 205 abed
dddd3  coeol | 2045 | abed 30.0 abed
Minimum wricth for column lakels.  |pgg = Table Caption

o WG | i a. Text for footnote a.
SITILIT S0 ar column lakeks: [ ]
= n b. Text for footnote b.

Minimum swicth for row labels:

Madimum wwicth for rowy labels:

| ok §|[Cance|][gpply ][ Help ]

To change general table properties:
» Click the General tab.
» Select the options that you want.

» Click OK or Apply.

Set Rows to Display

By default, tables with many rows are displayed in sections of 100 rows. To control the number of
rows displayed in a table:

» Select Display table by rows.
» Click Set Rows to Display.
or

» From the View menu of an activated pivot table, choose Display table by rows and Set Rows
to Display.
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Figure 11-10
Set Rows to Display dialog

- Set Rows to Display

Rovs to Display:
WidownaiOrphan Tolerance:

| [Cancel ] [ Helps ]

Rows to display. Controlsthe maximum number of rowsto display at onetime. Navigation controls
allow you move to different sections of the table. The minimum value is 10. The default is 100.

Widow/orphan tolerance. Controls the maximum number of rows of the inner most row dimension
of the table to split across displayed views of the table. For example, if there are six categories

in each group of the inner most row dimension, specifying a value of six would prevent any
group from splitting across displayed views. This setting can cause the total number of rowsin a
displayed view to exceed the specified maximum number of rows to display.

Figure 11-11
Displayed rows with default tolerance

Rows 1 through 10 of 24 08 W |WF||WF

Count Percent

Income Under §25 | Job Highly dissatisfied 350 209.8%
category in satisfaction - -
thousands Somewhat dissatisfied 316 26.9%
MNeutral 250 21.3%
Somewhat satisfied 157 13.4%
Highly satisfied 101 B8.6%
Total 1174 100.0%
$25- 549 Joh Highly dissatisfied 53 22.2%
satisfaction - -
Somewhat dissatisfied 534 22 4%
Meutral 542 22.7%
Somewhat satisfied A0F 20.8%

Figure 11-12
Tolerance set based on number of rows in inner row dimension group

Fows 1 through 12 0f 24 G5 6 W[ W7

Count Percent

Income Under$25 | Job Highly dissatisfied 350 29.8%
category in satisfaction - -

thousands Somewhat dissatisfied B 26.9%

MNeutral 250 21.3%

Somewhat satisfied 157 13.4%

Highly satisfied 101 B.6%

Total 1174 100.0%

$25- 548 Joh Highly dissatisfied 531 222%
satisfaction - -

Somewhat dissatisfied 534 27 4%

Meutral 542 22.7%

Somewhat satisfied AG6 20.8%

Highly satisfied 285 11.9%

Total 2388 100.0%
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Table Properties: Footnotes

The properties of footnote markers include style and position in relation to text.
m The style of footnote markersis either numbers (1, 2, 3, ...) or letters(a, b, ¢, ...).
m  The footnote markers can be attached to text as superscripts or subscripts.

Figure 11-13
Table Properties dialog box, Footnotes tab

EE Table Properties

General | Footnotes || Cell Formats | Borders | Printing

Mumber Fartat

@ slphabetic

@' Mumeric

Marker Position

@ superscript

@ Subscript

Sample
a
1234567

To change footnote marker properties:
» Click the Footnotes tab.
» Select afootnote number format.
» Select a marker position.

» Click OK or Apply.

Table Properties: Cell Formats

For formatting, atable is divided into areas: title, layers, corner labels, row labels, column labels,
data, caption, and footnotes. For each area of atable, you can modify the associated cell formats.
Cell formats include text characteristics (such as font, size, color, and style), horizontal and
vertical alignment, background colors, and inner cell margins.
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Figure 11-14

Areas of a table

Layers

Corner labels

Column labels

Row labels

Data

Caption
Footnotes

Pivot Tables

Cell formats are applied to areas (categories of information). They are not characteristics of

individual cells. Thisdistinction is an important consideration when pivoting atable.

For example,

m If you specify abold font as a cell format of column labels, the column labels will appear
bold no matter what information is currently displayed in the column dimension. If you
move an item from the column dimension to another dimension, it does not retain the bold

characteristic of the column labels.
If you make column labels bold simply by highlighting the cellsin an activated pivot table

and clicking the Bold button on the toolbar, the contents of those cells will remain bold no
matter what dimension you move them to, and the column labels will not retain the bold

characteristic for other items moved into the column dimension.
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Figure 11-15
Table Properties dialog box, Cell Formats tab

i Table Properties

Gerersl  Footnotes | Cell Formats | Borders  Printing

SansSerif = ||El — |

Sample
Table Title
Aliggrinent aner:la\,rerl
EEEE @ 3
== S = =5 [~ bbbl bhbbz
aada EEEE]
dddd cooe aaaal aaaal aaaal aaaal
Biackground Color ddddi cecel [ 0 abed Hid abed
EDlDrZC] (255, 255, 255) ool | 826 abed 23 68 abcd
_____ group  dddd?  cocecl | 105 ahcd 58453 ahcd
] Aternate Row Colar: (55|~ M ooz [ 1142 | abed | 205 abicd
dddd?  cecel | 2045 abed 0.0 abed

X . } Tahble Caption
Inner Marging (in points)

Top: [<] Left ] a. Text for footnote a.
- ' I~ - =] b. Text far footnote b
Eiottom: Right: [<]
- =l = il

To change cell formats:
» Select the Cell Formats tab.
» Select an Areafrom the drop-down list or click an area of the sample.
» Select characteristics for the area. Your selections are reflected in the sample.

» Click OK or Apply.

Alternating Row Colors

To apply adifferent background and/or text color to alternate rowsin the Data area of the table:
» Select Data from the Area drop-down list.
» Select (check) Alternate row color in the Background Color group.

» Select the colors to use for the alternate row background and text.

Alternate row colors affect only the Data area of the table. They do not affect row or column
label areas.
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Table Properties: Borders

For each border location in atable, you can select aline style and acolor. If you select None asthe
style, there will be no line at the selected location.

Figure 11-16
Table Properties dialog box, Borders tab

E Table Properties

General || Footnotes | Cell Formats || Borders || Printing

Borilet: Barcers

Titledayer separatar - r Table Title :
Left inner frame FW““-"
Right inner frame : bbbt :
Top inner frame bbbb bbbb2

Eattamm inner framie aaaa aaaa

Left outer frame | dddd cooo 3aaal | aaaaz | aaaal | aaaaz
Right cuter frame | dddat jreeet ] o) abed | 2124 | abed
Top outer frame 190002 | a5 | abcd | 8365 | abed
Bicttom cuter frame o[ groue j dddd2 § eocot | ans | abed | 5853 | abed
Data area left : : peeeed | 4442 | abed | 205 | abed
Data ares top | dddd3 | socet | 2045 | abed | 30.0 abcd
Horizontal category border (rows) vabis Cepiien

Hatizantal dimension barder (roves) . a. Testforfootnote a.

“Yertical category border (rowves) . b. Text for footnote b. :
Yertical dimension border (rows) SN
Hewvirord ol acdonieen s bowcdowe doel ianeme

Style

——

To change table borders:
» Click the Borders tab.

» Select aborder location, either by clicking its namein the list or by clicking aline in the Sample
area.

» Select aline style or select None.
» Select acolor.

» Click OK or Apply.

Table Properties: Printing

You can control the following properties for printed pivot tables:
m  Print al layers or only the top layer of the table, and print each layer on a separate page.
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m  Shrink atable horizontally or vertically to fit the page for printing.

m  Control widow/orphan lines by controlling the minimum number of rows and columns that
will be contained in any printed section of atable if the table is too wide and/or too long

for the defined page size.

Note: If atableistoo long to fit on the current page because there is other output above
it, but it will fit within the defined page length, the table is automatically printed on a new

page, regardless of the widow/orphan setting.

®m Include continuation text for tablesthat don’t fit on asingle page. You can display continuation
text at the bottom of each page and at the top of each page. If neither option is selected,

the continuation text will not be displayed.

Figure 11-17
Table Properties dialog box, Printing tab

fE Table Pro perties

General | Footnotes | Cell Formats || Borders | Printing

|2 | At top of table (&t end of title)

..... a. Text for footnote a.

b. Text for foatnate b.

| ok §|[Cance|][gpply ][ Help ]

I_-Z Print all layers Sample
[ Print each layer on separate page Table Title
[7] Rescale wide table to fit page Layerlayer
I__. Rescale long table to fit page bbbk
= bbbbA bbbbZ2
Widow (Orphan lines: H aaaa aaaa
id dddd GOGD aaaal EEEE"S aaaal 3aaaz
Continustion te:xt: |(cc.m.) dddd1 ceec il abod | 2124 | abed
ceec? | oggs abed | 8365 | abed
aroup  ddddz seesd 105 abed | 5253 | abed
ceoe2 | 4142 | abed 205 abed
dddd3  ceecl | g9.45 abod 300 abcd
Position of Continuation Text Table Caption

To control pivot table printing properties:
» Click the Printing tab.
» Select the printing options that you want.

» Click OK or Apply.
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Cell Properties

Cell properties are applied to a selected cell. You can change the font, value format, alignment,
margins, and colors. Cell properties override table properties; therefore, if you change table
properties, you do not change any individually applied cell properties.

To change cell properties:
» Activate atable and select the cell(s) in the table.

» From the Format menu or the context menu choose Cell Properties.

Font and Background
The Font and Background tab controls the font style and color and background color for the
selected cellsin the table.

Figure 11-18
Cell Properties dialog box, Font and Background tab
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Format Value

The Format Value tab controls value formats for the selected cells. You can select formats for
numbers, dates, time, or currencies, and you can adjust the number of decimal digits that are

displayed.
Figure 11-19
Cell Properties dialog box, Format Value tab
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Alignment and Margins

The Alignment and Margins tab controls horizontal and vertical aignment of values and top,
bottom, left, and right margins for the selected cells. Mixed horizontal alignment aligns the
content of each cell according to its type. For example, dates are right-aligned and text values
are left-aligned.
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Figure 11-20

Cell Properties dialog box, Alignment and Margins tab
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Footnotes and Captions

Pivot Tables

You can add footnotes and captions to atable. You can also hide footnotes or captions, change

footnote markers, and renumber footnotes.

Some footnote attributes are controlled by table properties. For more information, see the topic

Table Properties: Footnotes on p. 240.

Adding Footnotes and Captions

To add a caption to a table:

» From the Insert menu choose Caption.

A footnote can be attached to any item in atable. To add a footnote:

Click atitle, cell, or caption within an activated pivot table.

» From the Insert menu choose Footnote.
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To Hide or Show a Caption

To hide a caption:
» Select the caption.

» From the View menu choose Hide.

To show hidden captions:

» From the View menu choose Show All.

To Hide or Show a Footnote in a Table

To hide a footnote:
» Select the footnote.

» From the View menu choose Hide or from the context menu choose Hide Footnote.

To show hidden footnotes:

» From the View menu choose Show All Footnotes.

Footnote Marker

Footnote Marker changes the character(s) that can be used to mark a footnote.

Figure 11-21
Footnote Marker dialog box
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To change footnote markers:
» Select afootnote.
» From the Format menu choose Footnote Marker.

» Enter one or two characters.

Renumbering Footnotes

When you have pivoted atable by switching rows, columns, and layers, the footnotes may be out
of order. To renumber the footnotes:

» From the Format menu choose Renumber Footnotes.
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Data Cell Widths

Set Data Cell Width is used to set all data cells to the same width.

Figure 11-22
Set Data Cell Width dialog box
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To set the width for all data cells:
» From the menus choose:
Format
Set Data Cell Widths...

» Enter avaue for the cell width.

Changing Column Width

» Click and drag the column border.

Displaying Hidden Borders in a Pivot Table

For tables without many visible borders, you can display the hidden borders. This can simplify
tasks like changing column widths.

» From the View menu choose Gridlines.
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Figure 11-23
Gridlines displayed for hidden borders
Gender
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Selecting Rows and Columns in a Pivot Table

In pivot tables, there are some constraints on how you select entire rows and columns, and the
visual highlight that indicates the selected row or column may span noncontiguous areas of
the table. To select an entire row or column:

» Click arow or column label.
» From the menus choose;
Edit
Select
Data and Label Cells
or
» Right-click the category label for the row or column.
» From the context menu choose:
Select
Data and Label Cells
or

» Ctrl+Alt+click the row or column label.
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Printing Pivot Tables

Several factors can affect the way that printed pivot tables ook, and these factors can be controlled
by changing pivot table attributes.

m  For multidimensional pivot tables (tables with layers), you can either print al layers or print
only the top (visible) layer. For more information, see the topic Table Properties: Printing
onp. 243.

m  For long or wide pivot tables, you can automatically resize the table to fit the page or control
the location of table breaks and page breaks. For more information, see the topic Table
Properties: Printing on p. 243.

m For tables that are too wide or too long for a single page, you can control the location of
table breaks between pages.

Use Print Preview on the File menu to see how printed pivot tables will look.

Controlling Table Breaks for Wide and Long Tables

Pivot tables that are either too wide or too long to print within the defined page size are
automatically split and printed in multiple sections. (For wide tables, multiple sections will print
on the same page if there isroom.) You can:

m  Control the row and column locations where large tables are split.
m  Specify rows and columns that should be kept together when tables are split.
m Rescae large tables to fit the defined page size.

To Specify Row and Column Breaks for Printed Pivot Tables

» Click the column label to the left of where you want to insert the break, or click the row label
above where you want to insert the break.

» From the menus choose;

Format
Break Here

To Specify Rows or Columns to Keep Together

» Select the labels of the rows or columns that you want to keep together. (Click and drag or
Shift+click to select multiple row or column labels.)

» From the menus choose;

Format
Keep Together

Creating a Chart from a Pivot Table
» Double-click the pivot table to activate it.

» Select the rows, columns, or cells you want to display in the chart.
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» Right-click anywhere in the selected area.

» Choose Create Graph from the context menu and select a chart type.
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Models

Some results are presented as models, which appear in the output Viewer as a specia type of
visualization. The visualization displayed in the output Viewer is not the only view of the model
that isavailable. A single model contains many different views. You can activate the model in the
Model Viewer and interact with the model directly to display the available model views. You
can also choose to print and export al the views in the model.

Interacting with a Model

To interact with amodel, you first activate it:
» Double-click the model.
or
» Right-click the model and from the context menu choose Edit Content.

» From the submenu choose In Separate Window.

Activating the model displays the model inthe Model Viewer. For more information, see the topic
Working with the Model Viewer on p. 253.

Working with the Model Viewer

The Model Viewer is an interactive tool for displaying the available model views and editing the
look of the model views. (For information about displaying the Model Viewer, see Interacting
with aModel on p. 253.) The Model Viewer is split into two parts:

m  Main view. The main view appearsin the left part of the Model Viewer. The main view
displays some general visualization (for example, a network graph) for the model. The main
view itself may have more than one model view. The drop-down list below the main view
allows you to choose from the available main views.

m  Auxiliary view. The auxiliary view appears in the right part of the Model Viewer. The
auxiliary view typically displays amore detailed visualization (including tables) of the model
compared to the general visualization in the main view. Like the main view, the auxiliary
view may have more than one model view. The drop-down list below the auxiliary view
allows you to choose from the available main views. The auxiliary can aso display specific
visualizations for elements that are selected in the main view. For example, depending on
the type of model, you may be able to select a variable node in the main view to display a
table for that variable in the auxiliary view.
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The specific visualizations that are displayed depend on the procedure that created the model. For
information about working with specific models, refer to the documentation for the procedure
that created the model.

Model View Tables

Tables displayed in the Model Viewer are not pivot tables. You cannot manipulate these tables
as you can manipulate pivot tables.

Setting Model Properties

Within the Model Viewer, you can set specific properties for the model. For more information, see
the topic Model Properties on p. 254.

Copying Model Views

You can also copy individual model views within the Model Viewer. For more information, see
the topic Copying Model Views on p. 254.

Model Properties

From within the Model Viewer, choose from the menus:

File
Properties

Each model has associated properties that let you specify which views are printed from the output
Viewer. By default, only the view that is visible in the output Viewer is printed. Thisis always
amain view, and only one main view. You can also specify that all available model views are
printed. These include all the main views and all the auxiliary views (except for auxiliary views
based on selection in the main view; these are not printed). Note that you can also print individual
model views within the Model Viewer itself. For more information, see the topic Printing a
Model on p. 254.

Copying Model Views

From the Edit menu within the Model Viewer, you can copy the currently displayed main view or
the currently display auxiliary view. Only one model view is copied. You can paste the model
view into the output Viewer, where the individual model view is subsequently rendered as a
visualization that can be edited in the Graphboard Editor. Pasting into the output Viewer allows
you to display multiple model views simultaneously. You can aso paste into other applications,
where the view may appear as an image or a table depending on the target application.

Printing a Model

Printing from the Model Viewer

You can print asingle model view within the Model Viewer itself.
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» Activate the model in the Model Viewer. For more information, see the topic Interacting with
aModel on p. 253.

» From the menus choose:

View
Edit Mode

» On the General toolbar palette in the main or auxiliary view (depending on which one you want
to print), click the print icon. (If this palette is not displayed, choose Palettes>General from the
View menu.)

Printing from the Output Viewer

When you print from the output Viewer, the number of views that are printed for a specific model
depend on the model’s properties. The model can be set to print only the displayed view or al of
the available model views. For more information, see the topic Model Properties on p. 254.

Exporting a Model

By default, when you export models from the output Viewer, inclusion or exclusion of model
views is controlled by the model properties for each model. For more information about model
properties, see Model Properties on p. 254. On export, you can override this setting and include
all model views or only the currently visible model view. In the Export Output dialog box, click
Change Options... in the Document group. For more information about exporting and this dialog
box, see Export Output on p. 212. Note that all model views, including tables, are exported as
graphics. Also note that auxiliary views based on selections in the main view are never exported.



Chapter

13

Working with Command Syntax

The powerful command language alows you to save and automate many common tasks. It aso
provides some functionality not found in the menus and dialog boxes.

Most commands are accessible from the menus and dialog boxes. However, some commands
and options are available only by using the command language. The command language also
allows you to save your jobsin a syntax file so that you can repeat your analysis at a later date or
run it in an automated job with the a production job.

A syntax fileis simply atext file that contains commands. While it is possible to open a syntax
window and type in commands, it is often easier if you let the software help you build your
syntax file using one of the following methods:

m Pasting command syntax from dialog boxes

m  Copying syntax from the output log

m  Copying syntax from the journal file

Detailed command syntax reference information is available in two forms: integrated into the
overall Help system and as a separate PDF file, called the Command Syntax Reference, also

available from the Help menu. Context-sensitive Help for the current command in a syntax
window is available by pressing the F1 key.

Syntax Rules

When you run commands from a command syntax window during a session, you are running
commands in inter active mode.

The following rules apply to command specifications in interactive mode:

m Each command must start on anew line. Commands can begin in any column of a command
line and continue for as many lines as needed. The exception isthe END DATA command,
which must begin in the first column of the first line after the end of data.

m  Each command should end with a period as a command terminator. It is best to omit the
terminator on BEGIN DATA, however, so that inline data are treated as one continuous
specification.

m  The command terminator must be the last nonblank character in a command.

m In the absence of a period as the command terminator, a blank line is interpreted as a
command terminator.

Note: For compatibility with other modes of command execution (including command files run
with INSERT Or INCLUDE commands in an interactive session), each line of command syntax
should not exceed 256 bytes.
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®  Most subcommands are separated by slashes (/). The slash before the first subcommand
on acommand is usually optional.

Variable names must be spelled out fully.
Text included within apostrophes or quotation marks must be contained on asingle line.
A period (.) must be used to indicate decimals, regardless of your regiona or locale settings.

Variable names ending in a period can cause errors in commands created by the dialog boxes.
You cannot create such variable names in the dialog boxes, and you should generally avoid
them.

Command syntax is case insensitive, and three- or four-letter abbreviations can be used for many
command specifications. You can use as many lines as you want to specify a single command.
You can add space or break lines at amost any point where a single blank is allowed, such as
around slashes, parentheses, arithmetic operators, or between variable names. For example,

FREQUENCIES
VARIABLES=JOBCAT GENDER
/PERCENTILES=25 50 75
/BARCHART.

and

freq var=jobcat gender /percent=25 50 75 /bar.

are both acceptable alternatives that generate the same resullts.

INCLUDE Files
For command files run viathe INCLUDE command, batch mode syntax rules apply.

The following rules apply to command specifications in batch mode:

m  All commands in the command file must begin in column 1. You can use plus (+) or minus
(=) signsin thefirst column if you want to indent the command specification to make the
command file more readable.

m |f multiple lines are used for a command, column 1 of each continuation line must be blank.
m  Command terminators are optional.

® A line cannot exceed 256 bytes; any additional characters are truncated.

Unless you have existing command files that already use the TNCLUDE command, you should
probably use the TNSERT command instead, since it can accommodate command files that
conform to either set of rules. If you generate command syntax by pasting dialog box choices

into a syntax window, the format of the commands is suitable for any mode of operation. Seethe
Command Syntax Reference (available in PDF format from the Help menu) for more information.
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Pasting Syntax from Dialog Boxes

The easiest way to build acommand syntax file is to make selectionsin dialog boxes and paste the
syntax for the selections into a syntax window. By pasting the syntax at each step of alengthy
analysis, you can build ajob file that allows you to repeat the analysis at a later date or run an
automated job with the Production Facility.

In the syntax window, you can run the pasted syntax, edit it, and saveit in asyntax file.

To Paste Syntax from Dialog Boxes

» Open the dialog box and make the selections that you want.

» Click Paste.

The command syntax is pasted to the designated syntax window. If you do not have an open
syntax window, a new syntax window opens automatically, and the syntax is pasted there.

Figure 13-1
Command syntax pasted from a dialog box
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Copying Syntax from the Output Log

You can build a syntax file by copying command syntax from the log that appearsin the Viewer.
To use this method, you must select Display commands in the log in the Viewer settings (Edit
menu, Options, Viewer tab) before running the analysis. Each command will then appear in the
Viewer along with the output from the analysis.

In the syntax window, you can run the pasted syntax, edit it, and save it in a syntax file.
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Figure 13-2
Command syntax in the log
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To Copy Syntax from the Output Log

>

Before running the analysis, from the menus choose:
Edit
Options...

On the Viewer tab, select Display commands in the log.

Asyou run analyses, the commands for your dialog box selections are recorded in the log.

Open aprevioudly saved syntax file or create a new one. To create a new syntax file, from the

menus choose:

File
New
Syntax

In the Viewer, double-click alog item to activate it.
Select the text that you want to copy.
From the Viewer menus choose;

Edit
Copy
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» In asyntax window, from the menus choose:
Edit
Paste

Using the Syntax Editor

The Syntax Editor provides an environment specifically designed for creating, editing, and
running command syntax. The Syntax Editor features:

m  Auto-Completion. Asyou type, you can select commands, subcommands, keywords, and
keyword values from a context-sensitive list. You can choose to be prompted automatically
with the list or display the list on demand.

m  Color Coding. Recognized elements of command syntax (commands, subcommands,
keywords, and keyword values) are color coded so, at a glance, you can spot unrecognized
terms. Also, a number of common syntactical errors—such as unmatched quotes—are color
coded for quick identification.

m  Breakpoints. You can stop execution of command syntax at specified points, allowing you to
inspect the data or output before proceeding.

® Bookmarks. You can set bookmarks that allow you to quickly navigate large command syntax
files.

m  Step Through. You can step through command syntax one command at a time, advancing to the
next command with a single click.

Note: When working with right to left languages, it is recommended to check the Optimize for
right to left languages box on the Syntax Editor tab in the Options dialog box.



261

Working with Command Syntax

Syntax Editor Window

Figure 13-3
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The Syntax Editor window is divided into four areas:

m  The editor paneis the main part of the Syntax Editor window and is where you enter and
edit command syntax.

m  The gutter is adjacent to the editor pane and displays information such as line numbers and
breakpoint positions.

® The navigation pane is to the left of the gutter and editor pane and displays a list of all
commands in the Syntax Editor window and provides single click navigation to any command.

m  Theerror paneis below the editor pane and displays runtime errors.

Gutter Contents

Line numbers, breakpoints, bookmarks, command spans, and a progress indicator are displayed in
the gutter to the left of the editor pane in the syntax window.

m Line numbers do not account for any external files referenced in INSERT and INCLUDE
commands. You can show or hide line numbers by choosing View > Show Line Numbers
from the menus.

m  Breakpoints stop execution at specified points and are represented as ared circle adjacent to
the command on which the breakpoint is set.

m  Bookmarks mark specific lines in a command syntax file and are represented as a square
enclosing the number (1-9) assigned to the bookmark. Hovering over the icon for a bookmark
displays the number of the bookmark and the name, if any, assigned to the bookmark.
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m  Command spans are icons that provide visua indicators of the start and end of a command.
You can show or hide command spans by choosing View > Show Command Spans from
the menus.

m  The progress of agiven syntax run isindicated with a downward pointing arrow in the guitter,
stretching from the first command run to the last command run. Thisis most useful when
running command syntax containing breakpoints and when stepping through command
syntax. For more information, see the topic Running Command Syntax on p. 267.

Navigation Pane

The navigation pane contains a list of al recognized commands in the syntax window, displayed
in the order in which they occur in the window. Clicking on a command in the navigation pane
positions the cursor at the start of the command.

®  You can use the Up and Down arrow keys to move through the list of commands or click on a
command to navigate toit. A double click will select the command.

m  Command names for commands containing certain types of syntactical errors—such as
unmatched quotes—are colored red and in bold text by default. For more information, see
the topic Color Coding on p. 263.

m  Thefirst word of each line of unrecognized text is shown in gray.

® You can show or hide the navigation pane by choosing View > Show Navigation Pane from
the menus.

Error Pane

The error pane displays runtime errors from the most previous run.

m  Theinformation for each error contains the line number on which the error occurred.

®  You can use the Up and Down arrow keys to move through the list of errors.

m  Clicking on an entry in the list will position the cursor on the line that generated the error.
® You can show or hide the error pane by choosing View > Show Error Pane from the menus.

Terminology

Commands. The basic unit of syntax is the command. Each command begins with the command
name, which consists of one, two, or three words—for example, DESCRIPTIVES, SORT CASES,
or ADD VALUE LABELS.

Subcommands. Most commands contain subcommands. Subcommands provide for additional
specifications and begin with aforward slash followed by the name of the subcommand.

Keywords. Keywords are fixed terms that are typically used within a subcommand to specify
options available for the subcommand.

Keyword Values. Keywords can have values such as a fixed term that specifies an option or a
numeric value.
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Example

CODEBOOK gender jobcat salary
/VARINFO VALUELABELS MISSING
/OPTIONS VARORDER=MEASURE.

The name of the command is CODEBOOXK.
VARINFO and OPTIONS are subcommands.
VALUELABELS, MISSING, and VARORDER are keywords.

MEASURE is a keyword value associated with VARORDER.

Auto-Completion

The Syntax Editor provides assistance in the form of auto-completion of commands,
subcommands, keywords, and keyword values. By default, you are prompted with a
context-sensitive list of available terms. You can display the list on demand by pressing
Ctrl+Spacebar and you can close the list by pressing the Esc key.

The Auto Complete menu item on the Tools menu toggles the automatic display of the
auto-complete list on or off. You can also enable or disable automatic display of the list from the
Syntax Editor tab in the Options dialog box. Toggling the Auto Complete menu item overrides the
setting on the Options dialog but does not persist across sessions.

Note: The auto-completion list will close if a space is entered. For commands consisting of
multiple words—such as ApD FILES—select the desired command before entering any spaces.

Color Coding

The Syntax Editor color codes recognized elements of command syntax, such as commands
and subcommands, as well as various syntactical errors like unmatched quotes or parentheses.
Unrecognized text is not color coded.

Commands. By default, recognized commands are colored blue and in bold text. If, however,
there is arecognized syntactica error within the command—such as a missing parenthesis—the
command name is colored red and in bold text by default.

Note: Abbreviations of command names—such as FREQ for FREQUENCIES—are not colored, but
such abbreviations are valid.

Subcommands. Recognized subcommands are colored green by default. If, however, the
subcommand is missing a required equals sign or an invalid equals sign follows it, the
subcommand name is colored red by default.

Keywords. Recognized keywords are colored maroon by default. If, however, the keyword is
missing arequired equals sign or an invalid equals sign followsit, the keyword is colored red
by default.

Keyword values. Recognized keyword values are colored pink by default. User-specified values of
keywords such as integers, real numbers, and quoted strings are not color coded.

Comments. Text within a comment is colored gray.
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Syntactical Errors. Text associated with the following syntactical errorsis colored red by default.

m  Unmatched Parentheses, Brackets, and Quotes. Unmatched parentheses and brackets within
comments and quoted strings are not detected. Unmatched single or double quotes within
quoted strings are syntactically valid.

Certain commands contain blocks of text that are not command syntax—such as BEGIN
DATA-END DATA, BEGIN GPL-END GPL, and BEGIN PROGRAM-END PROGRAM.
Unmatched values are not detected within such blocks.

®m Long lines. Long lines are lines containing more than 251 characters.

m  End statements. Several commands require either an END statement prior to the command
terminator (for example, BEGIN DATA-END DATA) Of require a matching END command at
some point later in the command stream (for example, LooP-END L.0OP). In both cases, the
command will be colored red, by default, until the required END statement is added.

From the Syntax Editor tab in the Options dialog box, you can change default colors and text
styles and you can turn color coding off or on. You can also turn color coding of commands,
subcommands, keywords, and keyword values off or on by choosing Tools > Color Coding
from the menus. You can turn color coding of syntactical errors off or on by choosing Tools >
Validation. Choices made on the Tools menu override settings in the Options dialog box but do
not persist across sessions.

Note: Color coding of command syntax within macros is not supported.

Breakpoints

Breakpoints allow you to stop execution of command syntax at specified points within the syntax
window and continue execution when ready.

m Breakpoints are set at the level of a command and stop execution prior to running the
command.

m  Breakpoints cannot occur within LOOP-END LOOP, DO IF-END IF, DO REPEAT-END
REPEAT, INPUT PROGRAM-END INPUT PROGRAM, and MATRIX-END MATRIX blocks.
They can, however, be set at the beginning of such blocks and will stop execution prior
to running the block.

m  Breakpoints cannot be set on lines containing non-PASW Statistics command syntax, such
as occur within BEGIN PROGRAM-END PROGRAM, BEGIN DATA-END DATA, and BEGIN
GPL-END GPL blocks.

m  Breakpoints are not saved with the command syntax file and are not included in copied text.

m By default, breakpoints are honored during execution. You can toggle whether breakpoints are
honored or not from Tools > Honor Breakpoints.

To Insert a Breakpoint

» Click anywhere in the gutter to the left of the command text.

or

» Position the cursor within the desired command.
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» From the menus choose:

Tools
Toggle Breakpoint

The breakpoint is represented as ared circle in the gutter to the left of the command text and on
the same line as the command name.

Clearing Breakpoints

To clear a single breakpoint:

» Click ontheicon representing the breakpoint in the gutter to the left of the command text.
or

» Position the cursor within the desired command.

» From the menus choose;

Tools
Toggle Breakpoint

To clear al breakpoints:

» From the menus choose;

Tools
Clear All Breakpoints

See Running Command Syntax on p. 267 for information about the run-time behavior in the
presence of breakpoints.

Bookmarks

Bookmarks allow you to quickly navigate to specified positions in a command syntax file. You
can have up to 9 bookmarks in a given file. Bookmarks are saved with the file, but are not
included when copying text.

To Insert a Bookmark

» Position the cursor on the line where you want to insert the bookmark.

» From the menus choose;

Tools
Toggle Bookmark

The new bookmark is assigned the next available number, from 1 to 9. It isrepresented as a square
enclosing the assigned number and displayed in the gutter to the left of the command text.

Clearing Bookmarks

To clear a single bookmark:

» Position the cursor on the line containing the bookmark.
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» From the menus choose:

Tools
Toggle Bookmark

To clear all bookmarks:

» From the menus choose:

Tools
Clear All Bookmarks

Renaming a Bookmark

You can associate a name with a bookmark. Thisisin addition to the number (1-9) assigned to
the bookmark when it was created.

» From the menus choose:

Tools
Rename Bookmark

» Enter aname for the bookmark and click OK.

The specified name replaces any existing name for the bookmark.

Navigating with Bookmarks

To navigate to the next or previous bookmark:

» From the menus choose;

Tools
Next Bookmark

or

Tools
Previous Bookmark

To navigate to a specific bookmark:

» From the menus choose;

Tools
Go To Bookmark

» Select the desired bookmark.

Commenting Out Text

You can comment out entire commands as well as text that is not recognized as command syntax.

» Select the desired text. When selecting multiple commands, a command will be commented out
if any part of it is selected.

» From the menus choose;

Tools
Comment Selection
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You can comment out a single command by positioning the cursor anywhere within the command
and clicking the Comment Selection button on the toolbar.

Running Command Syntax
» Highlight the commands that you want to run in the syntax window.

» Click the Run button (the right-pointing triangle) on the Syntax Editor toolbar. It runs the selected
commands or the command where the cursor islocated if there is no selection.

or

» Choose one of the items from the Run menu.
®  All. Runsal commandsin the syntax window, honoring any breakpoints.

m  Selection. Runs the currently selected commands, honoring any breakpoints. This includes
any partially highlighted commands. If thereis no selection, the command where the cursor
is positioned is run.

m  To End. Runsall commands starting from the first command in the current selection to the
last command in the syntax window, honoring any breakpoints. If nothing is selected, the
run starts from the command where the cursor is positioned.

m  Step Through. Runs the command syntax one command at a time starting from the first
command in the syntax window (Step Through From Start) or from the command where the
cursor is positioned (Step Through From Current). If there is selected text, the run starts from
the first command in the selection. After a given command has run, the cursor advances to the
next command and you continue the step through sequence by choosing Continue.

LOOP-END LOOP, DO IF-END IF,DO REPEAT-END REPEAT, INPUT PROGRAM-END
INPUT PROGRAM, and MATRIX-END MATRIX blocks are treated as single commands when
using Step Through. You can not step into one of these blocks.

m  Continue. Continues arun stopped by a breakpoint or Step Through.

Progress Indicator

The progress of a given syntax run is indicated with a downward pointing arrow in the gutter,
spanning the last set of commands run. For instance, you choose to run al commands in a syntax
window that contains breakpoints. At the first breakpoint, the arrow will span the region from the
first command in the window to the command prior to the one containing the breakpoint. At the
second breakpoint, the arrow will stretch from the command containing the first breakpoint to the
command prior to the one containing the second breakpoint.

Run-time Behavior with Breakpoints

®  When running command syntax containing breakpoints, execution stops at each breakpoint.
Specifically, the block of command syntax from a given breakpoint (or beginning of the run)
to the next breakpoint (or end of the run) is submitted for execution exactly as if you had
selected that syntax and chosen Run > Selection.
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®  You can work with multiple syntax windows, each with its own set of breakpoints, but thereis
only one queue for executing command syntax. Once a block of command syntax has been
submitted—such as the block of command syntax up to the first breakpoint—no other block
of command syntax will be executed until the previous block has completed, regardless of
whether the blocks are in the same or different syntax windows.

m  With execution stopped at a breakpoint, you can run command syntax in other syntax
windows, and inspect Data Editor or Viewer windows. However, modifying the contents of
the syntax window containing the breakpoint or changing the cursor position in that window
will cancel the run.

Unicode Syntax Files

In Unicode mode, the default format for saving command syntax files created or modified during
the session is aso Unicode (UTF-8). Unicode-format command syntax files cannot be read by
versions of PASW Statistics prior to 16.0. For more information on Unicode mode, see General
Options on p. 291.

To save a syntax file in aformat compatible with earlier rel eases:

From the syntax window menus, choose:
File
Save As

In the Save As dialog, from the Encoding drop-down list, choose Local Encoding. The local
encoding is determined by the current locale.

Multiple Execute Commands

Syntax pasted from dialog boxes or copied from the log or the journal may contain EXECUTE
commands. When you run commands from a syntax window, EXECUTE commands are generally
unnecessary and may slow performance, particularly with larger data files, because each EXECUTE
command reads the entire data file. For more information, see the ExEcuTE command in the
Command Syntax Reference (available from the Help menu in any PASW Statistics window).

Lag Functions

One notable exception is transformation commands that contain lag functions. In a series of
transformation commands without any intervening EXECUTE commands or other commands that
read the data, lag functions are calculated after all other transformations, regardless of command
order. For example,

COMPUTE lagvar=LAG(varl) .
COMPUTE varl=varl*2.

and

COMPUTE lagvar=LAG(varl) .
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EXECUTE.
COMPUTE varl=varl*2.

yield very different results for the value of lagvar, since the former uses the transformed value of
var1 while the latter uses the origina value.
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Overview of the Chart Facility

High-resolution charts and plots are created by the procedures on the Graphs menu and by many
of the procedures on the Analyze menu. This chapter provides an overview of the chart facility.

Building and Editing a Chart

Before you can create a chart, you need to have your data in the Data Editor. You can enter
the data directly into the Data Editor; open a previously saved datafile; or read a spreadsheet,
tab-delimited datafile, or database file. The Tutorial selection on the Help menu has online
examples of creating and modifying a chart, and the online Help system provides information
about creating and modifying all chart types.

Building Charts

The Chart Builder allows you to build charts from predefined gallery charts or from the individual
parts (for example, axes and bars). You build a chart by dragging and dropping the gallery charts
or basic elements onto the canvas, which is the large area to the right of the Variableslist in the
Chart Builder dialog box.

Asyou are building the chart, the canvas displays a preview of the chart. Although the preview
uses defined variable labels and measurement levels, it does not display your actual data. Instead,
it uses randomly generated data to provide a rough sketch of how the chart will look.

Using the gallery is the preferred method for new users. For information about using the
gallery, see Building a Chart from the Gallery on p. 271.

How to Start the Chart Builder

» From the menus choose;

Graphs
Chart Builder

This opens the Chart Builder dialog box.

270
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Figure 14-1
Chart Builder dialog box
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Building a Chart from the Gallery

The easiest method for building chartsis to use the gallery. Following are general steps for
building a chart from the gallery.

» Click the Gallery tab if it is not already displayed.
» Inthe Choose From list, select a category of charts. Each category offers several types.

» Drag the picture of the desired chart onto the canvas. You can also double-click the picture. If the
canvas already displays a chart, the gallery chart replaces the axis set and graphic elements on
the chart.

» Drag variables from the Variables list and drop them into the axis drop zones and, if available,
the grouping drop zone. If an axis drop zone aready displays a statistic and you want to use that
statistic, you do not have to drag a variable into the drop zone. You need to add avariableto a
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zone only when the text in the zone is blue. If the text is black, the zone already contains a
variable or statistic.

Note: The measurement level of your variablesisimportant. The Chart Builder sets defaults based
on the measurement level while you are building the chart. Furthermore, the resulting chart may
also look different for different measurement levels. You can temporarily change a variable's
measurement level by right-clicking the variable and choosing an option.

Figure 14-2
Chart Builder dialog box with completed drop zones
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If you need to change statistics or modify attributes of the axes or legends (such as the scale
range), click Element Properties.
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Figure 14-3
Element Properties dialog box
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Overview of the Chart Facility

In the Edit Properties Of list, select the item you want to change. (For information about the

specific properties, click Help.)

After making any changes, click Apply.

If you need to add more variables to the chart (for example, for clustering or paneling), click the
Groups/Point ID tab in the Chart Builder dialog box and select one or more options. Then drag

categorical variables to the new drop zones that appear on the canvas.

If you want to transpose the chart (for example, to make the bars horizontal), click the Basic

Elements tab and then click Transpose.

Click OK to create the chart. The chart is displayed in the Viewer.
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Figure 14-4
Bar chart displayed in Viewer window
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Editing Charts

The Chart Editor provides a powerful, easy-to-use environment where you can customize your
charts and explore your data. The Chart Editor features:

m  Simple, intuitive user interface. You can quickly select and edit parts of the chart using menus,
context menus, and toolbars. You can also enter text directly on a chart.

m  Wide range of formatting and statistical options. You can choose from afull range of styles
and statistical options.

m  Powerful exploratory tools. You can explore your datain various ways, such as by labeling,
reordering, and rotating it. You can change chart types and the roles of variablesin the chart.
You can also add distribution curves and fit, interpolation, and reference lines.

m  Flexible templates for consistent look and behavior. You can create customized templates and
use them to easily create charts with the look and options that you want. For example, if
you always want a specific orientation for axis labels, you can specify the orientation in a
template and apply the template to other charts.

How to View the Chart Editor
» Create achart in PASW Statistics, or open a Viewer file with charts.

» Double-click achart in the Viewer.

The chart is displayed in the Chart Editor.
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Figure 14-5
Chart displayed in the Chart Editor
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Chart Editor Fundamentals

The Chart Editor provides various methods for manipulating charts.

Menus

Many actions that you can perform in the Chart Editor are done with the menus, especially
when you are adding an item to the chart. For example, you use the menus to add afit lineto a
scatterplot. After adding an item to the chart, you often use the Properties dialog box to specify
options for the added item.

Properties Dialog Box
Options for the chart and its chart elements can be found in the Properties dialog box.

To view the Properties dialog box, you can:
» Double-click a chart element.
or
» Select achart element, and then from the menus choose:

Edit
Properties

Additionally, the Properties dialog box automatically appears when you add an item to the chart.
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Figure 14-6
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The Properties dialog box has tabs that allow you to set the options and make other changesto a
chart. The tabs that you see in the Properties dialog box are based on your current selection.

Some tabs include a preview to give you an idea of how the changes will affect the selection
when you apply them. However, the chart itself does not reflect your changes until you click
Apply. You can make changes on more than one tab before you click Apply. If you have to change
the selection to modify a different element on the chart, click Apply before changing the selection.
If you do not click Apply before changing the selection, clicking Apply at alater point will apply
changes only to the element or elements currently selected.

Depending on your selection, only certain settings will be available. The help for the individua
tabs specifies what you need to select to view the tabs. If multiple elements are selected, you can
change only those settings that are common to all the elements.

Toolbars

The toolbars provide a shortcut for some of the functionality in the Properties dialog box. For
example, instead of using the Text tab in the Properties dialog box, you can use the Edit toolbar to
change the font and style of the text.



277

Overview of the Chart Facility

Saving the Changes

Chart modifications are saved when you close the Chart Editor. The modified chart is subsequently
displayed in the Viewer.

Chart Definition Options

When you are defining a chart in the Chart Builder, you can add titles and change options for the
chart creation.

Adding and Editing Titles and Footnotes

You can add titles and footnotes to the chart to help a viewer interpret it. The Chart Builder also
automatically displays error bar information in the footnotes.

How to Add Titles and Footnotes

» Click the Titles/Footnotes tab.

» Select one or more titles and footnotes. The canvas displays some text to indicate that these
were added to the chart.

» Usethe Element Properties dialog box to edit the title/footnote text.
How to Remove a Title or Footnote

» Click the Titles/Footnotes tab.

» Deselect thetitle or footnote that you want to remove.
How to Edit the Title or Footnote Text
When you add titles and footnotes, you cannot edit their associated text directly on the chart. As
with other items in the Chart Builder, you edit them using the Element Properties dialog box.

» Click Element Properties if the Element Properties dialog box is not displayed.

» Inthe Edit Properties Of list, select atitle, subtitle, or footnote (for example, Title 1).

» Inthe content box, type the text associated with the title, subtitle, or footnote.

» Click Apply.

Setting General Options

The Chart Builder offers general options for the chart. These are options that apply to the overall
chart, rather than a specific item on the chart. General options include missing value handling,
templates, chart size, and panel wrapping.

» Click Options.
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Modify the general options. Details about these follow.

Click Apply.

User-Missing Values

Break Variables. If there are missing values for the variables used to define categories or
subgroups, select Include so that the category or categories of user-missing values (values
identified as missing by the user) are included in the chart. These “missing” categories also act as
break variablesin calculating the statistic. The “missing” category or categories are displayed on
the category axis or in the legend, adding, for example, an extra bar or adice to apie chart. If
there are no missing values, the “missing” categories are not displayed.

If you select this option and want to suppress display after the chart is drawn, open the chart in
the Chart Editor and choose Properties from the Edit menu. Use the Categories tab to move the
categories that you want to suppress to the Excluded list. Note, however, that the statistics are not
recalculated if you hide the “missing” categories. Therefore, something like a percent statistic will
still take the “missing” categories into account.

Note: This control does not affect system-missing values. These are always excluded from the
chart.

Summary Statistics and Case Values. You can choose one of the following aternatives for exclusion

of cases having missing values:

m Exclude listwise to obtain a consistent base for the chart. If any of the variablesin the chart has
amissing value for a given case, the whole case is excluded from the chart.

®m  Exclude variable-by-variable to maximize the use of the data. If a selected variable has any
missing values, the cases having those missing values are excluded when the variable is
analyzed.

To see the difference between listwise and variable-by-variable exclusion of missing vaues,
consider the following figures, which show abar chart for each of the two options.

Figure 14-7
Listwise exclusion of missing values
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Figure 14-8
Variable-by-variable exclusion of missing values
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The data include some system-missing (blank) values in the variables for Current Salary and
Employment Category. In some other cases, the value 0 was entered and defined as missing. For
both charts, the option Display groups defined by missing values is selected, which adds the category
Missing to the other displayed job categories. In each chart, the values of the summary function,
Number of cases, are displayed in the bar labels.

In both charts, 26 cases have a system-missing value for the job category, and 13 cases have the
user-missing value (0). In the listwise chart, the number of casesisthe same for both variablesin
each bar cluster because whenever a value was missing, the case was excluded for all variables. In
the variable-by-variable chart, the number of nonmissing cases for each variable in a category
is plotted without regard to missing values in other variables.

Templates

A chart template allows you to apply the attributes of one chart to another. When you open a chart
in the Chart Editor, you can save it as atemplate. You can then apply that template by specifying
it at creation or later by applying it in the Chart Editor.

Default Template. Thisis the template specified by the Options. You can access these by choosing
Options from the Edit menu in the Data Editor and then clicking the Charts tab. The default
template is applied first, which means that the other templates can overrideit.

Template Files. Click Add to specify one or more templates with the standard file selection dialog
box. These are applied in the order in which they appear. Therefore, templates at the end of the
list can override templates at the beginning of the list.

Chart Size and Panels

Chart Size. Specify a percentage greater than 100 to enlarge the chart or less than 100 to shrink it.
The percentage is relative to the default chart size.

Panels. When there are many panel columns, select Wrap Panels to allow panelsto wrap across
rows rather than being forced to fit in a specific row. Unlessthis option is selected, the panels are
shrunk to force them to fit in a row.
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Utilities

This chapter describes the functions found on the Utilities menu and the ability to reorder target
variable lists.

Variable Information

The Variables dialog box displays variable definition information for the currently selected
variable, including:

m  Variable label
m Dataformat
m  User-missing values
m  Valuelabels
m  Measurement level
Figure 15-1
Variables dialog box
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Visible. The Visible column in the variable list indicates if the variableis currently visible in the
Data Editor and in dialog box variable lists. Visihility is controlled by variable sets. For more
information, see the topic Variable Sets on p. 281.

Go To. Goesto the selected variable in the Data Editor window.
Paste. Pastes the selected variables into the designated syntax window at the cursor location.

280
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To modify variable definitions, use the Variable view in the Data Editor.

To Obtain Variable Information

» From the menus choose;
Utilities
Variables...

» Select the variable for which you want to display variable definition information.

Data File Comments

You can include descriptive comments with a data file. For PASW Statistics data files, these
comments are saved with the datafile.

To Add, Modify, Delete, or Display Data File Comments

» From the menus choose:
Utilities
Data File Comments...

» To display the commentsin the Viewer, select Display comments in output.

Comments can be any length but are limited to 80 bytes (typically 80 characters in single-byte

languages) per line; lines will automatically wrap at 80 characters. Comments are displayed in the

same font as text output to accurately reflect how they will appear when displayed in the Viewer.
A date stamp (the current date in parentheses) is automatically appended to the end of the

list of comments whenever you add or modify comments. This may lead to some ambiguity

concerning the dates associated with comments if you modify an existing comment or insert a

new comment between existing comments.

Variable Sets

You can restrict the variables that are displayed in the Data Editor and in dialog box variable lists
by defining and using variable sets. Thisis particularly useful for datafiles with alarge number of
variables. Small variable sets make it easier to find and select the variables for your analysis.

Define Variable Sets

Define Variable Sets creates subsets of variables to display in the Data Editor and in dialog box
variable lists. Defined variable sets are saved with PASW Statistics data files.
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Figure 15-2
Define Variable Sets dialog box
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Set Name. Set names can be up to 64 bytes. Any characters, including blanks, can be used.

Variables in Set. Any combination of numeric and string variables can be included in aset. The
order of variablesin the set has no effect on the display order of the variables in the Data Editor or
in dialog box variable lists. A variable can belong to multiple sets.

To Define Variable Sets
From the menus choose;
Utilities
Define Variable Sets...
Select the variables that you want to include in the set.
Enter a name for the set (up to 64 bytes).

Click Add Set.

Using Variable Sets to Show and Hide Variables

Use Variable Sets restricts the variables displayed in the Data Editor and in dialog box variable
lists to the variables in the selected (checked) sets.
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Figure 15-3
Use Variable Sets dialog box
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m  The set of variables displayed in the Data Editor and in dialog box variable lists is the union
of all selected sets.

m A variable can be included in multiple selected sets.

m  Theorder of variablesin the selected sets and the order of selected sets have no effect on the
display order of variablesin the Data Editor or in dialog box variable lists.

m  Although the defined variable sets are saved with PASW Statistics data files, the list of
currently selected setsis reset to the default, built-in sets each time you open the datafile.

Thelist of available variable sets includes any variable sets defined for the active dataset, plus
two built-in sets:

m  ALLVARIABLES. This set contains all variablesin the datafile, including new variables created
during a session.

m  NEWVARIABLES. This set contains only new variables created during the session.

Note: Even if you save the data file after creating new variables, the new variables are still
included in the NEWVARIABLES set until you close and reopen the datafile.

At least one variable set must be selected. If ALLVARIABLES s selected, any other selected sets
will not have any visible effect, since this set contains al variables.

To Select Variable Sets to Display

» From the menus choose;
Utilities
Use Variable Sets...

» Select the defined variable sets that contain the variables that you want to appear in the Data
Editor and in dialog box variable lists.
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To Display All Variables

From the menus choose;
Utilities
Show All Variables

Reordering Target Variable Lists

Variables appear on dialog box target lists in the order in which they are selected from the source
list. If you want to change the order of variables on atarget list—but you don’t want to deselect all
of the variables and reselect them in the new order—you can move variables up and down on
the target list using the Ctrl key (Macintosh: Command key) with the up and down arrow keys.
You can move multiple variables simultaneously if they are contiguous (grouped together). You
cannot move noncontiguous groups of variables.

Working with Extension Bundles

Creating

Extension bundles provide the ability to package custom components, such as custom dialogs
and extension commands, so they can be easily installed by end users. For example, if you have
created a custom dialog for an extension command and wish to share this with other users, then
you'll want to create an extension bundle that contains the custom dialog package (.spd) file, and
the files associated with the extension command (the XML file that specifies the syntax of the
extension command and the implementation code file(s) written in Python or R). The extension
bundle is then what you share with other users.

Extension Bundles

How to Create an Extension Bundle
From the menus choose:
Utilities

Extension Bundles
Create Extension Bundle...

Enter values for al fields on the Required tab.
Enter values for any fields on the Optional tab that are needed for your extension bundle.
Specify atarget file for the extension bundle.

Click Save to save the extension bundle to the specified location. This closes the Create Extension
Bundle diaog box.
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Required Fields for Extension Bundles

Name. A unique name to associate with the extension bundle. It can consist of up to three words
and is not case sensitive. Characters are restricted to seven-bit ASCII. To minimize the possibility
of name conflicts, you may want to use a multi-word name, where the first word is an identifier for
your organization, such asa URL.

Files. Click Add to add the files associated with the extension bundle. An extension bundle must
at least include a custom dialog specification (.spd) file, or an XML specification file for an
extension command. If an XML specification fileisincluded then the bundle must include at least
one python or R code file—specifically, afile of type .py, pyc, .pyo, or .R.

Summary. A short description of the extension bundle, intended to be displayed as asingleline.

Description. A more detailed description of the extension bundle than that provided for the
Summary field. For example, you might list the major features available with the extension
bundle. If the extension bundle provides a wrapper for a function from an R package, then that
should be mentioned here.

Author. The author of the extension bundle. You may wish to include an email address.

Version. A version identifier of the form x.x.x, where each component of the identifier must
be an integer, asin 1.0.0. Zeros are implied if not provided. For example, a version identifier
of 3.1 implies 3.1.0.

Minimum PASW Statistics Version. The minimum version of PASW Statistics required to run
the extension bundle.

Optional Fields for Extension Bundles
Release Date. An optional release date. No formatting is provided.

Links. An optional set of URL'’s to associate with the extension bundle—for example, the author’s
home page. The format of thisfield is arbitrary so be sure to delimit multiple URL’s with spaces,
commas, or some other reasonable delimiter.

Categories. An optional set of categories with which to associate the extension bundle when
authoring an extension bundle for posting to Developer Central (http://mwww.spss.com/devcentral).
Enter one or more of the values that appear in the Filter Downloads drop-down list on the
Download Library page on Developer Central. For example, you might enter Extension
Commands, Satistics, and R.

Required Plug-ins. Check the boxes for any Plug-ins (Python or R) that are required in order to
run the custom components associated with the extension bundle. Users will be aerted at install
time if they don’t have the required Plug-ins.

Required R Packages. Enter the names of any R packages, from the CRAN package repository, that
are required for the extension bundle. Names are case sensitive. To add the first package, click
anywhere in the Required R Packages control to highlight the entry field. Pressing Enter, with the
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cursor in agiven row, will create anew row. You delete arow by selecting it and pressing Delete.
When the extension bundle is installed, PASW Statistics will check if the required R packages
exist on the end user’s machine and attempt to download and install any that are missing.

Required Python Modules. Enter the names of any Python modules, other than those added to the
extension bundle, that are required for the extension bundle. Any such modules should be posted
to Developer Central (http://www.spss.com/devcentral). To add the first module, click anywherein
the Required Python Modules control to highlight the entry field. Pressing Enter, with the cursor
inagiven row, will create anew row. You delete arow by selecting it and pressing Delete. The
end user is responsible for downloading any required Python modules and copying them to the
extensions directory under the PASW Statistics installation directory, or to an aternate location
specified by their SPSS EXTENS ONS_PATH environment variable.

Translation Catalogues Folder. You can include a folder containing translation catalogues created
with the GNU gettext utilities (http://www.gnu.org/software/gettext/). This allows you to provide
localized messages and localized output to end users of your extension bundle. For example, if
you have stored trandlation catal ogues for your extension bundle under the /myextbundle/po
folder, then browse to that folder and select it. Trandation catalogues are for use in localizing
output from Python and R programs. For more information, see the topics on the R Integration
Plug-in and the Python Integration Plug-in, in the Help system.

Installing Extension Bundles

To install an extension bundle;

From the menus choose:
Utilities
Extension Bundles
Install Extension Bundle...

Select the desired extension bundle. Extension bundles have afile type of spe.

If the extension bundle contains a custom dialog, you will be aerted that you need to restart
PASW Statistics to use the dialog. A restart is also required to use any extension commands
included with the bundle. To view details for the currently installed extension bundles, choose
Utilities>Extension Bundles>View Installed Extension Bundles.

You can aso install extension bundles with a command line utility that allows you to install
multiple bundles at once. For more information, see the topic Batch Installation of Extension
Bundles on p. 288.

Installation Locations for Extension Bundles

For Windows and Linux, and by default, installing an extension bundle requires write permission
to the PASW Statistics installation directory. If you do not have write permission to the required
location or would like to store extension bundles el sewhere, you can specify one or more aternate
locations by defining the SPSS EXTENSIONS PATH environment variable. When present,

the paths specified in SPSS EXTENSIONS PATH take precedence over the default location.
Extension bundles will be installed to the first writable location. For multiple locations, separate
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each with a semicolon on Windows and a colon on Linux. The specified locations must exist on
the target machine. After setting SPSS EXTENSIONS PATH , you will need to restart PASW
Statistics for the changes to take effect.

If the extension bundle contains a custom dialog and you don’t have write permission to the
PASW Statistics installation directory (for Windows and Linux) then you will also need to set the
SPSS CDIALOGS PATH environment variable. Therulesfor SPSS CDIALOGS PATH are the
same as for PSS EXTENS ONS PATH. If you don’t know whether the extension bundles you are
installing contain a custom dialog, and you don’'t have write access to the default location, then it
is best to specify an alternate location in SPSS_CDIALOGS _PATH.

To create the SPSS EXTENSIONS _PATH or SPSS CDIALOGS PATH environment variable on
Windows, from the Control Panel:

Windows XP
» Select System.
» Select the Advanced tab and click Environment Variables.

» Inthe User variables section, click New, enter the name of the environment variable—for instance,
PSS EXTENSIONS _PATH —in the Variable name field and the desired path(s) in the Variable
value field.

Windows Vista or Windows 7
» Select User Accounts.
» Select Change my environment variables.

» Click New, enter the name of the environment variable—for instance, SPSS EXTENSIONS PATH
—in the Variable name field and the desired path(s) in the Variable value field.

To view the current locations for extension bundles (the same locations as for extension
commands) and custom dialogs, run the following command syntax: SHOW EXTPATHS.

Required R Packages

The extension bundle installer attempts to download and install any R packages that are required
by the extension bundle and not found on your machine. If you do not have internet access, you
will need to obtain the necessary packages from someone who does. Packages can be downloaded
from http://mmw.r-project.org/ and then installed from within R. For details, see the R Installation
and Administration guide, distributed with R. If installation of the packages fails, you will be
alerted with the list of required packages. You can aso view the list from the Extension Bundle
Details dialog box, once the bundleisinstalled. For more information, see the topic Viewing
Installed Extension Bundles on p. 288.

Note: For UNIX (including Linux) users, packages are downloaded in source form and then
compiled. This requiresthat you have the appropriate tools installed on your machine. Seethe R
Installation and Administration guide for details. In particular, Debian users should install the
r-base-dev package from apt-get install r-base-dev.
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Permissions

By default, required R packages are installed to the library folder under the location where

R isinstalled—for example, C:\Program Files\R\R-2.8.1\library on Windows. If you do

not have write permission to this location or would like to store R packages—installed for
extension bundles—elsewhere, you can specify one or more aternate locations by defining

the PASW_RPACKAGES PATH environment variable. When present, the paths specified in
PASW _RPACKAGES PATH take precedence over the default location. R packages will be
installed to the first writable location. For multiple locations, separate each with a semicolon on
Windows and a colon on Linux and Mac. The specified |ocations must exist on the target machine.
After setting PASW_RPACKAGES PATH, you will need to restart PASW Statistics for the changes
to take effect. For information on how to set an environment variable on Windows, see Installation
Locations for Extension Bundles on p. 286.

Batch Installation of Extension Bundles

Viewing

>

>

You can install multiple extension bundles at once using the batch utility installextbundles.bat
(installextbundles.sh for Mac and UNIX systems) located in the PASW Statistics installation
directory. For Windows and Mac the utility is located at the root of the installation directory.
For Linux, the utility is located in the bin subdirectory of the installation directory. The utility
is designed to run from a command prompt and must be run from its installed location. The
form of the command lineiis:

installextbundles [-statssrv] [-download no|yes ] -source <folder> | <filename>...

-statssrv. Specifiesthat you are running the utility on a PASW Statistics Server. You should also
install the same extension bundles on client machines that connect to the server.

-download nolyes. Specifies whether the utility has permission to access the internet in order to
download any R packages required by the specified extension bundles. The default isno. If you
keep the default or do not have internet access then you will need to manually install any required
R packages. For more information, see the topic Required R Packages on p. 287.

—source <folder> | <filename>... Specifies the extension bundles to install. You can specify the
path to a folder containing extension bundles or you can specify alist of filenames of extension
bundles. If you specify afolder, all extension bundles (files of type .spe) found in the folder will
be installed. Separate multiple filenames with one or more spaces. Enclose paths with double
quotes if they contain spaces.

Installed Extension Bundles

To view details for the extension bundles installed on your machine:

From the menus choose:
Utilities
Extension Bundles
View Installed Extension Bundles...

Click on the highlighted text in the Summary column for the desired extension bundle.
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The Extension Bundle Details dialog box displays the information provided by the author of the
extension bundle. In addition to required information, such as Summary, Description, and Version,
the author may have included URL's to locations of relevance, such as the author’s home page.
An extension bundle may or may not include a Readme file.

Components. The Components group lists the custom dialog, if any, and the names of any
extension commands included in the extension bundle. Extension commands included with

the bundle can be run from the syntax editor in the same manner as built-in PASW Statistics
commands. Help for an extension command may be available by running CommandName /HELP
in the syntax editor. Help for a custom dialog is available if the dialog contains a Help button.

Note: Installing an extension bundle that contains a custom dialog requires a restart of PASW
Statistics in order to see the entry for the dialog in the Components group.

Dependencies. The Dependencies group lists add-ons that are required to run the components
included in the extension bundle.

m  Python and R Plug-ins. The components for an extension bundle may require the Python
Plug-in and/or the R Plug-in, both of which are freely available. For details, see How to Get
Integration Plug-ins, under the Python Integration Plug-in or R Integration Plug-in topic
in the Help system.

m R Packages. Lists any R packages required by the extension bundle. During installation of the
extension bundle, the installer attempts to download and install the necessary packages on
your machine. If this processfails, you will be alerted and will need to manualy install the
packages. For more information, see the topic Required R Packages on p. 287.

m  Python Modules. Lists any Python modules required by the extension bundle. Any such
modules should be available from Developer Central at http://mww.spss.comvdevcentral. The
modules should be copied to the extensions directory under the PASW Statistics installation
directory. For Mac, the installation directory refers to the Contents directory in the PASW
Statistics application bundle. If you have specified alternate locations for extension bundles
with the SPSS EXTENSIONS PATH environment variable then copy the Python modules
to one of those locations. For more information, see the topic Installation Locations for
Extension Bundles on p. 286. Alternatively, you can copy the modules to alocation on the
Python search path, such as the Python site-packages directory.
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Options

Options control awide variety of settings, including:

m  Session journal, which keeps arecord of all commands run in every session
m Display order for variables in dialog box source lists

m Itemsdisplayed and hidden in new output results

m TableLook for new pivot tables

m  Custom currency formats

To Change Options Settings
» From the menus choose:
Edit
Options...
» Click the tabs for the settings that you want to change.
» Change the settings.

» Click OK or Apply.
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General Options

Figure 16-1
Options dialog box: General tab
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Variable Lists

These settings control the display of variablesin dialog box lists. You can display variable names
or variable labels. Names or labels can be displayed in alphabetical or file order or grouped by
measurement level. Display order affects only source variable lists. Target variable lists always
reflect the order in which variables were selected.

Roles

Some dialogs support the ability to pre-select variables for analysis based on defined roles. For
more information, see the topic Roles in Chapter 5 on p. 76.

m  Use predefined roles. By default, pre-select variables based on defined roles.

m  Use custom assignments. By default, do not use roles to pre-select variables.
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You can also switch between predefined roles and custom assignment within the dialogs that
support this functionality. The setting here controls only the initial default behavior in effect
for each dataset.

Windows

Look and feel. Controls the basic appearance of windows and dialog boxes. If you notice any
display issues after changing the look and feel, try shutting down and restarting the application.

Open syntax window at startup. Syntax windows are text file windows used to enter, edit, and run
commands. If you frequently work with command syntax, select this option to automatically open
a syntax window at the beginning of each session. Thisis useful primarily for experienced users
who prefer to work with command syntax instead of dialog boxes.

Open only one dataset at a time. Closes the currently open data source each time you open a
different data source using the menus and dialog boxes. By default, every time you use the menus
and dialog boxes to open a new data source, that data source opensin anew Data Editor window,
and any other data sources open in other Data Editor windows remain open and available during
the session until explicitly closed.

When you select this option, it takes effect immediately but does not close any datasets that were
open at the time the setting was changed. This setting has no effect on data sources opened using
command syntax, which relies on DATASET commands to control multiple datasets.For more
information, see the topic Working with Multiple Data Sources in Chapter 6 on p. 92.

Character Encoding for Data Files and Syntax Files

This controls the default behavior for determining the encoding for reading and writing data files
and syntax files. You can change this setting only when there are no open data sources, and the
setting remains in effect for subsequent sessions until explicitly changed.

m Locale’s writing system. Use the current locale setting to determine the encoding for reading
and writing files. Thisisreferred to as code page mode.

m  Unicode (universal character set). Use Unicode encoding (UTF-8) for reading and writing
files. Thisisreferred to as Unicode mode.

There are a number of important implications regarding Unicode mode and Unicode files:

m  PASW Statistics data files and syntax files saved in Unicode encoding should not be used in
releases of PASW Statistics prior to 16.0. For syntax files, you can specify the encoding when
you save the file. For datafiles, you should open the data file in code page mode and then
resave it if you want to read the file with earlier versions.

m  When code page data files are read in Unicode mode, the defined width of all string variables
istripled. To automatically set the width of each string variable to the longest observed
value for that variable, select Minimize string widths based on observed values in the Open
Data dialog box.
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Output

No scientific notation for small numbers in tables. Suppresses the display of scientific notation for
small decimal valuesin output. Very small decimal values will be displayed as 0 (or 0.000).

Measurement System. The measurement system used (points, inches, or centimeters) for specifying
attributes such as pivot table cell margins, cell widths, and space between tables for printing.

Language. Controls the language used in the output. Does not apply to simple text output. The list
of available languages depends on the currently installed language files. (Note: This does not
affect the user interface language.) Depending on the language, you may a so need to use Unicode
character encoding for characters to render to properly.

Note: Custom scripts that rely on language-specific text strings in the output may not run correctly
when you change the output language. For more information, see the topic Script Options
on p. 306.

Notification. Controls the manner in which the program notifies you that it has finished running a
procedure and that the results are available in the Viewer.

User Interface

This controls the language used in menus, dialogs, and other user interface features. (Note: This
does not affect the output language.)

Viewer Options

Viewer output display options affect only new output produced after you change the settings.
Output aready displayed in the Viewer is not affected by changes in these settings.
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Figure 16-2
Options dialog box: Viewer tab
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Initial Output State. Controls which items are automatically displayed or hidden each time you
run a procedure and how items are initially aligned. You can control the display of the following
items: log, warnings, notes, titles, pivot tables, charts, tree diagrams, and text output. You can
also turn the display of commandsin the log on or off. You can copy command syntax from
the log and save it in a syntax file.

Note: All output items are displayed left-aligned in the Viewer. Only the alignment of printed
output is affected by the justification settings. Centered and right-aligned items are identified by a
small symbol above and to the left of the item.

Title. Controlsthe font style, size, and color for new output titles.

Page Title. Controlsthe font style, size, and color for new page titles and page titles generated by
TITLE and SUBTITLE command Syntax or created by New Page Title on the Insert menu.

Text Output Font used for text output. Text output is designed for use with a monospaced
(fixed-pitch) font. If you select a proportional font, tabular output will not align properly.
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Figure 16-3
Options dialog box: Data tab
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Transformation and Merge Options. Each time the program executes a command, it reads the data
file. Some data transformations (such as Compute and Recode) and file transformations (such as
Add Variables and Add Cases) do not require a separate pass of the data, and execution of these
commands can be delayed until the program reads the data to execute another command, such as
astatistical or charting procedure.

m For large data files, where reading the data can take some time, you may want to select
Calculate values before used to delay execution and save processing time. When this option is
selected, the results of transformations you make using dial og boxes such as Compute Variable
will not appear immediately in the Data Editor; new variables created by transformations will
be displayed without any data values; and data values in the Data Editor cannot be changed
while there are pending transformations. Any command that reads the data, such as a statistical
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or charting procedure, will execute the pending transformations and update the data displayed
in the Data Editor. Alternatively, you can use Run Pending Transforms on the Transform menu.

m  With the default setting of Calculate values immediately, when you paste command syntax from
dialogs, an ExecuTE command is pasted after each transformation command. For more
information, see the topic Multiple Execute Commands in Chapter 13 on p. 268.

Display Format for New Numeric Variables. Controls the default display width and number of
decimal places for new numeric variables. There is no default display format for new string
variables. If avalueistoo large for the specified display format, first decimal places are rounded
and then values are converted to scientific notation. Display formats do not affect internal data
values. For example, the value 123456.78 may be rounded to 123457 for display, but the original
unrounded value is used in any calculations.

Set Century Range for 2-Digit Years. Defines the range of years for date-format variables entered
and/or displayed with atwo-digit year (for example, 10/28/86, 29-OCT-87). The automatic range
setting is based on the current year, beginning 69 years prior to and ending 30 years after the
current year (adding the current year makes atotal range of 100 years). For a custom range, the
ending year is automatically determined based on the value that you enter for the beginning year.

Random Number Generator. Two different random number generators are available:

m Version 12 Compatible. The random number generator used in version 12 and previous rel eases.
If you need to reproduce randomized results generated in previous releases based on a
specified seed value, use this random number generator.

m  Mersenne Twister. A newer random number generator that is more reliable for simulation
purposes. If reproducing randomized results from version 12 or earlier isnot an issue, use this
random number generator.

Reading External Data. For data read from external file formats and older PASW Statistics data
files (prior to release 8.0), you can specify the minimum number of data values for a numeric
variable used to classify the variable as scale or nominal. Variables with fewer than the specified
number of unique values are classified as nominal.

Rounding and Truncation of Numeric Values. For the RND and TRuUNC functions, this setting controls
the default threshold for rounding up values that are very close to arounding boundary. The
setting is specified as a number of bitsand is set to 6 at install time, which should be sufficient
for most applications. Setting the number of bits to O produces the same results as in release 10.
Setting the number of bits to 10 produces the same results asin releases 11 and 12.

m  For the rND function, this setting specifies the number of least-significant bits by which the
value to be rounded may fall short of the threshold for rounding up but still be rounded up.
For example, when rounding a value between 1.0 and 2.0 to the nearest integer this setting
specifies how much the value can fall short of 1.5 (the threshold for rounding up to 2.0) and
still be rounded up to 2.0.

m  For the TRuNC function, this setting specifies the number of least-significant bits by which
the value to be truncated may fall short of the nearest rounding boundary and be rounded up
before truncating. For example, when truncating a value between 1.0 and 2.0 to the nearest
integer this setting specifies how much the value can fall short of 2.0 and be rounded up to 2.0.
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Customize Variable View. Controls the default display and order of attributesin Variable View. For
more information, see the topic Changing the Default Variable View on p. 297.

Change Dictionary. Controlsthe language version of the dictionary used for checking the spelling of
itemsin Variable View. For more information, see the topic Spell Checking in Chapter 5 on p. 82.

Changing the Default Variable View

You can use Customize Variable View to control which attributes are displayed by default in
Variable View (for example, name, type, label) and the order in which they are displayed.

Click Customize Variable View.

Figure 16-4
Customize Variable View (default)
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» Select (check) the variable attributes you want to display.

» Use the up and down arrow buttons to change the display order of the attributes.

Currency Options

You can create up to five custom currency display formats that can include special prefix and
suffix characters and specia treatment for negative values.

The five custom currency format names are CCA, CCB, CCC, CCD, and CCE. You cannot
change the format names or add new ones. To modify a custom currency format, select the format
name from the source list and make the changes that you want.
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Figure 16-5
Options dialog box: Currency tab
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Prefixes, suffixes, and decimal indicators defined for custom currency formats are for display
purposes only. You cannot enter valuesin the Data Editor using custom currency characters.
To Create Custom Currency Formats
» Click the Currency tab.
» Select one of the currency formats from the list (CCA, CCB, CCC, CCD, and CCE).
» Enter the prefix, suffix, and decimal indicator values.

» Click OK or Apply.
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Output Label Options

Output label options control the display of variable and data value information in the outline and
pivot tables. You can display variable names, defined variable labels and actual data values,
defined value labels, or a combination.

Descriptive variable and value labels (Variable view in the Data Editor, Label and Values
columns) often make it easier to interpret your results. However, long labels can be awkward
in some tables.

Figure 16-6
Options dialog box: Output Labels tab

B Options

Charts Pivat Tables File Locations Scripts Muttiple Imputations Synitax Editor

General Wiewer Data Currency Output Lakbels

Cutline Lakeling

“ariables in tem labels showen as:

|Labels " |

Variahle values in tem labels shoven as:

|Labels = |

Pivaot Table Lakeling

Variables in labelz showen as:

|Labels " |

Variable values in labels shown as:

|Labels = |

| EeTTS §|[Cance|][§pply ][ Help ]

Output label options affect only new output produced after you change the settings. Output
already displayed in the Viewer is not affected by changes in these settings. These settings affect
only pivot table output. Text output is not affected by these settings.
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Chart Options

Figure 16-7
Options dialog box: Charts tab
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Chart Template. New charts can use either the settings selected here or the settings from a chart
template file. Click Browse to select a chart template file. To create a chart template file, create
a chart with the attributes that you want and save it as a template (choose Save Chart Template
from the File menu).

Chart Aspect Ratio. The width-to-height ratio of the outer frame of new charts. You can specify a
width-to-height ratio from 0.1 to 10.0. Values less than 1 make charts that are taller than they are
wide. Values greater than 1 make charts that are wider than they aretall. A value of 1 produces a
square chart. Once a chart is created, its aspect ratio cannot be changed.

Current Settings. Available settings include:
m  Font. Font used for al text in new charts.



301

Options

m  Style Cycle Preference. Theinitial assignment of colors and patterns for new charts. Cycle
through colors only uses only colors to differentiate chart elements and does not use patterns.
Cycle through patterns only uses only line styles, marker symboals, or fill patternsto differentiate
chart elements and does not use color.

m  Frame. Controls the display of inner and outer frames on new charts.
m  Grid Lines. Controls the display of scale and category axis grid lines on new charts.

Style Cycles. Customizesthe colors, line styles, marker symbols, and fill patterns for new charts.
You can change the order of the colors and patterns that are used when a new chart is created.

Data Element Colors

Specify the order in which colors should be used for the data elements (such as bars and markers)
in your new chart. Colors are used whenever you select a choice that includes color in the Style
Cycle Preference group in the main Chart Options dialog box.

For example, if you create a clustered bar chart with two groups and you select Cycle through
colors, then patterns in the main Chart Options dialog box, the first two colors in the Grouped
Charts list are used as the bar colors on the new chart.

To Change the Order in Which Colors Are Used
» Select Simple Charts and then select a color that is used for charts without categories.

» Select Grouped Charts to change the color cycle for charts with categories. To change a category’s
color, select a category and then select a color for that category from the palette.

Optionally, you can:

m Insert anew category above the selected category.
Move a selected category.

Remove a selected category.

Reset the sequence to the default sequence.

Edit a color by selecting its well and then clicking Edit.

Data Element Lines

Specify the order in which styles should be used for the line data elements in your new chart. Line
styles are used whenever your chart includes line data el ements and you select a choice that
includes patterns in the Style Cycle Preference group in the main Chart Options dialog box.

For example, if you create a line chart with two groups and you select Cycle through patterns
only in the main Chart Options dialog box, the first two stylesin the Grouped Charts list are used
as the line patterns on the new chart.

To Change the Order in Which Line Styles Are Used

» Select Simple Charts and then select aline style that is used for line charts without categories.



302

Chapter 16

» Select Grouped Charts to change the pattern cycle for line charts with categories. To change a
category’sline style, select a category and then select aline style for that category from the palette.

Optionally, you can:

m Insert anew category above the selected category.
m  Move a selected category.

m  Remove a selected category.

m  Reset the sequence to the default sequence.

Data Element Markers

Specify the order in which symbols should be used for the marker data elementsin your new chart.
Marker styles are used whenever your chart includes marker data elements and you select a choice
that includes patternsin the Style Cycle Preference group in the main Chart Options dialog box.

For example, if you create a scatterplot chart with two groups and you select Cycle through
patterns only in the main Chart Options dialog box, the first two symbolsin the Grouped Charts
list are used as the markers on the new chart.

To Change the Order in Which Marker Styles Are Used
» Select Simple Charts and then select a marker symbol that is used for charts without categories.

» Select Grouped Charts to change the pattern cyclefor chartswith categories. To change acategory’s
marker symbol, select a category and then select a symbol for that category from the palette.

Optionally, you can:

m Insert anew category above the selected category.
m  Move a selected category.

m  Remove a selected category.

m  Reset the sequence to the default sequence.

Data Element Fills

Specify the order in which fill styles should be used for the bar and area data elements in your
new chart. Fill styles are used whenever your chart includes bar or area data elements, and you
select a choice that includes patterns in the Style Cycle Preference group in the main Chart
Options dialog box.

For example, if you create a clustered bar chart with two groups and you select Cycle through
patterns only in the main Chart Options dialog box, the first two stylesin the Grouped Charts list
are used as the bar fill patterns on the new chart.

To Change the Order in Which Fill Styles Are Used

» Select Simple Charts and then select afill pattern that is used for charts without categories.
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» Select Grouped Charts to change the pattern cyclefor charts with categories. To change acategory’s
fill pattern, select a category and then select afill pattern for that category from the palette.

Optionally, you can:

Insert a new category above the selected category.
Move a selected category.

Remove a selected category.

Reset the sequence to the default sequence.

Pivot Table Options

Pivot Table options set the default Tablel ook used for new pivot table output. TablelL ooks can
control avariety of pivot table attributes, including the display and width of grid lines; font
style, size, and color; and background colors.

Figure 16-8
Options dialog box: Pivot Tables tab
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TableLook. Select a TableL ook from the list of files and click OK or Apply. You can use one of the
Tablel ooks provided with PASW Statistics, or you can create your own in the Pivot Table Editor
(choose TableLooks from the Format menu).

m  Browse. Allowsyou to select a TablelL ook from another directory.

m  Set TableLook Directory. Allows you to change the default TablelL ook directory. Use Browse
to navigate to the directory you want to use, select a TableL ook in that directory, and then
select Set TableLook Directory.

Note: Tablel ooks created in earlier versions of PASW Statistics cannot be used in version 16.0 or
|ater.

Column Widths. Controls the automatic adjustment of column widthsin pivot tables.

m  Adjust for labels and data except for extremely large tables. For tables that don’t exceed 10,000
cells, adjusts column width to whichever is larger—the column label or the largest data value.
For tables with more than 10,000 cells, adjusts column width to the width of the column label.

®m  Adjust for labels only. Adjusts column width to the width of the column label. This produces
more compact tables, but data values wider than the label may be truncated.

®m  Adjust for labels and data. Adjusts column width to whichever islarger: the column label or the
largest data value. This produces wider tables, but it ensures that all values will be displayed.

Display Blocks of Rows. These settings control the display of large pivot tables in the Viewer.
These settings have no effect on printing large pivot tables or exporting output to external formats.

m Display the table as blocks of rows. Tables are displayed in the Viewer in sections, and
navigation controls allow you to view different sections of the table.

m  Rows to display. Sets the number of rowsto display in each section. The value must be an
integer between 10 and 1000.

m  Maximum cells. Setsthe maximum number of cellsto display in each section. The value
must an integer between 1000 and 100000.

m  Widow/orphan tolerance. Controls the maximum number of rows of the inner most row
dimension of the table to split across displayed views of the table. For example, if there are
six categoriesin each group of the inner most row dimension, specifying a value of six would
prevent any group from splitting across displayed views. The value must be an integer and
cannot be greater than the Rows to display value.

Several factors can affect the actual number of rows displayed, including:

m If the Maximum cells value is reached before the Rows to display value, then the tableis split
at that point. For example, if Rows to display is 1000 and Maximum cells is 10000, a table
with 20 columns will be displayed in blocks of 500 rows.

m  The Widow/orphan tolerance setting can cause fewer or more rows to be displayed than the
value specified for Rows to display.

Default Editing Mode. Controls activation of pivot tablesin the Viewer window or in a separate

window. By default, double-clicking a pivot table activates al but very large tablesin the Viewer
window. You can choose to activate pivot tablesin a separate window or select a size setting that
will open smaller pivot tables in the Viewer window and larger pivot tablesin a separate window.
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Copying wide tables to the clipboard in rich text format. \WWhen pivot tables are pasted in Word/RTF
format, tables that are too wide for the document width will either be wrapped, scaled down
to fit the document width, or left unchanged.

File Locations Options

Options on the File Locations tab control the default location that the application will use for
opening and saving files at the start of each session, the location of the journal file, the location of
the temporary folder, and the number of files that appear in the recently used file list.

Figure 16-9
Options dialog box: Flle Locations tab
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Startup Folders for Open and Save Dialog Boxes

m Specified folder. The specified folder is used as the default location at the start of each session.
You can specify different default locations for data and other (non-data) files.

m Lastfolder used. Thelast folder used to either open or savefilesin the previous session is used
as the default at the start of the next session. This applies to both data and other (non-data)
files.

These settings apply only to dialog boxes for opening and saving files—and the “last folder
used” is determined by the last dialog box used to open or save afile. Files opened or saved via
command syntax have no effect on—and are not affected by—these settings. These settings are
only availablein local analysis mode. In distributed analysis mode connected to a remote server
(requires PASW Statistics Server), you cannot control the startup folder locations.

Session Journal

You can use the session journal to automatically record commands run in a session. Thisincludes
commands entered and run in syntax windows and commands generated by dialog box choices.
You can edit the journal file and use the commands again in other sessions. You can turn
journaling off and on, append or overwrite the journa file, and select the journal filename and
location. You can copy command syntax from the journal file and save it in a syntax file.

Temporary Folder

This specifies the location of temporary files created during a session. In distributed mode
(available with the server version), this does not affect the location of temporary datafiles. In
distributed mode, the location of temporary datafilesis controlled by the environment variable
SPSSTMPDIR, which can be set only on the computer running the server version of the software.
If you need to change the location of the temporary directory, contact your system administrator.

Recently Used File List

This controls the number of recently used files that appear on the File menu.

Script Options

Use the Scripts tab to specify the default script language and any autoscripts you want to use. You
can use scripts to automate many functions, including customizing pivot tables.
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Figure 16-10
Options dialog box: Scripts tab
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Note: Legacy Sax Basic users must manually convert any custom autoscripts. The autoscripts
installed with pre-16.0 versions are available as a set of separate script files located in the Samples
subdirectory of the directory where PASW Statisticsisinstalled. By default, no output items are
associated with autoscripts. You must manually associate all autoscripts with the desired output
items, as described below. For information on converting legacy autoscripts, see Compatibility
with Versions Prior to 16.0 on p. 390.

Default script language. The default script language determines the script editor that is launched
when new scripts are created. It also specifies the default language whose executable will be used
to run autoscripts. The available scripting languages depend on your platform. For Windows,
the available scripting languages are Basic, which isinstalled with the Core system, and the
Python programming language. For al other platforms, scripting is available with the Python
programming language.
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To enabl e scripting with the Python programming language, you must have Python and the PASW
Statistics-Python Integration Plug-in installed. For information, see How to Get Integration
Plug-ins, available from Core System>Frequently Asked Questions in the Help system.

Enable Autoscripting. This check box allows you to enable or disable autoscripting. By default,
autoscripting is enabled.

Base Autoscript. An optional script that is applied to all new Viewer objects before any other
autoscripts are applied. Specify the script file to be used as the base autoscript as well as the
language whose executable will be used to run the script.

To Apply Autoscripts to Output Items

In the Command Identifiers grid, select a command that generates output items to which
autoscripts will be applied.

The Objects column, in the Objects and Scripts grid, displays alist of the objects associated with
the selected command. The Script column displays any existing script for the selected command.

Specify a script for any of the items shown in the Objects column. Click on the corresponding
Script cell. Enter the path to the script or click the ellipsis (...) button to browse for the script.

Specify the language whose executable will be used to run the script. Note: The selected language
is not affected by changing the default script language.

Click Apply or OK.

To Remove Autoscript Associations

In the Objects and Scripts grid, click on the cell in the Script column corresponding to the
script to dissociate.

Delete the path to the script and then click on any other cell in the Objects and Scripts grid.

Click Apply or OK.
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Syntax Editor Options
Figure 16-11
Options dialog box: Syntax Editor tab
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Syntax Color Coding

You can turn color coding of commands, subcommands, keywords, keyword values, and

comments off or on and you can specify the font style and color for each.

Error Color Coding

You can turn color coding of certain syntactical errors off or on and you can specify the font style
and color used. Both the command name and the text (within the command) containing the error
are color coded, and you can choose different styles for each. For more information, see the
topic Color Coding in Chapter 13 on p. 263.
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Auto-Complete Settings

You can turn automatic display of the auto-complete control off or on. The auto-complete
control can always be displayed by pressing Ctrl+Spacebar. For more information, see the topic
Auto-Completion in Chapter 13 on p. 263.

Gutter

These options specify the default behavior for showing or hiding line numbers and command
spans within the Syntax Editor’s gutter—the region to the left of the text pane that is reserved
for line numbers, bookmarks, breakpoints, and command spans. Command spans are icons that
provide visua indicators of the start and end of a command.

Panes

Display the navigation pane. This specifies the default for showing or hiding the navigation pane.
The navigation pane contains a list of al recognized commands in the syntax window, displayed
in the order in which they occur. Clicking on a command in the navigation pane positions the
cursor at the start of the command.

Automatically open Error Tracking pane when errors are found. This specifies the default for
showing or hiding the error tracking pane when run-time errors are found.

Optimize for right to left languages. Check this box for the best user experience when working
with right to left languages.
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Multiple Imputations Options

Figure 16-12
Options dialog box: Multiple Imputations tab
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The Multiple Imputations tab controls two kinds of preferences related to Multiple Imputations:

Appearance of Imputed Data. By default, cells containing imputed data will have a different
background color than cells containing nonimputed data. The distinctive appearance of the
imputed data should make it easy for you to scroll through a dataset and locate those cells. You can
change the default cell background color, the font, and make the imputed data display in bold type.

Analysis Output. This group controls the type of Viewer output produced whenever a multiply
imputed dataset is analyzed. By default, output will be produced for the original (pre-imputation)
dataset and for each of the imputed datasets. In addition, for those procedures that support pooling
of imputed data, final pooled results will be generated. When univariate pooling is performed,

pooling diagnostics will also display. However, you can suppress any output you do not want
to see.
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To Set Multiple Imputation Options
From the menus, choose:
Edit

Options

Click the Multiple Imputation tab.
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Customizing Menus and Toolbars

Menu Editor

You can use the Menu Editor to customize your menus. With the Menu Editor you can:
®  Add menu items that run customized scripts.
m  Add menu items that run command syntax files.

m  Add menu items that launch other applications and automatically send data to other
applications.

You can send data to other applications in the following formats: PASW Statistics, Excel, Lotus
1-2-3, tab-delimited, and dBASE IV.

To Add Items to Menus
» From the menus choose;
View
Menu Editor...

» Inthe Menu Editor dialog box, double-click the menu (or click the plus sign icon) to which
you want to add a new item.

Select the menu item above which you want the new item to appear.
Click Insert ltem to insert a new menu item.

Select thefile type for the new item (script file, command syntax file, or external application).

vV v v v

Click Browse to select afile to attach to the menu item.
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Figure 17-1
Menu Editor dialog box
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You can aso add entirely new menus and separators between menu items. Optionaly, you can
automatically send the contents of the Data Editor to another application when you select that
application on the menu.

Customizing Toolbars

You can customize toolbars and create new toolbars. Toolbars can contain any of the available
tools, including tools for all menu actions. They can aso contain custom tools that launch other
applications, run command syntax files, or run script files.

Show Toolbars

Use Show Toolbars to show or hide toolbars, customize toolbars, and create new toolbars.
Toolbars can contain any of the available tools, including tools for all menu actions. They can also
contain custom tools that launch other applications, run command syntax files, or run script files.
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Figure 17-2
Show Toolbars dialog box
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To Customize Toolbars
» From the menus choose;
View
Toolbars
Customize

» Select the toolbar you want to customize and click Edit, or click New to create a new toolbar.

» For new toolbars, enter a name for the toolbar, select the windows in which you want the toolbar
to appear, and click Edit.

» Select anitem in the Categories list to display available tools in that category.

» Drag and drop the tools you want onto the toolbar displayed in the dialog box.

v

To remove atool from the toolbar, drag it anywhere off the toolbar displayed in the dialog box.

To create a custom tool to open afile, to run acommand syntax file, or to run a script:
Click New Tool in the Edit Toolbar dialog box.
Enter a descriptive label for the tool.

Select the action you want for the tool (open afile, run a command syntax file, or run a script).

vV v v v

Click Browse to select afile or application to associate with the tool.

New tools are displayed in the User-Defined category, which also contains user-defined menu
items.
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Toolbar Properties

Use Toolbar Properties to select the window types in which you want the selected toolbar to
appear. Thisdialog box is also used for creating names for new toolbars.

Figure 17-3
Toolbar Properties dialog box
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To Set Toolbar Properties
» From the menus choose:
View
Toolbars
Customize
» For existing toolbars, click Edit, and then click Properties in the Edit Toolbar dialog box.
» For new toolbars, click New Tool.

» Select the window types in which you want the toolbar to appear. For new toolbars, also enter
atoolbar name.

Edit Toolbar

Use the Edit Toolbar dialog box to customize existing toolbars and create new toolbars. Toolbars
can contain any of the available tools, including tools for all menu actions. They can also contain
custom tools that launch other applications, run command syntax files, or run script files.
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Figure 17-4
Customize Toolbar dialog box
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To Change Toolbar Images

Select the tool for which you want to change the image on the toolbar display.

Click Change Image.

Select the image file that you want to use for the tool. The following image formats are supported:

BMP, PNG, GIF, JPG.

m Images should be square. Images that are not square are clipped to a square area.

® Images are automatically scaled to fit. For optimal display, use 16x16 pixel images for small
toolbar images or 32x32 pixel images for large toolbar images.

Create New Tool

Use the Create New Tool dialog box to create custom tools to launch other applications, run

command syntax files, and run script files.
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Figure 17-5
Create New Tool dialog box
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Creating and Managing Custom
Dialogs

The Custom Dialog Builder alows you to create and manage custom dialogs for generating
command syntax. Using the Custom Dialog Builder you can:

m Create your own version of adialog for a built-in PASW Statistics procedure. For example,
you can create a dialog for the Frequencies procedure that only allows the user to select the
set of variables and then generates command syntax with pre-set options that standardize
the outpui.

m Create auser interface that generates command syntax for an extension command. Extension
commands are user-defined PASW Statistics commands that are implemented in either the
Python programming language or R. For more information, see the topic Custom Dialogs for
Extension Commands on p. 341.

m  Open afile containing the specification for a custom dia og—perhaps created by another
user—and add the dialog to your installation of PASW Statistics, optionally making your
own modifications.

m  Save the specification for a custom dialog so that other users can add it to their installations
of PASW Statistics.

How to Start the Custom Dialog Builder

» From the menus choose:
Utilities
Custom Dialogs
Custom Dialog Builder...

What's New in Version 18?

List box control. The Custom Dialog Builder now has a list box control that supports single or
multiple selection. For more information, see the topic Combo Box and List Box Controls on
p. 333.

Dynamically populate list items. List itemsfor combo box controls and the new list box control can
be dynamically populated with values associated with the variables in a specified target list. For
more information, see the topic Specifying List Items for Combo Boxes and List Boxes on p. 334.

Nest controls under radio buttons. Radio buttons can now contain a set of nested controls. For more
information, see the topic Defining Radio Buttons on p. 337.
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Required Add-Ons property. The new Required Add-Ons dialog property allows you to specify
one or more add-ons—such as the Python or R Integration Plug-in—that are required in order

to run the command syntax generated by the dialog. For more information, see the topic Dialog
Properties on p. 321.
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The canvasis the area of the Custom Dialog Builder where you design the layout of your dialog.

Properties Pane

The properties pane is the area of the Custom Dialog Builder where you specify properties of the
controls that make up the dialog aswell as properties of the dialog itself, such as the menu location.

Tools Palette

The tools palette provides the set of controls that can be included in a custom dialog. You can
show or hide the Tools Palette by choosing Tools Palette from the View menu.
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Building a Custom Dialog

The basic steps involved in building a custom dialog are:

» Specify the properties of the dialog itself, such as thetitle that appears when the dialog is launched
and the location of the new menu item for the dialog within the PASW Statistics menus. For more
information, see the topic Dialog Properties on p. 321.

» Specify the controls, such as source and target variable lists, that make up the dialog and any
sub-dialogs. For more information, see the topic Control Types on p. 330.

» Create the syntax template that specifies the command syntax to be generated by the dialog. For
more information, see the topic Building the Syntax Template on p. 325.

» Install the dialog to PASW Statistics and/or save the specification for the dialog to a custom dialog
package (.spd) file. For more information, see the topic Managing Custom Dialogs on p. 328.

You can preview your dialog as you' re building it. For more information, see the topic Previewing
a Custom Dialog on p. 327.

Dialog Properties

To view and set Dialog Properties:

» Click on the canvasin an area outside of any controls. With no controls on the canvas, Dialog
Properties are always visible.

Dialog Name. The Dialog Name property is required and specifies a unique name to associate
with the dialog. Thisisthe name used to identify the dialog when installing or uninstalling it.
To minimize the possibility of name conflicts, you may want to prefix the dialog name with an
identifier for your organization, such asa URL.

Menu Location. Click the ellipsis(...) button to open the Menu Location dialog box, which allows
you to specify the name and location of the menu item for the custom dialog. Adding a menu
location for a new custom dialog or changing the menu location of an installed custom dialog
requires a restart of PASW Statistics.

Title. The Title property specifies the text to be displayed in the title bar of the dialog box.

Help File. The Help File property is optional and specifies the path to ahelp file for the dialog.
Thisisthe file that will be launched when the user clicks the Help button on the dialog. Help files
must be in HTML format. A copy of the specified help file is included with the specifications for
the dialog when the dialog is installed or saved to a custom dialog package file. The Help button
on the run-time dialog is hidden if there is no associated help file.

Any supporting files, such asimage files and style sheets, must be stored along with the main
help file once the custom dialog has been installed. By default, the specifications for an installed
custom dialog are stored in the ext/lib/< Dialog Name> folder of the installation directory

for Windows and Linux. For Mac, specifications are stored under the /Library/Application
Support/SPSS nc/PASWSati stics/< ver sion>/CustomDialogs/< Dialog Name> folder, where
<version> is the two digit PASW Statistics version—for example, 18. Supporting files should
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be located at the root of the folder and not in sub-folders. They must be manually added to any
custom dialog package files you create for the dialog.

If you have specified aternate locations for installed dialogs—using the SPSS CDIALOGS PATH
environment variable—then store any supporting files under the <Dialog Name> folder at the
appropriate aternate location. For more information, see the topic Managing Custom Dialogs
onp. 328.

Note: When working with a dialog opened from a custom dialog package (.spd) file, the Help
File property points to a temporary folder associated with the .spd file. Any modifications to the
help file should be made to the copy in the temporary folder.

Web Deployment Properties. Allows you to associate a properties file with this dialog for usein
building thin client applications that are deployed over the web.

Modeless. Specifies whether the dialog is modal or modeless. When a dialog is modal, it must be
closed before the user can interact with the main application windows (Data, Output, and Syntax)
or with other open dialogs. Modeless dialogs do not have that constraint. The default is modeless.

Syntax. The Syntax property specifies the syntax template, used to create the command syntax
generated by the dialog at run-time. Click the ellipsis (...) button to open the Syntax Template.
For more information, see the topic Building the Syntax Template on p. 325.

Required Add-Ons. Specifies one or more add-ons—such as the Python or R Integration
Plug-in—that are required in order to run the command syntax generated by the dialog. For
example, if the dialog generates command syntax for an extension command implemented in R,
then check the box for the R Integration Plug-in. Users will be warned about required add-ons that
are missing when they try to install or run the dialog.
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Specifying the Menu Location for a Custom Dialog

Figure 18-1
Custom Dialog Builder Menu Location dialog box
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The Menu Location dialog box allows you to specify the name and location of the menu item for a
custom dialog. Adding a menu location for a new custom dialog or changing the menu location of
an installed custom dialog requires arestart of PASW Statistics. Menu items for custom dialogs
do not appear in the Menu Editor within PASW Statistics.

» Double-click the menu (or click the plus sign icon) to which you want to add the item for the new
dialog. You can also add itemsto the top-level menu labelled Custom (located between the Graphs
and Utilitiesitems), which is only available for menu items associated with custom dial ogs.

If you want to create custom menus or sub-menus, use the Menu Editor. For more information,
see the topic Menu Editor in Chapter 17 on p. 313. Note, however, that other users of your dialog
will have to manually create the same menu or sub-menu from their Menu Editor; otherwise, the
dialog will be added to their Custom menu.

Note: The Menu Location dialog box displays al menus, including those for al add-on modules.
Be sure to add the menu item for your custom dialog to a menu that will be available to you
or end users of your dialog.

» Select the menu item above which you want the item for the new dialog to appear. Once the item
is added you can use the Move Up and Move Down buttons to reposition it.

» Enter atitle for the menu item. Titles within a given menu or sub-menu must be unique.

» Click Add.
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Optionally, you can:
m  Add aseparator above or below the new menu item.

m  Specify the path to an image that will appear next to the menu item for the custom dialog. The
supported image types are gif and png. The image cannot be larger than 16 x 16 pixels.

Laying Out Controls on the Canvas

You add controls to a custom dialog by dragging them from the tools pal ette onto the canvas. To
ensure consistency with built-in dialogs, the canvas is divided into three functional columnsin
which you can place controls.

Figure 18-2
Canvas structure
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Left Column. The left column is primarily intended for a source list control. All controls other than
target lists and sub-dialog buttons can be placed in the left column.

Center Column. The center column can contain any control other than source lists and sub-dialog
buttons.

Right Column. The right column can only contain sub-dialog buttons.

Although not shown on the canvas, each custom dialog contains OK, Paste, Cancel, and Help
buttons positioned across the bottom of the dialog. The presence and locations of these buttonsis
automatic, however, the Help button is hidden if there is no help file associated with the dialog
(as specified by the Help File property in Dialog Properties).

You can change the vertical order of the controls within a column by dragging them up or down,
but the exact position of the controls will be determined automatically for you. At run-time,
controls will resize in appropriate ways when the dialog itself is resized. Controls such as source
and target lists automatically expand to fill the available space below them.
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Building the Syntax Template

The syntax template specifies the command syntax that will be generated by the custom dialog. A
single custom dialog can generate command syntax for any number of built-in PASW Statistics
commands or extension commands.

The syntax template may consist of static text that is always generated and control identifiers
that are replaced at run-time with the values of the associated custom dialog controls. For
example, command names and subcommand specifications that don’t depend on user input would
be static text, whereas the set of variables specified in atarget list would be represented with
the control identifier for the target list control.

To Build the Syntax Template

» From the menus in the Custom Dialog Builder choose:
Edit
Syntax Template

(Or click the dlipsis(...) button in the Syntax property field in Dialog Properties)

» For static command syntax that does not depend on user-specified values, enter the syntax asyou
would in the Syntax Editor.

» Add control identifiers of the form $%Tdentifier% at the locations where you want to insert
command syntax generated by controls, where Tdenti fier isthe value of the Identifier property
for the control. You can select from alist of available control identifiers by pressing Ctrl+Spacebar.
If you manually enter identifiers, retain any spaces, since all spacesin identifiers are significant.

At run-time, and for all controls other than check boxes and check box groups, each identifier is
replaced with the current value of the Syntax property of the associated control. For check boxes
and check box groups, the identifier is replaced by the current value of the Checked Syntax

or Unchecked Syntax property of the associated control, depending on the current state of the
control—checked or unchecked. For more information, see the topic Control Types on p. 330.

Note: The syntax generated at run-time automatically includes a command terminator (period) as
the very last character if oneis not present.

Example: Including Run-time Values in the Syntax Template

Consider asimplified version of the Frequencies dialog that only contains a source list control and
atarget list control, and generates command syntax of the following form:

FREQUENCIES VARIABLES=varl var2...
/FORMAT = NOTABLE
/BARCHART.

The syntax template to generate this might look like:

FREQUENCIES VARIABLES=%%target_list%%
/FORMAT = NOTABLE
/BARCHART.



326

Chapter 18

B 3%target_list%% isthe value of the Identifier property for the target list control. At
run-time it will be replaced by the current value of the Syntax property of the control.

m  Defining the Syntax property of the target list control to be $3Thisvalue%% specifies that

at run-time, the current value of the property will be the value of the control, which is the
set of variables in the target list.

Example: Including Command Syntax from Container Controls

Building on the previous example, consider adding a Statistics sub-dialog that contains asingle
group of check boxes that allow a user to specify mean, standard deviation, minimum, and
maximum. Assume the check boxes are contained in an item group control, as shown in the
following figure.

*Customn DMalog Builder - statistics_subdialog g@
File Edit “iew indow  Help

Ar 2% 8 =T B

Statistice ————
[] mean

[ std. deviation
[] Winimum

[] maxiraurn

=

Item Group Properties

Propetty Value

Identifier stats_group

Title Statistics

Required for execution False

Syntax ISTATISTICS %% ThisValue% %

An example of the generated command syntax would be:

FREQUENCIES VARIABLES=varl var2...
/FORMAT = NOTABLE
/STATISTICS MEAN STDDEV
/BARCHART.

The syntax template to generate this might look like:

FREQUENCIES VARIABLES=%%target_list%%
/FORMAT = NOTABLE
$%stats_group%%
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/BARCHART.

u target_1list%% isthe value of the Identifier property for the target list control and

$%stats_group$% isthe value of the Identifier property for the item group control.

The following table shows one way to specify the Syntax properties of the item group and the
check boxes contained within it in order to generate the desired result. The Syntax property of the
target list would be set to $3Thisvalue%%, as described in the previous example.

Syntax property of item group /STATISTICS %%ThisvValue%$%
Checked Syntax property of mean check box MEAN

Checked Syntax property of stddev check box STDDEV

Checked Syntax property of min check box MINIMUM

Checked Syntax property of max check box MAXIMUM

At run-time, $%stats_group%% Will be replaced by the current value of the Syntax property

for the item group control. Specifically, $3$Thisvalue%% will be replaced by a blank-separated
list of the values of the Checked or Unchecked Syntax property of each check box, depending

on its state—checked or unchecked. Since we only specified values for the Checked Syntax
property, only checked boxes will contributeto $3Thisvalue%%. For example, if the user checks
the mean and standard deviation boxes, the run-time value of the Syntax property for the item
group will be /STATISTICS MEAN STDDEV.

If no boxes are checked, then the Syntax property for the item group control will be empty, and the
generated command syntax will not contain any referenceto $%stats_group%%. Thismay or
may not be desirable. For example, even with no boxes checked you may still want to generate the
STATISTICS subcommand. Thiscan be accomplished by referencing the identifiers for the check
boxes directly in the syntax template, asin:

FREQUENCIES VARIABLES=%%target_list%%
/FORMAT = NOTABLE
/STATISTICS %%stats_mean%% %%stats_stddev%% %%stats_min%% %%stats_max%%
/BARCHART.

Previewing a Custom Dialog

You can preview the dialog that is currently open in the Custom Dialog Builder. The dialog
appears and functions as it would when run from the menus within PASW Statistics.

m  Source variable lists are populated with dummy variables that can be moved to target lists.
®  The Paste button pastes command syntax into the designated syntax window.

m  The OK button closes the preview.
|

If ahelp fileis specified, the Help button is enabled and will open the specified file. If no
help file is specified, the help button is disabled when previewing, and hidden when the
actual didog isrun.
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>

To preview a custom dialog:

From the menus in the Custom Dialog Builder choose:
File
Preview Dialog

Managing Custom Dialogs

>

The Custom Dialog Builder allows you to manage custom dialogs created by you or by other
users. You can install, uninstall, or modify installed dialogs; and you can save specifications for a
custom dialog to an external file or open afile containing the specifications for a custom dialog in
order to modify it. Custom dialogs must be installed before they can be used.

Installing a Custom Dialog

You can install the dialog that is currently open in the Custom Dialog Builder or you can install
adialog from a custom dialog package (.spd) file. Re-installing an existing dialog will replace
the existing version.

To install the currently open dialog:

From the menus in the Custom Dialog Builder choose:
File

Install
To install from a custom dialog package file:

From the menus choose:
Utilities
Custom Dialogs
Install Custom Dialog...
To use a new custom dialog, you will need to restart PASW Statistics. Re-installing an existing
dialog does not require a restart unless the menu location changes.

For Windows and Linux, and by default, installing a dialog requires write permission to the
PASW Statistics installation directory. |f you do not have write permissions to the required
location or would like to store installed dialogs el sewhere, you can specify one or more aternate
locations by defining the SPSS CDIALOGS PATH environment variable. When present, the
paths specified in SPSS_CDIALOGS PATH take precedence over the default location. Custom
dialogs will be installed to the first writable location. Note that Mac users may also utilize the
SPSS CDIALOGS PATH environment variable. For multiple locations, separate each with a
semicolon on Windows and a colon on Linux and Mac. The specified |ocations must exist on the
target machine. After setting SPSS_ CDIALOGS PATH , you will need to restart PASW Statistics
for the changes to take effect.

To create the SPSS CDIALOGS PATH environment variable on Windows, from the Control Panel:

Windows XP
Select System.
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Select the Advanced tab and click Environment Variables.

In the User variables section, click New, enter SPSS CDIALOGS PATH in the Variable name field
and the desired path(s) in the Variable value field.

Windows Vista or Windows 7
Select User Accounts.
Select Change my environment variables.

Click New, enter SPSS_CDIALOGS PATH in the Variable name field and the desired path(s)
in the Variable value field.

To view the current locations for custom diaogs, run the following command syntax: sHow
EXTPATHS.

Opening an Installed Custom Dialog

You can open a custom dialog that you have aready installed, allowing you to modify it and/or
save it externally so that it can be distributed to other users.

From the menus in the Custom Dialog Builder choose:

File
Open Installed

Note: If you are opening an installed dialog in order to modify it, choosing File > Install will
re-install it, replacing the existing version.

Uninstalling a Custom Dialog

From the menus in the Custom Dialog Builder choose:
File
Uninstall

The menu item for the custom dialog will be removed the next time you start PASW Statistics.

Saving to a Custom Dialog Package File

You can save the specifications for a custom dialog to an external file, allowing you to distribute
the dialog to other users or save specifications for adialog that is not yet installed. Specifications
are saved to a custom dialog package (.spd) file.

From the menus in the Custom Dialog Builder choose:

File
Save

Opening a Custom Dialog Package File

You can open a custom dialog package file containing the specifications for a custom dialog,
alowing you to modify the dialog and re-save it or install it.
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» From the menus in the Custom Dialog Builder choose:

File
Open

Manually Copying an Installed Custom Dialog

By default, the specificationsfor aninstalled custom dialog are stored in the ext/lib/< Dialog Name>
folder of theinstallation directory for Windows and Linux. For Mac, specifications are stored under
the /Library/Application Support/SPSS nc/PASWSati stics/< version>/CustomDial ogs/< Dialog
Name> folder, where <version> is the two digit PASW Statistics version—for example, 18. You
can copy thisfolder to the same relative location in another instance of PASW Statistics and it will
be recognized as an installed dialog the next time that instance is launched.

If you have specified alternate locations for installed dialogs—using the
SPSS CDIALOGS PATH environment variable—then copy the <Dialog Name> folder from
the appropriate alternate location.

If alternate locations for installed dialogs have been defined for the instance of PASW
Statistics you are copying to, then you can copy to any one of the specified locations and the
dialog will be recognized as an installed dialog the next time that instance is launched.

Control Types

The tools palette provides the controls that can be added to a custom dialog.

Source List: A list of source variables from the active dataset. For more information, see
the topic Source List on p. 331.

Target List: A target for variables transferred from the source list. For more information,
see the topic Target List on p. 331

Check Box: A single check box. For more information, see the topic Check Box on p. 333.

Combo Box: A combo box for creating drop-down lists. For more information, see the topic
Combo Box and List Box Controls on p. 333.

List Box: A list box for creating single selection or multiple selection lists. For more
information, see the topic Combo Box and List Box Controls on p. 333.

Text control: A text box that accepts arbitrary text asinput. For more information, see the
topic Text Control on p. 335.

Number control: A text box that is restricted to numeric values as input. For more information,
see the topic Number Control on p. 335.

Static Text control: A control for displaying static text. For more information, see the topic
Static Text Control on p. 336.

Item Group: A container for grouping a set of controls, such as a set of check boxes. For more
information, see the topic Item Group on p. 336.

Radio Group: A group of radio buttons. For more information, see the topic Radio Group
on p. 337.

Check Box Group: A container for a set of controls that are enabled or disabled as a group, by a
single check box. For more information, see the topic Check Box Group on p. 338.
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m  File Browser: A control for browsing the file system to open or save afile. For more
information, see the topic File Browser on p. 339.

®m  Sub-dialog Button: A button for launching a sub-dialog. For more information, see the topic
Sub-dialog Button on p. 341.

Source List

The Source Variable List control displays the list of variables from the active dataset that are
available to the end user of the dialog. You can display all variables from the active dataset (the
default) or you can filter the list based on type and measurement level—for instance, numeric
variables that have a measurement level of scale. Use of a Source List control implies the use of
one or more Target List controls. The Source List control has the following properties:

Identifier. The unique identifier for the control.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control. The specified
text only appears when hovering over thetitle area of the control. Hovering over one of the listed
variables will display the variable name and label.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Variable Transfers. Specifies whether variables transferred from the source list to a target list
remain in the source list (Copy Variables), or are removed from the source list (Move Variables).

Variable Filter. Allows you to filter the set of variables displayed in the control. You can filter on
variable type and measurement level, and you can specify that multiple response sets are included
in the variable list. Click the ellipsis(...) button to open the Filter dialog. You can also open the
Filter dialog by double-clicking the Source List control on the canvas. For more information, see
the topic Filtering Variable Lists on p. 332.

Note: The Source List control cannot be added to a sub-dialog.

Target List

The Target List control provides atarget for variables that are transferred from the source list. Use
of the Target List control assumes the presence of a Source List control. You can specify that only
asingle variable can be transferred to the control or that multiple variables can be transferred to it,
and you can constrain which types of variables can be transferred to the control—for instance,
only numeric variables with a measurement level of nominal or ordinal. The Target List control
has the following properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.
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ToolTip. Optiona Tool Tip text that appears when the user hovers over the control. The specified
text only appears when hovering over thetitle area of the control. Hovering over one of the listed
variables will display the variable name and label.

Target list type. Specifies whether multiple variables or only a single variable can be transferred
to the control.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Required for execution. Specifies whether avalue is required in this control in order for execution
to proceed. If True is specified, the OK and Paste buttons will be disabled until avalueis specified
for this control. If False is specified, the absence of avaluein this control has no effect on the state
of the OK and Paste buttons. The default is True.

Variable Filter. Allows you to constrain the types of variables that can be transferred to the contral.
You can constrain by variable type and measurement level, and you can specify whether multiple
response sets can be transferred to the control. Click the ellipsis (...) button to open the Filter
dialog. You can aso open the Filter dialog by double-clicking the Target List control on the
canvas. For more information, see the topic Filtering Variable Lists on p. 332.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.

® You can specify any valid command syntax and you can use \n for line breaks.

m Thevaue $%Thisvalue%% Specifies the run-time value of the control, which is the list of
variables transferred to the control. Thisis the default.

Note: The Target List control cannot be added to a sub-dialog.

Filtering Variable Lists

Figure 18-3
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The Filter dialog box, associated with source and target variable lists, allows you to filter the types
of variables from the active dataset that can appear in the lists. You can aso specify whether
multiple response sets associated with the active dataset are included. Numeric variables include
all numeric formats except date and time formats.

Check Box

The Check Box control is asimple check box that can generate different command syntax for the
checked versus the unchecked state. The Check Box control has the following properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. The label that is displayed with the check box. For multi-line titles, use \n to specify line
breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Default Value. The default state of the check box—checked or unchecked.

Checked/Unchecked Syntax. Specifies the command syntax that is generated when the control is
checked and when it is unchecked. To include the command syntax in the syntax template, use
the value of the Identifier property. The generated syntax, whether from the Checked Syntax or
Unchecked Syntax property, will be inserted at the specified position(s) of the identifier. For
example, if the identifier is checkboxl, then at run-time, instances of $%checkbox1%% inthe
syntax template will be replaced by the value of the Checked Syntax property when the box is
checked and the Unchecked Syntax property when the box is unchecked.

®m  You can specify any valid command syntax and you can use \n for line breaks.

Combo Box and List Box Controls

The Combo Box control alows you to create a drop-down list that can generate command syntax
specific to the selected list item. It islimited to single selection. The List Box control allows
you to display alist of items that support single or multiple selection and generate command
syntax specific to the selected item(s). The Combo Box and List Box controls have the following
properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

List Items. Click the ellipsis (...) button to open the List Item Properties dialog box, which alows
you to specify the list items of the control. You can also open the List Item Properties dialog by
double-clicking the Combo Box or List Box control on the canvas.
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Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

List Box Type (List Box only). Specifies whether the list box supports single selection only or
multiple selection. You can also specify that items are displayed as alist of check boxes.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.

m Thevaue %$%Thisvalue%% specifies the run-time value of the control and is the default. If
the list items are manually defined, the run-time value is the value of the Syntax property for
the selected list item. If the list items are based on atarget list control, the run-time value is
the value of the selected list item. For multiple selection list box controls, the run-time value
is ablank-separated list of the selected items. For more information, see the topic Specifying
List Items for Combo Boxes and List Boxes on p. 334.

m  You can specify any valid command syntax and you can use \n for line breaks.

Specifying List Items for Combo Boxes and List Boxes

The List Item Properties dialog box allows you to specify the list items of a combo box or list
box contral.

Manually defined values. Allows you to explicitly specify each of the list items.
m Identifier. A unique identifier for the list item.
m  Name. The name that appearsin the list for thisitem. The nameisarequired field.

m Default. For acombo box, specifies whether the list item is the default item displayed in the
combo box. For alist box, specifies whether the list item is selected by default.

m  Syntax. Specifies the command syntax that is generated when the list item is selected.
m You can specify any valid command syntax and you can use \n for line breaks.

Note: You can add anew list item in the blank line at the bottom of the existing list. Entering any
of the properties other than the identifier will generate a unique identifier, which you can keep or
modify. You can delete alist item by clicking on the Identifier cell for the item and pressing delete.

Values based on the contents of a target list control. Specifies that the list items are dynamically
populated with values associated with the variables in a selected target list control. Select an
existing target list control as the source of thelist items, or enter the value of the Identifier property
for atarget list control into the text area of the Target List combo box. The latter approach allows
you to enter the Identifier for atarget list control that you plan to add later.

m Variable Names. Populate the list items with the names of the variables in the specified target
list control.

m Value Labels. Populate the list items with the union of the value labels associated with the
variables in the specified target list control. You can choose whether the command syntax
generated by the associated combo box or list box control contains the selected value label or
its associated value.
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m  Custom Attribute. Populate the list items with the union of the attribute values associated with
variablesin the target list control that contain the specified custom attribute.

m  Syntax. Displays the Syntax property of the associated combo box or list box control, alowing
you to make changes to the property. For more information, see the topic Combo Box and
List Box Controls on p. 333.

Text Control

The Text control is a simple text box that can accept arbitrary input, and has the following
properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Text Content. Specifies whether the contents are arbitrary or whether the text box must contain a
string that adheres to rules for PASW Statistics variable names.

Default Value. The default contents of the text box.

Required for execution. Specifies whether avalue is required in this control in order for execution
to proceed. If True is specified, the OK and Paste buttons will be disabled until avalueis specified
for this control. If False is specified, the absence of avalue in this control has no effect on the state
of the OK and Paste buttons. The default is False.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.

B You can specify any valid command syntax and you can use \n for line breaks.

m  Thevaue $3Thisvalue%% specifies the run-time value of the control, which is the content
of the text box. Thisis the default.

m |f the Syntax property includes $3Thisvalue%% and the run-time value of the text box is
empty, then the text box control does not generate any command syntax.

Number Control

The Number control is atext box for entering a numeric value, and has the following properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.
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Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Numeric Type. Specifies any limitations on what can be entered. A value of Real specifies that
there are no restrictions on the entered value, other than it be numeric. A value of Integer specifies
that the value must be an integer.

Default Value. The default value, if any.
Minimum Value. The minimum allowed value, if any.
Maximum Value. The maximum allowed value, if any.

Required for execution. Specifies whether avalue isrequired in this control in order for execution
to proceed. If True is specified, the OK and Paste buttons will be disabled until avalueis specified
for this control. If False is specified, the absence of avaluein this control has no effect on the state
of the OK and Paste buttons. The default is False.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.
B You can specify any valid command syntax and you can use \n for line breaks.

m  Thevaue $3Thisvalue%% specifiesthe run-time value of the control, which is the numeric
value. Thisis the default.

m |f the Syntax property includes $$Thisvalue%% and the run-time value of the number control
is empty, then the number control does not generate any command syntax.

Static Text Control

The Static Text control allows you to add a block of text to your dialog, and has the following
properties:

Identifier. The unique identifier for the control.

Title. The content of the text block. For multi-line content, use \n to specify line breaks.

Item Group

The Item Group control is a container for other controls, allowing you to group and control the
syntax generated from multiple controls. For example, you have a set of check boxes that specify
optional settings for a subcommand, but only want to generate the syntax for the subcommand if
at least one box is checked. Thisisaccomplished by using an Item Group control as a container
for the check box controls. The following types of controls can be contained in an Item Group:
check box, combo box, text control, number control, static text, radio group, and file browser. The
Item Group control has the following properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title for the group. For multi-line titles, use \n to specify line breaks.
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Required for execution. True specifies that the OK and Paste buttons will be disabled until at least
one control in the group has avalue. The default is False.

For example, the group consists of a set of check boxes. If Required for execution is set to True
and all of the boxes are unchecked, then OK and Paste will be disabled.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.

®m  You can specify any valid command syntax and you can use \n for line breaks.

®  You can include identifiers for any controls contained in the item group. At run-time the
identifiers are replaced with the syntax generated by the controls.

m Thevaue %$%Thisvalue%% generates a blank-separated list of the syntax generated by each
control in the item group, in the order in which they appear in the group (top to bottom). This
isthe default. If the Syntax property includes $$Thisvalue%% and no syntax is generated
by any of the controls in the item group, then the item group as a whole does not generate
any command syntax.

Radio Group

The Radio Group control is a container for a set of radio buttons, each of which can contain a set
of nested controls. The Radio Group control has the following properties:

Identifier. The unique identifier for the control.This is the identifier to use when referencing
the control in the syntax template.

Title. An optional title for the group. If omitted, the group border is not displayed. For multi-line
titles, use \n to specify line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Radio Buttons. Click the ellipsis(...) button to open the Radio Group Properties dialog box, which
allows you to specify the properties of the radio buttons as well as to add or remove buttons from
the group. The ability to nest controls under a given radio button is a property of the radio button
and is set in the Radio Group Properties dialog box. Note: You can aso open the Radio Group
Properties dialog by double-clicking the Radio Group control on the canvas.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.

B You can specify any valid command syntax and you can use \n for line breaks.

B Thevaue $%Thisvalue%% Specifiesthe run-time value of the radio button group, which
is the value of the Syntax property for the selected radio button. Thisisthe default. If the
Syntax property includes $$Thisvalue%% and no syntax is generated by the selected radio
button, then the radio button group does not generate any command syntax.

Defining Radio Buttons

The Radio Button Group Properties dialog box allows you to specify a group of radio buttons.

Identifier. A unique identifier for the radio button.
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Name. The name that appears next to the radio button. The nameisarequired field.
ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Mnemonic Key. An optional character in the name to use as amnemonic. The specified character
must exist in the name.

Nested Group. Specifies whether other controls can be nested under this radio button. The default
isfalse. When the nested group property is set to true, arectangular drop zoneis displayed, nested
and indented, under the associated radio button. The following controls can be nested under a
radio button: check box, text, static text, number, combo box, list box, and file browser.

Default. Specifies whether the radio button is the default selection.

Syntax. Specifies the command syntax that is generated when the radio button is selected.
B You can specify any valid command syntax and you can use \n for line breaks.

m  For radio buttons containing nested controls, the value $%Thisvalue%% generates a
blank-separated list of the syntax generated by each nested control, in the order in which they
appear under the radio button (top to bottom).

You can add a new radio button in the blank line at the bottom of the existing list. Entering any
of the properties other than the identifier will generate a unique identifier, which you can keep
or modify. You can delete a radio button by clicking on the Identifier cell for the button and
pressing delete.

Check Box Group

The Check Box Group control is acontainer for a set of controlsthat are enabled or disabled as a
group, by asingle check box. The following types of controls can be contained in a Check Box
Group: check box, combo box, text control, number control, static text, radio group, and file
browser. The Check Box Group control has the following properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title for the group. If omitted, the group border is not displayed. For multi-line
titles, use \n to specify line breaks.

Checkbox Title. An optional label that is displayed with the controlling check box. Supports
\n to specify line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Default Value. The default state of the controlling check box—checked or unchecked.

Checked/Unchecked Syntax. Specifies the command syntax that is generated when the control
is checked and when it is unchecked. To include the command syntax in the syntax template,
use the value of the Identifier property. The generated syntax, whether from the Checked
Syntax or Unchecked Syntax property, will be inserted at the specified position(s) of the
identifier. For example, if the identifier is checkboxgroupl, then at run-time, instances of
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%$%checkboxgroupl%% in the syntax template will be replaced by the value of the Checked
Syntax property when the box is checked and the Unchecked Syntax property when the box is
unchecked.

®m  You can specify any valid command syntax and you can use \n for line breaks.

B You caninclude identifiers for any controls contained in the check box group. At run-time the
identifiers are replaced with the syntax generated by the controls.

m Thevaue %%Thisvalue%% can be used in either the Checked Syntax or Unchecked Syntax
property. It generates a blank-separated list of the syntax generated by each control in the
check box group, in the order in which they appear in the group (top to bottom).

m By default, the Checked Syntax property has avalue of $$Thisvalue%% and the Unchecked
Syntax property is blank.

File Browser

The File Browser control consists of atext box for afile path and a browse button that opens a
standard PASW Statistics dialog to open or save afile. The File Browser control has the following
properties:

Identifier. The unique identifier for the control. Thisis the identifier to use when referencing
the control in the syntax template.

Title. An optional title that appears above the control. For multi-line titles, use \n to specify
line breaks.

ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

File System Operation. Specifies whether the dialog launched by the browse button is appropriate
for opening files or for saving files. A value of Open indicates that the browse dialog validates the
existence of the specified file. A value of Save indicates that the browse dialog does not validate
the existence of the specified file.

Browser Type. Specifies whether the browse dialog is used to select afile (Locate File) or to
select afolder (Locate Folder).

File Filter. Click the ellipsis(...) button to open the File Filter dialog box, which alows you to
specify the available file types for the open or save dialog. By default, all file types are allowed.
Note: You can also open the File Filter dialog by double-clicking the File Browser control on
the canvas.

File System Type. In distributed analysis mode, this specifies whether the open or save dialog
browses the file system on which PASW Statistics Server is running or the file system of your
local computer. Select Server to browse the file system of the server or Client to browse the file
system of your local computer. The property has no effect in local analysis mode.
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Required for execution. Specifies whether avalue is required in this control in order for execution
to proceed. If True is specified, the OK and Paste buttons will be disabled until avalueis specified
for this control. If False is specified, the absence of avaluein this control has no effect on the state
of the OK and Paste buttons. The default is False.

Syntax. Specifies command syntax that is generated by this control at run-time and can be inserted
in the syntax template.
m  You can specify any valid command syntax and you can use \n for line breaks.

m Thevaue $%Thisvalue%% specifiesthe run-time value of the text box, which isthefile path,
specified manually or populated by the browse dialog. Thisis the defaullt.

m |f the Syntax property includes $$Thisvalue%% and the run-time value of the text box is
empty, then the file browser control does not generate any command syntax.

File Type Filter

>

>

>

Figure 18-4
File Filter dialog box

File Filter

[ &1l File Types (*#)
[T Data File (*.5av)
[ Cotmplex Sample Plan (* csplan* ceapkan)

[ cther

Mame Sutfix

[ ok §|[Cancel][ Help ]

The File Filter dialog box allows you to specify the file types displayed in the Files of type and
Save as type drop-down lists for open and save dialogs accessed from a File System Browser
control. By default, al file types are allowed.

To specify file types not explicitly listed in the dialog box:
Select Other.

Enter a name for the file type.

Enter afile type using the form *.suffix—for example, *.xls. You can specify multiple file types,
each separated by a semicolon.



341

Creating and Managing Custom Dialogs

Sub-dialog Button

The Sub-dialog Button control specifies a button for launching a sub-dialog and provides access to
the Dialog Builder for the sub-dialog. The Sub-dialog Button has the following properties:

Identifier. The unique identifier for the control.
Title. The text that is displayed in the button.
ToolTip. Optiona Tool Tip text that appears when the user hovers over the control.

Sub-dialoeg. Click the ellipsis (...) button to open the Custom Dialog Builder for the sub-dial og.
You can also open the builder by double-clicking on the Sub-dial og button.

Mnemonic Key. An optional character in the title to use as a keyboard shortcut to the control. The
character appears underlined in the title. The shortcut is activated by pressing Alt+[mnemonic
key]. The Mnemonic Key property is not supported on Mac.

Note: The Sub-dialog Button control cannot be added to a sub-dialog.

Dialog Properties for a Sub-dialog

To view and set properties for a sub-dialog:

» Open the sub-dialog by double-clicking on the button for the sub-dialog in the main dialog, or
single-click the sub-dialog button and click the dllipsis(...) button for the Sub-dialog property.

» Inthe sub-diaog, click on the canvasin an area outside of any controls. With no controls on the
canvas, the properties for a sub-dialog are always visible.

Sub-dialog Name. The unique identifier for the sub-dialog. The Sub-dialog Name property is
required.

Note: If you specify the Sub-dialog Name as an identifier in the Syntax Template—as in $%My
Sub-dialog Name%%—it will be replaced at run-time with a blank-separated list of the syntax
generated by each control in the sub-diaog, in the order in which they appear (top to bottom
and left to right).

Title. Specifiesthe text to be displayed in the title bar of the sub-dialog box. The Title property is
optional but recommended.

Help File. Specifies the path to an optional help file for the sub-dialog. Thisisthe file that will
be launched when the user clicks the Help button on the sub-dialog, and may be the same help
file specified for the main dialog. Help files must bein HTML format. See the description of the
Help File property for Dialog Properties for more information.

Syntax. Click the élipsis(...) button to open the Syntax Template. For more information, see the
topic Building the Syntax Template on p. 325.

Custom Dialogs for Extension Commands

Extension commands are user-defined PASW Statistics commands that are implemented in either
the Python programming language or R. Once deployed to an instance of PASW Statistics, an
extension command is run in the same manner as any built-in PASW Statistics command.
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You can use the Custom Dialog Builder to create dialogs for extension commands, and you can
install custom dialogs for extension commands created by other users.

Creating Custom Dialogs for Extension Commands

Whether an extension command was written by you or another user, you can create a custom
dialog for it. The syntax template for the dialog should generate the command syntax for the
extension command. If the custom dialog is only for your use, install the dialog. Assuming the
extension command is already deployed on your system, you will be able to run the command
from the installed dialog.

If you are creating a custom dialog for an extension command and wish to share it with other
users, you should first save the specifications for the dialog to a custom dialog package (.spd)
file. You'll then want to create an extension bundle containing the custom dialog package file, the
XML file that specifies the syntax of the extension command, and the implementation code file(s)
written in Python or R. The extension bundle is then what you share with other users. For more
information, see the topic Working with Extension Bundles in Chapter 15 on p. 284.

Installing Extension Commands with Associated Custom Dialogs

An extension command with an associated custom dialog consists of three pieces: an XML file
that specifies the syntax of the command; one or more code files (Python or R) that implement
the command; and a custom dialog package file that contains the specifications for the custom
dialog. If the extension command and its associated custom dialog are distributed in an extension
bundle (.spe) file, then you can simply install the bundle from Utilities>Extension Bundles>I nstall
Extension Bundle. Otherwise, you need to install the custom dialog and the extension command
files separately as follows:

Custom Dialog Package File. Install the custom dialog package file from Utilities>Custom
Dialogs>Install Custom Dialog.

XML Syntax Specification File and Implementation Code. For Windows and Linux, the XML
file specifying the syntax of the extension command and the implementation code (Python
or R) should be placed in the extensions directory under the PASW Statistics installation
directory. For Mac, the XML and code files should be placed in the /Library/Application
Support/SPSS nc/PASWSati stics/18/extensions directory.

m  For Windows and Linux, If you do not have write permissions to the PASW Statistics
installation directory or would like to store the XML file and the implementation
code elsewhere, you can specify one or more aternate locations by defining the
SPSS EXTENSIONS PATH environment variable. When present, the paths specified in
SPSS EXTENSIONS PATH take precedence over the PASW Statistics installation directory.
For multiple locations, separate each with a semicolon on Windows and a colon on Linux.

To create the SPSS EXTENSIONS PATH environment variable on Windows, follow the
same general steps used to create the SPSS CDIALOGS PATH variable. See the section on
Installing a Custom Dialog in Managing Custom Dialogs on p. 328.
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To view the current locations for custom dialogs, run the following command syntax: sHow
EXTPATHS.

m  For an extension command implemented in Python, you can always store the associated Python
module(s) to alocation on the Python search path, such as the Python site-packages directory.

Creating Localized Versions of Custom Dialogs

You can create localized versions of custom dialogs for any of the languages supported by PASW
Statistics. You can localize any string that appears in a custom dialog and you can localize the
optional help file.

To Localize Dialog Strings

» Make acopy of the properties file associated with the dialog. The properties file contains all of
the localizable strings associated with the dialog. By default, it islocated in the ext/lib/< Dialog
Name> folder of the PASW Statistics installation directory for Windows and Linux, and under the
[Library/Application Support/SPSS nc/PASWStati stics/18/CustomDial ogs/< Dialog Name> folder
for Mac. The copy should reside in that same folder and not in a sub-folder.

If you have specified alternate locations for installed dialogs—using the SPSS CDIALOGS PATH
environment variable—then the copy should residein the <Dialog Name> folder at the appropriate
alternate location. For more information, see the topic Managing Custom Dialogs on p. 328.

» Rename the copy to <Dialog Name>_<language identifier>.properties, using the language
identifiers in the table below. For example, if the dialog name is mydialog and you want to
create a Japanese version of the dialog, then the localized properties file should be named
mydialog_ja.properties. Localized properties files must be manually added to any custom dialog
package files you create for the dialog. A custom dialog package fileis simply a ZIPfile that can
be opened and modified with an application such as WinZip on Windows.

» Open the new properties file with atext editor that supports UTF-8, such as Notepad on Windows,
or the TextEdit application on Mac. Modify the values associated with any properties that need to
be localized, but do not modify the names of the properties. Properties associated with a specific
control are prefixed with the identifier for the control. For example, the Tool Tip property for a
control with the identifier options_button is options_button_tooltip_LABEL. Title properties are
simply named <identifier> LABEL, asin options_button_LABEL.

When the dialog is launched, PASW Statistics will search for a properties file whose language
identifier matches the current language, as specified by the Language drop-down on the General
tab in the Options dialog box. If no such properties file is found, the default file <Dialog
Name>.properties will be used.

To Localize the Help File

» Make a copy of the help file associated with the dialog and localize the text for the
desired language. The copy must reside in the same folder as the help file and not in a
sub-folder. The help file should reside in the ext/lib/<Dialog Name> folder of the PASW
Statistics installation directory for Windows and Linux, and under the /Library/Application
Support/SPSS nc/PASWStati stics/18/CustomDi al ogs/< Dialog Name> folder for Mac.



344

Chapter 18

If you have specified aternate locations for installed dialogs—using the SPSS_CDIALOGS PATH
environment variable—then the copy should residein the < Dialog Name> folder at the appropriate
alternate location. For more information, see the topic Managing Custom Dialogs on p. 328.

Rename the copy to <Help File>_<language identifier>, using the language identifiers in the
table below. For example, if the help file is myhelp.htm and you want to create a German version
of the file, then the localized help file should be named myhelp_de.htm. Localized help files
must be manually added to any custom dialog package files you create for the dialog. A custom
dialog package file is ssmply a ZIP file that can be opened and modified with an application
such as WinZip on Windows.

If there are supplementary files such as image files that also need to be localized, you will need
to manually modify the appropriate paths in the main help file to point to the localized versions,
which should be stored along with the original versions.

When the dialog is launched, PASW Statistics will search for a help file whose language identifier
matches the current language, as specified by the Language drop-down on the General tab in the
Options dialog box. If no such help fileis found, the help file specified for the dialog (the file
specified in the Help File property of Dialog Properties) is used.

Language Ildentifiers

de German

en English

€s Spanish

fr French

it Italian

ja Japanese

ko Korean

pl Polish

ru Russian

zh CN Simplified Chinese
zh TW Traditional Chinese

Note: Text in custom dialogs and associated help filesis not limited to the languages supported by
PASW Statistics. You are free to write the dialog and help text in any language without creating
language-specific properties and help files. All users of your dialog will then see the text in that
language.
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Production jobs provide the ability to run PASW Statistics in an automated fashion. The program
runs unattended and terminates after executing the last command, so you can perform other tasks
while it runs or schedule the production job to run automatically at scheduled times. Production
jobs are useful if you often run the same set of time-consuming analyses, such as weekly reports.
Production jobs use command syntax files to tell PASW Statistics what to do. A command
syntax file is a simple text file containing command syntax. You can use any text editor to
create thefile. You can also generate command syntax by pasting dialog box selections into a
syntax window or by editing the journal file. For more information, see the topic Working with
Command Syntax in Chapter 13 on p. 256.

To create a production job:

» From the menus in any window choose:

Utilities
Production Job

Figure 19-1
Production Job dialog box

B production_example.spj - Production Job
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production_example.spj

Syntax Files
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File:
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» Click New to create a new production job or Open to open an existing production job.

3

N
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Note: Production Facility job files (.spp) created in releases prior to 16.0 will not run in release
16.0 or later. A conversion utility is available to convert Windows and Macintosh Production
Facility job files to production jobs (.spj). For more information, see the topic Converting
Production Facility Fileson p. 352.

» Select one or more command syntax files.
» Select the output file name, location, and format.

» Click Save or Save As to save the production job.

Syntax format. Controls the form of the syntax rules used for the job.

m Interactive. Each command must end with a period. Periods can appear anywhere within the
command, and commands can continue on multiple lines, but a period as the last nonblank
character on alineis interpreted as the end of the command. Continuation lines and new
commands can start anywhere on anew line. These are the “interactive’ rulesin effect when
you select and run commands in a syntax window.

m Batch. Each command must start at the beginning of a new line (no blank spaces before the
start of the command), and continuation lines must be indented at least one space. If you want
to indent new commands, you can use a plus sign, dash, or period as the first character at the
start of the line and then indent the actual command. The period at the end of the command is
optional. This setting is compatible with the syntax rules for command files included with
the INCLUDE command.

Note: Do not use the Batch option if your syntax files contain GGRapH command syntax that
includes crL statements. GpL statements will only run under interactive rules.
Error Processing. Controls the treatment of error conditionsin the job.

m  Continue processing after errors. Errorsin the job do not automatically stop command
processing. The commands in the production job files are treated as part of the normal
command stream, and command processing continues in the normal fashion.

m  Stop processing immediately. Command processing stops when the first error in a production
job fileis encountered. Thisis compatible with the behavior of command filesincluded with
the INCLUDE command.

Output. Controls the name, location, and format of the production job results. The following
format options are available:

m Viewer file to disk (.spv). Results are saved in PASW Statistics Viewer format in the specified
file location.

m Viewer file (.spv) to PES Repository. This requires the Adaptor for Enterprise Services option.
m  Web Reports (.spw) to PES Repository. This requires the Adaptor for Enterprise Services option.

®  Word/RTF (*.doc). Pivot tables are exported as Word tables with all formatting attributes
intact—for example, cell borders, font styles, and background colors. Text output is exported
as formatted RTF. Charts, tree diagrams, and model views are included in PNG format.

Note: Microsoft Word may not display extremely wide tables properly.

m  Excel (*.xls). Pivot table rows, columns, and cells are exported as Excel rows, columns,
and cdlls, with al formatting attributes intact—for example, cell borders, font styles, and
background colors. Text output is exported with all font attributes intact. Each line in the text
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output isarow in the Excel file, with the entire contents of the line contained in asingle cell.
Charts, tree diagrams, and model views are included in PNG format.

m  HTML (*.htm). Pivot tables are exported as HTML tables. Text output is exported as
preformatted HTML. Charts, tree diagrams, and model views are embedded by reference,
and you should export charts in a suitable format for inclusion in HTML documents (for
example, PNG and JPEG).

m Portable Document Format (*.pdf). All output is exported as it appearsin Print Preview, with all
formatting attributes intact.

m  PowerPoint file (*.ppt). Pivot tables are exported as Word tables and are embedded on separate
slidesin the PowerPoint file, with one slide for each pivot table. All formatting attributes of the
pivot table are retained—for example, cell borders, font styles, and background colors. Charts,
tree diagrams, and model views are exported in TIFF format. Text output is not included.

Export to PowerPoint is available only on Windows operating systems.

m  Text (*.txt). Text output formats include plain text, UTF-8, and UTF-16. Pivot tables can
be exported in tab-separated or space-separated format. All text output is exported in
space-separated format. For charts, tree diagrams, and model views, aline isinserted in the
text file for each graphic, indicating the image filename.

Print Viewer file on completion. Sends the final Viewer output file to the printer on completion
of the production job.

Run Jobh. This runsthe production job in a separate session. Thisis particularly useful for testing
new production jobs before deploying them.

Production Jobs with OUTPUT Commands

Production jobs honor ouTpPuT commands, such as OUTPUT SAVE, OUTPUT ACTIVATE, and
OUTPUT NEW. OUTPUT SAVE commands executed during the course of a production job will
write the contents of the specified output documents to the specified locations. Thisisin addition
to the output file created by the production job. When using ouTPUT NEW to create a new output
document, it is recommended that you explicitly save it with the ouTPuT SAVE command.

A production job output file consists of the contents of the active output document as of the
end of the job. For jobs containing ouTpuT commands, the output file may not contain all
output created in the session. For example, suppose the production job consists of a number of
procedures followed by an ouTpuT NEW command, followed by more procedures but no more
ouTpUuT commands. The ouTpuT NEW command defines a new active output document. At
the end of the production job, it will contain output from only the procedures executed after
the ouTPUT NEW command.

HTML Options

Table Options. No table options are available for HTML format. All pivot tables are converted to
HTML tables.

Image Options. The available image types are: EPS, JPEG, TIFF, PNG, and BMP. On Windows
operating systems, EMF (enhanced metafile) format is also available. You can also scale the
image size from 1% to 200%.
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Table Options. You can use the Viewer outline entries as dide titles. Each slide contains asingle
output item. Thetitleisformed from the outline entry for theitem in the outline pane of the Viewer.

Image Options. You can scale the image size from 1% to 200%. (All images are exported to
PowerPoint in TIFF format.)

Note: PowerPoint format is only available on Windows operating systems and requires
PowerPoint 97 or later.

PDF Options

Embed bookmarks. This option includes bookmarks in the PDF document that correspond to
the Viewer outline entries. Like the Viewer outline pane, bookmarks can make it much easier
to navigate documents with a large number of output objects.

Embed fonts. Embedding fonts ensures that the PDF document will look the same on all computers.
Otherwise, if some fonts used in the document are not available on the computer being used to
view (or print) the PDF document, font substitution may yield suboptimal results.

Text Options

Table Options. Pivot tables can be exported in tab-separated or space-separated format. For
space-separated format, you can also control:

m  Column Width. Autofit does not wrap any column contents, and each column is as wide as the
widest label or value in that column. Custom sets a maximum column width that is applied
to al columnsin the table, and values that exceed that width wrap onto the next line in that
column.

®  Row/Column Border Character. Controls the characters used to create row and column borders.
To suppress display of row and column borders, enter blank spaces for the values.

Image Options. The available image types are: EPS, JPEG, TIFF, PNG, and BMP. On Windows
operating systems, EMF (enhanced metafile) format is also available. You can also scale the
image size from 1% to 200%.

Runtime Values

Runtime values defined in a production job file and used in a command syntax file simplify tasks
such as running the same analysis for different datafiles or running the same set of commands for
different sets of variables. For example, you could define the runtime value @datafile to prompt
you for a data filename each time you run a production job that uses the string @datafile in
place of afilename in the command syntax file.
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Figure 19-2
Production Job dialog box, Runtime Values tab

@ StatisticsJob1 - Production Job

General | Runtime Yalues

Aruntime value (s substituted for a syrmbol used in syntae A symbol starts with
an i@ sign and must not contain any special characters or spaces. If no default
value is specified, do not use the ‘silent’ cormmand line keyward when running
the job from the command line.

Symhbol ‘Deiaun Yalue |User Prompt |Qucﬂa Yalue |
@location  CHProgram Files'SPSS .. Where is the data file? \:Z
@datafile  demo.sav Yhat is the name of the data file? \;f;
i@varlist gender incoat What varisbles should be used? \__

) o) G

Symbol. The string in the command syntax file that triggers the production job to prompt the user
for avalue. The symbol name must begin with an @ sign and must conform to variable naming
rules. For more information, see the topic Variable Names in Chapter 5 on p. 70.

Default Value. The value that the production job supplies by default if you don’t enter a different
value. Thisvalueis displayed when the production job prompts you for information. You can
replace or modify the value at runtime. If you don’t provide a default value, don’t usethe silent
keyword when running the production job with command line switches, unless you aso use

the -symbo1 switch to specify runtime values. For more information, see the topic Running
Production Jobs from a Command Line on p. 350.

User Prompt. The descriptive label that is displayed when the production job prompts you to enter
information. For example, you could use the phrase “What data file do you want to use?’ to
identify afield that requires a data filename.

Quote Value. Encloses the default value or the value entered by the user in quotes. For example,
file specifications should be enclosed in quotes.
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Figure 19-3
Runtime symbols in a command syntax file
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User Prompts

A production job prompts you for values whenever you run a production job that contains defined
runtime symbols. You can replace or modify the default values that are displayed. Those values
are then substituted for the runtime symbolsin all command syntax files associated with the

production job.

Figure 19-4
Production User Prompts dialog box

User Prompts for production_example.spj

‘Where is the data file? ‘programm files\spesisamples
WWhat iz the name of the data file? dema say
‘What variables should be used? gender inccat

|J | Cancel | | Help

Running Production Jobs from a Command Line

Command line switches enable you to schedule production jobs to run automatically at certain
times, using scheduling utilities available on your operating system. The basic form of the

command line argument is:

paswstat filename.spj -production
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Depending on how you invoke the production job, you may need to include directory paths for
the paswstat executable file (located in the directory in which the application isinstalled) and/or
the production job file.

You can run production jobs from a command line with the following switches:

-production [prompt|silent]. Start the application in production mode. The prompt and silent
keywords specify whether to display the dialog box that prompts for runtime values if they are
specified in the job. The prompt keyword is the default and shows the dialog box. The silent
keyword suppresses the dialog box. If you usethe silent keyword, you can define the runtime
symbols with the -symbo1 switch. Otherwise, the default valueis used. The -switchserver
and -singleseat switches areignored when using the -production switch.

-symbol <values>. List of symbol-value pairs used in the production job. Each symbol name
starts with @. Values that contain spaces should be enclosed in quotes. Rules for including
guotes or apostrophes in string literals may vary across operating systems, but enclosing a
string that includes single quotes or apostrophes in double quotes usually works (for example,
“'a quoted value'”).

To run production jobs on a remote server in distributed analysis mode, you also need to specify
the server login information:

-server <inet:hestname:port>. The name or | P address and port number of the server. Windows only.

-user <name>. A valid user name. If adomain name s required, precede the user name with the
domain name and a backslash (\). Windows only.

-password <password>. The user’s password. Windows only.

Example
paswstat \production_jobs\prodjob1.spj -production silent -symbol @datafile /data/July_data.sav

m  This example assumes that you are running the command line from the installation directory,
so no path is required for the paswstat executable file.

m  Thisexample also assumes that the production job specifies that the value for @datafile should
be quoted (Quote Value checkbox on the Runtime Values tab), so no quotes are necessary
when specifying the data file on the command line. Otherwise, you would need to specify
something like "'/data/July_data.sav™ to include quotes with the data file specification, since
file specifications should be quoted in command syntax.

m Thedirectory path for the location of the production job uses the Windows back slash
convention. On Macintosh and Linux, use forward slashes. The forward slashes in the quoted
data file specification will work on all operating systems since this quoted string is inserted
into the command syntax file and forward slashes are acceptable in commands that include
file specifications (for example, GET FILE, GET DATA, SAVE) on all operating systems.

B Thesilent keyword suppresses any user promptsin the production job, and the - symbol
switch inserts the quoted data file name and location wherever the runtime symbol @datafile
appears in the command syntax files included in the production job.
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Converting Production Facility Files

Production Facility job files (.spp) created in releases prior to 16.0 will not run in release 16.0 or
later. For Windows and Macintosh Production Facility job files created in earlier releases, you can
use prodconvert, located in the installation directory, to convert those files to new production job
files (.spj). Run prodconvert from a command window using the following specifications:

[installpath]\prodconvert [filepath]\filename.spp

where [installpath] isthe location of the folder in which PASW Statisticsisinstalled and [filepath]
is the location of the folder where the original production job file. A new file with the same
name but with the extension .spj is created in the same folder as the original file. (Note: If the
path contains spaces, enclose each path and file specification in double quotes. On Macintosh
operating systems, use forward slashes instead on back slashes.)

Limitations
m  WMF and EMF chart formats are not supported. PNG format is used in place of these formats.

m  The export options Output Document (No Charts), Charts Only, and Nothing are not supported.
All output objects supported by the selected format are included.

m  Remote server settings are ignored. To specify remote server settings for distributed analysis,
you need to run the production job from a command line, using command line switches to
specify the server settings. For more information, see the topic Running Production Jobs
from a Command Line on p. 350.

m  Publish to Web settings are ignored.
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The Output Management System (OMS) provides the ability to automatically write selected
categories of output to different output filesin different formats. Formats include: Word, Excel,
PDF, PASW Statistics datafile format (.sav), Viewer file format (.spv), web report format (.spw),
XML, HTML, and text. For more information, see the topic OM S Options on p. 359.

To Use the Output Management System Control Panel

From the menus choose;

Utilities

OMS Control Panel...

Figure 20-1

Output Management System Control Panel

ok Cutput Management System Control Panel

procedures.
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[ il ——— [ ]| Logging...

Mesy Reguest

To add & request, select one or more tems from the lists belowy, and any other desired propetties, and
press Add. Table Subtvpes displays only the subtypes available for st least one of the selected

Output Types: Command [dentifiers: Table Subtypes for Selected Commands:  Cutput Destinations:

Charts
Headings
Logs
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Texts
Trees

Warnings

Conjoirt Analysis <

Constrained Monl
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Create
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CECoxRey
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Case Processing Summary “| [ @ rone

Chi Seuare Tests @ File: C iatairesutts | | Browss...
Correlations

Crosstabulation © Based on ohject names
Descriptive Statistics

Directional Measures

Mantel-Haenszel Common Odds Rati © Mew dataset:

Motes = | ] Exclude from Wiewer

ot Fila Somerars

10:
Labels...

Paste ][geset ][Cance|][ Help ]

You can use the control panel to start and stop the routing of output to various destinations.
m Each OMS request remains active until explicitly ended or until the end of the session.
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m A dedtination file that is specified on an OMS request is unavailable to other procedures and
other applications until the OMS request is ended.

m  Whilean OMS request is active, the specified destination files are stored in memory (RAM),
so active OM S requests that write a large amount of output to external files may consume a
large amount of memory.

m  Multiple OMS requests are independent of each other. The same output can be routed to
different locations in different formats, based on the specificationsin different OM S requests.

m  The order of the output objects in any particular destination is the order in which they were
created, which is determined by the order and operation of the procedures that generate
the outpui.

To Add New OMS Requests

Select the output types (tables, charts, etc.) that you want to include. For more information,
see the topic Output Object Types on p. 355.

Select the commands to include. If you want to include all output, select all itemsin the list. For
more information, see the topic Command Identifiers and Table Subtypes on p. 357.

For commands that produce pivot table output, select the specific table types to include.

Thelist displays only the tables that are available in the selected commands; any table typethat is
available in one or more of the selected commandsis displayed in the list. If no commands are
selected, al table types are displayed. For more information, see the topic Command Identifiers
and Table Subtypes on p. 357.

To select tables based on text labels instead of subtypes, click Labels. For more information, see
the topic Labels on p. 358.

Click Options to specify the output format (for example, PASW Statistics data file, XML, or
HTML). By default, Output XML format is used. For more information, see the topic OMS
Options on p. 359.

Specify an output destination:
m  File. All selected output is routed to a singlefile.

m Based on object names. Output is routed to multiple destination files based on object names. A
separate file is created for each output object, with a filename based on either table subtype
names or table labels. Enter the destination folder name.

m New dataset. For PASW Statistics data file format output, you can route the output to a
dataset. The dataset is available for subsequent use in the same session but is not saved unless
you explicitly saveit as afile prior to the end of the session. Thisoption is available only for
PASW Statistics data file format output. Dataset names must conform to variable-naming
rules. For more information, see the topic Variable Namesin Chapter 5 on p. 70.

Optionaly:

m  Exclude the selected output from the Viewer. If you select Exclude from Viewer, the output
types in the OMS request will not be displayed in the Viewer window. If multiple active
OMS requests include the same output types, the display of those output types in the Viewer
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is determined by the most recent OM S request that contains those output types. For more
information, see the topic Excluding Output Display from the Viewer on p. 364.

m  Assign an ID string to the request. All requests are automatically assigned an ID value, and
you can override the system default 1D string with a descriptive 1D, which can be useful if
you have multiple active requests that you want to identify easily. 1D values that you assign
cannot start with a dollar sign ($).

The following tips are for selecting multiple itemsin alist:
B Press Ctrl+A to select al itemsin alist.

m  Use Shift+click to select multiple contiguous items.

m  Use Ctrl+click to select multiple noncontiguous items.

To End and Delete OMS Requests

Active and new OMS requests are displayed in the Requests list, with the most recent request

at the top. You can change the widths of the information columns by clicking and dragging the

borders, and you can scroll the list horizontally to see more information about a particular request.
An asterisk (*) after the word Active in the Status column indicates an OMS request that was

created with command syntax that includes features that are not available in the Control Panel.

To end a specific, active OMS request:
» Inthe Requests list, click any cell in the row for the request.

» Click End.
To end all active OMS requests:

» Click End All
To delete a new request (arequest that has been added but is not yet active):

» Inthe Requestslist, click any cell in the row for the request.

» Click Delete.

Note: Active OMS requests are not ended until you click OK.

Output Object Types

There are different types of output objects:

Charts. Thisincludes charts created with the Chart Builder, charting procedures, and charts created
by statistical procedures (for example, abar chart created by the Frequencies procedure).

Headings. Text objectsthat are labeled Title in the outline pane of the Viewer. Heading text objects
are not included with Output XML format.
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Logs. Log text objects. Log objects contain certain types of error and warning messages.
Depending on your Options settings (Edit menu, Options, Viewer tab), log objects may also
contain the command syntax that is executed during the session. Log objects are labeled Log
in the outline pane of the Viewer.

Models. Output objects displayed in the Model Viewer. A single model object can contain
multiple views of the model, including both tables and charts.

Tables. Output objects that are pivot tablesin the Viewer (includes Notes tables). Tables are the
only output objects that can be routed to PASW Statistics datafile (.sav) format.

Texts. Text objects that aren’t logs or headings (includes objects labeled Text Output in the outline
pane of the Viewer).

Trees. Tree model diagrams that are produced by the Decision Tree option.

Warnings. Warning objects contain certain types of error and warning messages.
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Figure 20-2
Output object types
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Thiz command not executed.

Command Identifiers and Table Subtypes

Command Identifiers

Command identifiers are available for al statistical and charting procedures and any other
commands that produce blocks of output with their own identifiable heading in the outline pane of
the Viewer. These identifiers are usually (but not always) the same or similar to the procedure
names on the menus and dialog box titles, which are usually (but not always) similar to the
underlying command names. For example, the command identifier for the Frequencies procedure
is“Frequencies,” and the underlying command name is a so the same.
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Labels
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There are, however, some cases where the procedure name and the command identifier
and/or the command name are not all that similar. For example, al of the procedures on the
Nonparametric Tests submenu (from the Analyze menu) use the same underlying command, and
the command identifier is the same as the underlying command name: Npar Tests.

Table Subtypes

Table subtypes are the different types of pivot tables that can be produced. Some subtypes are
produced by only one command; other subtypes can be produced by multiple commands (although
the tables may not look similar). Although table subtype names are generally descriptive, there can
be many names to choose from (particularly if you have selected a large number of commands);
also, two subtypes may have very similar names.

To Find Command Identifiers and Table Subtypes

When in doubt, you can find command identifiers and table subtype names in the Viewer window:
Run the procedure to generate some output in the Viewer.

Right-click the item in the outline pane of the Viewer.

Choose Copy OMS Command Identifier or Copy OMS Table Subtype.

Paste the copied command identifier or table subtype name into any text editor (such as a Syntax
Editor window).

As an alternative to table subtype names, you can select tables based on the text that is displayed
in the outline pane of the Viewer. You can aso select other object types based on their labels.
Labels are useful for differentiating between multiple tables of the same type in which the outline
text reflects some attribute of the particular output object, such as the variable names or labels.
There are, however, a number of factors that can affect the label text:

m | split-file processing is on, split-file group identification may be appended to the label.

m Labelsthat include information about variables or values are affected by your current output
label options settings (Edit menu, Options, Output L abels tab).

m Labelsare affected by the current output language setting (Edit menu, Options, General tab).
To Specify Labels to Use to Identify Output Objects

In the Output Management System Control Panel, select one or more output types and then select
one or more commands.

Click Labels.
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Figure 20-3
OMS Labels dialog box
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Label:

Selected Labels:

Tip: %ou can copy a label from the
Wiewer by right-clicking on a table
and choosing "Copy OMS Label"
from the popup menu.
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» Enter the label exactly asit appears in the outline pane of the Viewer window. (You can aso
right-click the item in the outline, choose Copy OMS Label, and paste the copied label into the
Label text field.)

» Click Add.
» Repeat the process for each label that you want to include.

» Click Continue.

Wildcards

You can use an asterisk (*) asthe last character of the labdl string as a wildcard character. All
labels that begin with the specified string (except for the asterisk) will be selected. This process
works only when the asterisk is the last character, because asterisks can appear as valid characters
inside a label.

OMS Options

You can use the OM S Options dialog box to:

m  Specify the output format.

m  Specify the image format (for HTML and Output XML output formats).
m  Specify what table dimension elements should go into the row dimension.
|

Include a variable that identifies the sequential table number that is the source for each case
(for PASW Statistics data file format).

To Specify OMS Options

» Click Options in the Output Management System Control Panel.
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Figure 20-4

OMS Options dialog box
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Format

Excel. Excel 97-2003 format. Pivot table rows, columns, and cells are exported as Excel rows,
columns, and cells, with all formatting attributes intact — for example, cell borders, font styles,
and background colors. Text output is exported with al font attributes intact. Each line in the
text output is arow in the Excel file, with the entire contents of the line contained in asingle cell.
Charts, tree diagrams, and model views are included in PNG format.

HTML. Output objects that would be pivot tablesin the Viewer are converted to simple HTML
tables. No TablelL ook attributes (font characteristics, border styles, colors, etc.) are supported.
Text output objects are tagged <PRE> in the HTML. Charts, tree diagrams, and model views are
exported as separatefilesin the sel ected graphics format and are embedded by reference. Imagefile
names use the HTML file name as the root name, followed by a sequential integer, starting with 0.

Output XML. XML that conforms to the spss-output schema.

PDF. Output is exported as it would appear in Print Preview, with all formatting attributes intact.
The PDF file includes bookmarks that correspond to the entriesin the Viewer outline pane.

PASW Statistics Data File. Thisformat isabinary file format. All output object types other than
tables are excluded. Each column of atable becomes avariablein the datafile. To use adatafile
that is created with OM S in the same session, you must end the active OM S request before you
can open the data file. For more information, see the topic Routing Output to PASW Statistics
Data Files on p. 365.

Text. Space-separated text. Output iswritten as text, with tabular output aligned with spaces for
fixed-pitch fonts. Charts, tree diagrams, and model views are excluded.
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Tabbed Text. Tab-delimited text. For output that is displayed as pivot tables in the Viewer, tabs
delimit table column elements. Text block lines are written asis; no attempt is made to divide
them with tabs at useful places. Charts, tree diagrams, and model views are excluded.

Viewer File. Thisisthe same format used when you save the contents of a Viewer window.

Web Report File. This output file format is designed for use with Predictive Enterprise Services.
It is essentially the same as the PASW Statistics Viewer format except that tree diagrams are
saved as static images.

Word/RTF. Pivot tables are exported as Word tables with al formatting attributes intact—for
example, cell borders, font styles, and background colors. Text output is exported as formatted
RTF. Charts, tree diagrams, and model views are included in PNG format.

Graphics Images

For HTML and Output XML formats, you can include charts, tree diagrams, and model views as
image files. A separate image fileis created for each chart and/or tree.

m  For HTML document format, standard <IMG SRC='filename'> tagsareincluded in the
HTML document for each image file.

m  For Output XML document format, the XML file contains a chart element with an
ImageFile attribute of the general form <chart imageFile="filepath/filename" />
for each image file.

m Imagefilesare saved in a separate subdirectory (folder). The subdirectory name is the name of
the destination file, without any extension and with _files appended to the end. For example,
if the destination file is julydata.htm, the images subdirectory will be named julydata_files.

Format. The available image formats are PNG, JPG, EMF, BMP, and VML.

m  EMF (enhanced metéfile) format is available only on Windows operating systems.

m VML image format is available only for HTML document format.

® VML image format does not create separate image files. The VML code that renders the
image is embedded in the HTML.

m VML image format does not include tree diagrams.
Size. You can scale the image size from 10% to 200%.

Include Imagemaps. For HTML document format, this option creates image map Tool Tips that
display information for some chart elements, such as the value of the selected point on aline
chart or bar on abar chart.

Table Pivots

For pivot table output, you can specify the dimension element(s) that should appear in the
columns. All other dimension elements appear in the rows. For PASW Statistics data file format,
table columns become variables, and rows become cases.
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m If you specify multiple dimension elements for the columns, they are nested in the columnsin
the order in which they are listed. For PASW Statistics data file format, variable names are
constructed by nested column elements. For more information, see the topic Variable Names
in OMS-Generated Data Fileson p. 372.

m If atable doesn't contain any of the listed dimension elements, all dimension elements for
that table will appear in the rows.

m Table pivots that are specified here have no effect on tables that are displayed in the Viewer.

Each dimension of atable—row, column, layer—may contain zero or more elements. For
example, asimple two-dimensional crosstabulation contains a single row dimension element and a
single column dimension element, each of which contains one of the variables that are used in
the table. You can use either positional arguments or dimension element “names’ to specify the
dimension elements that you want to put into the column dimension.

All dimensions in rows. Creates a single row for each table. For PASW Statistics format datafiles,
this means each table is a single case, and all the table elements are variables.

List of positions. The general form of a positional argument is a letter indicating the default
position of the element—C for column, R for row, or L for layer—followed by a positive integer
indicating the default position within that dimension. For example, R1 would indicate the
outermost row dimension element.

m  To specify multiple elements from multiple dimensions, separate each dimension with a
space—for example, R1 C2.

m  Thedimension letter followed by ALL indicates all elementsin that dimension in their default
order. For example, CALL isthe same as the default behavior (using all column elementsin
their default order to create columns).

m CALL RALL LALL (or RALL CALL LALL, and so on) will put all dimension elements
into the columns. For PASW Statistics data file format, this creates one row/case per table

in the datafile.
Figure 20-5
Row and column positional arguments
] | ! 1
—' G '_1 2 | | R3 | Previous
Expetience Months Bedinning
Modke! (morths) since Hire Salary Date of Birth
1 Correlations Previous Experience 1 000 57 a7 a5
[manthis)
hanths since Hire 067 1.000 012 0a3
Beginning Salary -.087 nz2 1.000 -07a
Date of Bitth 805 nss -075 1.000
Cowariances | Previous Experience
(months) 31.307 12940 -022 7 096E-08
Morths since Hire 12940 1205245 19 4 B35E-06
Beginning Salary -022 19 ooz -5.236E-09
Diate of Bitth 7 096E-08 4 B3SE-08 -5.236E-09 2435612

List of dimension names. As an aternative to positional arguments, you can use dimension element
“names,” which are the text labels that appear in the table. For example, asimple two-dimensional
crosstabulation contains a single row dimension e ement and a single column dimension element,
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each with |abels based on the variables in those dimensions, plus a single layer dimension element
labeled Statistics (if English is the output language).

m  Dimension e ement names may vary, based on the output language and/or settings that affect
the display of variable names and/or labelsin tables.

m Each dimension element name must be enclosed in single or double quotation marks. To
specify multiple dimension element names, include a space between each quoted name.

The labels that are associated with the dimension elements may not always be obvious.

To See All Dimension Elements and Their Labels for a Pivot Table

» Activate (double-click) the table in the Viewer.

>

From the menus choose;

View
Show All

and/or

If the pivoting trays aren’t displayed, from the menus choose:

Pivot
Pivoting Trays

The element labels are dispalyed in the pivoting trays.
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Figure 20-6
Dimension element names displayed in table and pivoting trays
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Logging

You can record OMS activity in alog in XML or text format.

m  Thelog tracks all new OMS requests for the session but does not include OM S requests that
were aready active before you requested a log.

m  Thecurrent log file ends if you specify a new log file or if you deselect (uncheck) Log OMS
activity.
To specify OMS logging:

» Click Logging in the Output Management System Control Panel.

Excluding Output Display from the Viewer

The Exclude from Viewer check box affects all output that is selected in the OMS request by
suppressing the display of that output in the Viewer window. This process is often useful for
production jobs that generate alot of output and when you don’t need the results in the form of
a Viewer document (.spv file). You can also use this functionality to suppress the display of
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particular output objects that you simply never want to see, without routing any other output to
some external file and format.

To suppress the display of certain output objects without routing other output to an externa file:
Create an OM S reguest that identifies the unwanted output.
Select Exclude from Viewer.

For the output destination, select File—but leave the File field blank.

vV v v v

Click Add.

The selected output will be excluded from the Viewer while all other output will be displayed in
the Viewer in the normal fashion.

Note: This setting has no effect on OM S output saved to external formats or files, including the
Viewer SPV and SPW formats. It also has no effect on output saved to SPV format in a batch job
executed with the Batch Facility (available with PASW Statistics Server).

Routing Output to PASW Statistics Data Files

A datafilein PASW Statistics format consists of variables in the columns and cases in the rows,
which is essentially the format in which pivot tables are converted to datafiles:

m  Columnsin the table are variables in the data file. Valid variable names are constructed
from the column labels.

m  Row labelsin the table become variables with generic variable names (Varl, Var2, Var3, and
so on) in the datafile. The values of these variables are the row labelsin the table.

m  Threetable-identifier variables are automatically included in the data file: Command._,
Subtype , and Label_. All three are string variables. The first two variables correspond to the
command and subtype identifiers. For more information, see the topic Command Identifiers
and Table Subtypes on p. 357. Label__ contains the table title text.

®  Rowsin the table become cases in the datafile.
Example: Single Two-Dimensional Table

In the simplest case—a single two-dimensiona table—the table columns become variables,
and the rows become cases in the data file.
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Figure 20-7
Single two-dimensional table
Report
Beginning
Gender currert Salary Salary
Female | Mean $26031 92 | $13,091.97
Median $24,300.00 | $12,375.00
hinimLm 13,730 $49,000
tdaximum 58,125 $30,000
tlale hean F41,441 .78 | F20,301.40
& *temp.sav [DataSet1] - Data Editor E]@
File Edit Yiew Data Transform Analze Graphs  Wilities  Add-ons  Window  Help
Tatal
i Visible: 7 of 7 Variables
Command_| Subtype_| Label_| Warl | Ward | CurrentSaIary|EleginningSaI
L @# 1 [Means Report  Report  Female Mean $265,031.92 EAICHNEN [R= P el
2 |Means Report  Report  Female Median  $24 300.00 1237500 |=
3 |Means Report  Report  Female Minimum $15750 $3,000
4 |Means Report Repot Female Maximum $58 125 $30,000
5 |Means Report Report Male Mean 541 441.78 $20,301.40
6 |Means Report Report Male Median  §32,350.00 F14,750.00
7 |Means Report Report Male Minimum  $19 650 #9000
g8 |Means Report Report Male Maximum §135,000 §79 230
9

Means Report Report Total Mlean F34 41987 F17 016.09

am lna T " T " Toiol BA L o . sl T A o0 o)

1 | A | | Pl_

| DataView | “ariahle View

-

m  Thefirst three variables identify the source table by command, subtype, and label.

m  The two elements that defined the rows in the table—values of the variable Gender and
statistical measures—are assigned the generic variable names Var 1 and Var2. These variables
are both string variables.

m  The column labels from the table are used to create valid variable names. In this case,
those variable names are based on the variable labels of the three scale variables that are
summarized in the table. If the variables didn’'t have defined variable labels, or you choseto
display variable names instead of variable |abels as the column labels in the table, the variable
names in the new data file would be the same as in the source data file.

Example: Tables with Layers

In addition to rows and columns, atable can also contain athird dimension: the layer dimension.
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Figure 20-8
Table with layers
Layer 2
Layer Minarity Classification Yes j|
Gender
Femals hale
Employmert Clerical 40 47
Cat
egory Custor Layer 1
Manac
Layer inarity Classification Mo j|
Gender
Femals dale
Employvment Clerical 166 110
Category Custodial ] 14
lanager 10 70
£ temp.sav [DataSet?] - Data Editor E]@
File Edit VYiew Data Transform Analyze Graphs  Uklities Add-ons  Window Help
1 Commaned_ CTables Yisikle;
ari | Yar2 | Varg | Yard | Female | hale | ~
1 |Employment Category Clerical Minority Clazsification Mo 166 110
2| Employment Category Clerical Minority Classification Yes 40 47
3| Employment Category Custodial | Minority Classification Mo 1] 14
4 |Employment Category Custodial | Minority Classification Yes 1] 13
2 | Employment Category Manager Minority Classification Mo 10 Ta
G | Employvment Category Manager Minority Classification Yes 1] 4 o
4| v |\Data View £ variable view / R

m Inthetable, the variable labeled Minority Classification defines the layers. In the datafile,
two additional variables are created: one variable that identifies the layer element and one
variable that identifies the categories of the layer element.

m  Aswith the variables that are created from the row elements, the variables that are created
from the layer elements are string variables with generic variable names (the prefix Var
followed by a sequential number).

Data Files Created from Multiple Tables

When multiple tables are routed to the same data file, each table is added to the datafilein a

fashion that is similar to merging data files by adding cases from one data file to another datafile
(Data menu, Merge Files, Add Cases).

m  Each subsequent table will always add cases to the datafile.

m If column labelsin the tables differ, each table may also add variables to the data file, with
missing values for cases from other tables that don’t have an identically labeled column.

Example: Multiple Tables with the Same Column Labels

Multiple tables that contain the same column labels will typically produce the most immediately
useful datafiles (datafiles that don’t require additional manipulation). For example, two or more
frequency tables from the Frequencies procedure will all have identical column labels.
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Figure 20-9
Two tables with identical column labels
Gender
Cumulative
Freguency Percert “alid Percert Percert
Walid Fermale MB 456 456 456
Mlale 258 4.4 4.4 100.0
- Employiment Category
Cumulstive
Frecuency Percert Walic) Percent Percert
Walid Clerical 363 766 766 766
Custoclial 27 a7 a7 23
Manager 54 177 177 1000
B *temp.sav [DataSet3] - Data Editor [Z]@
File Edit Wew Data Transform Analyze Graphs Utlities Add-ons  Window Help
1 Commane_ Frecuencies Yizible: 9 of 9 Wa
Subtvpe_ | Label_ | Warl | War2 |Frequency| Percent |\f'a|idPercerrt| CumulativePercent| ~
1 |Frequencies  |Gender “alid |Female 216 456 456 456
2 |Frequencies | Gender Yalid |Male 255 4.4 244 100.0
3 |Frequencies | Gender “alid | Total 474 100.0 100.0 .
4 [Frequencies | Employment Categor “alid | Clerical 363 TEE TEE TEE
5|Freguencies  |Employment Categar YWalid | Custodial 27 57 57 823
B|Frequencies  |Employment Categar Walid | Manager a4 177 177 100.0
7 |Frequencies  |Employment Categar “alid | Tatal 474 1000 1000
&
el w
4 » |\ Data View £ variahle View f [< 2]

m  The second table contributes additional cases (rows) to the data file but contributes no new
variables because the column labels are exactly the same, so there are no large patches

of missing data.

m  Although the values for Command_and Subtype are the same, the Label _ value identifies the
source table for each group of cases because the two frequency tables have different titles.

Example: Multiple Tables with Different Column Labels

A new variableis created in the datafile for each unique column label in the tables that are routed
to the datafile. This process results in blocks of missing values if the tables contain different

column labels.
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Figure 20-10
Two tables with different column labels

Table 1

Beginning
Salary
$13,091 97
$12,373.00
$20,301 40

Gender
Female

current Salary
$26,031 .92
§24,300.00
$41 441 .78

tlean
Meddian

tlean

filale

Tahle 2
Total

Months
zince Hire

Gender Education level

flean
teclian

Female 1237

1200

8035
81.00

flale flean 14.43 8172

Output Management System

o *temp.sav [DataSetd] - Data Editor

BEX]

1 Command_ Means

Current
Salary

Beginning

Subtype | Label_
Salary

“arl ‘ “ar2

Educationsl
Levelyears

File Edit Wew Data Transform Analvze Graphs  Utilities  Add-ons  Window Help

haonthssince
Hire

™

Female |Mean
Female |Median
flale flean
flale teclian
Total  |Mean
Total  |Median
Female |Mean
Iedlian
flean
Iedian
flean
fledian

$13092.0
$123730
$20301 .4
137300
$17016.1
$1:3000.0

Report
Report
Report
Report
Report
Report
Report
Report
Report
Report
Report
Report

‘ >4KDataView A variahle view f

Repott
Repott
Repott
Repott
Repott
Repott
Report
Report
Report
Report
Report
Report

F26032
F24300
41442
F32830
F34420
28875

Ol |m |t | & ko

Female
Iale
fale
Tatal
Tatal

[i=]

10
11
12

12357
1200
1443
1300
1348
12.00

&0.35
&1.00
a1.72
g2.00
1.1
&1.00

G

The first table has columns labeled Beginning Salary and Current Salary, which are not

present in the second table, resulting in missing values for those variables for cases from

Conversely, the second table has columns labeled Education level and Months since Hire,

which are not present in the first table, resulting in missing values for those variables for

| ]

the second table.
| ]

cases from the first table.
| ]

Mismatched variables like the variables in this example can occur even with tables of the same

subtype. In this example, both tables are the same subtype.

Example: Data Files Not Created from Multiple Tables

If any tables do not have the same number of row elements as the other tables, no datafile will be
created. The number of rows doesn’t have to be the same; the number of row elements that become
variables in the data file must be the same. For example, atwo-variable crosstabulation and a
three-variable crosstabulation contain different numbers of row elements, because the “layer”
variable is actually nested within the row variable in the default three-variable crosstabul ation

display.
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Figure 20-11
Tables with different numbers of row elements

Employment Category * Gender Crosstabulation

Fender
Female hale Tatal
Emplaviment Cletical 205 157 363
Category Custadial 0 berd 7
Manager 10 74 g4
Total 26 253 474

Employment Category * Gender * Minority Classification Crosstabulation

Gender

Winarity Classification Female hale Total
Mo Employment Clerical 166 110 276
Cateory Custodial i 14 14
Mananer 10 70 a0
Total 176 194 370
Yes Employment Clerical 40 47 a7
Categaory Custodial 0 13 13
Manager ] 4 4
Total 40 B4 104

Controlling Column Elements to Control Variables in the Data File

In the Options dialog box of the Output Management System Control Panel, you can specify
which dimension elements should be in the columns and therefore will be used to create variables
in the generated datafile. This processis equivalent to pivoting the table in the Viewer.

For example, the Frequencies procedure produces a descriptive statistics table with statisticsin
the rows, while the Descriptives procedure produces a descriptive statistics table with statistics
in the columns. To include both table types in the same data file in a meaningful fashion, you
need to change the column dimension for one of the table types.

Because both table types use the element name “ Statistics’ for the statistics dimension, we
can put the statistics from the Frequencies statistics table in the columns simply by specifying
“Statistics” (in quotation marks) in the list of dimension names in the OM S Options dialog box.
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OMS Options dialog box

@ OMS: Options
Format: | Sy Statistics Data File -

Graphics Images

Tahle Pivaots
© Mone

@ All dimmensions in & sindle row
@ List of postions

@ List of dimenzion names

Tahle Mumber Yariable: (TableMumber

Cancel ][ Help ]

Figure 20-13
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Combining different table types in a data file by pivoting dimension elements

Default Frequencies Statistics Table

Bedinning
Salary Current Salary
M *Walid 474 474
Mi=sing 0 0
Mhean F17 N1AR N9 %34 419 57
hlinimu Pivoted Frequencies Statistics Tables
Tdazimy
M
“alic Miz=sing Mean MinirmLim Maimum
Beginning
Salary 474 o | $17 01609 9,000 F73,980
Default Descriptive Statistics Table 135,000
I finimLim hazimum hean
Marths since Hire 474 63 95 1.1
Previous Experience
(mantihs] 474 a 476 9586 .
L | *temp.sav [] - SPSS Data Editor E]@
Flle Edit Wiew Data Transform  Analyze Graphs Utilities Add-oms  Window Help
1 Commane_ Frequencies
Warl | “alicl | Missing | hiean | Minimum| Mazimum | il | A
1 | Beginning Salary 474 0/$17016 | $9,000| §$79950
2| Current Salary 474 034420 $15,750 | $135,000 .
3 [Months since Hire R $63 pis o] 474
4 |Previous Experience .| ‘F95.56 §0 F47G 474
5 | Walicd M (listwise) 474
&
7
— w
4 v |\ Data View A variable view f < >
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Some of the variables will have missing values, because the table structures till aren’t exactly the
same with statistics in the columns.

Variable Names in OMS-Generated Data Files

OMS congtructs valid, unique variable names from column labels:

m  Row and layer elements are assigned generic variable names—the prefix Var followed by a
sequential number.

m Charactersthat aren’t allowed in variable names (spaces, parentheses, etc.) are removed. For
example, “This (Column) Label” would become a variable named ThisColumnLabel.

m If the label begins with a character that is allowed in variable names but not allowed as the
first character (for example, anumber), “ @" isinserted as a prefix. For example, “2nd” would
become a variable named @2nd.

m  Underscores or periods at the end of 1abels are removed from the resulting variable names.
The underscores at the end of the automatically generated variables Command_, Subtype ,
and Label_ are not removed.

m If more than one element is in the column dimension, variable names are constructed by
combining category labels with underscores between category labels. Group labels are not
included. For example, if VarB is nested under VarA in the columns, you would get variables
like CatAl CatB1, not VarA CatAl VarB CatBl.

Figure 20-14
Variable names constructed from table elements
| Warl | | Ward | | Ward | | In | | Out | | Tatal |
|
Column “ariahle |
Laver Wariable In [out) Total
High Rowe Yariahle  Yes 1 1 2
Mo i} 1 1
Total 1 2 3
Lo Rovwe Yariahle Wes 1 0 1
Mo 1 1 2
Tatal 2 1 3
High_In High_Total Low_ Out
[(Val | [ vaz | [ High_Out] Low_In [Low_Total]
Lavyer Wariable
High Low
Calumn “ariakle Colunn Wariakle
In (o) Total In [iout) Total
Row Wariable  Ye 1 1 2 1 0] 1
i} ] 1 1 1 1 2
Total 1 2 3 2 1 3
OXML Table Structure

Output XML (OXML) is XML that conformsto the spss-output schema. For adetailed description
of the schema, see the Output Schema section of the Help system.
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®m  OMS command and subtype identifiers are used as values of the command and subType
attributes in OXML. An exampleis as follows:

<command text="Frequencies" command="Frequencies"...>
<pivotTable text="Gender" label="Gender" subType="Frequencies"...>

m OMScommand and subType attribute values are not affected by output language or display
settings for variable names/labels or values/value labels.

m XML iscase sensitive. A subType attribute value of “frequencies’ is not the same as a
subType attribute value of “Frequencies.”

m  All information that is displayed in atable is contained in attribute valuesin OXML. At the
individual cell level, OXML consists of “empty” elements that contain attributes but no
“content” other than the content that is contained in attribute values.

m Table structure in OXML is represented row by row; elements that represent columns are
nested within the rows, and individual cells are nested within the column elements:

<pivotTable...>
<dimension axis="row'...>
<dimension axis='column’...>
<category...>
<cell text="..." number="..." decimals="..."/>
</category>
<category...>
<cell text="..." number="..." decimals="..."/>
</category>
</dimension>
</dimension>

</pivotTable>

The preceding example is a simplified representation of the structure that shows the
descendant/ancestor relationships of these elements. However, the example does not necessarily
show the parent/child relationships, because there are typically intervening nested element levels.

The following figure shows a simple frequency table and the complete output XML
representation of that table.

Figure 20-15
Simple frequency table
Gender
Cumulative
Frequency Percert “alid Percert Percent
Walid Fermale 26 456 456 456
Male 258 244 244 100.0
Total 474 100.0 1000
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Figure 20-16
Output XML for the simple frequency table

<?xml version="1.0" encoding="UTF-8" 7>
<outputTreeoutputTree xmIns="http://xml.spss.com/spss/oms"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalocation="http://xml.spss.com/spss/oms
http://xml.spss.com/spss/oms/spss-output-1.0.xsd">
<command text="Frequencies" command="Frequencies"
displayTableValues="label" displayOutlineValues="label"
displayTableVariables="label" displayOutlineVariables="label">
<pivotTable text="Gender" label="Gender" subType="Frequencies"
varName="gender" variable="true">
<dimension axis="row" text="Gender" label="Gender"
varName="gender" variable="true">
<group text="Valid">
<group hide="true" text="Dummy">
<category text="Female" label="Female" string="f"
varName="gender">
<dimension axis="column" text="Statistics">
<category text="Frequency">
<cell text="216" number="216"/>
</category>
<category text="Percent">

<cell text="45.6" number="45.569620253165" decimals="1"/>
</category>

<category text="Valid Percent">

<cell text="45.6" number="45.569620253165" decimals="1"/>
</category>

<category text="Cumulative Percent">

<cell text="45.6" number="45.569620253165" decimals="1"/>
</category>

</dimension>
</category>
<category text="Male" label="Male" string="m" varName="gender">
<dimension axis="column" text="Statistics">
<category text="Frequency">

<cell text="258" number="258"/>
</category>

<category text="Percent">

<cell text="54.4" number="54.430379746835" decimals="1"/>
</category>

<category text="Valid Percent">

<cell text="54.4" number="54.430379746835" decimals="1"/>
</category>

<category text="Cumulative Percent">

<cell text="100.0" number="100" decimals="1"/>
</category>

</dimension>
</category>
</group>
<category text="Total">
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<dimension axis="column" text="Statistics">
<category text="Frequency">

<cell text="474" number="474"/>

</category>

<category text="Percent">

<cell text="100.0" number="100" decimals="1"/>

</category>
<category text="Valid Percent">
<cell text="100.0" number="100" decimals="1"/>
</category>
</dimension>
</category>
</group>
</dimension>
</pivotTable>
</command>
</outputTree>

Asyou may notice, asimple, small table produces a substantial amount of XML. That’s partly

because the XML contains some information that is not readily apparent in the original table,

some information that might not even be available in the original table, and a certain amount

of redundancy.

m  The table contents as they are (or would be) displayed in a pivot table in the Viewer are
contained in text attributes. An exampleis as follows:

<command text="Frequencies" command="Frequencies"...>

m  Text attributes can be affected by both output language and settings that affect the display of
variable names/labels and values/value labels. In this example, the text attribute value will
differ, depending on the output language, whereas the command attribute value remains the
same, regardless of output language.

m  Wherever variables or values of variables are used in row or column labels, the XML will
contain atext attribute and one or more additional attribute values. An exampleisasfollows:

<dimension axis="row" text="Gender" label="Gender" varName="gender">
..<category text="Female" label="Female" string="f" varName="gender">

m  For anumeric variable, there would be a number attribute instead of a string attribute. The
label attribute is present only if the variable or values have defined labels.

m  The<cell> elementsthat contain cell values for numbers will contain the text attribute and one
or more additional attribute values. An exampleis asfollows:

<cell text="45.6" number="45.569620253165" decimals="1"/>
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The number attribute is the actual, unrounded numeric value, and the decimals attribute indicates

the number of decimal positions that are displayed in the table.

m  Because columns are nested within rows, the category element that identifies each column is
repeated for each row. For example, because the statistics are displayed in the columns, the
element <category text="Frequency"> appears three times in the XML: once for the male row,

once for the female row, and once for the total row.

OMS Identifiers

The OMS Identifiers dialog box is designed to assist you in writing OMS command syntax.
You can use this dialog box to paste selected command and subtype identifiers into a command

syntax window.

Figure 20-17

OMS Identifiers dialog box

B OMS Identifiers

Command Idertifiers:

Thiz dialoy dizplays the OMS idertifiers for commands and output table subtypes that are used in creating OMS synitax.

Tahle Subtype Identifiers:

DATAFILE ATTRIBUTE
DATASET ACTNVATE
DATASET CLOSE
DATASET COPY
DATASET DECLARE
DATAZET DISPLAY
DATASET NAME
DELETE % ARIABLES
DESCRIPTIVES
DETECTAMCMALY
DISCRIMIMNARNT

Synitax Identifiers
COXREG Cox Regression
CREATE Create
CROSSTABS Crozstabs
CSCOXREG CSCoxRey
CSDESCRIPTIVES CEDexscriptives
CSGLM CSGLM
CELOGISTIC CELogistic
CSORDINAL CSOrdingl
CSPLAN CSPlan
CSSELECT CESelect
CSTABLLATE CSTabulate
CTABLES CTables
CLURVEFIT Curve Fit

Datafile Attribute
Datazet Activate
Datazet Close
Datazet Copy
Datazet Declare
Datazet Display
Datazet Mame
Delete Variables
Descriptives
Detect Anatmaly
Discriminart

Kl

Cagse Processing Summary

Chi Sojuare Tests

Crosstabulstion

Descriptive Statistics

Directional Measures

Mantel-Haenszel Common Odds Ratio Est
Motes

Qutput File Summary

Risk Estimate

Symmetric Measures

Tests of Condtional Independence
Tests of Homogeneity of the Odds Ratio
Warnings

Zero Crder and Partial Gammas

1 el | ¥ |

Paszte Cammands

Pazte Subtypes

To Use the OMS Identifiers Dialog Box

» From the menus choose;

Utilities
OMS l|dentifiers...
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» Select one or more command or subtype identifiers. (Use Ctrl+click to select multiple identifiers
in each list.)

» Click Paste Commands and/or Paste Subtypes.

m  Thelist of available subtypesis based on the currently selected command(s). If multiple
commands are selected, the list of available subtypes is the union of all subtypes that are
available for any of the selected commands. If nho commands are selected, all subtypes are
listed.

m Theidentifiers are pasted into the designated command syntax window at the current
cursor location. If there are no open command syntax windows, a new syntax window
is automatically opened.

m Each command and/or subtype identifier is enclosed in quotation marks when pasted, because
oMs command syntax requires these quotation marks.

m |dentifier lists for the comManDs and sUBTYPES keywords must be enclosed in brackets, asin:

/IF COMMANDS=['Crosstabs' 'Descriptives']
SUBTYPES=['Crosstabulation' 'Descriptive Statistics']

Copying OMS Identifiers from the Viewer Outline

You can copy and paste OMS command and subtype identifiers from the Viewer outline pane.
» Inthe outline pane, right-click the outline entry for the item.

» Choose Copy OMS Command Identifier or Copy OMS Table Subtype.

This method differs from the OMS Identifiers dialog box method in one respect: The copied
identifier is not automatically pasted into a command syntax window. The identifier is simply
copied to the clipboard, and you can then paste it anywhere you want. Because command and
subtype identifier values are identical to the corresponding command and subtype attribute values
in Output XML format (OXML), you might find this copy/paste method useful if you write
XSLT transformations.

Copying OMS Labels

Instead of identifiers, you can copy labels for use with the LaBELS keyword. Labels can be used
to differentiate between multiple graphs or multiple tables of the same type in which the outline
text reflects some attribute of the particular output object, such as the variable names or labels.
There are, however, a number of factors that can affect the label text:

m If split-file processing is on, split-file group identification may be appended to the label.

m Labelsthat include information about variables or values are affected by the settings for the
display of variable names/labels and values/value labels in the outline pane (Edit menu,
Options, Output Labels tab).

m Labelsare affected by the current output language setting (Edit menu, Options, General tab).
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To copy OMS labels
» Inthe outline pane, right-click the outline entry for the item.

» Choose Copy OMS Label.

As with command and subtype identifiers, the labels must be in quotation marks, and the entire
list must be enclosed in square brackets, asin:

/IF LABELS=['Employment Category' 'Education Level']
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Scripting Facility

The scripting facility alows you to automate tasks, including:
m  Opening and saving datafiles.

m  Exporting charts as graphic filesin a variety of formats.
m  Customizing output in the Viewer.

Scripting Languages

The available scripting languages depend on your platform. For Windows, the available scripting
languages are Basic, which isinstalled with the Core system, and the Python programming
language. For al other platforms, scripting is available with the Python programming language.

To enabl e scripting with the Python programming language, you must have Python and the PASW
Statistics-Python Integration Plug-in installed. For information, see How to Get Integration
Plug-ins, available from Core System>Frequently Asked Questions in the Help system.

Note: SPSS Inc. is not the owner or licensor of the Python software. Any user of Python must
agree to the terms of the Python license agreement located on the Python Web site. SPSS Inc.
does not make any statement about the quality of the Python program. SPSS Inc. fully disclaims
all liability associated with your use of the Python program.

Default Script Language

The default script language determines the script editor that is launched when new scripts are
created. It also specifies the default language whose executable will be used to run autoscripts.
On Windows, the default script language is Basic. You can change the default language from the
Scriptstab in the Options dialog. For more information, see the topic Script Optionsin Chapter 16
on p. 306.

Sample Scripts

A number of scripts are included with the software, in the Samples subdirectory of the directory
where PASW Statisticsis installed. You can use these scripts as they are or you can customize
them to your needs.

379
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To Create a New Script

» From the menus choose;

File
New
Script

The editor associated with the default script language opens.

To Run a Script

» From the menus choose:
Utilities
Run Script...
» Select the script you want.

» Click Run.

Python scripts can be run in a number of ways, other than from Utilities>Run Script. For more
information, see the topic Scripting with the Python Programming Language on p. 383.

To Edit a Script

» From the menus choose;
File
Open
Script...

» Select the script you want.

» Click Open.

The script is opened in the editor associated with the language in which the script is written.

Autoscripts

Autoscripts are scripts that run automatically when triggered by the creation of specific pieces of
output from selected procedures. For example, you can use an autoscript to automatically remove
the upper diagonal and highlight correlation coefficients below a certain significance whenever a
Correlations table is produced by the Bivariate Correlations procedure.

Autoscripts can be specific to a given procedure and output type or apply to specific output
types from different procedures. For example, you might have an autoscript that formats the
ANOVA tables produced by One-Way ANOVA as well as ANOVA tables produced by other
statistical procedures. On the other hand, Frequencies produces both a frequency table and atable
of statistics, and you might choose to have a different autoscript for each.

Each output type for a given procedure can only be associated with a single autoscript. You
can, however, create a base autoscript that is applied to all new Viewer items prior to the
application of any autoscripts for specific output types. For more information, see the topic Script
Options in Chapter 16 on p. 306.
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The Scriptstab in the Options dialog box (accessed from the Edit menu) displays the autoscripts
that have been configured on your system and allows you to set up new autoscripts or modify the
settings for existing ones. Optionally, you can create and configure autoscripts for output items
directly from the Viewer.

Events that Trigger Autoscripts

The following events can trigger autoscripts:
m Creation of apivot table

m Creation of a Notes object

m  Creation of a Warnings object

You can also use a script to trigger an autoscript indirectly. For example, you could write a
script that invokes the Correlations procedure, which in turn triggers an autoscript registered
to the resulting Correlations table.

Creating Autoscripts

You can create an autoscript by starting with the output object that you want to serve as the
trigger—for instance, a frequency table.

» Inthe Viewer, select the object that will trigger the autoscript.
» From the menus choose:

Utilities
Create/Edit AutoScript...
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Figure 21-1
Creating a new autoscript
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If the selected object does not have an associated autoscript, an Open dialog prompts you for the
location and name of a new script.
Browse to the location where the new script will be stored, enter afile name and click Open. The
editor for the default script language opens. You can change the default script language from
the Scripts tab on the Options dialog. For more information, see the topic Script Optionsin
Chapter 16 on p. 306.
Type the code.

For help with coding autoscripts in Python, see Getting Started with Autoscriptsin Python on
p. 386. For help with converting custom Sax Basic autoscripts used in pre-16.0 versions, see
Compatibility with Versions Prior to 16.0 on p. 390.

Note: By default, the executable associated with the default script language will be used to run the
autoscript. You can change the executable from the Scripts tab in the Options dialog.

If the selected object is already associated with an autoscript, the script is opened in the script
editor associated with the language in which the script is written.

Associating Existing Scripts with Viewer Objects

>

>

You can use existing scripts as autoscripts by associating them with a selected object in the
Viewer—for instance, afrequency table.

In the Viewer, select an object to associate with an autoscript (multiple Viewer objects can trigger
the same autoscript, but each object can only be associated with a single autoscript).

From the menus choose:
Utilities
Associate AutoScript...
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Figure 21-2
Associating an autoscript
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If the selected object does not have an associated autoscript, the Select Autoscript dialog opens.
» Browse for the script you want and select it.

» Click Apply.

If the selected object is already associated with an autoscript, you are prompted to verify that you
want to change the association. Clicking OK opens the Select Autoscript dialog.

Optionally, you can configure an existing script as an autoscript from the Scripts tab in the Options
dialog box. The autoscript can be applied to a selected set of output types or specified as the base
autoscript that is applied to al new Viewer items. For more information, see the topic Script
Options in Chapter 16 on p. 306.

Scripting with the Python Programming Language

PASW Statistics provides two separate interfaces for programming with the Python language on
Windows, Linux, and Mac OS. Use of these interfaces requires the PASW Statistics-Python
Integration Plug-in, which is provided with your PASW Statistics product. For information, see
How to Get Integration Plug-ins, available from Core System>Frequently Asked Questionsin the
Help system. For help getting started with the Python programming language, see the Python
tutorial, available at http://docs.python.org/tut/tut.html.

Python Scripts

Python scripts make use of the interface exposed by the Python spssclient module. They
operate on user interface and output objects and can also run command syntax. For instance, you
would use a Python script to customize a pivot table.


http://docs.python.org/tut/tut.html
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m  Python scripts are run from Utilities>Run Script, from the Python editor launched from PASW
Statistics (accessed from File>Open>Script), or from an external Python process, such as a
Python IDE or the Python interpreter.

m Python scripts can be run as autoscripts.
m  Python scripts run on the machine where the PASW Statistics client is running.

Complete documentation of the PASW Statistics classes and methods available for Python scripts
can be found in the PASW Statistics Scripting Guide, available under Python Integration Plug-in
in the Help system.

Python Programs

Python programs make use of the interface exposed by the Python spss module. They operate
on the PASW Statistics processor and are used to control the flow of a command syntax job, read
from and write to the active dataset, create new datasets, and create custom procedures that
generate their own pivot table output.

m  Python programs are run from command syntax within BEGIN PROGRAM-END PROGRAM
blocks, or from an external Python process, such as a Python IDE or the Python interpreter.

m  Python programs cannot be run as autoscripts.

m In distributed analysis mode (available with PASW Statistics Server), Python programs
execute on the computer where PASW Statistics Server is running.

More information about Python programs, including complete documentation of the PASW
Statistics functions and classes available for them, can be found in the documentation for the
PASW Statistics-Python Integration Package, available under Python Integration Plug-in in the
Help system.

Running Python Scripts and Python programs

Both Python scripts and Python programs can be run from within PASW Statistics or from an
external Python process, such as a Python IDE or the Python interpreter.

Python Scripts

Python Script Run from PASW Statistics. You can run a Python script from Ultilities>Run Script
or from the Python script editor which is launched when opening a Python file (.py) from
File>Open>Script. Scripts run from the Python editor that is launched from PASW Statistics
operate on the PASW Statistics client that launched the editor. This allows you to debug your
Python code from a Python editor.

Python Script Run from an External Python Process. You can run a Python script from any external
Python process, such as a Python IDE that is not launched from PASW Statistics, or the Python
interpreter. The script will attempt to connect to an existing PASW Statistics client. If more than
one client is found, a connection is made to the most recently launched one. If an existing client is
not found, the Python script starts up a new instance of the PASW Statistics client. By default, the
Data Editor and Viewer are invisible for the new client. You can choose to make them visible or
work in invisible mode with datasets and output documents.
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Python Programs

Python Program Run from Command Syntax. You can run a Python program by embedding Python
code within aBEGIN PROGRAM-END PROGRAM block in command syntax. The command syntax
can be run from the PASW Statistics client or from the PASW Statistics Batch Facility—a separate
executable provided with PASW Statistics Server.

Python Program Run from an External Python Process. You can run a Python program from any
external Python process, such as a Python IDE or the Python interpreter. In this mode, the Python
program starts up a new instance of the PASW Statistics processor without an associated instance
of the PASW Statistics client. You can use this mode to debug your Python programs using the
Python IDE of your choice.

Invoking Python Scripts from Python Programs and Vice Versa

Python Script Run from Python Program. You can run a Python script from a Python program by
importing the Python module containing the script and calling the function in the module that
implements the script. You can also call Python script methods directly from within a Python
program. For more information, see the topic Running Python Scripts from Python Programs on
p. 387. These features are not available in distributed mode or when running a Python program
from an external Python process. To programmatically invoke a Python script in distributed
mode, use the scRTPT command.

Python Autoscript Triggered from Python Program. A Python script specified as an autoscript will be
triggered when a Python program executes the procedure containing the output item associated
with the autoscript. For example, you associate an autoscript with the Descriptive Statistics
table generated by the Descriptives procedure. You then run a Python program that executes the
Descriptives procedure. The Python autoscript will be executed.

Python Program Run from Python Script. Python scripts can run command syntax, which means they
can run command syntax containing Python programs.

Limitations and Warnings

®  Running a Python program from the Python editor launched by PASW Statistics will start up
anew instance of the PASW Statistics processor and will not interact with the instance of
PASW Statistics that launched the editor.

m  Python programs are not intended to be run from Utilities>Run Script.
m Python programs cannot be run as autoscripts.
m Theinterfaces exposed by the spss module cannot be used in a Python script.

Getting Started with Python Scripts

The basic structure of a Python script is:

import SpssClient
SpssClient.StartClient ()
<Python language statements>
SpssClient.StopClient ()
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B Theimport SpssClient statement imports the Python module containing the PASW
Statistics classes and methods available in the Python scripting interface.

B SpssClient.StartClient () provides aconnection to the associated PASW Statistics
client, enabling the script to retrieve information from the client and to perform operations on
objects managed by the client, such as pivot tables. Whether the script connects to an existing
client or starts up anew client depends on how the script was invoked. For more information,
see the topic Running Python Scripts and Python programs on p. 384.

B SpssClient.StopClient () terminatesthe connection to the PASW Statistics client and
should be called at the completion of each Python script.

Note: If you're running a Python script from an external Python process that starts up a new
client, cal spssCclient.Exit () before SpssClient.StopClient ().

Example

This script accesses the designated output document and sets each of the pivot tables as sel ected.

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType () == SpssClient.OutputItemType.PIVOT:
OutputItem.SetSelected (True)
SpssClient.StopClient ()

Target for Standard output

The Python print statement writes output to Python’s standard output. When you run a Python
script from Utilities>Run Script, Python's standard output is directed to alog item in the PASW
Statistics Viewer.

Getting Started with Autoscripts in Python

Autoscripts typically require a reference to the object that triggered the script. They may also
require areference to the associated output document and possibly the index of the output item in
the output document. These values are obtained from the spssScriptContext object, as shown
in this example of an autoscript that transposes the rows and columns of a pivot table.

import SpssClient
SpssClient.StartClient ()

SpssScriptContext = SpssClient.GetScriptContext ()
SpssOutputItem = SpssScriptContext.GetOutputItem()
SpssPivotTable = SpssOutputItem.GetSpecificType /()
SpssPivotMgr = SpssPivotTable.PivotManager ()
SpssPivotMgr.TransposeRowsWithColumns ()

SpssClient.StopClient ()
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B SpssClient.GetScriptContext refurnsan SpssScriptContext object that provides
values for use by the autoscript.

B TheGetoutputItem method of the SpssScriptContext object returns the output item
that triggered the current autoscript—in this example, the pivot table whose rows and columns
are to be transposed.

Although not used in this example, the Getoutputboc method of the SpssScriptContext
object returns the associated output document, and the GetOutputItemIndex method returns
the index (in the associated output document) of the output item that triggered the autoscript.

Detecting When a Script is Run as an Autoscript

Using the GetscriptContext method, you can detect when a script is being run as an
autoscript. This allows you to code a script so that it functions in either context (autoscript or
not). Thistrivial script illustrates the approach.

import SpssClient
SpssClient.StartClient ()

SpssScriptContext = SpssClient.GetScriptContext ()

if SpssScriptContext == None:
print "I'm not an autoscript"
else:

print "I'm an autoscript"

SpssClient.StopClient ()

m  When ascript is not run as an autoscript, the Get ScriptContext method will return a
value of None.

m Giventheif-else logicin this example, you would include your autoscript-specific code
inthe else clause. Any code that is not to be run in the context of an autoscript would be
included in the i f clause. Of course you can aso include code that isto be run in either
context.

Running Python Scripts from Python Programs

You can run Python scripts from Python programs and you can call Python script methods
from within a Python program. This allows you to write Python programs that operate on user
interface and output objects.

Note: This feature is only available when running a Python program from the PASW Statistics
client—within aBEGIN PROGRAM-END PROGRAM block in command syntax or within an
extension command. It is not available in distributed mode or when running a Python program
from an external Python process. To programmatically invoke a Python script in distributed
mode, use the scrRIPT command.

Example: Calling a Python Script from a Python Program

This example shows a Python program that creates a custom pivot table and calls a Python script
to make the column labels of the table bold.
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BEGIN PROGRAM.

import spss, MakeColsBold

spss.StartProcedure ("Demo")

table = spss.BasePivotTable("Sample Table", "OMS subtype")

table.SimplePivotTable (rowlabels = ["1","2"],
collabels = ["A","B"],
cells = ["lA", "lB", ||2An’ "2B"])

spss.EndProcedure ()
MakeColsBold.Run ("Sample Table")
END PROGRAM.

m  Python programs use the interface exposed by the Python spss module, so the first line of
the program contains an import statement for that module. The Python script is assumed
to be contained in a Python module named MakeColsBold, SO the import Statement also
includes that module.

m Thecodefrom spss.StartProcedure 10 spss.EndProcedure creates a pivot table
titled “ Sample Table".

B MakeColsBold.Run("Sample Table") calsthe Run functioninthe MakeColsBold
module and passes the value “ Sample Table” as the argument. The Run function implements
the Python script to make the column labels of the specified table bold.

The content of the MakeColsBold moduleis as follows:

import SpssClient

def Run(tableName) :
SpssClient.StartClient ()
OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()
for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT \
and OutputItem.GetDescription() == tableName:
PivotTable = OutputItem.GetSpecificType()
ColumnLabels = PivotTable.ColumnLabelArray ()
for i in range(ColumnLabels.GetNumColumns()) :
ColumnlLabels.SelectLabelAt (1,1)
PivotTable.SetTextStyle (SpssClient.SpssTextStyleTypes.SpssTSBold)
SpssClient.StopClient ()

®m Theimport SpssClient Statement is needed to access the classes and methods available
in the Python scripting interface.

®  The module contains a single function named rRun, which implements the script. It takesa
single argument that specifies the name of the table to modify. There is nothing special about
the name Run and the module is not limited to a single function. You can create a module that
contains many functions, each of which implements a different script.

® TheRrun function calls spssClient.StartClient () to provide a connection to the
associated PASW Statistics client and spssClient.StopClient () to terminate the
connection at the completion of the script.

Example: Calling Python Scripting Methods Directly from a Python Program

This example shows a Python program that creates a custom pivot table and makes direct callsto
Python scripting methods to make the title of the table italic.
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BEGIN PROGRAM.

import spss, SpssClient

spss.StartProcedure ("Demo")

table = spss.BasePivotTable("Sample Table", "OMS subtype")
table.SimplePivotTable(cells = ["A","B","C","D"])
spss.EndProcedure ()

SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()

OutputItems = OutputDoc.GetOutputItems ()

OutputItem = OutputItems.GetItemAt (OutputItems.Size()-1)

PivotTable = OutputItem.GetSpecificType ()

PivotTable.SelectTitle ()

PivotTable.SetTextStyle (SpssClient.SpssTextStyleTypes.SpssTSItalic)
SpssClient.StopClient ()

END PROGRAM.

m Theimport spss, SpssClient statement provides access to the classes and methods
available for Python programs (spss) as well as those for Python scripts (Spssclient).

m  Thecodefrom spss.StartProcedure t0 spss . EndProcedure is the Python program
code that creates the pivot table.

m Thecodefrom spssClient.StartClient () t0 SpssClient.StopClient () isthe
Python script code that makes the title italic.

Script Editor for the Python Programming Language

For the Python programming language, the default editor is IDLE, which is provided with Python.
IDLE provides an integrated development environment (IDE) with alimited set of features. Many
IDE’s are available for the Python programming language. For instance, on Windows you may
choose to use the freely available PythonWin IDE.

To change the script editor for the Python programming language:

» Open the file clientscriptingcfg.ini, located in the directory where PASW Statistics is installed.
Note: clientscriptingcfg.ini must be edited with a UTF-16 aware editor, such as SCiTE on
Windows or the TextEdit application on Mac.

» Under the section labeled [Python], change the value of EDITOR_PATH to point to the executable
for the desired editor.

» In that same section, change the value of EDITOR_ARGS to handle any arguments that need to be
passed to the editor. If no arguments are required, remove any existing values.

Scripting in Basic

Scripting in Basic is available on Windows only and is installed with the Core system. Extensive
online help for scripting in Basic is available from the PASW Statistics Basic Script Editor. The
editor can be accessed from File>New>Script when the default script language (set from the
Scripts tab on the Options dialog) is set to Basic (the system default on Windows). It isalso
accessed from File>Open>Script, by choosing Basic (wwd;shs) in the Files of type list.
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Compatibility with Versions Prior to 16.0

Obsolete Methods and Properties

A number of automation methods and properties are obsolete for version 16.0 and above. In
terms of general features, thisincludes all objects associated with interactive graphs, the Draft
Document object, and methods and properties associated with maps. For additional information,
see “Release Notes for Version 16.0” in the help system provided with the PASW Statistics
Basic Script Editor. The PASW Statistics-specific help is accessed from Help>PASW Statistics
Objects Help, in the script editor.

Global Procedures

Prior to version 16.0, the scripting facility included a globa proceduresfile. For version 16.0 and
above the scripting facility does not use a global procedures file, although the pre-16.0 version of
Global.shs (renamed Global .wwd) isinstalled for backwards compatibility.

To migrate a pre-16.0 version of a script that called functionsin the global proceduresfile, add the
statement ' #Uses "<install dir>\Samples\Global.wwd" to the declarations section of
the script, where <install dir> isthedirectory where PASW Statisticsisinstalled. ' #Uses is
a special comment recognized by the Basic script processor. If you're not sure if a script uses the
global procedures file, you should add the ' #Uses statement. You can also use ' $Include:
instead of ' #Uses.

Legacy Autoscripts

Prior to version 16.0, the scripting facility included a single autoscript file containing all
autoscripts. For version 16.0 and above there is no single autoscript file. Each autoscript is now
stored in a separate file and can be applied to one or more output items, in contrast to pre-16.0
versions where each autoscript was specific to a particular output item.

Some of the autoscripts installed with pre-16.0 versions are available as a set of separate script
files located in the Samples subdirectory of the directory where PASW Statisticsisinstalled. They
are identified by afilename ending in Autoscript, with afile type of wwd. By default, they are
not associated with any output items. The association is done from the Scripts tab of the Options
dialog. For more information, see the topic Script Options in Chapter 16 on p. 306.

Any custom autoscripts used in pre-16.0 versions must be manually converted and associated with
one or more output items, from the Scripts tab of the Options dialog. The conversion process
involves the following steps:

Extract the subroutine specifying the autoscript from the legacy Autoscript.shsfile and saveit asa
new file with an extension of wwd or sbs. The name of the fileis arbitrary.

Change the name of the subroutine to Main and remove the parameter specification, keeping track
of which parameters are required by the script, such as a pivot table that triggers the autoscript.

Usethe scriptContext object (always available) to get the values required by the autoscript,
such as the output item that triggered the autoscript.
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» From the Scripts tab of the Options dialog, associate the script file with the desired output object.

To illustrate the converted code, consider the autoscript
Descriptives_Table DescriptiveStatistics Create from the legacy Autoscript.sbsfile.

Sub Descriptives_Table_DescriptiveStatistics_Create(objPivotTable As Object, objOutputDoc A:
'Autoscript

'Trigger Event: DescriptiveStatistics Table Creation after running Descriptives procedure.

'Purpose: Swaps the Rows and Columns in the currently active pivot table.
'Assumptions: Selected Pivot Table is already activated.

'Effects: Swaps the Rows and Columns in the output

'Inputs: Pivot Table, OutputDoc, Item Index

Dim objPivotManager As ISpssPivotMgr
Set objPivotManager=objPivotTable.PivotManager
objPivotManager .TransposeRowsWithColumns

End Sub
Following is the converted script:

Sub Main

'Purpose: Swaps the Rows and Columns in the currently active pivot table.
'Effects: Swaps the Rows and Columns in the output

Dim objOutputItem As ISpssItem

Dim objPivotTable as PivotTable

Set objOutputItem scriptContext.GetOutputItem/()
Set objPivotTable objOutputItem.ActivateTable

Dim objPivotManager As ISpssPivotMgr
Set objPivotManager = objPivotTable.PivotManager
objPivotManager .TransposeRowsWithColumns
objOutputItem.Deactivate

End Sub

m  Notice that nothing in the converted script indicates which object the script is to be applied to.
The association between an output item and an autoscript is set from the Scripts tab of the
Options dialog and maintained across sessions.

B scriptContext.GetOutputItem getsthe output item (an ISpssItem object) that
triggered the autoscript.

m  The object returned by scriptContext.GetOutputItem isnot activated. If your script
requires an activated object, you'll need to activate it, as done in this example with the
ActivateTable method. When you're finished with any table manipulations, call the
Deactivate method.

For version 16.0, there is no distinction between scripts that are run as autoscripts and scripts that
aren’t run as autoscripts. Any script, appropriately coded, can be used in either context. For more
information, see the topic The scriptContext Object on p. 392.

Note: To trigger a script from the application creation event, see Startup Scripts.
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Script Editor

For version 16.0 and above the script editor for Basic no longer supports the following pre-16.0
features:

m  The Script, Analyze, Graph, Utilities, and Add-Ons menus.
m  The ability to paste command syntax into a script window.

The PASW Statistics Basic Script Editor is a standalone application that is launched from within
PASW Statistics via File>New>Script, File>Open>Script, or Utilities>Create/Edit AutoScript
(from a Viewer window). It allows you to run scripts against the instance of PASW Statistics from
which it was launched. Once opened, the editor will remain open after exiting PASW Statistics,
but scripts that use PASW Statistics objects will no longer run.

File Types

For version 16.0 and above, the scripting facility will continue to support running and editing
scripts with a file type of sbs. By default, new Basic scripts created with the PASW Statistics
Basic Script Editor have afile type of wwd.

Using External COM Clients

For version 16.0 and above, the program identifier for instantiating PASW Statistics from an
external COM client is sPss.applicationl6. Application objects should be declared as
spsswinLib.Application16. For example:

Dim objSpssApp As spsswinLib.Applicationlé
Set objSpssApp=CreateObject ("SPSS.Applicationl6")

To connect to arunning instance of the PASW Statistics client from an external COM client, use:

Dim objSpssApp As spsswinLib.Applicationl6
Set objSpssApp=GetObject("", "SPSS.Applicationlé6")

If more than one client is running, Getobject will connect to the most recently launched one.

Note: For post-16.0 versions, the identifier is still Applicationis.

The scriptContext Object

Detecting When a Script is Run as an Autoscript

Using the scriptContext object, you can detect when a script is being run as an autoscript.
This alows you to code a script so that it functions in either context (autoscript or not). This
trivial script illustrates the approach.

Sub Main
If scriptContext Is Nothing Then
MsgBox "I'm not an autoscript"
Else
MsgBox "I'm an autoscript"
End If

End Sub
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When a script is not run as an autoscript, the scriptContext object will have a value of
Nothing.

Giventhe 1f-Else logic in this example, you would include your autoscript-specific code
inthe Else clause. Any code that is not to be run in the context of an autoscript would be

included in the T £ clause. Of course you can aso include code that isto be run in either
context.

Getting Values Required by Autoscripts

The scriptContext object provides access to values required by an autoscript, such as the
output item that triggered the current autoscript.

The scriptContext.GetOutputItem method returns the output item (an ISpssItem
object) that triggered the current autoscript.

The scriptContext .GetOutputDoc method returns the output document (an
ISpssOutputDoc object) associated with the current autoscript.

The scriptContext.GetOutputItemIndex method returns the index, in the associated
output document, of the output item that triggered the current autoscript.

Note: The object returned by scriptContext.GetOutputItem iSnot activated. If your script
requires an activated object, you’'ll need to activate it—for instance, with the ActivateTable
method. When you' re finished with any manipulations, call the Deactivate method.

Startup Scripts

You can create a script that runs at the start of each session and a separate script that runs each
time you switch servers. For Windows you can have versions of these scripts in both Python and
Basic. For al other platforms the scripts can only be in Python.

The startup script must be named SartClient_.py for Python or SartClient_.wwd for Basic.

The script that runs when switching servers must be named SartServer_.py for Python or
SartServer _.wwd for Basic.

The scripts must be located in the scripts directory of the installation directory—Iocated at the
root of the installation directory for Windows and Linux, and under the Contents directory
in the application bundle for Mac.

On Windows, if the scripts directory contains both a Python and a Basic version of
SartClient_ or SartServer_then both versions are executed. The order of execution isthe
Python version followed by the Basic version.

If your system is configured to start up in distributed mode, then at the start of each session
any SartClient_ scripts are run followed by any StartServer__ scripts. Note: The StartServer_

scripts aso run each time you switch servers, but the SartClient_ scripts only run at the
start of a session.



Appendix

A
TABLES and IGRAPH Command Syntax
Converter

If you have command syntax filesthat contain TABLES Syntax that you want to convert to CTABLES
syntax and/or TGRAPH syntax that you want to convert to GGRAPH Syntax, asimple utility program
is provided to help you get started with the conversion process. There are, however, significant
functionality differences between TaBLES and cTABLES and between TGRAPH and GGRAPH. It is
likely that you will find that the utility program cannot convert some of your TABLES and IGRAPH
syntax jobs or may generate CTABLES and GGRAPH Syntax that produces tables and graphs that do
not closely resemble the originals produced by the TaABLES and TGRAPH commands. For most
tables, you can edit the converted syntax to produce atable closely resembling the original.

The utility program is designed to:
m Create anew syntax file from an existing syntax file. The original syntax fileis not altered.

m  Convert only TABLES and IGRAPH commands in the syntax file. Other commands in the
file are not altered.

Retain the original TABLES and IGRAPH Syntax in commented form.
Identify the beginning and end of each conversion block with comments.
Identify TABLES and TGRAPH Syntax commands that could not be converted.

Convert command syntax files that follow either interactive or production mode syntax rules.

This utility cannot convert commands that contain errors. The following other limitations also
apply.

TABLES Limitations

The utility program may convert TABLES commands incorrectly under some circumstances,
including TABLES commands that contain:

m Parenthesized variable names with the initial letters “sta” or “1ab” in the TABLES
subcommand if the variable is parenthesized by itself—for example, varl by (statvar)
by (labvar). Thesewill beinterpreted asthe (sTaTIsTICS) and (LABELS) keywords.

®  SORT subcommands that use the abbreviations a or D to indicate ascending or descending sort
order. These will be interpreted as variable names.

The utility program cannot convert TABLES commands that contain:
m  Syntax errors.

394
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B OBSERVATION subcommands that refer to a range of variables using the To keyword (for
example, var01 TO var05).

m  String literals broken into segments separated by plus signs (for example, TITLE "My"
+ "Title").

m  Macro callsthat, in the absence of macro expansion, would be invalid TABLES syntax. Since
the converter does not expand the macro calls, it treats them asif they were simply part of the
standard TABLES Syntax.

The utility program will not convert TABLES commands contained in macros. All macros are
unaffected by the conversion process.

IGRAPH Limitations
IGRAPH changed significantly in release 16. Because of these changes, some subcommands and
keywords in TGRAPH syntax created before that release may not be honored. See the 1GrRaPH
section in the Command Syntax Reference for the complete revision history.

The conversion utility program may generate additional syntax that it stores in the

INLINETEMPLATE keyword within the GGrapa syntax. This keyword is created only by the
conversion program. Its syntax is not intended to be user-editable.

Using the Conversion Utility Program

The conversion utility program, SyntaxConverter.exe, can be found in the installation directory. It
is designed to run from a command prompt. The general form of the command is:

syntaxconverter.exe [path]/inputfilename.sps [path]/outputfilename.sps

You must run this command from the installation directory.
If any directory names contain spaces, enclose the entire path and filename in quotation marks,

asin:

syntaxconverter.exe /myfiles/oldfile.sps "/new files/newfile.sps"

Interactive versus Production Mode Command Syntax Rules

The conversion utility program can convert command files that use interactive or production
mode syntax rules.

Interactive. The interactive syntax rules are:
m  Each command begins on a new line.
m  Each command ends with a period (.).
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Production mode. The Production Facility and commands in files accessed via the INCLUDE
command in a different command file use production mode syntax rules:

m  Each command must begin in the first column of a new line.
m  Continuation lines must be indented at least one space.
m The period at the end of the command is optional.

If your command files use production mode syntax rules and don’t contain periods at the end
of each command, you need to include the command line switch -b (or /b) when you run
SyntaxConverter.exe, as in:

syntaxconverter.exe -b /myfiles/oldfile.sps /myfiles/newfile.sps

SyntaxConverter Script (Windows Only)

On Windows, you can aso run the syntax converter with the script SyntaxConverter.wwd, located
in the Samples directory of the installation directory.

» From the menus choose;
Utilities
Run Script...

» Navigate to the Samples directory and select SyntaxConverter.wwd.

Thiswill open asimple dialog box where you can specify the names and locations of the old and
new command syntax files.



Access (Microsoft), 15
active file, 59-60
caching, 60
creating a temporary active file, 60
virtual active file, 59
active window, 3
adding group labels, 230
aggregating data, 177
aggregate functions, 180
variable names and labels, 180
algorithms, 9
alignment, 77, 207, 293
in Data Editor, 77
output, 207, 293
alternating row colors
pivot tables, 240
aspect ratio, 300
attributes
custom variable attributes, 78
automated production, 345
autoscripts, 306, 380
associating with viewer objects, 382
Basic, 392
creating, 381
Python, 386
trigger events, 381

background color, 245
banding, 116
basic steps, 7
binning, 116
Blom estimates, 142
BMP files, 212, 222
exporting charts, 212, 222
borders, 243, 249
displaying hidden borders, 249
break variables
in Aggregate Data, 177

caching, 60
active file, 60

Cancel button, 5

captions, 247-248

cases, 86, 188
finding duplicates, 113
finding in Data Editor, 87
inserting new cases, 86
restructuring into variables, 188
selecting subsets, 182, 184-185
sorting, 169
weighting, 186
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categorical data, 100
converting interval data to discrete categories, 116
cell properties, 245-246
cellsin pivot tables, 240, 248-249
formats, 240
hiding, 234
showing, 234
widths, 249
centered moving average function, 161
centering output, 207, 293
Chart Builder, 270
gdlery, 271
chart creation, 270
Chart Editor, 274
properties, 275
chart options, 300
charts, 206, 212, 251, 270, 300
aspect ratio, 300
Chart Builder, 270
copying into other applications, 211
creating, 270
creating from pivot tables, 251
exporting, 212
hiding, 206
missing values, 277
overview, 270
size, 277
templates, 277, 300
wrapping panels, 277
chartsoutput, 211
collapsing categories, 116
colorsin pivot tables, 243
borders, 243
column width, 76, 237, 249, 303
controlling default width, 303
controlling maximum width, 237
controlling width for wrapped text, 237
in Data Editor, 76
pivot tables, 249
columns, 249-250
changing width in pivot tables, 249
selecting in pivot tables, 250
COMMA format, 72-73
comma-delimited files, 28
command identifiers, 357
command language, 256
command line switches, 350
Production jobs, 350
command syntax, 256, 267, 313, 317, 345
accessing Command Syntax Reference, 9
adding to menus, 313
journal file, 268
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output log, 258
pasting, 258
Production jobs rules, 345
running, 267
running with toolbar buttons, 317
syntax rules, 256
command syntax editor, 260
auto-completion, 263
bookmarks, 261, 265
breakpoints, 261, 264, 267
color coding, 263
command spans, 261
commenting out text, 266
line numbers, 261
options, 309
command syntax files, 268
computing variables, 124
computing new string variables, 126
conditional transformations, 126
continuation text, 243
for pivot tables, 243
controlling number of rows to display, 237
counting occurrences, 129
Crosstabs
fractional weights, 186
CSsV format
reading data, 28
saving data, 40
CTABLES
converting TABLES command syntax to CTABLES,
394
cumulative sum function, 161
currency formats, 297
custom attributes, 78
custom currency formats, 72, 297
Custom Diaog Builder, 319
check box, 333
check box group, 338
combo box, 333
combo box list items, 334
custom dialog package (spd) files, 328
custom dialogs for extension commands, 341
dialog properties, 321
file browser, 339
file type filter, 340
filtering variable lists, 332
help file, 321
installing dialogs, 328
item group control, 336
layout rules, 324
list box, 333
list box list items, 334
localizing dialogs and help files, 343
menu location, 323
modifying installed dialogs, 328
number control, 335
opening dialog specification files, 328

preview, 327
radio group, 337
radio group buttons, 337
saving dialog specifications, 328
source list, 331
static text control, 336
sub-dialog button, 341
sub-dialog properties, 341
syntax template, 325
target list, 331
text control, 335

custom tables
converting TABLES command syntax to CTABLES,

394
custom variable attributes, 78

data analysis, 7
basic steps, 7
data dictionary
applying from another file, 106
Data Editor, 68, 70, 76-77, 83-87, 90-91, 313
alignment, 77
changing data type, 87
column width, 76
data value restrictions, 84
Data View, 68
defining variables, 70
display options, 90
editing data, 85
entering data, 83
entering hon-numeric data, 84
entering numeric data, 84
filtered cases, 90
inserting new cases, 86
inserting new variables, 86
moving variables, 87
multiple open data files, 92, 291
multiple views/panes, 90
printing, 91
roles, 76
sending data to other applications, 313
Variable View, 69
data entry, 83
datafiles, 11-12, 28, 3940, 45, 60, 65, 188
adding comments, 281
dictionary information, 39
file information, 39
flipping, 171
improving performance for large files, 60
multiple open data files, 92, 291
opening, 11-12
PASW Data Collection, 37
protecting, 58
Quancept, 37
Quanvert, 37
remote servers, 65
restructuring, 188
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saving, 3940
saving output as PASW Statistics data files, 353
saving subsets of variables, 45
text, 28
transposing, 171
DATA LIST, 59
versus GET DATA command, 59
data transformations, 295
computing variables, 124
conditional transformations, 126
delaying execution, 295
functions, 127
ranking cases, 141
recoding values, 133-134, 136, 138
string variables, 126
time series, 158, 160
data types, 72-73, 87, 297
changing, 87
custom currency, 72, 297
defining, 72
display formats, 73
input formats, 73
Data View, 68
databases, 14-15, 18, 20-21, 23, 25, 27
adding new fields to atable, 53
appending records (cases) to atable, 54
conditional expressions, 21
converting strings to numeric variables, 25
creating a new table, 56
creating relationships, 20
defining variables, 25
Microsoft Access, 15
parameter queries, 21, 23
Prompt for Value, 23
random sampling, 21
reading, 14-15, 18
replacing a table, 56
replacing values in existing fields, 52
saving, 46
saving queries, 27
selecting a data source, 15
selecting data fields, 18
specifying criteria, 21
SQL syntax, 27
table joins, 20
updating, 46
verifying results, 27
Where clause, 21
datasets
renaming, 94
date format variables, 72—73, 295
add or subtract from date/time variables, 143
create date/time variable from set of variables, 143
create date/time variable from string, 143
extract part of date/time variable, 143
date formats
two-digit years, 295
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date variables
defining for time series data, 159

dBASE files, 11, 13, 40
reading, 11, 13
saving, 40

default file locations, 305

defining variables, 70, 72, 74-75, 77-78, 96
applying a data dictionary, 106
copying and pasting attributes, 77-78
data types, 72
missing values, 75
templates, 77-78
value labels, 74, 96
variable labels, 74

deleting multiple EXECUTES in syntax files, 268

deleting output, 206

designated window, 3

dialog boxes, 6, 281-282, 291
controls, 5
defining variable sets, 281
displaying variable labels, 4, 291
displaying variable names, 4, 291
reordering target lists, 284
selecting variables, 6
using variable sets, 282
variable display order, 291
variable icons, 6
variable information, 6
variables, 4

dictionary, 39

difference function, 161

disk space, 59-60
temporary, 59-60

display formats, 73

display order, 229

distributed mode, 62—63, 6567
available procedures, 66
data file access, 65
relative paths, 67

DOLLAR format, 72—73

DOT format, 72—73

duplicate cases (records)
finding and filtering, 113

editing data, 85
entering data, 83-84
non-numeric, 84
numeric, 84
using value labels, 84
environment variables, 305
SPSSTMPDIR, 305
EPS files, 212, 222
exporting charts, 212, 222
Excd files, 11, 13, 40, 313
adding menu item to send data to Excel, 313
opening, 11, 13
saving, 40
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saving value labels instead of values, 40
Excel format
exporting output, 212, 216, 359

excluding output from Viewer with OMS, 364

EXECUTE (command)
pasted from dialog boxes, 268
export data, 40
exporting
models, 255
exporting charts, 212, 222, 345
automated production, 345
exporting data, 313
adding menu items to export data, 313
exporting output, 212, 217, 220
Excel format, 212, 216, 359
HTML, 214
HTML format, 212
OMS, 353
PDF format, 212, 219, 359
PowerPoint format, 212
text format, 359
Word format, 212, 215, 359
extension bundles
creating extension bundles, 284
installing extension bundles, 286
viewing installed extension bundles, 288
extension commands
custom dialogs, 341

file information, 39
file locations
controlling default file locations, 305
file transformations, 187188
aggregating data, 177
merging datafiles, 172, 175
restructuring data, 187-188
sorting cases, 169
split-file processing, 181
transposing variables and cases, 171
weighting cases, 186
files, 209
adding atext file to the Viewer, 209
opening, 11
filtered cases, 90
in Data Editor, 90
find and replace
viewer documents, 210
fixed format, 28
fonts, 90, 209, 245
in Data Editor, 90
in the outline pane, 209
footers, 224
footnotes, 240, 247—-248
charts, 277
markers, 240, 248
renumbering, 248
freefield format, 28

functions, 127
missing value treatment, 127

GET DATA, 59
versus DATA LIST command, 59
versus GET CAPTURE command, 59
GGRAPH
converting IGRAPH to GGRAPH, 394
grid lines, 249
pivot tables, 249
group labels, 230
grouping rows or columns, 230
grouping variables, 188
creating, 188

headers, 224

Help button, 5

Help windows, 9

hiding, 206, 234, 248, 314
captions, 248
dimension labels, 234
footnotes, 248
procedure results, 206
rows and columns, 234
titles, 235
toolbars, 314

hiding (excluding) output from the Viewer with OMS, 364

hiding variables
Data Editor, 282
dialog lists, 282
HTML, 212, 214
exporting output, 212, 214

icons
in dialog boxes, 6
IGRAPH
converting IGRAPH to GGRAPH, 394
import data, 11, 14
imputations
finding in Data Editor, 87
inner join, 20
input formats, 73
inserting group labels, 230
interactive charts, 211
copying into other applications, 211

journal file, 305

JPEG files, 212, 222
exporting charts, 212, 222

justification, 207, 293
output, 207, 293

keyed table, 175
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|abels, 230
deleting, 230
inserting group labels, 230
vs. subtype namesin OMS, 358
LAG (function), 161
lag function, 132
language
changing output language, 291
changing user interface language, 291
layers, 223, 231, 233, 237, 243
creating, 231
displaying, 231, 233
in pivot tables, 231
printing, 223, 237, 243
lead function, 132, 161
level of measurement, 71, 100
defining, 71
line breaks
variable and value labels, 75
local encoding, 268
logging in to a server, 62
Lotus 1-2-3 files, 11, 40, 313
adding menu item to send data to Lotus, 313
opening, 11
saving, 40

measurement level, 71, 100
defining, 71
icons in dialog boxes, 6
measurement system, 291
memory, 291
menus, 313
customizing, 313
merging data files
dictionary information, 175
files with different cases, 172
files with different variables, 175
renaming variables, 175
metafiles, 212
exporting charts, 212
Microsoft Access, 15
missing values, 75, 277
charts, 277
defining, 75
in functions, 127
replacing in time series data, 162
string variables, 75
model file
loading saved models to score data, 165
Model Viewer, 253
models, 253
activating, 253
copying, 254
exporting, 255
interacting, 253
Model Viewer, 253
printing, 254

Index

properties, 254
moving rows and columns, 229
Multiple Imputation
options, 311
multiple open datafiles, 92, 291
suppressing, 95
multiple response sets
defining, 104
multiple categories, 104
multiple dichotomies, 104
multiple views/panes
Data Editor, 90

new features

version 18, 1
nominal, 71

measurement level, 71, 100
normal scores

in Rank Cases, 142
numeric format, 72—73

OK button, 5
OMS, 353, 376
command identifiers, 357
controlling table pivots, 359, 370
Excel format, 359
excluding output from the Viewer, 364
output object types, 355
PASW Statistics data file format, 359, 365
PDF format, 359
SAV file format, 359, 365
table subtypes, 357
text format, 359
using XSLT with OXML, 377
variable namesin SAV files, 372
Word format, 359
XML, 359, 372
online Help, 9
Statistics Coach, 7
opening files, 11-15, 28
controlling default file locations, 305
datafiles, 11-12
dBASE files, 11, 13
Excel files, 11, 13
Lotus 1-2-3 files, 11
spreadsheet files, 11, 13
Stata files, 14
SYSTAT files, 11
tab-delimited files, 11
text data files, 28
options, 291, 293, 295, 297, 299-300, 303, 305-306, 309
charts, 300
currency, 297
data, 295
general, 291
multiple imputation, 311
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output labels, 299
pivot table look, 303
scripts, 306
syntax editor, 309
temporary directory, 305
two-digit years, 295
Variable View, 297
Viewer, 293
ordinal, 71
measurement level, 71, 100
outer join, 20
outline, 207—208
changing levels, 208
collapsing, 208
expanding, 208
in Viewer, 207
output, 205207, 211-212, 227, 293
alignment, 207, 293
centering, 207, 293
changing output language, 291
copying, 206
copying into other applications, 211
deleting, 206
exporting, 212
hiding, 206
moving, 206
pasting into other applications, 211
saving, 227
showing, 206
Viewer, 205
Output Management System (OMS), 353, 376
output object types
in OMS, 355
OXML, 377

page numbering, 226
page setup, 224, 226
chart size, 226
headers and footers, 224
pane splitter
Data Editor, 90
Paste button, 5
PASW Data Collection data, 37
saving, 58
PASW Statistics data file format
routing output to a datafile, 359, 365
PDF
exporting output, 212, 219
PDF format
exporting output, 359
performance, 60
caching data, 60
pivot tables, 206, 211-212, 223, 228-231, 234-235, 237,
240, 243, 249-251, 303
aignment, 246
aternating row colors, 240
background color, 245

borders, 243
captions, 247-248
cell formats, 240
cell properties, 245246
cell widths, 249
changing display order, 229
changing the look, 235
continuation text, 243
controlling number of rowsto display, 238
controlling table breaks, 251
copying into other applications, 211
creating charts from tables, 251
default column width adjustment, 303
default look for new tables, 303
deleting group labels, 230
displaying hidden borders, 249
editing, 228
exporting as HTML, 212
fonts, 245
footnote properties, 240
footnotes, 247248
general properties, 237
grid lines, 249
grouping rows or columns, 230
hiding, 206
inserting group labels, 230
layers, 231
manipulating, 228
margins, 246
moving rows and columns, 229
pasting as tables, 211
pasting into other applications, 211
pivoting, 228
printing large tables, 251
printing layers, 223
properties, 237
rotating labels, 230
scaling to fit page, 237, 243
selecting rows and columns, 250
showing and hiding cells, 234
transposing rows and columns, 230
ungrouping rows or columns, 230
using icons, 228
pivoting
controlling with OM S for exported output, 370
PNG files, 212, 222
exporting charts, 212, 222
port numbers, 63
portable files
variable names, 40
PostScript files (encapsulated), 212, 222
exporting charts, 212, 222
PowerPoint, 217
exporting output as PowerPoint, 217
PowerPoint format
exporting output, 212
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printing, 91, 223-224, 226, 237, 243, 251
chart size, 226
charts, 223
controlling table breaks, 251
data, 91
headers and footers, 224
layers, 223, 237, 243
models, 254
page numbers, 226
pivot tables, 223
print preview, 223
scaling tables, 237, 243
space between output items, 226
text output, 223
prior moving average function, 161
Production Facility, 291
converting files to production jobs, 352

using command syntax from journal file, 291

Production jobs, 345, 348, 350
command line switches, 350
converting Production Facility files, 352
exporting charts, 345
output files, 345
running multiple production jobs, 350
scheduling production jobs, 350
substituting values in syntax files, 348
syntax rules, 345
programming with command language, 256
properties, 237
pivot tables, 237
tables, 237
proportion estimates
in Rank Cases, 142
Python
autoscripts, 386
scripts, 383

Quancept, 37
Quanvert, 37

random number seed, 128
random sample, 21
databases, 21
random number seed, 128
selecting, 185
ranking cases, 141
fractional ranks, 142
percentiles, 142
Savage scores, 142
tied values, 143
Rankit estimates, 142
recoding values, 116, 133-134, 136, 138
remote servers, 62—63, 6567
adding, 63
available procedures, 66
data file access, 65
editing, 63
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logging in, 62
relative paths, 67
removing group labels, 230
renaming datasets, 94
reordering rows and columns, 229
replacing missing values
linear interpolation, 164
linear trend, 164
mean of nearby points, 164
median of nearby points, 164
series mean, 164
Reset button, 5
restructuring data, 187-188, 190-192, 194-199, 201, 203
and weighted data, 203
creating a single index variable for variables to cases,
196
creating index variables for variables to cases, 194
creating multiple index variables for variables to cases,
197
example of cases to variables, 190
example of one index for variables to cases, 195
example of two indices for variables to cases, 196
example of variables to cases, 190
options for cases to variables, 201
options for variables to cases, 198
overview, 187
selecting data for cases to variables, 199
selecting data for variables to cases, 192
sorting data for cases to variables, 201
types of restructuring, 188
variable groups for variables to cases, 191
roles
Data Editor, 76
rotating labels, 230
rows, 250
selecting in pivot tables, 250
running median function, 161

sampling
random sample, 185
SASfiles
opening, 11
reading, 11
saving, 40
SAV file format
routing output to PASW Statistics data file, 359
routing output to PASW Statistics data files, 365
Savage scores, 142
saving charts, 212, 222
BMP files, 212, 222
EMF files, 212
EPS files, 212, 222
JPEG files, 212, 222
metafiles, 212
PICT files, 212
PNG files, 222
PostScript files, 222
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TIFF files, 222 Shift Values, 132
saving files, 3940 showing, 206, 234, 248, 314
controlling default file locations, 305 captions, 248
data files, 40 dimension labels, 234
database file queries, 27 footnotes, 248
PASW Statistics data files, 39 results, 206
saving output, 212, 217, 220 rows or columns, 234
Excel format, 212, 216 titles, 235
HTML, 212, 214 toolbars, 314
HTML format, 212 sizes, 208
PDF format, 212, 219 in outline, 208
PowerPoint format, 212, 217 smoothing function, 161
text format, 212, 220 sorting
Word format, 212, 215 variables, 170
scale, 71 sorting cases, 169
measurement level, 71, 100 sorting variables, 170
scale variables space-delimited data, 28
binning to create categorical variables, 116 speed, 60
scaling caching data, 60
pivot tables, 237, 243 spelling, 82
scientific notation, 72, 291 dictionary, 295
suppressing in output, 291 split-file processing, 181
scoring splitting tables, 251
displaying loaded models, 167 controlling table breaks, 251
loading saved models, 165 spp files
models supported for export and scoring, 164 converting to spj files, 352
scripts, 313, 317, 379 spreadsheet files, 11-13, 42
adding to menus, 313 opening, 13
autoscripts, 380 reading ranges, 12
Basic, 389 reading variable names, 12
creating, 379 writing variable names, 42
default language, 306, 379 SPSSTMPDIR environment variable, 305
editing, 379 Stata files, 14
languages, 379 opening, 11, 14
Python, 383 reading, 11
running, 379 saving, 40
running with toolbar buttons, 317 Statistics Coach, 7
startup scripts, 393 status bar, 4
search and replace string format, 72
viewer documents, 210 string variables, 75, 84
seasonal difference function, 161 breaking up long strings in earlier releases, 40
select cases, 182 computing new string variables, 126
selecting cases, 182 entering data, 84
based on selection criteria, 184 in dialog boxes, 4
date range, 185 missing values, 75
random sample, 185 recoding into consecutive integers, 138
range of cases, 185 subsets of cases
time range, 185 random sample, 185
selection methods, 250 selecting, 182, 184-185
selecting rows and columns in pivot tables, 250 subtitles
servers, 62—63 charts, 277
adding, 63 subtypes, 357
editing, 63 vs. labels, 358
logging in, 62 syntax, 256, 267, 316, 345
names, 63 accessing Command Syntax Reference, 9
port numbers, 63 journa file, 268

session journal, 305 output log, 258
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pasting, 258
Production jobs rules, 345
running, 267
running command syntax with toolbar buttons, 316
syntax rules, 256
Unicode command syntax files, 268
syntax converter, 394
syntax editor, 260
auto-completion, 263
bookmarks, 261, 265
breakpoints, 261, 264, 267
color coding, 263
command spans, 261
commenting out text, 266
line numbers, 261
options, 309
SYSTAT files, 11
opening, 11

T4253H smoothing, 161
tab-delimited files, 11-12, 28, 40, 42
opening, 11
reading variable names, 12
saving, 40
writing variable names, 42
table breaks, 251
table chart, 251
table subtypes, 357
vs. labels, 358
Tablel ooks, 235-236
applying, 235
creating, 236
tables, 251
alignment, 246
background color, 245
cell properties, 245-246
controlling table breaks, 251
converting TABLES command syntax to CTABLES,
394
fonts, 245
margins, 246
TABLES
converting TABLES command syntax to CTABLES,
394
target lists, 284
templates, 77-78, 277, 300
charts, 277
in charts, 300
using an external datafile as atemplate, 106
variable definition, 77—78
temporary active file, 60
temporary directory, 305
setting location in local mode, 305
SPSSTMPDIR environment variable, 305
temporary disk space, 59-60
text, 28, 209, 212, 220
adding atext file to the Viewer, 209
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adding to Viewer, 209
datafiles, 28
exporting output as text, 212, 220, 359
TIFF files, 222
exporting charts, 212, 222
time series data
creating new time series variables, 160
data transformations, 158
defining date variables, 159
replacing missing values, 162
transformation functions, 161
titles, 209
adding to Viewer, 209
charts, 277
toolbars, 314, 316-317
creating, 314, 316
creating new tools, 317
customizing, 314, 316
displaying in different windows, 316
showing and hiding, 314
transposing rows and columns, 230
transposing variables and cases, 171
trigger events, 381
autoscripts, 381
Tukey estimates, 142

Unicode, 11, 39
Unicode command syntax files, 268
user-missing values, 75

value labels, 74, 84, 90, 96, 299
applying to multiple variables, 102
copying, 102
in Data Editor, 90
in merged datafiles, 175
in outline pane, 299
in pivot tables, 299
inserting line breaks, 75
saving in Excel files, 40
using for data entry, 84

Van der Waerden estimates, 142

variable attributes, 7778
copying and pasting, 77-78
custom, 78

variable information, 280

variable labels, 74, 291, 299
in dialog boxes, 4, 291
in merged datafiles, 175
in outline pane, 299
in pivot tables, 299
inserting line breaks, 75

variable lists, 284
reordering target lists, 284

variable names, 70, 291
generated by OMS, 372
in dialog boxes, 4, 291
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mixed case variable names, 70
portable files, 40
rules, 70
truncating long variable namesin earlier releases, 40
wrapping long variable names in output, 70
variable pairs, 188
creating, 188
variable sets, 281-282
defining, 281
using, 282
Variable View, 69
customizing, 82, 297
variables, 6, 70, 86-87, 188, 280-281, 291
defining, 70
defining variable sets, 281
definition information, 280
display order in dialog boxes, 291
finding in Data Editor, 87
in dialog boxes, 4
inserting new variables, 86
moving, 87
recoding, 133-134, 136, 138
renaming for merged data files, 175
restructuring into cases, 188
selecting in dialog boxes, 6
sorting, 170
variable information in dialog boxes, 6
vertical label text, 230
viewer
find and replace information, 210
search and replace information, 210
Viewer, 205-209, 226-227, 293, 299
changing outline font, 209
changing outline levels, 208
changing outline sizes, 208
collapsing outline, 208
deleting output, 206
display options, 293
displaying data values, 299
displaying value |abels, 299
displaying variable labels, 299
displaying variable names, 299
excluding output types with OMS, 364
expanding outline, 208
hiding results, 206
moving output, 206
outline, 207
outline pane, 205
results pane, 205
saving document, 227
space between output items, 226
virtual active file, 59
Visual Bander, 116

weighted data, 203
and restructured data files, 203

weighting cases, 186
fractional weightsin Crosstabs, 186
wide tables
pasting into Microsoft Word, 211
window splitter
Data Editor, 90
windows, 2
active window, 3
designated window, 3
Word format
exporting output, 212, 215, 359
wide tables, 212
wrapping, 237
controlling column width for wrapped text, 237
variable and value labels, 75

XML
OXML output from OMS, 377
routing output to XML, 359
saving output as XML, 353
table structure in OXML, 372
XSLT
using with OXML, 377

years, 295
two-digit values, 295

Z scores
in Rank Cases, 142
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